
 
 1 

 
 
 
 
 
 
 
 
 

                                                                                                                                                      ® 

WINGRIDDS 

 
 
 
 
 
 
 
 
 

User’s Guide 

 
 
 
 
 
 
 
 
 
 
 

Version: 6.00b 01/01/2022 
 
 
 
 
 
 
 
 

International Copyright © / Trademark ® 2022.  All rights reserved. 
 



 
 2 

WINGRIDDS Table Of Contents 
 
License ...............................................................................................7 
Forward ..............................................................................................9 
Introduction ...................................................................................... 11 
System Requirements and Preparation .......................................... 11 
Installation of WINGRIDDS ............................................................. 12 
Removal of WINGRIDDS ......................................................................... 17 
 
WINGRIDDS Applications ..................................................................... 22 
Downloading GRIB Data .......................................................................... 22 
Automated GRIB Downloading ................................................................ 26 
Ingesting GRIB Data ................................................................................ 26 
Processing Ensemble Probability GRIB Data .......................................... 30 
Automated GRIB Data Ingest .................................................................. 34 
WAFS GRIB Data Ingest ......................................................................... 34 
ECMWF WAFS GRIB Data Ingest ........................................................... 36 
Convert WAFS GRIB Data to WINGRIDDS Format ................................ 37 
Automated WAFS GRIB Data Ingest ....................................................... 38 
Downloading Observation Data ............................................................... 41 
Automated Observation Data Downloading ............................................. 44 
Ingesting Observation Data ..................................................................... 44 
Observation Data File Editing .................................................................. 48 
Reanalyze Observation Data ................................................................... 52 
Automated Observation Data Ingest ........................................................ 52 
Downloading ASUS Frontal Data ............................................................ 52 
Automated ASUS Frontal Position Data Download ................................. 56 
Using WINGRIDDS ................................................................................. 57 
Using Custom Grids/Maps ....................................................................... 62 
 
WINGRIDDS Tutorial  ............................................................................. 72 
Sample Ingest Session for WAFS GRIB Data  ........................................ 72 
Sample Ingest Session for NWS/Regular GRIB Data  ............................. 77 
Sample Ingest Session for Observation Data  ......................................... 79 
Sample WINGRIDDS Applications Session  ............................................ 82  
 
WINGRIDDS Operations ........................................................................ 86 
Starting WINGRIDDS .............................................................................. 86 
File Menu ................................................................................................. 88 
   -Open New Processed Data File .......................................................... 88 
   -Change Processed Data File ............................................................... 90 
   -List Processed Data Contents ............................................................. 92 
Specs Menu ............................................................................................. 93 
   -Forecast Hour ...................................................................................... 94 
   -Vertical Level ....................................................................................... 95 
Display Menu ........................................................................................... 97 
   -Define the Plane View Mode ............................................................... 99 
   -Define the Cross Section Mode ......................................................... 112 



 
 3 

   -Define the Time Section Mode .......................................................... 118 
Sounding/Hodograph/BUFKIT/Trajectory Point Setup ........................... 123  
   -Sounding Display .............................................................................. 126 
   -Hodograph Display ............................................................................ 130 
   -BUFKIT File Generation .................................................................... 132 
   -Trajectory Display .............................................................................. 134 
   -Surface Frontal Positions .................................................................. 137 
Products Menu ...................................................................................... 138 
   -Product Category .............................................................................. 138 
   -Command Window ............................................................................ 140 
Command Line Operations .................................................................... 141 
1 Panel/4 Panel Operations ................................................................... 141 
 
Defining Products ................................................................................ 143 
Command Line Execution ...................................................................... 143 
Products Menu Execution ...................................................................... 143 
Macro Files ............................................................................................ 147 
Plot Labels ............................................................................................. 151 
Custom Labels ....................................................................................... 153 
 
WINGRIDDS Command Line Operations ........................................... 159 
Changing Flag Variable Values – Level/Layer Specification.................. 160 
Changing Flag Variable Values – Time Specification ............................ 160 
Specifying the Display Area ................................................................... 160 
Choosing Custom Map Backgrounds .................................................... 161 
Choosing 1 Panel or 4 Panel Display Mode .......................................... 161 
Choosing Custom Map Navigation Mode .............................................. 162 
Command Structures – Displaying Primary Data Fields ........................ 162 
Overlaying Displays on a Single Command Line ................................... 164 
Changing Contour Intervals ................................................................... 164 
Simplified Contour Interval Selection ..................................................... 165 
Changing Contour Colors / Dashed Contours ....................................... 165 
Single Line Contour Plot ........................................................................ 165 
Plotting Digital Grid values at Data Points / Scaling Options ................. 166 
Wind Displays ........................................................................................ 166 
Changing Arrow Length ......................................................................... 167 
Displaying Wind Barbs or Streamlines .................................................. 167 
Use of Layers or Multiple Time Periods ................................................. 167 
Native RUC (Rapid Update Cycle) Hybrid-B levels ............................... 168 
Animation  .............................................................................................. 169 
Animation in 4 Panel Mode .................................................................... 170 
Animation Controls ................................................................................ 171 
Specify a Cross Section Path ................................................................ 171 
Cross Section Wind Displays ................................................................. 172 
Specify a Time Section Plot ................................................................... 172 
Sounding Commands ............................................................................ 174 
Hodograph Commands.......................................................................... 174 
Trajectory Commands ........................................................................... 175 
BUFKIT Data Generation Commands ................................................... 175 



 
 4 

Printing  .............................................................................................. 175 
Saving and Restoring Pre-Generated Graphics .................................... 176 
Data Masking Commands ..................................................................... 176 
Velocity Potential/Stream Function Commands ..................................... 177 
 
WINGRIDDS Contour Color Fill Operations ...................................... 178 
Line Based, Graduated Color (CTLG [CLN*] ) ....................................... 180 
Fill Based, Selected Pattern (CTFP [CFP*] ) ......................................... 181 
Fill Based Selected Color (CTFC [CFC*] ) ............................................. 181 
Fill Based, Graduated Color (CTFG [CFG*] )  ....................................... 184 
 
WINGRIDDS Climate Calculations ..................................................... 186 
 
WINGRIDDS Observation Data Operations ....................................... 188 
Observation Data Ingesting with OBS2PCG (Command Line) .............. 190 
Observation Data Ingesting with OBS2PCG from within WINGRIDDS . 191 
Observation PCG Data File Names ....................................................... 193 
Combined Observation Data File Names .............................................. 193 
Editing Combined Observation Files  .................................................... 198 
Station Model Plot Color Control ........................................................... 200 
Plotting Station Model Data ................................................................... 201 
WINGRIDDS Observation Commands .................................................. 201 
 
Diagnostic Functions .......................................................................... 202 
Diagnostic Functions – Background and Philosophy ............................. 202 
Available Diagnostic Functions .............................................................. 202 
Diagnostic Functions – Cross Section Specific ...................................... 204 
Examples of Diagnostic Functions ......................................................... 204 
Shorthand Specifications and Commonly Used Functions .................... 205 
Repeating Previous Commands ............................................................ 205 
Calculating Convection and Shear Parameters ..................................... 206 
Command (Macro) Files ........................................................................ 207 
Sample Command File .......................................................................... 207 
 
Diagnostic Functions - Advanced Explanations ............................... 208 
Vertical Level Commands ...................................................................... 208 
Commands to Alter Contour Interval ..................................................... 210 
Commands to Alter Forecast Time ........................................................ 212 
Commands to Display Gridded Data ..................................................... 213 
Pressure and Geopotential Height Commands ..................................... 214 
Temperature Commands ....................................................................... 215 
Wind Commands ................................................................................... 215 
Cross/Time Section Displays ................................................................. 220 
Cross/Time Section Commands ............................................................ 220 
Moisture Commands ............................................................................. 225 
Precipitation Fields Commands ............................................................. 226 
Scalar/Vector Commands ...................................................................... 227 
Scalar Diagnostics ................................................................................. 228 
Vector Diagnostics ................................................................................. 231 



 
 5 

Commands for Layer/Time Values ........................................................ 237 
Commands for Lifting Layers ................................................................. 240 
Commands to Alter Appearance of Display Fields & Data..................... 241 
 
 
WINGRIDDS Automatic Mode Operations ......................................... 243 
 
Online Help ........................................................................................... 244 
Macro Help ............................................................................................ 245 
WINGRIDDS Documentation ................................................................. 245 
GRIB1 & GRIB2 Documentation ............................................................ 245 
  
Customizing the WINGRIDDS System ............................................... 246 
WINGRIDDS Configuration ................................................................... 246 
   -Properties – WINGRIDDS Contour Colors ........................................ 247 
   -Properties – Surface/Upper Air Station Colors .................................. 248 
   -Properties – WINGRIDDS Data Directories ....................................... 249 
   -Properties – WINGRIDDS Directories Dialog .................................... 250 
   -Properties – Sounding Colors ............................................................ 251 
   -Properties – Hodograph Colors ......................................................... 252 
   -Properties – Streamline Settings ....................................................... 253 
   -Properties – WINGRIDDS General Settings ...................................... 254 
   -Properties – WINGRIDDS Map Settings ........................................... 255 
   -Properties – WINGRIDDS General Settings 2 ................................... 256 
   -Properties – WINGRIDDS Custom Color Selection ........................... 257 
Model Origination and Flight Levels for Labels ...................................... 258 
Initial Pressure Levels and Forecast Hours ........................................... 258 
Changing Width of a Cross-Section Plot................................................ 259 
Changing Pressure Levels for Cross-Section and Time-Section Plots .. 259 
Changing Forecast Hours for Time-Section Plots .................................. 260 
Station ID Lists ...................................................................................... 261 
User Defined Alias Commands .............................................................. 262 
GRIB Specification for Data Ingest ........................................................ 263 
   -GRIBMODL.DAT ............................................................................... 263 
   -GRID.DAT ......................................................................................... 263 
   -GRIBPARM.DAT/MOSGRIBPARM.DAT ........................................... 264 
   -GRIB2PARM.DAT ............................................................................. 265 
   -GRIB2ENSPROBPARM.DAT ............................................................ 267 
   -GRIBLEVEL.DAT .............................................................................. 268 
   -GRIB2SKIP.DAT ............................................................................... 268 
Map Type Specifications ........................................................................ 269 
Background Map Selection .................................................................... 269 
Plan, Cross Section & Time Section Area Lookup Tables ..................... 271 
Setting and reading Default Contour Color-Fill Colors ........................... 272 
 
Customizing Data Downloading ............................................................. 273 
   -GRIB/Observation Data Download Category File .............................. 274 
   -Download List File ............................................................................. 275 
   -Download Data File ........................................................................... 276 



 
 6 

   -Automated Data Download ................................................................ 278 
   -GETGRIB Download Utility ................................................................ 278 
 
WINGRIDDS Workstation/Server Automation Setup ........................ 282 
Workstation Automation Configuration .................................................. 283 
GRIB Download Scripts and Batch Files ............................................... 288 
Automated GRIB Download Schedule Setup ........................................ 290 
Server Configuration .............................................................................. 300 
Server File Sharing Configuration Setup ............................................... 300 
 
Troubleshooting GRIB Download and Processing ........................... 314 
 
 
APPENDIX A: Command Function Summary .................................... 320 
Commands/Diagnostics contained in the ALIAS.DAT file ...................... 344 
Commands/Diagnostics contained in the ALIAS.USR file ..................... 346 
 
APPENDIX B: Listing of Basic Grid Fields ........................................ 348 
 
Appendix C:  Observation Station Weather Symbols ............... 354 
Current Weather Symbols ..................................................................... 354 
Sky Cover Symbols ............................................................................... 359 
Pressure Tendency Symbols ................................................................. 360 
Past Weather Symbols .......................................................................... 361 
 
APPENDIX D: Common Color Tables ................................................ 362 
 
APPENDIX E: Assorted Diagnostic Formulas ............................... 366 



 
 7 

 

WINGRIDDS LICENSE 
 
Thank you for your interest in WINGRIDDS.  Although WINGRIDDS software is freeware, your use of the 
WINGRIDDS software is subject to the terms and conditions of this License. 
 
In downloading and/or using the WINGRIDDS software you agree to the terms and conditions of this 
License.  If you do not accept the terms and conditions of this License you should not use the WINGRIDDS 
software and should remove any copies of the WINGRIDDS software from your system. 
 
 
Intellectual Property Rights 
============================ 
All intellectual property rights in the WINGRIDDS software are owned and retained by Jeff Krob, registered 
in the United States of America.  
 
License 
======= 
WINGRIDDS hereby grants you a non-exclusive, perpetual, worldwide, personal license to use the 
WINGRIDDS software. 
 
You may make copies of the WINGRIDDS software for distribution to others on a not-for-profit basis, 
provided that all such copies are identical to the WINGRIDDS software you downloaded.  WINGRIDDS 
recommends that you pass the details of the WINGRIDDS website to anyone you provide your 
WINGRIDDS software to, so that they have the option of downloading the most recent version of the 
WINGRIDDS software. The WINGRIDDS home page is: winweather.org. 
 
You may not translate, reverse engineer, decompile, disassemble, modify or create derivative works based 
on the WINGRIDDS software except as expressly permitted by the law applicable to these terms and 
conditions. 
 
All other rights are reserved to WINGRIDDS. 
 
Liability 
========= 
WINGRIDDS developer has used all reasonable skill and care to ensure that the WINGRIDDS software will 
run properly on a suitably configured system and is virus free.  However, WINGRIDDS cannot guarantee 
that the WINGRIDDS software will be free from bugs, errors, or other damaging code, or that it will be 
suitable for your purposes.    
 
You therefore agree that you run the WINGRIDDS software on your system at your own risk and that 
WINGRIDDS is under no obligation to update the WINGRIDDS software or to correct errors in it.  Other 
than the statements made in this License WINGRIDDS excludes all warranties, representations and 
conditions, whether express or implied by statute or otherwise to the extent permitted by law. 
 
WINGRIDDS is absolved, removed and has no liability in contract, tort (including negligence or breach of 
statutory duty), misrepresentation, restitution or otherwise, arising in connection with your use of the 
WINGRIDDS software. 
 
You agree that WINGRIDDS is not liable for pure economic loss, loss of profit, loss of business, depletion 
of goodwill, loss of data, waste of management or office time or otherwise, in each case whether direct, 
indirect or consequential, or any claims for consequential compensation whatsoever (howsoever caused) 



 
 8 

which arise out of or in connection with your use of, or inability to use, the WINGRIDDS software. 
 
Nothing in these terms and conditions excludes or limits the liability of WINGRIDDS for death or personal 
injury caused by WINGRIDDS’ negligence or for fraudulent misrepresentation or for anything else for which 
it would be unlawful to exclude liability. 
 
These terms and conditions constitute the entire agreement between you and WINGRIDDS in connection 
with your use of the WINGRIDDS software. 
 
Law 
 
If any provision of these terms and conditions is prohibited by law or judged to be illegal, void, invalid or 
unenforceable (in whole or in part) by any court or administrative body of competent jurisdiction for any 
reason, that provision shall to that extent be deemed not to form part of these terms and conditions but the 
enforceability of the remainder of these terms and conditions shall not be affected and shall remain in full 
force and effect. 
 
These terms and conditions shall be governed by and construed in accordance with the law of the United 
States.  You and WINGRIDDS agree that the courts of United States shall have exclusive jurisdiction over 
any claim or matter arising under or in connection with these terms and conditions. 
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WINGRIDDS FORWARD 
 

Welcome to WINGRIDDS, the Microsoft Windows 32-bit version of the original Personal Computer based 
Gridded Interactive Display and Diagnostic System (PCGRIDDS).  It is intended as a forecaster's tool for 
providing interactive access to high resolution meteorological information in support of domestic forecasting 
and international aviation using the Microsoft WINDOWS computer environment. 
 
WINGRIDDS is a software tool that allows forecasters to perform a wide variety of diagnostic operations on 
gridded model data and observation data. The software runs on any x86-based personal computer (PC) 
running Microsoft Windows XP or newer. The gridded data are obtained from numerical weather prediction 
(NWP) models routinely run at the National Center for Environmental Prediction (NCEP) in Camp Springs, 
Maryland, other international meteorological forecast centers as well as local-run mesoscale models. The 
observation data is freely available from various university, collage and government web and FTP sites. 
 
WINGRIDDS offers an amazing variety of commands to view and manipulate gridded data and observation 
data. Included with WINGRIDDS are a host of diagnostic functions to perform such operations as compute 
advection, divergence, take differences between fields, multiple a scalar field by a constant, etc. - the list is 
extensive. The WINGRIDDS user interface allows one to enter various combinations of command. Lengthy 
combinations of commands, or commands frequently used can be stored on disk for future use as a 
"command file". Command files have been written to compute such quantities as moisture convergence, 
850 mb theta-E advection, Q-vectors, scalar frontogenesis, etc. 
 
To realize and effectively use the full spectrum of WINGRIDDS commands - to go beyond simply 
displaying basic fields of temperature, wind, and moisture - requires a sound background in mathematics, 
especially elementary vector operations. Much of the background on vector operations can be found in any 
undergraduate calculus or dynamical meteorology textbooks. Good references would include the recent 
books by Holton (1992) or Bluestein (1992). Basically, if you understand the mathematical concepts of 1) 
partial differentiation, 2) gradient of a quantity, and 3) the scalar "dot" product and advection of a quantity, 
you'll be a long way to learning how to use WINGRIDDS effectively. Regardless, even without the 
mathematics, WINGRIDDS is still quite a useful diagnostic tool. 
 
WINGRIDDS is also quite useful for displaying meteorological quantities in an isentropic coordinate 
framework. The area of isentropic analysis is enjoying quite a resurgence with the meteorological 
community. This resurgence is no doubt helped by availability of software, like WINGRIDDS, to view 
quantities isentropically. Moore (1993) contains a thorough review of isentropic analysis in the forecast 
process. Forecasters who use WINGRIDDS should try examining moisture and wind data in isentropic 
space. 
 
What is this document? 
 
This document is a reference manual that describes all commands available within WINGRIDDS. It will not 
teach you mathematics or dynamic meteorology. It will not teach you how to use WINGRIDDS to put a 
forecast together. What it does provide is documentation for each of the variety of WINGRIDDS commands 
that you may (someday) want to use. There are over 300 unique WINGRIDDS commands! Like any 
reference manual, you consult it when you have some question on what a particular command does and 
what input quantities the command requires, or what the output from the command is. 
 
It's a good idea to skim through this manual, taking note of commands that interest you. Also, scan through 
the table of contents. Don't be afraid to try out new commands or experiment with computing various 
quantities - you won't break the system. Often, learning a new command sparks some interest in using it to 
answer some question you may have about the model data field. 
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WINGRIDDS is useful for local research studies. Once the model grids for a particular event are obtained, 
one can easily and readily review the model forecasts and perform sophisticated diagnoses of various 
fields.  
 
Good luck and enjoy. 
 
Jeff Krob 
 
NESDIS 
National Oceanic and Atmospheric Administration 
Department of Commerce 
United States of America 
 
WINGRIDDS Home Page: http://winweather.org 
PCGRIDDS32/WINGRIDDS User Support Forum: http://www.weathergraphics.com/forum 
WINGRIDDS Email Support: Jeffrey.A.Krob@noaa.gov 
                                                 jkrob@comcast.net 

http://winweather.org/
http://www.weathergraphics.com/forum
mailto:Jeffrey.A.Krob@noaa.gov
mailto:jkrob@comcast.net
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Introduction 
 
WINGRIDDS, a 32-bit Microsoft WINdows based GRidded Interactive Display and Diagnostic System, is a 
software package that allows the user to view meteorologically significant fields of gridded analysis and 
numerical weather prediction model output as well as observation data.  The fields are displayed in either 
contour or vector format, whichever is appropriate for a particular field. Observation data can also be 
displayed in Surface or Upper-air Station plots.  This package also allows the user to extract a variety of 
information from meteorological diagnostic parameters computed from the data fields. 
 
The flexibility of WINGRIDDS allows the package to meet the needs of users with a wide range of skills 
and requirements.  The novice can quickly learn to display a wide variety of predefined products using the 
WINGRIDDS Menu system.  More advanced users can develop specialized products to meet their 
individual needs using the programmable WINGRIDDS Command language, including the creation of 
customized menu options to meet specific user needs. 
 
This documentation guides users through installation and the basic concepts of operating WINGRIDDS 
through its menu system.  It then proceeds with a discussion of topics useful for the more advanced user or 
system administrator.  ONLINE HELP is available while using WINGRIDDS.  All users should read the first 
four sections carefully: 
 

A. Introduction 
B. Installation of WINGRIDDS 
C. Using WINGRIDDS 

 
The remaining sections can be selected according to the user’s needs and interests. 
 
 Before Installation 

 
System Requirements and Preparation 
 
-- Hardware Recommendations 
 

AMD Athlon/Intel PENTIUM processor or greater running MS Windows XP or greater. 
 
 VGA graphics adapter    Microsoft Windows compatible VGA or better color 

monitor. 
 

 16MB or greater memory   This amount of memory is the minimum required to run 
WINGRIDDS on Windows XP.  As with any Microsoft 
Windows installation, the more memory, the better. 

 
 Printer                      WINGRIDDS uses the default Windows printer.    

 
 
-- System Setup 

WINGRIDDS runs Microsoft Windows XP or later.  WINGRIDDS development no longer supports 
earlier version. The system configuration necessary to run WINGRIDDS is described in this section.   
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Networks 
 Installation The WINGRIDDS software is designed for installation on a standalone PC. 

Data download is usually done via a network and Internet connection. 
    

 
 Data  The data displayed within WINGRIDDS may be located on a network drive.  

The complete path (drive and directory) to the data must be specified in the file, 
USER\WINGMODE.DAT.  Refer to ‘WINGRIDDS Configuration’ section 
additional information. 

 
 
-- Memory Requirements 

WINGRIDDS requires a minimum of 7MB of memory.  The ingest programs that convert data from 
GRIB to WINGRIDDS format require about 3MB each of memory.  Check the available memory for 
running programs. 
 

 
Installation of WINGRIDDS 
 
 

 New Installation of WINGRIDDS 
 

Before you start the installation, read and check the following information. 
 

1. The WINGRIDDS software must be installed on a hard drive which is located on a 
standalone PC.   

 
2. If necessary, the installation will create the following directories:  \WINGRIDDS.  If 

the directories already exist, it will write over any files in these directories.  Before 
installation, save any important files in these directories and remove the directories. 

 
 
 Internet Access to WINGRIDDS Software and Documentation 
  

WINGRIDDS Home Page: http://winweather.org 
  
  

 
 
 
 
 
 
 
 
 
 
 

http://www.winweather.org/
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-- Install WINGRIDDS from your hard drive 
Once the transfer of the WINGRIDDS files to your local system is complete, you can install 
WINGRIDDS from your hard drive. 

 
1. Copy the WINGRIDDS installation file (WINGRIDDS.MSI) to a temporary directory of the hard 

drive you wish WINGRIDDS to execute from.  If the file is not seen on your system as an 
executable file, you will have to download and install the latest Microsoft Installation client which 
is available from Microsoft or downloadable from the WINGRIDDS Home Page. 

 
 2. Execute the WINGRIDDS.MSI file and you will see the following: 
 

 
   
 

3.   Click on the ‘Next’ Button and follow the instructions. 
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4.  The Installation Utility will default to the C:\WINGRIDDS directory and that is the preferred 
location.  However, if you wish to have WINGRIDDS run from another directory or drive, you may 
select it here.  
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NOTE: If the directory used for data displayed by WINGRIDDS is not stored in the directory 
\WINGRIDDS\GRIDDATA directory, you MUST modify entry 2 in the file 
USER\WINGMODE.DAT.  Refer to the section ‘WINGRIDDS Configuration’ or the internal 
documentation in the file for additional information. 

 

 
 
5.  Click the ‘Install’ Button to begin the file copy process. 
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6.  During the installation process, all files and directories will be created and copied.  Also Program 

File and Desktop shortcuts to WINGRIDDS will be created. 
 
 

 
 
7.  At the successful end of the installation, click the ‘Finnish’ button.  No system restart is required. 
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Removal of WINGRIDDS 
 
In order to uninstall WINGRIDDS, go to “Settings>Control Panel>Add/Remove Programs” section of 
Windows.  Once the program listing is complete, scroll down to the bottom of the page to where 
WINGRIDDS is listed (the program listing should be alphabetical).  Once the WINGRIDDS list is found, 
click on the “Add/Remove” button to uninstall WINGRIDDS.  Since there are no scattered DLL files, the 
uninstall process is clean and all files, directories and icons will be removed. 
 
-- Directory Structure 

Below is a diagram of the directory structure required to run WINGRIDDS.  All directories must be 
present in order to run WINGRIDDS.   

 
 

─ WINGRIDDS──────┬───ANIMATE 
                 ├───CLIMO 
                 ├───DATA 
                 ├───DOC─────┬──GRIB1 
                 ├           └──GRIB2 
                 ├  
                 ├───GRIB─────┬──NWS * 
                 ├            ├──MOS * 
                 ├            ├──USER 
                 ├            └──WAFS * ──┬──OCTANTI 
                 ├                        ├──OCTANTJ 
                 ├                        ├──OCTANTK 
                 ├                        ├──OCTANTL 
                 ├                        ├──OCTANTM 
                 ├                        ├──OCTANTN 
                 ├                        ├──OCTANTO 
                 ├                        └──OCTANTP 

                                                      ├ 
                 ├ 
                 ├───GRIDDATA──┬──MODEL 
                 ├             └──OBS 
                 ├───HELP 
                 ├───MACROS 
                 ├───MAPFIL──────Country_Provinces 
                 ├───OBS──────┬──SURFACE──┬──BUOY 
                 ├            ├           ├──FRONT 
                 ├            ├           ├──METAR 
                 ├            ├           ├──SHIP 
                 ├            ├           └──SYN 
                 ├            └──UPPER-AIR            
                 ├ 
                 ├───PRTFIL 
                 └───USER 

 
 

WINGRIDDS The main WINGRIDDS directory contains the temporary and status files written by 
WINGRIDDS and the program files used to run the WINGRIDDS system. 

Your system administrator may modify the .PCG file to meet the needs of your environment.  If 
an error occurs during the execution of WINGRIDDS, files, such as WINGRIDDS.LOG, 
GRIB2PCG32.OUT, NGRB2PCG32.OUT and OBS2PCG.OUT may provide information 
about the source of the problem. 
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           ANIMATION       The ANIMATION directory contains all of the files which are created and used 
                                     every time an animation command is executed within WINGRIDDS. 
 

CLIMO  The CLIMO directory contains supporting data files used by WINGRIDDS to 
calculate climate averages & anomalies. There is a data file for each month of the 
year with various SCALAR & VECTOR meteorological averaged parameters 
calculated over 2 time periods: 30yr (1985-2015) and 60yr (1955-2015).  

 
 

DATA  The DATA directory contains supporting data files used by WINGRIDDS to display 
items such as forms and messages.  This directory does not contain gridded data 
files. 

The contents of these files are crucial to the operation of WINGRIDDS and should be modified 
only by the system administrator. 

 
 DOC   The DOC directory contains the WINGRIDDS User Guide as well as the html                               

GRIB1 and GRIB2 documentation. 
 

GRIB  The GRIB directory contains files that control the selection and processing of GRIB 
data that is converted to WINGRIDDS format.  Within it are located the sub-
directories NWS, WAFS, MOS and USER. Under the WAFS directory are 
subdirectories for each WAFS Octant, I-P. 

Files in this directory are crucial to the operation of the ingest process and should not be 
modified by any user. 

 
   NWS  Non-WAFS GRIB data files that will be converted to WINGRIDDS format are 

stored in the WINGRIDDS\GRIB\NWS directory. This directory may be 
located in another location including shared drives if necessary.  If relocated, 
it must be reflected in the WINGMODE.DAT file. 

 
Files in this directory are provided by the GETGRIB utility (refer to ‘Downloading 
GRIB data’ and ‘Customizing the GRIB Download Process’) or by the user using 
other transfer methods separate from WINGRIDDS. 

 
   MOS  Non-WAFS MOS GRIB data files that will be converted to WINGRIDDS 

format are stored in the WINGRIDDS\GRIB\MOS directory. This directory 
may be located in another location including shared drives if necessary.  If 
relocated, it must be reflected in the WINGMODE.DAT file. 

 
Files in this directory are provided by the GETGRIB utility (refer to ‘Downloading 
GRIB data’ and ‘Customizing the GRIB Download Process’) or by the user using 
other transfer methods separate from WINGRIDDS. 

 
   USER  Contains all of the GRIB and Observation data Internet download scripts that 

control the data download process and the data files to create the Data 
Download Menus. 

Files in this directory are used by the GETGRIB utility (refer to ‘Downloading 
GRIB data’ and ‘Customizing the GRIB Download Process’) . 
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These files can be modified by the system administrator to meet your requirements 
(refer to ‘Customizing the Data Download Process’). 

 
   WAFS  WAFS GRIB data files that will be converted to WINGRIDDS format are 

stored in the WINGRIDDS\GRIB\WAFS\OCTANT* directory where the ‘*’ 
stands for the Octant letter it represents. The user should place all ‘J’ Octant 
GRIB files in the WINGRIDDS\GRIB\WAFS\OCTANTJ directory and so on. 
This directory may be located in another location including shared drives if 
necessary.  If relocated, it must be reflected in the WINGMODE.DAT file. 

 
Files in this directory are provided by the GETGRIB utility (refer to ‘Downloading 
GRIB data’ and ‘Customizing the GRIB Download Process’) or by the user using 
other transfer methods separate from WINGRIDDS. 

 
GRIDDATA The GRIDDATA directory is the default directory where the processed gridded 

meteorological data are stored. This is also where GEMPAK data files would be 
stored. This directory may be located in another location including shared drives if 
necessary.  If relocated, it must be reflected in the WINGMODE.DAT file. 

 
Gridded data files can be added or deleted.   

 
   MODEL   The directory where the new version gridded meteorological data are 

stored. The regular GRIB ingest utility NGRB2PCG32 has been modified to 
create a new data file format to allow for the processing of much larger GRIB 
datasets. The older single-file data format has been changed to a multiple-file 
data format organized by a controlling inventory file. 

 
   OBS   Contains all of the processed Surface and Upper-Air Observation data 

processed for a specific time.  This text-based data is used to create the 
Station Plots and build the gridded data files. These text files are what should 
be edited to remove erroneous observations which are corrupting the gridded 
data. 

 
HELP  The HELP directory contains files used to supply ONLINE HELP for WINGRIDDS 

Command Macros. 
 

WINGRIDDS is delivered with a default set of HELP files.  If any customized macros are 
added to a 'Product List' menu, it is strongly recommended that a corresponding HELP file 
should also be added to the HELP directory. 

 
 MACROS  The MACROS directory contains the currently active command files (xxxx.CMD) 

used to display WINGRIDDS products, the text file for the 'Product Category' menu 
(CMDMENU.LST), and the text files for the 'Product List' menus (CMDMENU.###). 

 
WINGRIDDS is delivered with a default set of macros.  You are encouraged to develop 
customized command files and menus to meet the special requirements of your environment 
(refer to 'Defining Products'). 
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MAPFIL  The MAPFIL directory stores all of the original resolution and high resolution map 

files which are plotted on the WINGRIDDS background. In order to display a map on 
the screen, WINGRIDDS must transform latitude/longitude based line segment 
coordinates (found, for example, in the file WINGRIDDS\MAPFIL\WORLD.MAP) to 
the current map projection on the screen.  This is a time consuming process.  To 
increase the efficiency of WINGRIDDS, display maps can be saved.  The MAPFIL 
directory contains the saved display maps (QCONTMP.###, QCONLTLN.###) and 
the list (MAP.LST) of and index (MAP.IDX) to the names of the saved display maps. 

 
Your system administrator can save frequently accessed display maps by using the SVMP 
command.  Files in this directory are controlled by WINGRIDDS and should not be modified by 
any user. 

 
    Country_Provinces The Country_Provinces contains individual high resolution 

data map files of country province outlines which can be used in conjunction 
with the other high resolution map files. The MAPFILE.DAT file controls the 
use of all high resolution map files. 

 
OBS  The OBS directory contains the subdirectories which hold the raw observation files to be 

processed and converted by the OBS2PCG Observation Ingest utility. 
 

     SURFACE   This directory contains the categorized subdirectories which contain the       
surface observations. 

 
     BUOY   The BUOY directory contains the individual raw buoy observation 

messages. 
 

     FRONT   The FRONT directory contains the individual ASUS Frontal Position 
observation messages. 

 
     METAR   The METAR directory contains the individual raw SAO/METAR 

observation messages. 
 
     SHIP   The SHIP directory contains the individual raw ship observation 

messages. 
 
     SYN   The SYN directory contains the individual raw synoptic observation 

messages. 
 
 

 
 

    UPPERAIR  The UPPERAIR directory contains the individual raw RAOB upper-air 
observation messages. 

 
 
PRTFIL  The PRTFIL directory contains files used for printing.  Files with the extension .SVG 

contain products saved by the user for printing and restoring to the screen. 
 

The files, !A.SVG and A.SVG, are dummy files used by WINGRIDDS and should not be 
deleted.  Files that begin with '!' are used for delayed printing and should be managed through 
WINGRIDDS.  All other .SVG files may be deleted by the user when they are no longer 
needed. 
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USER  The USER directory contains files that control defaults for and the appearance of 

product displays, menu displays, and printed output.  Other files provide 
WINGRIDDS with information about your computing environment. 

These files can be modified to meet your requirements (refer to 'Customizing WINGRIDDS'). 
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WINGRIDDS Applications 
 
 
Downloading GRIB Data  
 
WINGRIDDS works off of GRIB model data or Observation data and that data must be transferred into the 
WINGRIDDS system to be converted into PCG data format. This section will only cover GRIB data. 
WINGRIDDS uses the GETGRIB utility build the FTPDATA.BAT batch file using user configured data files 
within the WINGRIDDS/GRIB/USER directory and executes the cURL utility to perform the actual transfer 
of downloading GRIB files via the Internet or local intranet.  The GRIB transfer process can be performed 
from within WINGRIDDS while WINGRIDDS is executing or it can be done in an automated function during 
off hours through scheduled batch file execution using user created batch files and the Microsoft Windows 
Scheduling task.  This process is covered in more detail below. 
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-- GRIB Download within WINGRIDDS 
 
The first selection under the ‘File’ Menu, ‘Download GRIB Files’, leads to a sub-menu which has ‘WAFS 
GRIB’, ‘Regular GRIB’, ‘MOS GRIB’ and ‘Ensemble GRIB’.  The Ensemble GRIB selection has its own 
sub-menu which lists ‘Regular GRIB’ and ‘WAFS GRIB’ selections.  See the figure below. 
 

 
 
These selections are listed because each has its own separate directory destination under the GRIB 
directory.  Any types of GRIB which do not fall under the category of WAFS, MOS or Ensemble should be 
listed under the ‘Regular GRIB’ listing.   
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Upon choosing a GRIB category, for example, ‘Regular GRIB’, brings up the GRIB Download Category: 
 

 
 
 
This will display the contents of a file which is configurable by the user (refer to ‘Customizing the GRIB 
Download Process’).  The user can double-click on a selection or single-click a selection to highlight and  
Click the ‘OK’ button.   
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Upon the selection by the user, the ‘GRIB Download Selection’ window is displayed.  See the figure below. 
 

 
 
The GRIB Download Selection windows lists the individual data file names and descriptions for doing a 
GRIB download job.  These files are also configurable by the user (refer to ‘Customizing the GRIB Download 
Process’).  The user can double-click on a selection or single-click a selection to highlight and  
Click the ‘OK’ button.   
 
Upon this action, the GRIB download utility will begin and open a separate window to show the progress of 
the file download.  If the user is running WINGRIDDS, that window can be iconized or placed in the 
background so WINGRIDDS operations can resume. 
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-- Automated GRIB Download Outside WINGRIDDS 
 
The user can create batch files to execute the GETGRIB utility using the Microsoft Windows Scheduler to 
time when and where the batch file will run.  The commands for the batch file are as follows: 
 
GETGRIB “user file”.DAT 
 
Where the “user file” is a ‘.DAT’ file which holds the commands for downloading the specific GRIB files the 
user wants.  This file name is the same as what is listed in the left column in the GRIB Download Selection 
window (refer to ‘Customizing the GRIB Download Process’). 
 
Detailed configuration & use of automation scripts and scheduling tasks for stand-alone Workstations or 
Workstation/Server system configurations are given in the Workstation/Server Setup section. 
 
 
Ingesting GRIB Data  
 
As the name implies, WINGRIDDS works off of GRIB format gridded model data.  However, WINGRIDDS 
cannot work with the GRIB data directly. It must convert the GRIB data to WINGRIDDS rapid-access 
format before any data can be displayed.  This process is referred to as ingesting GRIB data and this is 
where the GRIB ingest utilities are used.  The use of these utilities will be covered in separate sections 
below. The utility NGRB2PCG32 is used to ingest regular (non-WAFS) & ensemble GRIB data, the 
NMOSGRIB2PCG32 utility is used to ingest MOS GRIB data only and the GRIB2PCG32 utility is used to 
ingest WAFS & ensemble WAFS GRIB data.  
 
Both NGRB2PCG32 and NMOSGRB2PCG32 have the same command line options but the utilities can  
be executed without any options and they will use default settings. The command line options are as  
follows: 
 
NGRB2PCG32 [S/source directory] [D/destination directory] [F/file name] [L/] [O/] 
 
Where; 
S/source directory  = forces ingest from the requested data directory 
D/destination directory  = forces processed data placed in requested directory 
F/file name  = forces the processed data to be saved as a user define file name 
L/  = will save the output log file in a unique file name 
O/ = will save processed data files in the old format 
 
As stated, when executed without arguments, NGRB2PCG32 & NMOSGRB2PCG32 will execute using the 
directory properties read from the USER\Wingcfg.dat file but in the following example, the GRIB data will 
be read from the D:\GRIB and placed in the C:\OUT directory, the output file called PCGMODEL.DAT and 
create a unique log file for records. The command will be: 
 
NGRB2PCG32 S/D:\GRIB D/C:\OUT F/PCGMODEL.DAT L/ 
 
The logfile name will be created from the processed data file name: PCGMODEL.DAT.LOG 
 
The WINGRIDDS-format files created with these new GRIB ingest utilities are not compatible with the DOS 
versions.  With WINGRIDDS v3, and new data file format, PCG Version 2, has been created to allow for 
larger data sets as well as including the Grid Navigation information so the files MAPTYPE.DAT and 
GRIDTYPE.DAT are no longer needed in association with these new files.  However, if you still wish to 
display the older, PCG Version 1 (DOS) versions of PCG files, due to the lack of grid navigation information 
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embedded within the file, the MAPTYPE.DAT file from the DOS PCGRIDDS program which created those 
files will have to be copied to \WINGRIDDS\DATA directory so WINGRIDDS may obtain the grid navigation 
information and display the Version 1 files correctly.  
 
The PCG Version 2 files have a different naming convention from PCG Version 1 files.  The Version 1 files 
had a name format such as for WAFS: WAF27APR.00Z  where: 
 
      WAF  - WAFS grid 

27  - Day of the month 
APR  - Month 
00Z  - Hour of Model run 

 
or for NWS-type files: JN089500.E48  where: 
 
      JN -  Month 

08 -  Day of the month 
95 -  Year 
00 -  Hour of Model run 
E48 -  Three alphanumeric representation for grid projection from   
     MAPTYPE.DAT file. 

 
 
The PCG Version 3 files have a different, and much more descriptive naming convention.  WAFS, NWS 
and NWS MOS files still have their differences.  A WAFS file would have a name such as:   
MAR150312.AVN-JKLI 
where: 
 
     MAR -  Month 

15 -  Day of month 
03 -  Year (last two digits) 
12 -  Hour of Model run 
AVN   -  3-letter Model name 
JKLI  -  Octants included in GRIB ingest 

 
Or for NWS-type files: NOV070312.NAM211  where:    
 
   NOV -   Month 
   07 -   Day of the Month 
   03 -   Year (last two digits) 
   12 -   Hour of Model run 
   NAM -   3-letter Model name 
   211 -   Grid Projection Number             
 
Or for NWS MOS-type files: NOV070312.NAMMOS211  where:    
 
   NOV -   Month 
   07 -   Day of the Month 
   03 -   Year (last two digits) 
   12 -   Hour of Model run 
   NAM -   3-letter Model name 
   MOS -   Signifying MOS-type data 
   211 -   Grid Projection Number          
 
WINGRIDDS can also process Ensemble GRIB data.  This results in a different data file name format to 
convey the information concerning the Ensemble model data.  The NWS-type files will have a name format 
of the following:   
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The Date-Time-Group will be the same format as all PCG data files.      
 
Following the center decimal;  AAABCCCDDEEFFF 
 
Where –  
 
AAA  =   3-letter Model name 
B    =   ‘E’ for Ensemble-type data file 
CCC  =   ‘NEG’ for Negative Perturbed Forecast 
         ‘POS’ for Positive Perturbed Forecast 
         ‘MBR’ for Ensemble Member ID  
DD   =   ’00-20’ Ensemble member ID 
EE   =   ‘FU’ Full Field 
         ‘SD’ Standard Deviation 
         ‘WM’ Weighted Mean 
 
--- OR --- 
 
If data is Ensemble Weighted Mean, CCCDDEE = ‘AVERAGE’ 
If data is Ensemble Standard Deviation, CCCDDEE = ‘STDEVAT’ 
If data is Ensemble Probability data, CCCDDEE ‘PROBLTY’ 
 
FFF =  Grid Projection Number          
 
The WAFS-type files will have a name format of the following:   
 
The Date-Time-Group will be the same format as all PCG data files.      
 
Following the center decimal;  AAA’-‘BCCCDDEEFF 
 
Where –  
 
AAA  =   3-letter Model name 
B    =   ‘E’ for Ensemble-type data file 
CCC  =   ‘NEG’ for Negative Perturbed Forecast 
         ‘POS’ for Positive Perturbed Forecast 
         ‘MBR’ for Ensemble Member ID  
DD   =   ’00-20’ Ensemble member ID 
EE   =   ‘FU’ Full Field 
         ‘SD’ Standard Deviation 
         ‘WM’ Weighted Mean 
             
--- OR --- 
 
If data is Ensemble Weighted Mean, CCCDDEE = ‘AVERAGE’ 
If data is Ensemble Standard Deviation, CCCDDEE = ‘STDEVAT’ 
If data is Ensemble Probability data, CCCDDEE ‘PROBLTY’ 
 
FF = Total number of Octants 
 
With WINGRIDDS v4, the regular GRIB ingest utility NGRB2PCG32 has been modified further to allow 
much larger GRIB data sets to be ingested and used within WINGRIDDS. The heritage file format from the 
original PCGRIDDS had all GRIB inventory and model data packed into a single data file with some 
element of data compression used. As model outputs grew, this format began to bump into the 4 Gb file 
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size limit for 32-bit operating systems. For example, a complete GFS model run out to only 192 hours 
creates over 100GB of data and obviously, this would not fit into a single data file within the 4GB limit. Also, 
there was a data corruption issue if the ingested GRIB data pack had any *missing* data points around the 
sides of the data area. These missing data points would corrupt the data compression algorithm and the 
resulting data could not be viewed correctly within WINGRIDDS – scalar data would show a ‘stair-stepping’ 
effect & was not usable.  
 
Both of these issues have been corrected with the creation of a new processed data file format/ 
organization system.  This has required a new directory to be created within the WINGRIDDS\GRIDDATA 
directory called WINGRIDDS\GRIDDATA\MODEL. The new GRIB processing is described below. 
 
As a set of GRIB files for a model run are processed, the regular data file within the 
WINGRIDDS\GRIDDATA directory is created & this is what is visible to the WINGRIDDS user to open a 
processed file for use within WINGRIDDS. However, the date-time-group of the model run is determined 
and a new subdirectory within the MODEL directory is created to store the processed data. This directory 
has the name as the date-time-group of the model run as follows: YYYY-MM-DD-HH. The ‘HH’ in the name 
is the hour of the day the model was run & will be from 00-24. Any model GRIB data from the ‘00’ hour, for 
example, which is processed, will be stored in the ‘00’ hour directory of that date. Within each date-time-
group directory, for each model run processed, there is a corresponding ‘detailed’ inventory file created and 
a data file is created for each forecast hour processed. The detailed inventory file contains an inventory 
entry of each parameter & corresponding level/forecast hour. For each of these entries, there is also listed 
the forecast-hour file name which contains that specific parameter as well as an address entry pointing to 
the location within that specific forecast-hour file where to find the data array for that parameter.  All of the 
file names created in the process are associated with the file named within the GRIBDATA directory. 
Therefore, even if the user creates a customized processed file name, that naming will be passed along to 
the detailed inventory file as well as the forecast-hour file names. Here is an example of a typical GRIB 
ingest process for a Navy FNMC model run. 
 
NGRB2PCG32 processes a 00Z FNMC model run from October 23rd 2010 which had a NWS grid ID of 
240. The regular WINGRIDDS file name created in the GRIBDATA directory is called OCT231000.FNP240 
but, as stated, this only contains grid navigation info as well as parameter/level inventory info for the full 
model data processed. There is *NO* model scalar/vector data within this file so it will be much smaller 
than before.  With the date-time-group of the model run determined, a new directory is created within the 
GRIDDATA\MODEL directory called “2010-10-23-00”. As different forecast hours are processed, forecast-
hour files are created and the uncompressed, unpacked GRIB data are stored and the addresses of each 
parameter/level are recorded for the creation of the detailed inventory file at the end.  Each forecast-hour 
file name is a subset of the original file created in the GRIBDATA.  The alphanumeric entries to the *right* 
of the period in the original file name are used to create the forecast-hour file name as well as the detailed 
inventory file name. Since the GRIDDATA file name is OCT231000.FNP240, the “FNP240” portion is used 
to create the forecast-hour filename a 4-digit place for the actual forecast hour & ending in “.GDAT”.  So 
the processed data will look like this: 
 
FNP2400000.GDAT 
FNP2400006.GDAT 
FNP2400009.GDAT 
FNP2400012.GDAT 
FNP2400015.GDAT 
FNP2400018.GDAT 
FNP2400021.GDAT 
FNP2400030.GDAT 
FNP2400036.GDAT 
FNP2400042.GDAT 
FNP2400048.GDAT 
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At the end of the GRIB processing, all of the inventory and data addressing information is collected and the 
detailed inventory file is created, again, with the “FNP240” name but followed with “.INV”. So, the detailed 
inventory file name would be FNP240.INV. All of this is transparent to WINGRIDDS operations. 
 
*****NOTICE***** When you need to back-up any new processed model data, you need to remember to 
collect not only the file created within the GRIBDATA directory, but also all associated directories, inventory 
and data files and they *MUST* be installed in the destination computer in the same date-time-group 
directory within “MODEL” as it was taken from the original PC. 
 
 
*****NOTICE***** If the user chooses to override the default file naming and use custom file names in the 
GRIB processing, the name *MUST* have a delimitating decimal point!! The alphanumerics to the *LEFT* 
of the decimal point are not important *HOWEVER*, the alphanumerics are *VERY* important to the 
*RIGHT* of the decimal point & must be chosen wisely. It is advised to include at least the model ID. 
 
A new Fixed Surface Type processing has been added to NGRB2PCG32 to processes Potential Vorticity 
Surfaces and to show the distance the PV level is above or below the Tropopause. The new PV level is 
prefixed with the ‘P’ letter  a ‘+’ or ‘-‘. As an example: 
 
P+05      =  PV level   500 ft above the Tropopause 
P-15       =  PV level 1500 ft below the Tropopause 
 
 
-- Processing Ensemble Probability GRIB data 
NGRB2PCG32 now has the ability to process Ensemble Probability GRIB data files.  Ensemble probability 
GRIB file are completely different in the data they contain when compared to regular GRIB data. With 
regular GRIB data, the data area contains data points that reflect the value of the parameter they are 
associated with.  For example, a GRIB message for Temperature data (TEMP) will contain data values of 
actual temperature measurements and so on with pressure, height, etc. However, for probability GRIB 
messages, the data area contains percentages of probability, ranging from 0% to 100%, of the likelihood a 
specific value of that parameter will occur. Those probabilities are in three possible groups: 
 
1 = Probability of event below lower limit  
2 = Probability of event above upper limit  
3 = Probability of event between lower and upper limits  
 
Associated with these messages are either one or two numbers which define the limit(s) of the parameter 
the GRIB message is associated with. 
 
To accommodate the special processing requirements associated with ingesting Ensemble Probability 
GRIB data so it will work within the structure of the WINGRIDDS data model, NGRB2PCG32 uses a 
special GRIB2-to-Parameter decoding file. This file, GRIB2EnsProbParm.DAT, is used instead of the 
regular GRIB2Parm.DAT file.  The file structure is the same.  See the example below: 
 
000 000 000 TMP                     TEMPerature (deg K converted to deg C by WINGRIDDS) 
000 001 008 TPC       0000  -3 Total PreCiPitation (m converted to cm in WINGRIDDS) 
000 001 015 SNO                     Large scale snow   kg m**-2  
 
There may be multiple parameters of the same name on the same surface in the same forecast hour but 
with different value thresholds. Therefore, what happens, is when NGRB2PCG32 comes across the first 
example of a specific parameter within a specific forecast hour, it adds a ‘1’ to the end of the parameter 
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name i.e. the first GRIB message of temperature (TMP) becomes TMP1 and if it later comes across 
another GRIB message of temperature, that parameter name becomes TMP2 and so on. If the number of 
similar parameters exceeds 9, the extension will go from the letter ‘A’ and continue incrementing till it gets 
to ‘Z’ (TMPA, TMPB, - TMPZ).  This process will occur for every unique parameter name, regardless of 
surface level, for that forecast hour.  When the next forecast hour is processed, the extension cycle starts 
over at the number ‘1’. 
 
 
Unfortunately, there is no way of telling the parameter limit values that are associated with the parameters 
by just the name alone. However, from within WINGRIDDS, when one looks at the Grid File Listing of an 
Ensemble Probability data file, the limit values for each parameter are show as in the figure below: 
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In addition, when an Ensemble Probability parameter is displayed on the screen, at the bottom-left corner 
of the screen, the limit values are shown there as well as in the figure below: 
 

 
It is presumed that only one probability parameter will be displayed on the screen at one time. 
 
-- Types of GRIB data 

Several types of GRIB data are available to the WINGRIDDS user:  WAFS (global data), NWS and 
NWS - MOS.  Because the data are structured differently, the ingest procedures for the data types 
are different.  The selected ingest procedure which is displayed in the title of the ‘Ingest GRIB Data’ 
menu must match the data type that is ingested. 

 
WAFS 
 Data for global grids (WAFS data) are subdivided into octets (I,J,K,L,M,N,O,P).  This data must 

be preprocessed to create an inventory and list of model runs available for conversion from 
GRIB to WINGRIDDS format.  Only one model run may be converted to WINGRIDDS format in 
a single ingest session. WAFS GRIB data is preprocessed and converted to WINGRIDDS 
format using the utility GRIB2PCG32.EXE.  If any problems or errors occur while using 
GRIB2PCG32, please refer to the file GRIB2PCG32.OUT. 

 
NWS 

Data for the entire grid are stored together as a single group in NWS GRIB data files.  No pre-
processing of NWS GRIB data is necessary before the data are converted to WINGRIDDS 
format.  Multiple model runs may be converted from GRIB to WINGRIDDS format in a single 
ingest session.  The conversion utility is called NGRB2PCG32.EXE.  If any problems or errors 
occur while using NGRB2PCG32, please refer to the file NGRB2PCG32.OUT. 

 
MOS 

Data for the entire grid are stored together as a single group in MOS GRIB data files.  No pre-
processing of MOS GRIB data is necessary before the data are converted to WINGRIDDS 
format.  However, the data parameters for a MOS file are different than a NWS file so a different 
ingest utility is required. Where the GRIBPARM.DAT file is used in the NWS ingest process, a 
new file, MOSGRIBPARM.DAT is required to process MOS GRIB files. Multiple model runs may 
be converted from GRIB to WINGRIDDS format in a single ingest session.  The conversion 
utility is called NMOSGRB2PCG32.EXE.  If any problems or errors occur while using 
NMOSGRB2PCG32, please refer to the file NMOSGRB2PCG32.OUT. 

 
 
 
-- Selecting the method used to process GRIB data within WINGRIDDS 
 
The procedure used to convert GRIB data to WINGRIDDS format differs for NWS, NWS-MOS and WAFS 
data.  The selected procedure MUST match the type of GRIB data that you process.  
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To select the appropriate Ingest process within WINGRIDDS, under the ‘File’ Menu selection, select either 
the ‘Convert WAFS GRIB Data’ or ‘Convert Non-WAFS GRIB Data’, whichever is appropriate for your 
situation.  ‘Convert Non-WAFS GRIB Data’ (see figure below) shows a sub-Menu which lists ‘Convert 
Regular GRIB Data’ and ‘Convert MOS GRIB Data’.  Because of the way Ensemble GRIB are processed, 
they are included with the Regular GRIB selection.  When ‘Regular GRIB’ is selected, the utility 
NGRB2PCG32 is executed and when ‘MOS GRIB’ is selected, NMOSGRB2PCG32 is executed.  Both of 
these utilities have debug message files created under their respective names with the “.OUT” extension.  
If any problems are encountered when running these utilities, please refer to the “.OUT” file to help show 
what the problem was.  
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-- Automated GRIB Ingest 
 
GRIB data can be ingested automatically when the GRIB Ingest utilities are called from within a batch file 
routine.  For Regular and MOS GRIB files, the NGRB2PCG32 and NMOSGRB2PCG32 utilities can be 
executed directly without any command arguments.  See the “WAFS GRIB Data Ingest” portion of this 
document for the automatic download instructions of this data. 
     
Detailed configuration & use of automation scripts and scheduling tasks for stand-alone Workstations or 
Workstation/Server system configurations are given in the Workstation/Server Setup section. 
 
 
 
 
 
 
 
 
WAFS GRIB Data Ingest 
 
The following steps show you how to manually convert WAFS data encoded using a Gridded Binary format 
(GRIB) to WINGRIDDS format.  WAFS GRIB data can be ingested in a manual mode or automatic mode.  
The following instructions show the steps for manual WAFS GRIB ingest.  At the end of these instructions, 
the automatic method is explained.  
 
-- Starting the manual ingest process 
 
With the selection of ‘Convert WAFS GRIB Data’ from the ‘File’ Menu selection, the ‘WAFS Area Selection 
Menu’ is displayed (see figure below). 
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As in PCGRIDDS/PCGRIDDS32, the user must select which WAFS Octets they wish to ingest and select 
the orientation of the grid.  The 3-letter groups in the left column refer to the 3-letter extension of the 
OCTETS.*** files in the WINGRIDDS/GRIB directory.   These files contain octet selection and grid 
orientation information. The GRIB2PCG32 WAFS GRIB Ingest utility uses this information when performing 
the WAFS GRIB ingest.   
 

If you initially decide to convert part of your GRIB data to WINGRIDDS format, you may convert 
additional data at a later time. 

 
As long as the new GRIB data you select covers the same area and was produced from the 
same model run as the initial data, the ingest program adds new variables to the existing file 
without reprocessing or overwriting the variables currently in the file. 
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If you select a new area but the GRIB data are from the same model run, then the ingest 
program produces a new file with the same name, but modifies the last letters of the extension 
to reflect the different octants.  For example, if the initial WINGRIDDS file is MAR150312.AVN-
JKLI, the next files may be named MAR150312.AVN-IJKL or MAR150312.AVN-LIJK. 

 
If the GRIB data are from a different model run, then a new WINGRIDDS file is produced and 
named according to the model run.  For example, if the last file produced is MAR150312.AVN-
JKLI, then the first file from the next model run is named MAR160300.AVN-JKLI. 

 
 
-- Select Area for Gridded Data Set 

The surface of the earth is divided into eight areas (octants) identified by the labels I,J,K,L,M,N,O,P.  
You must specify the area that is covered by the gridded data set you are creating from the GRIB 
data.  If you do not select a new area, then the area you selected for the last gridded data set is used.  
Only those GRIB data octants within the selected area are included in the WINGRIDDS data set. 

 
The menu displayed on the screen lists the areas available for the conversion process.  The required 
octants are listed for each entry.  GRIB data for all octants required by the selected area must be 
placed in the GRIB/WAFS/OCTANT* directory where the “*” denotes the Octant letter.  If any 
required octants are missing for a field, GRIB data for that field will not be converted to PCG format. 

 
The location of each octant is described below: 

 
Octant  Latitude   Longitude 
---------  -----------   --------------- 
I   0-90N   30W - 60E 
J   0-90N   60E -150E 
K   0-90N  150E -120W 
L   0-90N  120W - 30W 
M   0-90S   30W - 60E 
N   0-90S   60E -150E 
O   0-90S  150E -120W 
P   0-90S  120W - 30W 

 
 
-- ECMWF WAFS GRIB Processing 
 
 

GRIB2PCG32 now has the ability to process ECMWF WAFS grids.  This is important 
because ECMWF WAFS grids do *not* conform to WMO WAFS area definitions, but they are 
similar and will be explained below. 
 
 
 
ECMWF WAFS Grids –  
The grid sections for the ECMWF WAFS grids are composed of 12 octant-like sections 
covering the globe but only 8 are used in GRIB2PCG32.  Sections 1-4 cover the northern 
hemisphere, sections 9-12 cover the southern hemisphere and sections 5-7 cover a 70 
degree belt around the equator (+/- 35 deg latitude).  Sections 5-8 are not processed by 
GRIB2PCG32. Also, the grid section areas cover slightly different areas of the globe as 
shown below. 

 
 



 
 37 

 
 
 
 
 
 
 
 
 

WMO WAFS Global Coverage of Grids 
Octants of the Globe 

 
90N 37 

I 
38 
J 

39 
K 

40 
L 

41 
M 

42 
N 

43 
O 

44 
P 

 

 
0 

90S 
 330E 60E 150E 240E 330E  

 

 
ECMWF WAFS Global Coverage of Grids 

Octants of the Globe 
 

90N 4 
I 

3 
J 

2 
K 

1 
L 

12 
M 

11 
N 

10 
O 

9 
P 

 

 
0 

90S 
 0E 90E 180E 270E 360E  

 

 
The graphics show there is a 30 degree west longitude offset between the WMO WAFS grids 
(on top) and the ECMWF WAFS grids (on bottom). The ECMWF graphic also shows the 
WMO octant letter ID’s which the ECMWF data are mapped to.  Therefore, the WMO octant 
letters which are selected to tell GRIB2PCG32 which grids to ingest & process are mapped 
to the ECMWF grid numbers. 
 
Another difference between the WMO & ECMWF is the grid spacing.  The WMO standard is 
a 1.25 deg grid spacing and the ECMWF has 2.5 deg grid spacing. 

 
 
 
-- Convert WAFS GRIB Data to WINGRIDDS Format 

After your GRIB data are stored in the GRIB\WAFS/Octant* directories, you are ready to preprocess 
the GRIB data to produce an inventory and list of model runs to be included in the gridded data set 
and convert your GRIB data to PCG format. The WAFS GRIB preprocessing used to be a separate 
utility in PCGRIDDS.  In WINGRIDDS, that function has been incorporated within the GRIB2PCG32 
ingest utility. 
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Use the following steps to proceed with the conversion process: 
 

The use may double-click on any entry within the ‘WAFS Area Selection Menu’ area or single-click a 
selection to highlight and click the ‘Ingest’ button.  GRIB data are preprocessed and inventoried 
before they are converted to PCG format.  This procedure may require a significant amount of time if 
you are processing a large quantity of data.  The Ingest process runs outside of the WINGRIDDS 
application so other WINGRIDDS tasks may be run at the same time.  Once The GRIB Ingest 
process is complete, the window it was running in is closed.  The data are now ready to be used in a 
WINGRIDDS session. 

 
After the conversion is complete, the data files in PCG format are placed in the directory, 
\WINGRIDDS\GRIDDATA, and are available for display by WINGRIDDS (refer to ‘Sample 
WINGRIDDS Applications Session’). 

 
Note: All GRIB files are left unchanged after the PCG file is created. 
 

 
 

--Automated WAFS GRIB Data Ingest 
 

 The WAFS GRIB ingest process can be performed through a batch file for automatic execution.  
Within the batch file, GRIB2PCG32.EXE routine can be called from the command line with an Octets 
definition file listed in \WINGRIDDS\GRIB as a command argument.  See the example below: 
 
 GRIB2PCG32 OCTETS.PL2 
 
This command string will execute the GRIB2PCG32 utility and it will ingest octets P & L. The user   can 
select which OCTETS.*** file to use according to their needs. 

 
As with the automatic GRIB Download, the GRIB Ingest scheduling is done through the Microsoft 
Windows Scheduler (refer to Microsoft Windows documentation for operation and configuration of the 
Scheduler). 

 
 
 
 
 
Downloading Observation Data  
 
WINGRIDDS works off of GRIB model data or Observation data and that data must be transferred into the 
WINGRIDDS system to be converted into PCG data format. This section will only cover Observation data.   
 
Observation data is available in 2 groups of data; 1)ASCII (text) format Surface or Upper-Air data and 2) 
some observation-based BUFR format files. With the BUFR data, It must be noted these are ‘observation’ 
BUFR files and *NOT* GRIB forecast-based BUFR files which cannot be processed. In case you are not 
familiar, a single GRIB-based message contains data which covers a broad area of the earth however, the 
BUFR format contains data for a single point on the earth and this can be an observation data point or a 
forecast data point. A single BUFR file can contain thousands of single-point data records.  
 
For ASCII-based observation files, Surface report types come in several different varieties such as METAR 
(or SAO), Synoptic, Buoy or Ship reports and Upper-Air reports are reported in RAOB format.  All of these 
messages are in text format and are downloaded into their respective subdirectories in the OBS directory. 
Surface reports are usually available for every hour of the day but Upper-Air (RAOB) reports usually are 
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only available at 00Z & 12Z.  Therefore, it is possible to mix and match the Surface obs times with the 
Upper-Air obs times.  This information is reflected in the corresponding file name created when observation 
data is ingested and converted with the OBS2PCG.EXE utility covered later. 
 
For BUFR binary data files, OBS2PCG can only process observation-based BUFR data files and there are 
also some observation BUFR files it cannot decode due to processing limitations.  Below is a list of the 
base file names used on the NCEP servers which OBS2PCG can decode (“?” denotes incomplete 
description info): 
 
Surface Obs- 
metars.buf  METAR-based obs 
adpsfc.buf  Synoptic-based obs (?) 
sfcshp.buf  Surface Ship obs 
marine.buf  Surface ship/buoy obs (?) 
 
Upper-Air/non-surface Obs- 
vadwnd.buf  NEXRAD VAD winds 
proflr.buf  Profiler Winds 
adpupa.buf  RAOBs  
satwnd.buf  Satellite-based wind obs (over ocean) 
qkswnd.buf  Quicksat surface radar winds (over ocean) 
qkscat.buf  QuickScat surface radar winds (over ocean) 
goesfv.buf  Processed GOES-based Satellite Sounder obs 
atovs.buf  Processed Polar-based Satellite Sounder obs 
 
Below is a list of the base file names used on the NCEP servers which OBS2PCG can *NOT* decode: 
 
trmm.buf  Rain Rate obs (over ocean) 
wndsat.buf  WindSat obs – dead platform 
gspro.buf  CHAMP radio occultation data 
geoimr.buf  Processed GOES Imager Tb data 
prepbufr.buf  unknown format issues 
rassda.bufr  raw HIRS-1 1b format 
1bamua.bufr  raw amsu-a 1b format 
1bamub.bufr  raw amsu-b 1b format 
1bhrs3.buf  raw hirs-3 1b format 
1bhrs4.buf  raw hirs-4 1b format 
1bmhs.buf  raw MHS Tb data (NOAA-18, METOP-2) 
airsev.buf  raw AIRS/AMSU-A/HSB 1b DATA (AQUA) 
amsre.buf  raw AMSRE-E Channel data 
mtiasi.buf  unknown data 
osbuv8.buf  unknown data 
sptgrmm.buf  unknown data – possible TRMM as above. 
aircft.buf  AIRCAR (Commercial aircraft) obs (?) 
 
The BUFR data processing can be combined with the regular text-based obs files to improve the Barnes 
Analysis and final data output.  *HOWEVER*, it was found during testing the text-based surface data was 
more complete as compared to the BUFR data and it is not advised to mix the two observation types 
together.  It was found that the best final product used text-based surface obs combined with BUFR-based 
non-surface obs. It must also be noted that the GOES & Polar Processed Sounding files are very large and 
may take a long time to download & process – depending on your internet and computer CPU speed. 
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When downloading BUFR data files onto your PC, the surface-based files can be transferred to their 
appropriate “OBS\Surface” subdirectories within WINGRIDDS i.e.:  
metars.buf – type files can go into the METAR directory, sfcshp.buf – type files can go into the Ship 
directory, etc. However, due to the different way the text-based RAOB obs are processed, it was required 
that a BUFR directory be created under the  “OBS\UpperAir”  directory and *ALL* non-surface BUFR files 
need to be stored for processing within this directory…even the adpupa.buf – type RAOB BUFR files. 
 
 
WINGRIDDS uses the GETGRIB utility build the FTPDATA.BAT batch file using user configured data files 
within the WINGRIDDS/GRIB/USER directory and executes the Curl utility to perform the actual transfer of 
downloading Observation data files via the Internet or local intranet.  The Observation data transfer 
process can be performed from within WINGRIDDS while WINGRIDDS is executing or it can be done in an 
automated function during off hours through scheduled batch file execution using user created batch files 
and the Microsoft Windows Scheduling task.  This process is covered in more detail below. 
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-- Observation Data Download With in WINGRIDDS 
 
Under the second selection of the ‘File’ Menu, select ‘Download Observation Files’.  See the figure below. 
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Upon choosing a ‘Download Observation Files’, brings up the Observation Download Category: 
 

 
 
 
This displays the contents of a file which is configurable by the user (refer to ‘Customizing the Data Download 
Process’).  The user can double-click on a selection or single-click a selection to highlight and  
Click the ‘OK’ button.   
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Upon the selection by the user, the ‘Observation Download Selection’ window is displayed.  See the figure 
below. 
 

 
 
The Observation Download Selection windows lists the individual data file names and descriptions for 
doing a Surface and/or Upper-Air download job.  These files are also configurable by the user (refer to 
‘Customizing the Data Download Process’).  The user can double-click on a selection or single-click a 
selection to highlight and Click the ‘OK’ button.   
 
Upon this action, the Observation download utility will begin and open a separate window to show the 
progress of the file download.  If the user is running WINGRIDDS, that window can be iconized or placed in 
the background so WINGRIDDS operations can resume. 
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-- Automated Observation Data Downloading  
 
The user can create batch files to execute the GETGRIB utility using the Microsoft Windows Scheduler to 
time when the batch file will.  The commands for the batch file are as follows: 
 
GETGRIB “user file”.DAT 
 
Where the “user file” is a ‘.DAT’ file which holds the commands for downloading the specific Surface and/or 
Upper-Air files the user wants.  This file name is the same as what is listed in the left column in the 
Observation Download Selection window (refer to ‘Customizing the Data Download Process’). 
 
Detailed configuration & use of automation scripts and scheduling tasks for stand-alone Workstations or 
Workstation/Server system configurations are given in the Workstation/Server Setup section. 
 
 
--Ingesting Observation Data  
 
As the name implies, WINGRIDDS works off of gridded data.  Therefore, WINGRIDDS cannot work with 
the textual observation data directly. It must convert the textual surface and upper-air observation data to 
WINGRIDDS rapid-access format before any data can be displayed.  This process is referred to as 
ingesting Observation data and this is where the Observation ingest utility OBS2PCG.EXE is used.  The 
use of this utility will be covered in a separate section below. 
 
The WINGRIDDS-format files created with these new GRIB ingest utilities are not compatible with the DOS 
versions.   
 
The PCG Version 2 observation-based files have a similar but different naming convention to the GRIB-
based PCG data files.  WAFS and regular Non-WAFS files still have their differences.  A WAFS file would 
have a name such as:    
 
 Surface only:  MAR1503S12.OBS-JKLI 
     MAR -  Month 

15 -  Day of month 
03 -  Year (last two digits) 
S  -  Surface Data 
12 -  Hour of Observation  
OBS -  Shows Observation-type Data 
JKLI -  Octants included in Observation ingest 

 
 Surface and Upper Air at different times:   MAR1503S16U12.OBS-JKLI 
     MAR -  Month 

15 -  Day of month 
03 -  Year (last two digits) 
S  -  Surface Data 
16 -  Hour of Observation  
U  -  Upper-Air Data 
12 -  Hour of Observation  
OBS -  Shows Observation-type Data 
JKLI -  Octants included in Observation ingest 
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Or for Regular Grid-type Surface only files: NOV0703S06.OBS211   
where:    
 
   NOV -  Month 
   07 -  Day of the Month 
   03 -  Year (last two digits) 

 S  -  Surface Data 
   06 -  Hour of Observation 

 OBS  -  Shows Observation-type Data 
   211 -  Grid Projection Number             
 
Or for Regular Grid-type Surface and Upper-Air files: NOV0703S06U00.OBS211   
where:    
 
   NOV -  Month 
   07 -  Day of the Month 
   03 -  Year (last two digits) 

 S  -  Surface Data 
   06 -  Hour of Observation 

 U  -  Upper-Air Data 
 12 -  Hour of Observation  
 OBS  -  Shows Observation-type Data 

   211 -  Grid Projection Number             
 
 
 
-- Selecting Options used to process Observation data within WINGRIDDS 
 
The procedure used to convert Observation data to WINGRIDDS format differs from the GRIB conversion 
due to the nature of the data.  The data is in ASCII text in a specific WMO (World Meteorological 
Organization) format which means there are specific Carriage-Returns and Line-Feeds inserted at the 
beginnings of every observation message which the ingest utility searches for to know the start of an 
individual observation.   
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To select the Observation Ingest process within WINGRIDDS, under the ‘File’ Menu selection, choose the 
‘Convert Observation Data’ menu selection (see figure below).   
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Upon this selection, the ‘Convert Observation Data’ dialog is opened (see figure below).   
 

 
 
If the data to be ingested is not current, the user must select the proper day of the month and  
observation time which is the same as the data which was downloaded.  If only surface data or upper- 
air data is to be ingested, select only the proper category to be ingested.  If both surface and upper-air  
data is to be processed, select both categories and the proper time selection for each data type. 
 
-- NOTICE***** 
The Date-Time information within the observation messages only includes the day and hour of the 
observation.  There is no month or year data.  Therefore, it is possible for the WINGRIDDS operator to 
ingest data from May 21, but the current month may be July 21.  The ingest utility will not be able to know 
any difference and as long as the observation times fall within the requested time, the PCG data file 
created will have the *current* year, month and day assigned to the file name. 
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-- Observation Grid Selection 
The observation data must be mapped to a proper grid projection for the Barnes Analysis.  The user must 
choose if the observation data will be mapped to a standard NWS-type grid or a WAFS-type grid(s).  The 
NWS Grid ID will default to a preselected value which is set in the WINGMODE.DAT file. 
 
For more information about changing the configuration of WINGRIDDS, see the Customizing the 

WINGRIDDS System section. 
If the user wishes to use a NWS-type grid projection, the proper number from 1-255 should be entered in 
the window.  All NWS grid ID descriptions are available in the GRIB1 documentation under the ‘HELP’ 
section. 
 
If the user wishes to use a WAFS-type grid projection, the user must enter the proper letter(s) which 
identify the WAFS grid octant(s) (IJKLMNOP).  
 
NOTICE**** Remember, as with the GRIB WAFS ingest process, if needing more than one WAFS octant, 
the octant order *must* be ordered from Left to Right, Bottom to Top. 
 
 
 
-- Observation Data File Editing 
WINGRIDDS now has the ability to edit observation data files if data errors are found after initial processing 
is performed.  If the user, while viewing observation data, saw spurious data contour ‘bulls-eyes’ in the 
analysis, this was an indication that there was a data parameter being misreported in the data from an 
observation station.  The user would have to go outside WINGRIDDS, search for that specific data file and 
open it with a text editor to search for the reporting station which contained the bad data and either correct 
the data value or change it to a ‘missing’ value of -9999. Now, WINGRIDDS has its own text editor which 
will automatically open the current observation data file when executed.  This editor is located within the 
‘Convert Observation Data’ dialog.  
 
When an observation data file is opened within WINGRIDDS and it is determined the contents need to be 
edited follow these simple steps: 
 

1) On the WINGRIDDS Plan display, locate the geographic area where the spurious data bulls-eye is 
located and note the parameter which is displayed (TEMP, HGHT, etc.) 

2) Type the command ‘STID’ to show the reporting stations and find the station IDs in the area of the 
bad data. 

3) Open the ‘Convert Observation Data’ dialog and click the ‘Edit’ button to open the Observation Data 
Editor (see below). 
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4) Perform a search for the station ID. Refer to the WINGRIDDS documentation for the data layout of 

the observation data file. 
5) Once the station is found and the data value is seen, either correct the data value or replace the 

value with the ‘missing’ value of -9999. 
6) Save the file and, from within the ‘Convert Observation Data’ dialog, check the ‘Reanalyze’ button 

and reprocess the observation data with the corrected data value and the data bulls-eye should be 
gone. 
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With the many additional observation data sources added in the BUFR capability, the resulting Obs Text 
data file, which is stored in the WINGRIDDS\GRIDDATA\OBS directory, has become much larger and new 
data separators are needed to separate the different observation types.  As before, the string “**** 99999 -
9999.99…” is written to show then end of surface obs & the start of RAOB observations.  At the end of any 
RAOB obs though, the new BUFR data is added – each observation type within its own section.  The next 
data separators are written as:  
 
“**** 11111 -9999.99 …”  QKSAT Surface Wind observations. 
“**** 22222 -9999.99 …”  NEXRAD VAD/Profiler observations. 
“**** 44444 -9999.99 …”  Satellite Wind observations. 
“**** 55555 -9999.99 …”  Satellite Sounding observations. 

 
The data collected & concatenated within the Obs Text data file are different, depending on the platform 
type which reported, thus the different data sections. Below are short examples of the different data types 
with short explanations of the contents for each. 
 
Surface QKSAT obs are listed on a single line with the standard “WNDSAT” label observation ID, Lat/Lon, 
Wind Direction/Wind Speed entries as follows:  
 
**** 11111 -9999.99 -9999.99 -9999.99 -9999.99 -9999.99 -9999.99 -9999.99 
WNDSAT    0000001W    56.68  154.10   259.00     2.80 
WNDSAT    0000002W    56.69  154.32   270.00     3.00 
WNDSAT    0000003W    56.71  154.53   258.00     3.30 

 
NEXRAD VAD/Profiler entries are in a similar format to the RAOB entries with Mandatory Level and 
Significant Level sections. However, Temperature & Dewpoint entries are always missing and only Wind 
Speed/Wind Direction are listed.  Each observation has a standard “VADPRF” label. 
 
**** 22222  -9999.99 -9999.99 -9999.99 -9999.99 -9999.99 -9999.99 -9999.99 
VADPRF 701      
      65.50   -144.68    259.00 
          12 
 64.      982.00   259.00 -9999.00 -9999.00 -9999.00 -9999.00 
 32.     1000.00 -9999.00 -9999.00 -9999.00 -9999.00 -9999.00 
 32.      925.00 -9999.00 -9999.00 -9999.00 -9999.00 -9999.00 
 32.      850.00 -9999.00 -9999.00 -9999.00    96.00     4.00 
 32.      700.00 -9999.00 -9999.00 -9999.00   108.00     1.00 
 32.      500.00 -9999.00 -9999.00 -9999.00   157.00     4.00 
 32.      400.00 -9999.00 -9999.00 -9999.00   190.00     9.00 
 32.      300.00 -9999.00 -9999.00 -9999.00   196.00    14.00 
 32.      250.00 -9999.00 -9999.00 -9999.00   195.00    15.00 
 32.      200.00 -9999.00 -9999.00 -9999.00   189.00     8.00 
 32.      150.00 -9999.00 -9999.00 -9999.00 -9999.00 -9999.00 
 32.      100.00 -9999.00 -9999.00 -9999.00 -9999.00 -9999.00 
   
          27 
 64.      982.00   259.00 -9999.00 -9999.00 -9999.00 -9999.00 
  4.      898.00  1009.00 -9999.00 -9999.00    35.00     1.50 
  4.      871.00  1259.00 -9999.00 -9999.00    85.00     2.60 
  4.      844.00  1509.00 -9999.00 -9999.00   100.00     5.50 
  4.      819.00  1759.00 -9999.00 -9999.00   106.00     5.80 
  4.      794.00  2009.00 -9999.00 -9999.00    97.00     4.80 
  4.      770.00  2259.00 -9999.00 -9999.00   119.00     2.80 
  4.      746.00  2509.00 -9999.00 -9999.00   128.00     2.90 
  4.      723.00  2759.00 -9999.00 -9999.00   130.00     1.30 
  4.      700.00  3009.00 -9999.00 -9999.00   108.00     1.00 
    4.      678.00  3259.00 -9999.00 -9999.00   104.00     1.40 
  4.      576.00  4509.00 -9999.00 -9999.00   112.00     2.10 
  4.      558.00  4759.00 -9999.00 -9999.00   138.00     2.20 
  4.      355.00  8009.00 -9999.00 -9999.00   206.00    11.70 
  4.      343.00  8259.00 -9999.00 -9999.00   200.00    11.90 
  4.      330.00  8509.00 -9999.00 -9999.00   198.00    12.50 
  4.      318.00  8759.00 -9999.00 -9999.00   199.00    14.10 
  4.      307.00  9009.00 -9999.00 -9999.00   198.00    14.70 
  4.      296.00  9259.00 -9999.00 -9999.00   195.00    15.10 
  4.      244.00 10509.00 -9999.00 -9999.00   196.00    15.20 
  4.      235.00 10759.00 -9999.00 -9999.00   198.00    13.00 
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  4.      226.00 11009.00 -9999.00 -9999.00   197.00    13.50 
  4.      217.00 11259.00 -9999.00 -9999.00   197.00    12.60 
  4.      209.00 11509.00 -9999.00 -9999.00   199.00    10.60 
  4.      201.00 11759.00 -9999.00 -9999.00   191.00     9.00 
  4.      165.00 13009.00 -9999.00 -9999.00   153.00     5.20 
  4.      158.00 13259.00 -9999.00 -9999.00   159.00     4.40 

 
 
Next, Satellite Cloud-Track Winds have single-line entries the standard “SATWD” label  observation ID, 
Lat/Lon, Pressure Level, Height, Temperature, Dewpoint (always ‘Missing’), Wind Direction/Wind Speed 
entries as follows:  
 
**** 44444 -9999.99 -9999.99 -9999.99 -9999.99 -9999.99 -9999.99 -9999.99 
SATWD     C100002I    47.45   34.84   400.00  7184.37   -35.67 -9999.00   190.00    19.20 
SATWD     C100003I    47.40   34.65   400.00  7184.37   -35.27 -9999.00   190.00    20.40 
SATWD     C100004I    47.53   32.53   400.00  7184.37   -34.01 -9999.00   210.00    24.40 
SATWD     C100005I    47.23   31.63   300.00  9163.38   -45.81 -9999.00   214.00    24.30 
SATWD     C100006I    46.67   33.50   500.00  5567.28   -18.54 -9999.00   205.00    25.60 

 
Finally, Satellite Sounding section is formatted similar to the RAOB entries with Mandatory Level and 
Significant Level sections. However, Wind Speed/Wind Direction entries are always missing and only 
Temperature & Dewpoint are listed.  Each observation has a standard “SATSND” label and there is no 
differentiation between a polar satellite sounding obs and a geostationary satellite sounding obs. 
 
**** 55555 -9999.99 -9999.99 -9999.99 -9999.99 -9999.99 -9999.99 -9999.99 
SATSN  = 806561 
     -38.49     61.95      0.00 
          12 
 64.     1019.90     0.00    15.44 -9999.00 
 32.     1000.00    88.66    18.84    13.38 
 32.      925.00   298.70    14.94     9.78 
 32.      850.00   662.09    10.67     6.50 
 32.      700.00   880.94     3.09    -4.68 
 32.      500.00  1012.20   -12.34   -21.11 
 32.      400.00   532.43   -23.37   -32.04 
 32.      300.00  1074.77   -39.23   -45.48 
 32.      250.00   998.60  -132.86  -146.61 
 32.      200.00   894.78  -139.48  -152.00 
 32.      150.00  1117.29  -141.48  -153.63 
 32.      100.00   531.31  -143.60  -155.38 
          21 
 64.     1019.90     0.00    15.44 -9999.00 
  4.      950.00   436.55    16.35    10.96 
  4.      920.00   271.13    14.65     9.54 
  4.      780.00   709.17     6.81     0.60 
  4.      670.00   352.97     1.18    -7.83 
  4.      620.00   618.56    -2.56   -12.50 
  4.      570.00   661.58    -6.16   -16.52 
  4.      475.00   389.71   -14.86   -22.03 
  4.      430.00   745.15   -19.93   -26.90 
  4.      350.00   962.00   -30.71   -38.90 
  4.      135.00   405.54  -141.85  -153.94 
  4.      115.00   613.65  -142.98  -154.86 
  4.       85.00   616.63  -143.48  -155.27 
  4.       70.00   739.33  -142.66  -154.61 
  4.       60.00   592.35  -141.10  -153.32 
  4.       50.00   707.43  -140.10  -152.51 
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-- Reanalyze Observation Data 
There may be times when a previous observation data set would need to be reanalyzed. This would fall 
under the following two categories: 
 
 1) Correction of erroneous data – after processing a set of observation data, the user may find some 

erroneous observation data from a station which is causing the Barnes Analysis to create incorrect 
contour bulls-eyes in the analyzed data.  This can be corrected when the user goes and edits the 
associated observation data file in the GRIB\OBS directory and, once the station is found, either 
enters the correct data or deletes the incorrect data parameter by replacing the bad value with -
9999.00. This will be flagged as *missing* data and ignored when the data is scanned during the 
Reanalysis operation.  Once the data file is corrected, select the proper Date-Time and the same grid 
selection and select ‘Reanalyze’ and the OBS2PCG process will reprocess the observation data in 
the corrected data file saving the data to the same file name as before, overwriting the previous 
processed data. 

 
 2) Mapping processed data to a different grid map – If the user wishes to have  a previously 

processed observation data set mapped to a different grid projection, the whole data ingest process 
does not need to be repeated.  Simply select the proper Date-Time for the data requested, the new 
grid selection and select ‘Reanalyze’ and the OBS2PCG process will skip parsing the raw obs data 
and utilize the observation which are already in the GRIB\OBS data file for the Date-Time selected. 

 
 
 
-- Automated Observation Data Ingest 
 
Observation data can be ingested automatically when the Observation Ingest utility OBS2PCG.EXE is 
called from within a batch file routine.  See complete instruction on p.123. 
 
Detailed configuration & use of automation scripts and scheduling tasks for stand-alone Workstations or 
Workstation/Server system configurations are given in the Workstation/Server Setup section. 
 
     
 
 
Downloading ASUS Frontal Data  
 
WINGRIDDS can now download and display the ASUS Frontal position data files – both the regular and 
Hi-resolution versions. All of these messages are in text format and are downloaded into the 
SURFACE/FRONT directory. Frontal reports are usually available every 3 hours during the day.   
 
WINGRIDDS uses the GETGRIB utility build the FTPDATA.BAT batch file using user configured data files 
within the WINGRIDDS/GRIB/USER directory and executes the cURL utility to perform the actual transfer 
of downloading ASUS Frontal Position data files via the Internet or local intranet.  The ASUS Frontal 
Position data transfer process can be performed from within WINGRIDDS while WINGRIDDS is executing 
or it can be done in an automated function during off hours through scheduled batch file execution using 
user created batch files and the Microsoft Windows Scheduling task.  This process is covered in more 
detail below. 
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-- ASUS Frontal Data Download With in WINGRIDDS 
 
Under the third selection of the ‘File’ Menu, select ‘Download Frontal Position Files’.  See the figure below. 
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Upon choosing a ‘Download Frontal Files’, brings up the Frontal Position Download Category: 
 

 
 
 
This displays the contents of a file which is configurable by the user (refer to ‘Customizing the Data Download 
Process’).  The user can double-click on a selection or single-click a selection to highlight and  
Click the ‘OK’ button.   
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Upon the selection by the user, the ‘Frontal Position Download Selection’ window is displayed.  See the 
figure below. 
 

 
 
The Frontal Position Download Selection windows lists the individual data file names and descriptions for 
doing a Frontal Position download job.  These files are also configurable by the user (refer to ‘Customizing 
the Data Download Process’).  The user can double-click on a selection or single-click a selection to highlight 
and Click the ‘OK’ button.   
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Upon this action, the Frontal Position download utility will begin and open a separate window to show the 
progress of the file download.  If the user is running WINGRIDDS, that window can be iconized or placed in 
the background so WINGRIDDS operations can resume. 
 
 
-- Automated ASUS Frontal Position Data Downloading  
 
The user can create batch files to execute the GETGRIB utility using the Microsoft Windows Scheduler to 
time when the batch file will.  The commands for the batch file are as follows: 
 
GETGRIB “user file”.DAT 
 
Where the “user file” is a ‘.DAT’ file which holds the commands for downloading the specific Surface and/or 
Upper-Air files the user wants.  This file name is the same as what is listed in the left column in the Frontal 
Position Download Selection window (refer to ‘Customizing the Data Download Process’). 
 
Detailed configuration & use of automation scripts and scheduling tasks for stand-alone Workstations or 
Workstation/Server system configurations are given in the Workstation/Server Setup section. 
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Using WINGRIDDS 
 
This section provides background information on WINGRIDDS.  It should be noted, as in PCGRIDDS32, 
there is no longer a WAFS version and NWS version of WINGRIDDS as there were in PCGRIDDS.  
WINGRIDDS processes and displays WAFS as well as Regular grids interchangeably.  Therefore, there is 
no need to switch back and forth as was the case in DOS PCGRIDDS. 
 
 
-- Modes of Operation 

In WINGRIDDS, there are two modes of operation. 
 

User Mode  In User Mode you perform tasks such as displaying products, retrieving 
data, and modifying parameters by selecting choices from predefined 
options or you display fields and the full variety of diagnostic calculations 
by entering WINGRIDDS commands directly from the keyboard in the 
Command Line. 

 
Automatic Mode In Automatic Mode you display fields and the full variety of diagnostic 

calculations by starting WINGRIDDS, loading up to 35 data files and 
executing a single command macro from a batch file.  GRIB file 
downloading and Ingesting can also be performed. 

 
During the execution of PCGRIDDS/PCGRIDDS32, you had to switch between the Menu mode and 
the Command Mode. In WINGRIDDS, Menu mode and Command mode have been blended into one 
operational environment.  There is also a Tool Bar with frequently used buttons to ease the operation 
of WINGRIDDS.  The WINGRIDDS Desktop will be explained below.   
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-- WINGRIDDS Desktop 
 

The WINGRIDDS Desktop has (from top down) pull-down menus, a tool bar, command entry, display 
area and status bar. 
 
The Menus consist of the ‘File’ menu, ‘Products’ menu, ‘Specs’ menu, ‘Display’ menu, and ‘Help’ 
menu. 
 
 

 
 
WINGRIDDS in Single Panel (1PNL) Mode 
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WINGRIDDS in 4 Panel (4PNL) Mode (without Window Banner) 
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WINGRIDDS in 4 Panel (4PNL) Mode (with Window Banner) 
 

There are 5 menu options across the top. 
 

File   Download and Ingest GRIB files, select, change, or list the contents of a 
forecast data file and Exit WINGRIDDS. 

 
Products  Display predefined WINGRIDDS products. 

 
Specs  Define the forecast hour and vertical level specifications. 

 
Display  Change to or define one of the following display modes:  Plan view (default), 

Cross-section, Time-section. 
 

Help           Display Help files for WINGRIDDS Operations. 
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Command Line – Enter WINGRIDDS commands 
Open File – Opens PCG Data files which have been through the GRIB Ingest Process 
Change Forecast Files – Switches between multiple opened PCG Data files 
List File Contents – Lists all GRIB parameters in the current PCG file for the active forecast time 
Print Screen – Prints the contents of the display area to the default printer 
Overlay Display – Overlays the next issued command with what is on the screen 
Previous Command – Executes the previous command 
Erase Map – Erases the display area & leaves a blank map 
Decrement Forecast Hour – Decrement forecast hour by one step 
Increment Forecast Hour – Increment forecast hour by one step 
Decrement Grid Level – Steps Grid level farther from the surface (Lower in pressure) 
Increment Grid Level - Steps Grid level closer to the surface (Higher in pressure) 
Decrement Forecast File – Activates the previous loaded forecast file (if previously opened) 
Increment Forecast File – Activates the next loaded forecast file (if previously opened) 
Station Observation Data Plot – Plots the Observation data in Station Model format 
Frontal Position Data Plot – Plots the ASUS Frontal position data if available at observation hour. 
Map Zoom Out – Zooms the map display out for a wider view 
Map Zoom In – Zooms the map display in for a narrower view 
Pan Map West – Moves the map field of view toward the West 
Pan Map East – Moves the map field of view toward the East 
Pan Map North – Moves the map field of view toward the North 
Pan Map South – Moves the map field of view toward the South 
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Choose PLAN Display – Switches to PLAN Display (default) 
Choose CROSS Display – Switches to CROSS-Section Display (if configured) 
Choose TIME Display – Switches to TIME-Section Display (if configured) 
Switch Between 1Panel/4Panel Mode – Changes the display format between 1Panel & 4 Panel mode 
Select Window 1 – Moves command focus to Window 1 in 4PNL mode (Default in 1PNL mode) 
Select Window 2 – Moves command focus to Window 2 in 4PNL mode 
Select Window 3 – Moves command focus to Window 3 in 4PNL mode 
Select Window 4 – Moves command focus to Window 4 in 4PNL mode 
 
GO – Executes Commands and Macros 
STOP – Halts execution of Macro Loops 
Command History – Redisplays recent commands in the command line: 

   = Step Back one command 

   = Step Forward one command 
 
Status Line – Real time display of grid, time and file status 
 
 
Using Custom Grid/Maps  
 
Custom Grid/Map Mode –  
A limitation of the program since PCGRIDDS has been, the program can only overlay gridded data which 
has the same geometric grid mapping.  In other words, if you have multiple data files open for analysis, 
their data can only be overlaid if they all had the same grid projection i.e. Lat/Lon data used with other 
Lat/Lon data, Lambert Conformal data used with other Lambert Conformal data, etc.  You could not mix-
and-match viewing data from different grid projections. Also, with the original PCGRIDDS, the different 
gridded files even had to have the same grid resolution as well as grid projections but this requirement was 
relaxed in WINGRIDDS.  Now, in this WINGRIDDS v4 release, the user can create custom grid mapping 
projections for their use and any gridded data file opened will be remapped to the user’s grid projection and 
allow the overlay of gridded data from different grid projections as long as the original data had the same 
geographic coverage.  This is referred to a data interpolation.  
 
There are, at this time, 3 different grid projections you can use to interpolate data to;  
 
Equidistant Latitude/Longitude (Lat/Lon) - best for near the Equator region (0-30 deg) 
Lambert Conic Conformal (NLCC) – best for the mid-latitudes (30-60 deg) 
Polar Stereographic (NPST) – best for above 60 deg to the Poles. 
 
There are two different ways to set up a custom grid display and this can be done either before or after any 
data files have been opened – there is a command-line option or it can be done through a graphical dialog. 
 
 
Customized Grid Command-Line:  
 
The command to set up a customized grid (for use with command macro scripts & such) is: 
 
CSTMGRID [Center Lat, Center Lon, Blowup Size, (Tangent Cone), Grid Type] 
 
Or 
 
CSTMGRID [Grid Spec File Name] 
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Notice, this is argument string is similar to the AREA command. There are two different command string 
argument types with this command – depending on which grid projections you wish to use.  For Lat/Lon & 
Polar Stereographic grids, you would use the Center latitude, Center Longitude, Blowup Size & Grid Type 
arguments however, the Lambert Conformal also requires a Tangent Cone (in degrees) entry as well. As 
with the AREA command, the coordinate information is describing the *center* of the grid and the *size* (in 
N/S Latitude) of the grid. 
 
*****NOTICE***** 
1) All 4 numeric entries are to be entered in *WHOLE* degrees  a period.  
 
2) All negative Latitude entries are for Southern Hemisphere and positive Latitude are Northern 
Hemisphere. 
 
3) ALL negative Longitude entries are for Western hemisphere and all positive Longitude are for Eastern 
Hemisphere. 
 
4) All Lambert Conformal identities for Grid Type are “NLCC” – even for Southern Hemisphere Views. 
 
5) All Polar Stereographic identities for Grid Type are “NPST” – even for Southern Hemisphere Views. 
 
 
Examples… 
 
To create a custom Lambert Conformal (NLCC) grid roughly centered on the United States, enter: 
 
CSTMGRID 40. -100. 45. 25. NLCC 
 
To create a custom Lat/Lon (LTLN) grid over Saudi Arabia, enter: 
 
CSTMGRID 20. 45. 50. LTLN 
 
To create a custom Polar Stereographic (NPST) grid over Northern Europe, enter: 
 
CSTMGRID 60. 12. 60. NPST 
 
The Command-Line entry to disable Custom Grids is: 
 
CSTMGRID 9999 
 
At this command, the custom grid settings will be removed and the grid navigation of whatever is the 
current data file is will be used at the areal size configured for the Custom Grid. 
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Customized Grid User Graphical Dialog: 
 
Customized grids can also be set up through the Plan Area Setup dialog. 
 

  
 
Notice, a new button has been added called “Custom Grid”. This opens up a new dialog called 
WINGRIDDS Custom Map Selection.  This dialog is composed of; 
 
Three Tabs; one for each different grid projection (Latitude/Longitude, Lambert Conic Conformal & Polar 
Stereographic)  
 
Information Readouts at the top for Center Latitude, Center Longitude, Latitude Distance and Tangent 
Cone  
 
Three Buttons along the bottom; OK, Clear & Cancel 
 
Each Tab has a Graphical Map Window and three drag-bars (Lambert has 4 drag-bars). There is a drag-
bar for to go along with each parameter at the top of the page.  The Center Latitude spans 180 deg (-90 to 
+90), the Center Longitude spans 360 deg (-180 to +180) and the Latitude Distance spans 180 deg (0-
180).  The Graphical Map Window will display the map projection reflecting the drag-bar status in real-time. 
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Below, the screen captures of the WINGRIDDS Custom Map Selection showing each map tab: 
 

 
 
Latitude/Longitude  
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Lambert Conic Conformal (notice Tangent Cone drag-bar) 
 
*****NOTICE***** A unique function in the Lambert Conic Conformal dialog operation is the limit of the grid 
area from crossing the pole (90 deg Lat). There can be potential of adjusting the Center Latitude bar with 
the Latitude Distance bar where the border of the grid would cross over the pole & this is not allowed. 
Therefore, there are automatic limits with these adjustments and the bars will not move beyond these 
limits. If the user wishes a larger area view (larger Latitude Distance), the Center Latitude will not go as far 
North (or South if Southern Hemisphere). Conversely, if the user wishes a view farther North (or South if 
Southern Hemisphere), the Latitude Distance cannot have as large a value (must be zoomed in closer). 
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Polar Stereographic 
 
 
Any coordinate adjustments made on one tab will be reflected if you switch to another tab.  If one wishes to 
not accept any adjustments to a projection & not use a Custom Grid, press the ‘Cancel’ button. 
 
If one wishes to clear-out any previous configured Custom Grid & go back to normal WINGRIDDS 
operations, press the ‘Clear’ button. 
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Once the adjustments are finalized, the user can either click [OK] and use the setting operationally in the 
current session or the user can also save the settings for use latter by clicking the [Save As] button. 
 
 
 
Clicking the Save As button allows the user to save the current adjusted map parameters for use latter. 
This file is stored in the WINGRIDDS/USER directory and requires the “.grd” file extension. 
 
*****NOTICE***** Any Cross/Time Sections you wish to create while a Custom Grid session is in effect, the 
Cross/Time points *MUST* be within the Custom Grid domain. 
 
 
*****NOTICE***** If the user wishes to use WAFS data to re-map to a custom projection, they need to 
insure that all 8 Octets of the WAFS data GRIB files are used regardless of the desired projection to ensure 
there is proper data coverage for the custom map.  
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In order for the user to choose a Custom Map File, they should click [Open] and the Load Custom Grid 
Description dialog is displayed. 
 
 

 
 
The WINGRIDDS Properties has an added feature in relation to Custom Grid operations.  If the user 
wishes for WINGRIDDS to Start-up with a Customized Grid and any data files opened to be automatically 
mapped to that areal projection, first create and save a Custom Grid projection as outlined above, open the 
WINGRIDDS Properties and choose the WINGRIDDS Map Settings tab. At the bottom, you will see an 
information area which has been added. 
 
The WINGRIDDS Map Navigation section was created to allow the user to enable Start-up Custom Grid 
operations.  When the WINGRIDDS Map Settings portion of the Properties is first opened, all of the data 
windows of the WINGRIDDS Map Navigation section are grayed-out with the exception of the Custom Map 
Navigation Enabled at Startup ‘Check-Box’.  If a Custom Map has been setup, upon checking the Check-
Box, the other data windows will be filled with the info describing the current Custom Map setup.  These 
windows are for display only and only reflect the current Custom Map settings.   
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In order for the user to choose a Custom Map File, they should click [Load] and the Select Custom Grid 
Description dialog is displayed. 
 

 
 
This window shows the contents of the WINGRIDDS/USER directory for the user to select any predefined 
and saved Custom Grid Description files. Once a file is selected and the checkbox is enabled, at the next 
WINGRIDDS startup, the custom grid will be used by default for any data file opened.  
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WINGRIDDS Tutorial 
 
Sample Ingest Session for WAFS GRIB Data 
 
The following steps show you how to convert WAFS data encoded using a GRIdded Binary format (GRIB) 
to WINGRIDDS format.  The instructions assume you are using the sample WAFS data set provided with 
the program.  After you have completed the example, read the documentation in detail to get a better 
understanding of the software and to answer your questions. 
 

Start a session. 
 
  1. From the desktop, double-click the icon WINGRIDDS 
 

2. Click: File>Convert WAFS GRIB Data 
Selects File choice #2 (Convert WAFS GRIB Data).  Displays the ‘WAFS Area Selection’ dialog and 
begins your ingest session. 

 
 

Select area for gridded data set. 
 

1. Use the [Down arrow] key or [click-hold] the mouse on the vertical scroll bar on the right 
of the window and drag up or down to scroll to position the highlight to an area you want to 
select. 

 Data that fall with in the boundaries of the selected area are converted from GRIB to PCG format. 
 
 

Convert WAFS GRIB data to WINGRIDDS PCG format. 
 

1. Click:  Ingest or press Enter 
Converts GRIB data for the selected model run to WINGRIDDS PCG format using the utility 
GRIB2PCG32 and places the data in the WINGRIDDS\GRIDDATA directory.  This may require a 
significant amount of time if you are processing a large quantity of data. A window will show the 
progress of the GRIB2PCG32 utility. The window will close when the conversion process is 
completed.  If any errors are encountered during the conversion process, the GRIB2PCG32.LOG file 
can be viewed for details. The data are now ready to be used in a WINGRIDDS session (refer to 
‘Sample WINGRIDDS Applications Session’). 
 
 

 
Ingesting WAFS GRIB Data 
 
You can receive gridded data from a variety of sources (e.g., satellite, phone lines).  These data files are 
encoded using a GRIdded Binary communications format (GRIB).  Before the data can be displayed and 
processed by WINGRIDDS, it must be converted to WINGRIDDS rapid-access PCG format.  This process 
is referred to as ingesting GRIB data. 
 
-- Types of GRIB data 

Three types of GRIB data are available to the WINGRIDDS user:  WAFS (global data) GRIB and 
NWS or Regular GRIB and MOS GRIB.  Because the data are structured differently, the ingest 
procedures for the three data types are different.  The selected ingest procedure which is displayed in 
the ‘File’ menu must match the data type that is ingested  
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WAFS 
Data for global grids (WAFS data) are subdivided into octets (I,J,K,L,M,N,O,P).  This data must 
be preprocessed to create an inventory of data and list of model runs available for conversion 
from GRIB to WINGRIDDS PCG format.  Only one model run may be converted to WINGRIDDS 
format in a single ingest session. 

 
NWS/Regular and MOS 

Data for the entire grid are stored together as a single group in NWS GRIB data files.  No pre-
processing of NWS GRIB data is necessary before the data are converted to WINGRIDDS PCG 
format.  Multiple model runs may be converted from GRIB to WINGRIDDS PCG format in a 
single ingest session. 

 
 
 
-- Delete GRIB Data 

GRIB data from the previous forecast cycle should be deleted before you acquire GRIB data for a 
new forecast cycle.  This will avoid mixing data from different model forecasts and speed up the 
conversion to WINGRIDDS PCG format because the programs that perform these conversions may 
process files for ALL the forecast model dates that are present. 

 
To delete GRIB data, Click: File> Delete WAFS GRIB Files 

Selects choice #4 (Delete WAFS GRIB Files) from the ‘File’ menu. 
 

You are asked to verify that you want to delete all the files in every GRIB/WAFS/* directory.  Press 
[Y] to begin deleting files.  Press [N] to stop the deletion process. 

 
 
-- Converting WAFS Data from GRIB to WINGRIDDS PCG format 

An important step must be taken to describe the area included in the WINGRIDDS data set 
before you begin the conversion.  This is done when you Click: File>Convert WAFS GRIB Data.  
The ‘WAFS Area Selection’ dialog is displayed for the user to select the geographical area which they 
desire to be included in the ingest process. 
 

 
A summary of the conversion process and any errors is contained in the file GRIB2PCG32.LOG. 

 
If you initially decide to convert part of your GRIB data to WINGRIDDS format, you may convert 
additional data at a later time. 

 
As long as the new GRIB data you select covers the same area and was produced from the 
same model run as the initial data, the ingest program adds new variables to the existing file 
without reprocessing or overwriting the variables currently in the file. 

 
If you select a new area but the GRIB data are from the same model run, then the ingest 
program produces a new file with the same name, but modifies the last letter of the extension to 
match the octants requested.  For example, if the initial WINGRIDDS file covering Octant L is 
MAR150300.AVN-L and you wish to also cover the areas of Octants L & P, those files are 
named MAR150300.AVN-PL. 

 
If the GRIB data are from a different model run, then a new PCGRIDDS file is produced and 
named according to the model run.  For example, if the last file produced is MAR150300.AVN-L, 
then the first file from the next model run is named MAR150312.AVN-L. 
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-- Select Area for Gridded Data Set 

The surface of the earth is divided into eight areas (octants) identified by the labels I,J,K,L,M,N,O,P.  
You must specify the area that is covered by the gridded data set you are creating from the GRIB 
data.  If you do not select a new area, then the area you selected for the last gridded data set is used.  
Only those GRIB data octants within the selected area are included in the WINGRIDDS data set. 

 
The menu displayed on the screen lists the areas available for the conversion process.  The required 
octants are listed for each entry.  GRIB data for all octants required by the selected area must be 
placed in the GRIB/WAFS/OCTANT* directory where the “*” denotes the Octant letter.  If any 
required octants are missing for a field, GRIB data for that field will not be converted to PCF format. 

 
The location of each octant is described below: 

 
Octant  Latitude    Longitude 
---------  -----------  ------------------ 
I   0-90N   30W - 60E 
J   0-90N   60E -150E 
K   0-90N  150E -120W 
L   0-90N  120W - 30W 
M   0-90S   30W - 60E 
N   0-90S   60E -150E 
O   0-90S  150E -120W 
P   0-90S  120W - 30W 
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Use the following steps to select an area for the gridded data set: 
 

1. Click: File>Convert WAFS GRIB Data 
Selects File choice #2 (Convert WAFS GRIB Data).  Displays the ‘WAFS Area Selection’dialog and 
shows the available areas for selection.  The menu is shown in Fig.17.   

 
2. Select an area. 

To select an entry with the highlight 
Position the highlight to the desired choice and press [Enter] or click [Ingest]. 

 
 
 

Fig.17 

 
 
 
-- Convert GRIB Data to PCG Format 

After your GRIB data are stored in the GRIB\WAFS/Octant* directories, you are ready to preprocess 
the GRIB data to produce an inventory and list of model runs to be included in the gridded data set 
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and convert your GRIB data to PCG format. The WAFS GRIB preprocessing used to be a separate 
utility in PCGRIDDS.  In WINGRIDDS, that function has been incorporated within the GRIB2PCG32 
ingest utility. 

 
 
 
 

Use the following steps to proceed with the conversion process: 
 

1. Within the WAFS Area Selection Menu, press [Enter] or click [Ingest]  
The GRIB2PCG32 GRIB Conversion Utility is started and data are preprocessed and inventoried 
before they are converted to PCG format.  This procedure may require a significant amount of time if 
you are processing a large quantity of data.  When the GRIB2PCG32 utility is started, the WAFS 
Area Selection Menu disappears and a window opens to show the progress and status of 
GRIB2PCG32. Other WINGRIDDS tasks and operations may be performed during this process. The 
Window closes when the conversion process is completed.  The data are now ready to be used in a 
WINGRIDDS session. 

 
After the conversion is complete, the data files in PCG format are placed in the directory, 
\WINGRIDDS\GRIDDATA, and are available for display by WINGRIDDS (refer to ‘Sample 
WINGRIDDS Applications Session’). 

 
Note: If not every octant has the same GRIB parameters, those parameters which are missing 

are skipped. All GRIB files are left unchanged after the WINGRIDDS file is created. 
 

A summary of the conversion process and any errors encountered are contained in the file 
GRIB2PCG32.OUT. 

 
 

Note: All GRIB files are left unchanged after the PCG file is created. 
 
 
 
Sample Ingest Session for NWS/Regular GRIB Data 
 
The following steps show you how to convert NWS/Regular data encoded using a GRIdded Binary format 
(GRIB) to WINGRIDDS PCG format.  The instructions assume you are using the sample NWS data set 
provided.  After you have completed the example, read the documentation in detail to get a better 
understanding of the software and to answer your questions. 
 

Sample data set contents 
The sample NWS data set contains: 

 
NAM model fields (00 and12 hour forecast) 
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Start a session. 
 
  1. From the desktop, double-click the icon WINGRIDDS 
 

2. Click: File>Convert Non-WAFS GRIB Data>Convert Regular GRIB Data 
 

Selects File choice #4 (Convert Non-WAFS GRIB Data) and Sub-Menu choice #1 (Convert 
Regular GRIB Data) which begins your ingest session. The utility NGRB2PCG32 Converts 
GRIB data to WINGRIDDS PCG format and places the data in the WINGRIDDS\GRIDDATA 
directory.  This procedure may require a significant amount of time if you are processing a large 
quantity of data.  A window opens to show the progress and any errors during the conversion process.  
While the conversion process is ongoing, other WINGRIDDS tasks and operations may be performed. 
This window closes when the conversion process is completed.  The data are now ready to be used in a 
WINGRIDDS session (refer to ‘Sample WINGRIDDS Applications Session’). 
 

 
 
 
 

Delete existing GRIB data. 
Use the following optional steps to delete NWS GRIB data files from previous forecasts, if desired, 
before you acquire new data: 

 
To delete GRIB data, Click: File> Delete Regular GRIB Files 

Selects choice #5 (Delete Regular GRIB Files) from the ‘File’ menu. 
 

2. Type: Y 
Answers ‘yes’ when asked if you want to delete all the files in the GRIB\NWS directory.  Type N if 
you want to exit this process without deleting files. 

 
 
 
 
Ingesting NWS GRIB Data 
 
You can receive gridded data from a variety of sources (e.g., satellite, phone lines, Internet).  These data 
files are encoded using a GRIdded Binary communications format (GRIB).  Before the data can be 
displayed and processed by WINGRIDDS, it must be converted to WINGRIDDS rapid-access PCG format.  
This process is referred to as ingesting GRIB data.  
 
-- Types of GRIB data 

Three types of GRIB data are available to the WINGRIDDS user:  WAFS (global data) GRIB and 
NWS or Regular GRIB and MOS GRIB.  Because the data are structured differently, the ingest 
procedures for the three data types are different.  The selected ingest procedure which is displayed in 
the ‘File’ menu must match the data type that is ingested  

 
WAFS 

Data for global grids (WAFS data) are subdivided into octets (I,J,K,L,M,N,O,P).  This data must 
be preprocessed to create an inventory of data and list of model runs available for conversion 
from GRIB to WINGRIDDS PCG format.  Only one model run may be converted to WINGRIDDS 
format in a single ingest session. 
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NWS/Regular and MOS 
Data for the entire grid are stored together as a single group in NWS GRIB data files.  No pre-
processing of NWS GRIB data is necessary before the data are converted to WINGRIDDS PCG 
format.  Multiple model runs may be converted from GRIB to WINGRIDDS PCG format in a 
single ingest session. 

 
-- Selecting the method used to process GRIB data 
 
The procedure used to convert GRIB data to PCG format differs for NWS and WAFS data.  The selected 
procedure MUST match the type of GRIB data that you process. When ingesting and converting non-
WAFS GRIB files to PCG files, the user must use the Convert Non-WAFS GRIB Data menu selections 
and vice-versa for WAFS.  
 
 

A) As long as the new GRIB data you select covers the same area and was produced from the 
same model run as the initial data, the ingest program adds new variables to the existing file 
without reprocessing or overwriting the variables currently in the file. 

 
B) If you select a new area but the GRIB data are from the same model run, then the ingest 
program produces a new file with the same name, but modifies the first character of the year 
field.  For example, if the initial PCG file is JL030300.ETA211, the next files are named 
JL030300A.ETA211, JL030300B.ETA211 (up to a total of 10 files). 

 
C) If the GRIB data are from a different model run, then a new PCGRIDDS file is produced and 
named according to the model run.  For example, if the last file produced is JL030300.ETA211, 
then the first file from the next model run is named JL030312.ETA211. 

 
 
 
-- Convert GRIB Data to PCG Format 

After your GRIB data are stored in the GRIB\NWS directory, you are ready to convert your 
GRIB data to PCG format.  Begin the conversion process by Clicking: File>Convert Non-WAFS 
GRIB Data>Convert Regular GRIB Data from the WINGRIDDS menu.  This will start the 
NGRB2PCG32.EXE GRIB Conversion utility. After the conversion is complete, the data files in 
PCG format are placed in the directory, \WINGRIDDS\GRIDDATA, and are available for display 
by WINGRIDDS. 
 

A summary of the conversion process and any errors encountered are contained in the file 
NGRIB2PCG32.OUT. 

 
 

Note: All GRIB files are left unchanged after the PCG file is created. 
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Sample Ingest Session for Observation Data 
 
The following steps show you how to convert Surface and/or Upper-Air data to WINGRIDDS PCG format.  
The instructions assume you are using the sample Observation data set provided.  After you have 
completed the example, read the documentation in detail to get a better understanding of the software and 
to answer your questions. 
 

Sample data set contents 
The sample Observation data set contains: 

 
00Z Surface and Upper-Air RAOB messages 

 
 

Start a session. 
 
  1. From the desktop, double-click the icon WINGRIDDS 
 

2. Click: File>Convert Observation Files 
 

Selects File choice #5 (Convert Observation Files) which begins your ingest session. The 
Convert Observation Data dialog will be shown. Once the selections have been made, selecting ‘OK’ 
will start the utility OBS2PCG32 which converts Observation data to WINGRIDDS PCG format 
and places the data in the WINGRIDDS\GRIDDATA directory and creates a text-based 
corresponding combined observation data file in the WINGRIDDS\GRIDDATA\OBS directory .  
This procedure may require a significant amount of time if you are processing a large quantity of data.  
A window opens to show the progress and any errors during the conversion process.  While the 
conversion process is ongoing, other WINGRIDDS tasks and operations may be performed. This 
window closes when the conversion process is completed.  The data are now ready to be used in a 
WINGRIDDS session (refer to ‘Sample WINGRIDDS Applications Session’). 
 

 
 
 

Delete existing OBS data. 
Use the following optional steps to delete observation data files from previous ingests, if desired, 
before you acquire new data: 

 
To delete Observation data, Click: 
 File> Delete Observation Files 

Selects choice #9 (Delete Observation Files) from the ‘File’ menu. 
 

2. Click:  Y 
Answers ‘yes’ when asked to acknowledge the successful deletion of the Observation data.  If any 
deletions failed, they will create their own error dialog. 

 
 
 
Ingesting Observation Data 
 
You can receive Surface and/or Upper-Air observation data from a variety of sources (e.g., satellite, phone 
lines, Internet).  These data files are text-based WMO formatted files.  Before the data can be displayed 
and processed by WINGRIDDS, it must be scanned, filtered, a Barnes Analysis performed and then 
converted to WINGRIDDS rapid-access PCG format.  This process is referred to as ingesting Observation 
data.  
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-- Types of Observation data 

Two main categories of observation data are available to the WINGRIDDS user:  Surface and Upper-
Air (RAOB) observations.  The Surface category can be subdivided into 4 categories: Buoy data, 
METAR or SAO data, Ship data and Synoptic data. Because the data are structured differently, the 
ingest procedures for the three data types are different.  The selected ingest procedure which is 
displayed in the ‘File’ menu must match the data type that is ingested  

 
 
 
 
-- Convert Observation Data to PCG Format 

After your Observation data are stored in the OBS directories, you are ready to convert your 
Observation data to PCG format.  Before you begin, you must ensure the Date-Time selections 
match the data which was downloaded. You must also select the grid area to perform the 
Barnes Analysis on during the conversion.  Once these selections have been made, you begin 
the conversion process by clicking the ‘OK’ button. This will start the OBS2PCG.EXE 
Observation Conversion utility. After the conversion is complete, the data file in PCG format is 
placed in the directory, \WINGRIDDS\GRIDDATA, and are available for display by 
WINGRIDDS.  There will also be a corresponding combined observation text file stored in the 
\WINGRIDDS\GRIDDATA\OBS directory. 
 

A summary of the conversion process and any errors encountered are contained in the file 
OBS2PCG.OUT. 

 
 

Note: All Observation files are left unchanged after the PCG file is created. 
 

For full details and full coverage of all Observation Ingest options, please refer to the WINGRIDDS 
Observation Data Options section. 
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Sample WINGRIDDS Applications Session  
 
 
The following steps show you how to display a simple product using WINGRIDDS.  After you have 
completed the example, read the documentation in detail to get a better understanding of the software and 
to answer your questions. 
 
 

Start a session. 
 
  1. From the desktop, double-click the icon WINGRIDDS 

Begins your WINGRIDDS session. 
 

Select forecast data file. 
 

1. Click: File>Open New Forecast File or click: Open New Forecast File Button on 
Toolbar. 

A list of the available forecast data files is displayed on the screen.  The first action you must take is to 
select a forecast data file. 
 

2. Either Single-click a single file and click Open or you can double-click a single file and that 
file will open. 

Selects forecast data file and displays a map of the areal coverage. 
 

 
Display a GRIB Parameter. 
 1. Click in the Command Line. 
  
 2. Enter: HGHT 
   This should show a contour of the 850 mb Heights  
 
 3. Enter:  WIND 
   This should erase the Heights contour and display the WIND at 850 mb 
 
 4. Enter:  HGHT&WIND 
   This should show both the Heights & WIND at 850 mb 

 
 
 NOTE:  All command requests are processed from right to left (a la Reverse  
 Polish Notation).  As such, the command  HGHT&WIND  will produce a Wind  
 field first,  a Height field in a second color.   
 

 
Define forecast hour. 

 
1. Click: Specs 

Selects the ‘Specs’ dropdown menu.  The highlight is positioned at the entry ‘Forecast hour’ in the 
‘Specs’ menu. 

 
2. Select the Forecast Hour menu 
          The window used to define time parameters is displayed on the screen.  A list of available forecast 

hours is displayed in the right side of the window. 
 

3. Position the cursor to the field for forecast hour. 
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4. Type:  012 

This clears the field by overwriting the old value.  Enters a new value in the field.   
 

5. Click:   [OK] 
Sets the forecast hour used for the data displays to 12 hours and saves the value.  Erases the form. 

 
 
 

Define a display mode. 
 

1. Click: Display menu 
Selects the ‘Display’ entry.  The checkmark  is positioned at the entry ‘Plan View’ in the ‘Display’ 
menu to show the display is in Plan View Mode. 

 
2. Click: Plan View 

Selects the option to define a display mode.  The window used to define the plan view mode is 
displayed on the screen. 

 
3. Click: Lookup Button 

A list of predefined plan view definitions is displayed in a separate window. 
 

4. Click-drag the scroll bal on the right side of the window to pan up/down to view the 
selection then click the area of your choice or use the [down arrow] key to move the 
highlight to the area of your choice. 

 
5. Click: OK 

Erases the list of definitions.  The definition values are entered into the form. 
 

6. Click: OK 
Sets the plan view definition.  A map showing the area you defined is displayed. 

 
 
 

Display a product. 
 

1. Click: Products menu 
Selects the ‘Products’ entry.   

 
2. Drag your mouse across the Products Menu and the entries will highlight as you move 

your mouse.   
 

3. Go down and click on the ‘Build Your Own Maps’ entry (10th entry down) 
 
  4. The ‘Command window’ will be displayed with the Command macros listed for that entry.   

 
5. Single-Click:: HGHT then click OK or Double-click HGHT 

Selects the product and displays it on the screen.  You should now see the 850 mb heights displayed on 
your screen. 
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Switch Between 1 Panel mode and 4 Panel mode. 
 

1. If the display is in 1 Panel mode, to switch to 4 Panel mode either  

         a) Click:   Button on the WINGRIDDS Tool Bar or 
         b) Enter the command 4PNL on the Command Line 

 
This will change the display mode from 1 Panel to 4 Panel mode.   

 
        If the display is in 4 Panel mode, to switch to 1 Panel mode either  

         a) Click:   Button on the WINGRIDDS Tool Bar or 
         b) Enter the command 1PNL on the Command Line 

 
This will change the display mode from 4 Panel to 1 Panel mode.   

 
  Once this is complete, you need to re-calculate the area displays.  
 

2. Click: Display menu 
Selects the ‘Display’ entry.  The checkmark  is positioned at the entry ‘Plan View’ in the ‘Display’ 
menu to show the display is in Plan View Mode. 

 
3. Click: Plan View 

Selects the option to define a display mode.  The window used to define the plan view mode is 
displayed on the screen. 

 
4. Click: OK 

Sets the plan view definition.  A map showing the area you defined is displayed. 
 

If CROSS or TIME section have previously been defined, they must be re-calculated as                                      
well.  For the Cross Section: 

 
5. Click: Display menu 

Selects the ‘Display’ entry.   
 

6. Click: Cross View 
Selects the option to define a display mode.  The window used to define the plan view mode is 
displayed on the screen. 

 
7. Click: OK 

Recalculates the cross view definition.  A map showing the area you defined is displayed. 
 

For the Time Section: 
 

8. Click: Display menu 
Selects the ‘Display’ entry.   

 
9. Click: Time View 

Selects the option to define a display mode.  The window used to define the plan view mode is 
displayed on the screen. 

 
10. Click: OK 

Recalculates the time view definition.  A map showing the area you defined is displayed. 
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Exit WINGRIDDS 
 

1. Click: File> Exit  menu 
Exits the WINGRIDDS program. 

 
    or 
 

2. Type: X       at the Command Line 
Exits the WINGRIDDS program. 

 
 
 
 
For more information or detailed instruction about WINGRIDDS operations, see the WINGRIDDS Operations 
section.  For information about changing the configuration of WINGRIDDS, see the Customizing the 
WINGRIDDS System section. 
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WINGRIDDS Operations 
 

The following discussions describe the operation of WINGRIDDS. 
 
 
-- Starting WINGRIDDS 

Use the following steps to initiate a WINGRIDDS session: 
 
  1. From the desktop, double-click the icon WINGRIDDS 

                  
 or 
 

2.      From the ‘Start> Programs> WINGRIDDS’ menu, click WINGRIDDS 
 
 

When you enter WINGRIDDS you may download data or ingest data but you can not perform any 
work on the data until a forecast file is opened. 

 
-- Main Screen 

The main screen for WINGRIDDS is displayed horizontally on line 2 (top) of the screen (Fig.2). 
 

Fig.2 

 
All Buttons except the Open File button are disabled and grayed out until a file is opened. 
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-- Grid Information 

The grid information is displayed on the status line at the bottom of the screen.  This line shows the 
current settings that are used for data selection.  When you begin WINGRIDDS, these values are set 
to the default values found in \WINGRIDDS\USER\INITGRID.SPC (refer to 'Customizing 
WINGRIDDS'). 

 
LEVEL Pressure level, Isentropic level, Potential Vorticity level, Sigma level or Height level 

 
LAYER A grid layer consisting of 2 levels; used for level differences, etc. 

 
FHR  Forecast hour 

 
FHRS Pair of forecast hours (Time range) used for time differences, etc. 

 
MODEL A 4 character forecast model identification name the forecast model date 

 
m/#  Current display mode (m) and grid data-thinning factor (#).  The character 'm' can 

have one of three values:  P (Plan view), T (Time-section), X (Cross-section).  The 
character # can have a power of two value: 1, 2, 4, 8, A(16), B(32), etc. 

 
Other         Once a forecast file is loaded, the date-time-group of the model run as well as the 

file name will be displayed. 
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-- File Menu 
 

Fig.3 

 
 
 

When you select 'File' from the main menu, a ‘pull-down’ menu (Fig.3) with the following choices is 
displayed. 

            
                  1. Download GRIB Files 

This is where GRIB data files are downloaded through WINGRIDDS (refer to                           
‘Downloading GRIB Data’). 

 
                  2. Download Observation Files 

This is where Observation data files are downloaded through WINGRIDDS (refer to                           
‘Downloading Observation Data’). 

 
                  3. Download Frontal Position Files 

This is where ASUS Frontal Position data files are downloaded through WINGRIDDS 
(refer to ‘Downloading ASUS Frontal Data’). 

 
  4. Convert WAFS GRIB Data 

This is where WAFS GRIB files are ingested and converted to PCG-format forecast files 
(refer to ‘Ingest WAFS GRIB Data’). 
 

 



 
 89 

  5. Convert Non-WAFS GRIB Data 
This is where all other GRIB files are ingested and converted to PCG-format forecast files 
(refer to ‘Ingest GRIB Data’). 

 
  6. Convert Observation Data 

This is where all Observation files are scanned and processed, Barnes Analysis applied 
and the data converted to PCG-format forecast files (refer to ‘Convert Observation Data’). 

 
  7. Delete WAFS GRIB Files 

All WAFS GRIB files are deleted from the GRIB/WAFS/Octant* directories after they have 
been converted to PCG Format. 

 
  8. Delete Regular GRIB Files 

All Regular GRIB files are deleted from the GRIB/NWS directory after they have been 
converted to PCG Format. 

 
  9. Delete MOS GRIB Files 

All MOS GRIB files are deleted from the GRIB/MOS directory after they have been 
converted to PCG Format. 

 
  10. Delete Observation Files 

All Surface and Upper-Air Observation data files are deleted from the OBS directory after 
they have been converted to PCG Format. 

 
  11. Delete Frontal Position Files 

All ASUS Frontal Position data files are deleted from the FRONT directory. 
 
  12. Delete Processed Data File 

Delete a selected Processed Data file from the configured GRIDDATA directory. 
 

  13. Properties 
Opens WINGRIDDS Properties Dialog to configure WINGRIDDS operations (refer to                           
‘Customizing the WINGRIDDS System’). 
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14. Open New Processed Data File 
This selects a new forecast data file from the list of files in the current gridded data 
directory. When you select this option, a list of available forecast data files is displayed on 
the screen. Both GEMPAK and PCG data files will be stored here. 
 

 
 
To select a new forecast data file: 

 
1. Double-click on the filename you wish to open, or… 

By default the files are listed in alphabetical order by name. 
 

2. Single-click on the filename you wish to open and click “Open” 
 

The current gridded data directory is specified in the file 
\WINGRIDDS\USER\WINGMODE.DAT (refer to 'Customizing WINGRIDDS').  The default 
value for this directory is \WINGRIDDS\GRIDDATA. 
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Selecting a new forecast data file must be the first action you perform in WINGRIDDS 
before any WINGRIDDS commands can be accepted.  No other actions (except 
Downloading or ingesting GRIB files or exiting) are allowed until you select a file.  You can 
select only one file at a time.  Each file you select is added to the list of up to 35 files 
available for access by WINGRIDDS.  However, you can use only one file at a time.  The 
last file you select will be the active forecast data file unless you change it with choice #5 
(Change forecast file). 

 
14. Change Processed Data file 

Changes the active forecast data file to one of the files displayed in the list of previously 
selected forecast files (Fig.4).  Files are added to this list each time you select a new 
forecast file (choice #4).  Only one file may be active at a time.  Data for products are 
obtained from the active file. When you select this option, a list of previously selected 
forecast data files is displayed on the screen.  To change the active forecast data file: 

 
1. Double-click on the filename you wish to open, or… 

The currently active processed data file is highlighted. 
 

2. Single-click on the filename you wish to open and click “Open” 
                  Makes the file active.  
 
                                 (FIG 4) 
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15. List Processed Data file contents 
Lists the gridded data available in the active forecast data file at the currently selected 
forecast hour shown at the bottom of the screen (Fig.5). 

 
The information displayed at the beginning of the listing includes:  the filename 
(FEB160800.NAM211), the forecast model name (MODEL=NAM8), the model date 
(FROM 2008/02/16/00), the currently selected forecast hour (FHR=0), the level 
(LEVEL=850), the layer (LAYER=1000/ 500), and the time range (FHRS= 00/ 24) 

 
Data fields are identified by a 4 character description a 4 character level.  For example, 
TEMP 250 corresponds to the TEMPerature grid at 250 hPa and PRESTROP corresponds 
to the PRESsure grid at the TROPopause. 

 
 

Fig.5 
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-- Specs Menu 
The 'Specs' option controls the setting of time and level specifications. 

 
Note: The time parameters should be set before the level parameters so that all of the levels 

available for the currently selected forecast hour are displayed when you select the vertical 
levels. 

 
 
When you select 'Specs' from the main menu, a ‘pull-down’ menu (Fig.6) with the choices, ‘Forecast 
hour’ and ‘Vertical level’, is displayed. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 



 
 94 

 
 

Forecast hour 
When you choose this option, the current forecast hour and time range are displayed in a 
form (Fig.6) along with a list of the forecast times available in the currently active gridded 
data set. 

 
 

Fig.6 

 
 

You can modify the forecast time parameters by entering the integer times or selecting 
values from the list of available forecast hours. 

 
To enter a value 

 
1. Position the cursor to the desired field (Forecast hour, Time range start or end). 

 
2. Type the number. 

 
The values in the ‘Available Times’ are not selectable.  They are only there for 
reference. 
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After you have completed all of your revisions click [OK] to save the values you have set 
or click [Cancel] to cancel the operation.  

 
 

Vertical level 
With this option, the current level and layer values are displayed in a form (Fig.7) along 
with the list of levels which are available at the currently specified forecast time for the 
active gridded data set. 

 
 

Fig.7 

 
 

You can modify these parameters by entering values by referencing them from the list of 
levels displayed in the ‘Available Levels’ window.  Since levels are listed only for the 
current forecast hour and may vary from one forecast time to another, you should select 
the time values (choice #1) before you select the levels. 
 
-- Non-Pressure Levels 
If the user wishes to enter Isentropic, Potential Vorticity, Sigma or Height levels, those 
values are entered here as well.  Isentropic range from I220-I500 degrees Kelvin. Sigma 
levels are preceded with the letter ‘S’. Height ranges can be in Meters or Feet and must be 
in hundreds and preceded with the letter ‘H’.  For example, ‘H100’ would define the 10,000 
ft/mtr level.  The Feet/Meters selection is specified in the file 
\WINGRIDDS\USER\WINGMODE.DAT (refer to 'Customizing WINGRIDDS').   
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To enter a value 
 

1. Click the cursor in the desired field (LEVEL, LAYER: Bottom Level, Top Level). 
 

2. Type the number.  Ensure values are LEFT justified. 
 

The values in the ‘Available Levels’ are not selectable.  They are only there for 
reference. 
 

After you have completed all of your revisions click [OK] to save the values you have set 
or click [Cancel] to cancel the operation.  
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-- Display Menu 
The 'Display' option controls the setting and definition of the display mode.  When you select 'Display' 
from the main menu, a ‘pull-down’ menu (Fig.8) appears on the screen with the following choices. 

 
Plan view 

Data are displayed over a horizontal area determined by a central latitude and longitude 
and a north/south distance in degrees. 

 
Cross-section 

Data are displayed at multiple pressure levels along a vertical cross-section path which is 
defined between a left latitude and longitude point and a right latitude and longitude point. 

 
Time-section 

The vertical structure of data is displayed for a specified time period and multiple pressure 
levels at a particular point which is defined by a latitude and longitude. 

 
 

Fig.8 
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Change the active display mode 
The active display mode is identified with a check-mark next to the appropriate menu choice 
and the appropriate button on the Tool Bar is darkened. To change the active display mode, 
either click the file selection under the ‘Display’ menu or click the enabled Display Select button 
on the Tool Bar. 

 
Note: A display mode must be defined before you can make it active. 
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Define the Plane View Mode 
After clicking on the desired mode, the current latitude and longitude parameters that define the 
selected display mode are displayed in a form (Fig.9).  You can use one of four methods to 
modify these parameters. 

 
To enter a value (Fig.9) 

 
1. Click in the desired field with the mouse to highlight the value. 

 
2. Type the value of the desired latitude or longitude in degrees. 

Degrees may be expressed as a positive integer value or as a positive real value. 
  
OR 

Click on the up-down arrows to increment or decrement the value in the 
window. 

 
3. When direction is required, type one of the following characters to indicate the 

appropriate hemisphere:  N, S, W, E. 
 

4. Press [OK]. 
Saves the values you set. 
 

Fig.9 
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To select an entry from the lookup table (Fig.10) 
 

1. Click [Lookup]. 
Activates the lookup menu.  A list of display mode definitions is shown on the screen. 

 
2. Double-click to select the entry immediately or single-click the entry. 

Remember the table may contain multiple pages. 
 

3. Click [OK]. 
Saves the values you set. 

 
 

Fig.10 

 
 
 
To add entries into the Lookup Table refer to 'Customizing WINGRIDDS’. 
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To select an entry from the station id list (Fig.11) 
 

1. Click [Station ID]. 
Activates selection by station identifier (id).  A request for one or more station id's 
appears on the screen. 

 
2. Type a 3 or 4 character station id in the field. 

 
3. Click [OK]. 

Retrieves the parameters for the station id and enters them into the form. 
 

4. When you are using the station id list to define a plan view, you must type in 
the N-S display distance manually if you want it changed from the current 
setting. 

 
5. Click [OK]. 

Saves the values you set. 
 
 

Fig.11 

 



 
 102 

To select an entry from the Map Select (Fig.12) 
 

1. Click [Map Select]. 
Activates the Map Plan Section Select Window.  A list of display mode options are 
shown on the screen. 

Fig.12 

 
 
 As the mouse is moved within the Map Select window, the ‘Center Latitude’ and ‘Center Longitude’ 
numbers will dynamically change to show the location of the mouse pointer. The ‘Zoom’ and ‘Pan’ buttons 
allow the user to change the geographic area shown in the window for more accurate area selection. 
 

2.     To create a Plan Area selection, click and hold the left mouse button. When you start 
to move the mouse, a rectangle will be drawn showing the Plan Area selection. Also, 
the ‘Center Latitude’ and ‘Center Longitude’ numbers will start showing the 
geographic center of the rectangle and the ‘North/South Distance’ number will start 
to update the vertical distance of the rectangle (in degrees) as the mouse position is 
changed. When the mouse is moved to show the geographic area the user wants in 
the Plan Area, release the left mouse button and the Plan Area will be stored. 
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 3.  Click [OK] to save the Plan Area selection. The Selection Window will close. 
 
  OR 
 
 4. Click [CLEAR] to undo the Plan Area selection and start again. 
 
  OR 
 
 5. Click [Cancel] to close the Plan Area selection and clear any selection 

 
 
 
For all three display modes, remember that you must click [OK] to save the values 
you have set.  WINGRIDDS will define the new display mode and make it active.  
After this process is completed, a map is displayed on the screen showing the 
current plan view definition.  The position of the cross-section line and the time-
section point are indicated on the map if they are defined and lie within the map area. 
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To select a Custom Grid Projection (Figs.13,14,15) 
The user can enable a Custom Grid projection by either creating one from scratch or 
opening a previously saved projection. The following are instructions to create from 
scratch: 

 
1. Click [Custom Grid]. 

Activates the Custom Grid dialog.  A display of different grid projections  is shown on 
the screen. 

 
2. Select one of the three tabs (Latitude/Longitude, Lambert Conic Conformal or 

Polar Stereographic) for the desired grid projection. (see figs below) 
 
 
 

Fig.13 

 
 
Custom Map – Latitude/Longitude Selection 
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Fig.14 

 
 
 
Custom Map – Lambert Conic Conformal Selection 
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Fig.15 

 
 
 
Custom Map – Polar Stereographic Selection 
 
    3. Once a base projection is selected, the user is free to use the drag pointers to 

adjust the field of view to suit the users’ requirements. 
 
    4. Once the desired field of view is achieved, click [Next]. 
     (a Lambert Conic Conformal projection will be used as the example) 
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Fig.16 

  
 
 Fig. 16 shows the base map with the interpolated latitude/longitude gridded data overlaid in red.  
 It is seen that the base map latitude/longitude lines in white do not match the interpolated 

latitude/longitude gridded data in red. At this point, the user must use the adjustments above the 
window to make the data in red overlay and match the background as close as possible.  

 ***NOTE – it may not be possible to get an exact match. The goal is to get it as close as possible. 
 It takes practice to get familiar with how the adjustments affect the display. 
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Fig.17 

 
 
 Fig. 17 shows the base map with the interpolated latitude/longitude gridded data overlaid in red after 

user adjustments have been applied.  
 
 At this point, the user may either click [OK] to use the custom map settings operationally or, to save 

the custom map settings for rapid recall at a later time, click the [Save As] button to save the 
settings. (see fig. 18 below). 
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Fig.18 

  
 
Fig. 18 shows the Save Custom Grid Description dialog where the user selects a file name to save the 

Custom Map configuration settings. The files are saved in the WINGRIDDS/USER directory and 
require the “.grd” file extension. 
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  To select a Saved Custom Grid Projection (Figs.19) 
 

Fig.19 

 
 
 
To open and use a previously saved Custom Grid Projection, within the Custom Map Selection dialog, click 
[Open] (see fig 20). 
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Fig.20 

 
 
When the user selects to use a saved Custom Grid Description, the Load Custom Grid Description dialog is 
displayed showing any saved grid description files that are in the WINGRIDDS/USER directory.  Select the 
preferred file and click [Open]. WINGRIDDS will accept the predefined navigation information in the file 
and will not require the user to do any adjustments to the display. 
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Define the Cross Section Mode  
After clicking on the desired mode, the current latitude and longitude parameters that define the 
selected display mode are displayed in a form (Fig.21).  You can use one of four methods to 
modify these parameters. 

 
To enter a value (Fig.21) 

 
1. Click in the desired field with the mouse to highlight the value. 

 
2. Type the value of the desired latitude or longitude in degrees. 

Degrees may be expressed as a positive integer value or as a positive real value. 
  
OR 

                                             
Click on the up-down arrows to increment or decrement the value in the 
window. 

 
3. When direction is required, type one of the following characters to indicate the 

appropriate hemisphere:  N, S, W, E. 
 
                           The following entries are optional 
                                             
                                           Accept default entries or- 
 

4.      Enter ‘U’ to display the Preset pressure levels listed the INITGRID.SPC file or 
enter ‘A’ to display all pressure levels in the current data file or enter ‘I’ to 
calculate data on Isentropic levels or enter ‘H’ to calculate data on height levels 
in feet or meters or enter ‘X’ to use a user defined file which is entered next. 

 
5.      Enter the 4-letter file name which contains the user defined pressure levels. 

 
6. Click [OK]. 

Saves the values you set. 
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Fig.21 
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To select an entry from the Lookup table (Fig.22) 
 

1. Click [Lookup]. 
Activates the lookup menu.  A list of display mode definitions is shown on the screen. 

 
2. Double-click to select the entry immediately or single-click the entry. 

Remember the table may contain multiple pages. 
 

3. Click [OK]. 
Saves the values you set. 

 
 

Fig.22 
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To add entries into the Lookup Table refer to 'Customizing WINGRIDDS’. 
 
 

 
To select an entry from the Station ID list (Fig.23) 

 
1. Click [Station ID]. 

Activates selection by station identifier (id).  A request for one or more station id's 
appears on the screen. 

 
2. Type a 3 or 4 character station id in the field. 

If there is a second field, position the cursor to the next field using the [Tab] key and 
type a second station id. 

 
3. Click [OK]. 

Retrieves the parameters for the station id and enters them into the form. 
 

4. Click [OK]. 
Saves the values you set. 

 
 

Fig.23 
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To select an entry from the Map Select (Fig.24) 
 

1. Click [Map Select]. 
Activates the Map Cross Section Select Window.  A list of display mode options are 
shown on the screen. 

 
Fig.24 

 
 
 As the mouse is moved within the Map Select window, the ‘Start Latitude/Longitude’ numbers will 
dynamically change to show the location of the mouse pointer. The ‘Zoom’ and ‘Pan’ buttons allow the user 
to change the geographic area shown in the window for more accurate area selection. 
 

2.     To create a Cross-Section selection, click and hold the left mouse button. When 
you start to move the mouse, a line will be drawn showing the Cross-Section 
selection. Also, the ‘Start Latitude/Longitude’ numbers will be frozen at the first click-
point. Now, the ‘End Latitude/Longitude’ numbers will start to update the mouse 
position. When the mouse is moved to the geographic area the user wants the 
Cross-Section to end, release the left mouse button and the Cross-Section line will 
be stored. 
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 3.  Click [OK] to save the Cross-Section selection. The Selection Window will close. 
 
  OR 
 
 4. Click [CLEAR] to undo the Cross-Section selection and start again. 
 
  OR 
 
 5. Click [Cancel] to close the Cross-Section selection and clear any selection. 
 
  
Note: You can define cross-section lines and time-section points that fall outside the plan 

view display area but within the area covered by the currently active gridded data 
set.  However, they are not displayed on the plan view map. 

 
If both ends of the cross-section line or the time-section point fall outside the area 
covered by the currently active gridded data set, then the definition points for that 
display mode are canceled and you are returned to the plan view display mode. 
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Define the Time Section Mode  
After clicking on the desired mode, the current latitude and longitude parameters that define the 
selected display mode are displayed in a form (Fig.25).  You can use one of four methods to 
modify these parameters. 

 
To enter a value (Fig.25) 

 
1. Click in the desired field with the mouse to highlight the value. 

 
2. Type the value of the desired latitude or longitude in degrees. 

Degrees may be expressed as a positive integer value or as a positive real value. 
  
OR 

                                             
Click on the up-down arrows to increment or decrement the value in the 
window. 

 
3. When direction is required, type one of the following characters to indicate the 

appropriate hemisphere:  N, S, W, E. 
 
                           The following entries are optional 
                                             
                                            Accept default entries or- 

4.      Enter ‘U’ to display the Preset pressure levels listed the INITGRID.SPC file or 
enter ‘A’ to display all pressure levels in the current data file or enter ‘I’ to 
calculate data on Isentropic levels or enter ‘H’ to calculate data on height levels 
in feet or meters or enter ‘X’ to use a user defined file which is entered next. 

 
5.      Enter the 4-letter file name which contains the user defined pressure levels. 

 
6.      Enter ‘U’ to display the Preset forecast hours listed the INITGRID.SPC file or 

enter ‘A’ to display all forecast hours in the current data file or enter ‘X’ to use a 
user defined file which is entered next. 

 
7.      Enter the 4-letter file name which contains the user defined forecast hours. 

 
8. Click [OK]. 
         Saves the values you set. 
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Fig.25 
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To select an entry from the lookup table (Fig.26) 
 

1. Click [Lookup]. 
Activates the lookup menu.  A list of display mode definitions is shown on the screen. 

 
2. Double-click to select the entry immediately or single-click the entry. 

Remember the table may contain multiple pages. 
 

3. Click [OK]. 
Saves the values you set. 

 
4. Click [OK]. 

Saves the values you set. 
 
 

Fig.26 
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To add entries into the Lookup Table refer to 'Customizing WINGRIDDS’. 
 
 

 
To select an entry from the station id list (Fig.27) 

 
1. Click [Station ID]. 

Activates selection by station identifier (ID).  A request for one or more station id's 
appears on the screen. 

 
2. Type a 3 or 4 character station id in the field. 

 
3. Click [OK]. 

Retrieves the parameters for the station id and enters them into the form. 
 

4. Click [OK]. 
Saves the values you set. 

 
 

Fig.27 
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To select an entry from the Map Select (Fig.28) 
 

1. Click [Map Select]. 
Activates the Map Time Section Select Window.  A list of display mode options are 
shown on the screen. 

 
Fig.28 

 
 
 As the mouse is moved within the Map Select window, the ‘Grid-Point Latitude’ and ‘Grid-Point 
Longitude’ numbers will dynamically change to show the location of the mouse pointer. The ‘Zoom’ and 
‘Pan’ buttons allow the user to change the geographic area shown in the window for more accurate area 
selection. 
 

2.     To create a Time-Section selection, move the mouse around to the geographic area 
you wish the point to be. A single left mouse button click will store the location and 
the ‘Grid-Point Latitude’ and ‘Grid-Point Longitude’ numbers will no longer update 
when the mouse is moved. 

 
 3.  Click [OK] to save the Time-Section selection. The Selection Window will close. 
 
  OR 
 
 4. Click [CLEAR] to undo the Time -Section selection and start again. 
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  OR 
 
 5. Click [Cancel] to close the Time -Section selection and clear any selection. 

 
 

Note: You can define cross-section lines and time-section points that fall outside the plan 
view display area but within the area covered by the currently active gridded data 
set.  However, they are not displayed on the plan view map. 

 
If both ends of the cross-section line or the time-section point fall outside the area 
covered by the currently active gridded data set, then the definition points for that 
display mode are canceled and you are returned to the plan view display mode. 

 
 
Sounding/Hodograph/BUFKIT/Trajectory Point Setup 
 
The WINGRIDDS ‘Display’ menu has an entry added at the bottom.  There is a common dialog which is 
used to select a Sounding, Hodograph, Bufkit generation or Trajectory display.  These are grouped 
together because they all show data from a single grid point or location.  WINGRIDDS *must* be in ‘Plan’ 
view to create any of these displays. 
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The following dialog is displayed whenever the ‘Sounding/Hodograph/Bufkit/Trajectory’ menu selection is 
chosen.  
 

 
 
Within this dialog, the user can choose one type of display operation at a time. Each type of display 
(Sounding [Skew-T, Telphigram & Stuve], Hodograph, Bufkit & Trajectory) can store its own separate 
location information and the last location used will be saved. As the Latitude or Longitude is changed, the 
Grid X/Y location is updated to reflect the new location and vice-versa.  The ‘Lookup’ and ‘Station ID’ 
buttons work the same as on the ‘Time Section Select’ dialog.  The new button (also on the ‘Plan’, ‘Cross’ 
& ‘Time’ dialogs but covered in their own section) is the ‘Map Select’ button.  See below: 
 



 
 125 

  
 
The ‘Map Data Point Select’ window opens and allows the user to graphically select the grid-point location 
for the operation requested.  This works as follows; when the window opens, the full grid area is shown.  As 
the user moves the mouse curser across the screen, the grid-point latitude and longitude dynamically 
update to show the real-time position of the curser.  The user can pan around or zoom in or out using the 
buttons across the top.  The selection of a point for use is made with the *single* left-click of the mouse.  At 
that point, the grid-point locations are frozen at that location.  If the user does not want that location and 
wishes to choose another, click the ‘Clear’ button and start again.  If the user wishes to just cancel from the 
Map Select operation all together and reject any selection, click the ‘Cancel’ button.  However, if the user 
has selected a valid location, click the ‘OK’ button.  The window will close and the location information will 
be transferred to the Setup dialog. 
 
Once the location and display type is selected in the Setup dialog, clicking the ‘OK’ button will cause the 
requested display or operation to be executed. 
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If a Trajectory display has been selected, the ‘Trajectory Direction’ selection area will be enabled as seen 
below: 
 

 
 
Since trajectories can be computed in either forward direction (where the wind parcel is moving to) or 
backward direction (where the wind parcel is moving from), the selection should be made by the user.  The 
default selection is a ‘Forward Trajectory’. 
 
 
 
 
 
Sounding Displays 
 
WINGRIDDS can produce 3 different types of sounding displays and they apply for either model data or 
observation data. The 3 displays are Skew-T, Telphigrams and Stuve displays.  If model data is displayed, 
data from all levels (except boundary and sigma levels) will be displayed.  If data is requested from an 
observation data file, 2 situations exists; if the data request is from a RAOB reporting station, the full RAOB 
report will be displayed. However, if the data request is from an area between reporting stations, only the 
interpolated gridded data will be displayed.   
 
WINGRIDDS Commands 
 
The Sounding displays can either be created using the menu dialog (above) or from the WINGRIDDS 
command line.  Command-line location can be requested from either a Lat/Lon location, Grid-point X/Y 
location or Station ID.  The commands for Skew-T plots are as follows: 
 
SKEW LAT25.82N LON80.28W                 > Lat/Lon location 
SKEW X71 Y13                                           > Grid X/Y location 
SKEW STIDKMIA                                         > Station ID selection 
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NOTICE – there is a space between command parameters *however* there are no spaces in the command 
parameters. “LAT25.82N” is all one continuous string with no spaces. This is the same for the longitude, 
the grid ‘X’ & ‘Y’ values as well as the Station ID.  The Station ID (STID) should be the 4-letter WMO ID 
(KMIA). 
 
The commands for Telphigram and Stuve plots are similar: 
 
TEPH LAT25.82N LON80.28W                 > Lat/Lon location 
TEPH X71 Y13                                           > Grid X/Y location 
TEPH STIDKMIA                                         > Station ID selection 
 
STUV LAT25.82N LON80.28W                 > Lat/Lon location 
STUV X71 Y13                                           > Grid X/Y location 
STUV STIDKMIA                                         > Station ID selection 
 
 
Sounding Plots 
The text within the sounding display is as follows from bottom to top: 
 
MULPL – Most Unstable Lifted Parcel Level 
MULCL - Most Unstable Lifted Condensation Level 
MULFC - Most Unstable Level of Free Convection 
WBZ – Wet Bulb Zero level 
FRZLVL – Freezing Level 
MUEQL - Most Unstable Equilibrium Level 
TROPO – Tropopause (only displayed if listed in observation RAOB report) 
 
Sounding Winds 
Winds are displayed in 5 layers in height by color; 0-3km, 3-6km, 6-9km, 9-12km, above 12km 
 
Sounding Plots 
The following data are displayed (as referenced in the plot below): Temperature (solid red line), Virtual 
Temperature (dotted red line), Dew Point (solid blue line), Wet Bulb Temperature (dotted blue line), Parcel 
track (dotted yellow line).  The line characteristics are fixed, the colors are selectable. 
 
Sounding Text Information 
 
MODEL DATA NAMA 00 UTC FRI 26 SEP 2008                   >  Model data – model name – Date-Time Group 
 ---------------------------------------------------------- 
 STATION ID :   MIA /72202  - MIAMI INTL AIRPORT            > Station Location Info 
 LAT/LON:      25.82 /    -80.28                                                  > Location Latitude and Longitude 
 GRDX/GRDY   71 /   13                                                            > Grid X/Y Location 
 ---------------------------------------------------------- 
 FRZLVL:       4696.99                                                                > Freezing Level (meters) 
 PWATER:          4.08                                                                 > Precipitable Water (cm) 
 CONVT:          28.77                                                                  > Convective Temperature 
 HSIZE:           1.12                                                         > calculated Hail Size 
 DENBUOY:         1.00                                                      > Density Buoyancy 
 -- PARCEL --  
 CAPE:          847.55                                                                    > Convective Available Potential Energy  
 CIN:           -10.53                                                         > Convective Inhibition 
 LIFTED:         -3.57                                                                    > Lifted Index (deg c) 
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 KINDEX:         25.93                                                     > K Index 
 TOTAL:          40.92                                                                   > Totals Index 
 CRSTOT:         18.08                                                     .> Cross Totals Index 
 VERTOT:         22.84                                                     > Vertical Totals Index 
 SHWLTR:          1.88                                                                 > Showalter Index 
 SWEATX:        163.27                                                                > SWEAT Index 
 VVMAX:          15.46                                                                 > Vertical Velocity Maximum (mps) 
 -- WIND -- 
 AVG DIR:       247.19                                                                 > Average Wind Direction 
 AVG SPD:        12.62                                                                 > Average Wind Speed (kts) 
 BRSHEAR:        11.97                                                             > Bulk Richardson Shear 
 STORM MOTION (DIR/SPD):        316.55 /     14.15                > Right-Moving Storm Motion 
 STORM REL HELICITY:      -1664.46 
 STORM REL HOLICITY:       -225.95 
 -- OTHER -- 
 BRN:            70.81                                                                         > Bulk Richardson Number 
 EHI:            -8.82                                                             > Energy Helicity Index 
 VGP:           126.92                                                             > Vorticity Generation Potential  
 SCP:            -4.22                                                             > Supercell Composite Parameter 
 STP:            -5.78                                                                           > Significant Tornado Parameter 
 PRECIP TYPE: RAIN 
 
 

 
 

This is the Skew-T plot sounding. 
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This is the Telphigram plot sounding 

 

 
This is the Stuve plot sounding 
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Hodograph Displays 
 
WINGRIDDS can produce hodograph displays and they apply for either model data or observation data. If 
model data is displayed, data from all levels (except boundary and sigma levels) will be displayed.  If data 
is requested from an observation data file, 2 situations exists; if the data request is from a RAOB reporting 
station, the wind from the full RAOB report will be displayed. However, if the data request is from an area 
between reporting stations, only the interpolated gridded data will be displayed.   
 
The wind speed rings are either dynamically scaled to the maximum wind speed so the whole display area 
is filled or they can be set to a fixed maximum wind. (refer to 'Customizing WINGRIDDS’.) 
 
WINGRIDDS Commands 
 
The Hodograph displays can either be created using the menu dialog (above) or from the WINGRIDDS 
command line.  Command-line location can be requested from either a Lat/Lon location, Grid-point X/Y 
location or Station ID.  The commands for hodograph plots are as follows: 
 
HODO LAT25.82N LON80.28W                 > Lat/Lon location 
HODO X71 Y13                                           > Grid X/Y location 
HODO STIDKMIA                                         > Station ID selection 
 
NOTICE – as with the sounding commands, there is a space between command parameters *however* 
there are no spaces in the command parameters. “LAT25.82N” is all one continuous string with no spaces. 
This is the same for the longitude, the grid ‘X’ & ‘Y’ values as well as the Station ID.  The Station ID (STID) 
should be the 4-letter WMO ID (KMIA). 
 
Hodograph Text Information 
 
MODEL DATA NAMA 00 UTC FRI 26 SEP 2008                   >  Model data – model name – Date-Time Group 
 ---------------------------------------------------------- 
STATION ID :   MIA /72202  - MIAMI INTL AIRPORT        > Station Location Info 
 LAT/LON:      25.82 /    -80.28                                                  > Location Latitude and Longitude 
 GRDX/GRDY   71 /   13                                                            > Grid X/Y Location 
 ---------------------------------------------------------- 
-- PARCEL --  
CAPE:          847.55                                                                    > Convective Available Potential Energy  
 CIN:           -10.53                                                         > Convective Inhibition 
 LIFTED:         -3.57                                                                    > Lifted Index (deg c) 
 KINDEX:         25.93                                                     > K Index 
 TOTAL:          40.92                                                                   > Totals Index 
 CRSTOT:         18.08                                                     .> Cross Totals Index 
 VERTOT:         22.84                                                     > Vertical Totals Index 
 SHWLTR:          1.88                                                                 > Showalter Index 
 SWEATX:        163.27                                                                > SWEAT Index 
 VVMAX:          15.46                                                                 > Vertical Velocity Maximum (mps) 
 -- WIND --  
 AVG DIR/SPD:     247.19 /12.62  
 MEAN WIND DIR/SPD:     252.24 /28.00  
 STORM MOTION 30/75 DIR/SPD:     254.00 /7.24 
 STORM MOTION 15/85 DIR/SPD:     239.00 /8.20 
 BUNKERS RM STORM MOTION (DIR/SPD):     316.55 /14.15 
 BUNKERS LM STORM MOTION (DIR/SPD):     164.31 /14.86 
 CORFIDI VECTOR (DIR/SPD):     262.11 /10.73 
 RM STORM REL HELICITY:   -1664.46 
 LM STORM REL HELICITY:   -1041.40 
 RM STORM REL HOLICITY:    -225.95 
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 LM STORM REL HOLICITY:    1664.55 
 -- OTHER -- 
 BRN:            70.81 
 BRSHEAR:        11.97 
 EHI:            -8.82 
 VGP:           126.92 
 SCP:            -4.22 
 STP:            -5.78 
 VGP:           126.92 
 PRECIP TYPE: RAIN 
 
 

 
 
The following markers are present on the Hodograph display: 
 

 - Mean Wind Direction/Speed Marker 

 - Storm Motion 30/75 Direction/Speed Marker 

- Storm Motion 15/85 Direction/Speed Marker 

- Bunkers Right-Moving Storm Motion Direction/Speed Marker 

- Bunkers Left-Moving Storm Motion Direction/Speed Marker 

- Corfidi Vector 
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BUFKIT File Generation 
 
WINGRIDDS can produce BUFKIT Data files and they apply for only model data. The files will be 
generated for each forecast hour from the gridded data file contents and any diagnostic commands which 
are required will be executed to create the needed data points. The BUFKIT Data file will be stored in the 
BUFKIT Destination Directory which is selected in the ‘Properties’ dialog (refer to 'Customizing 
WINGRIDDS’). The user needs to ensure the correct destination directory for the BUFKIT installation is 
selected. 
 
WINGRIDDS BUFKIT Data File Naming Convention 
 
The BUFKIT Data File naming style within WINGRIDDS uses the following convention: 
 
XXXXXXXXX_YYYYYY.buf 
Model Name    Location.buf 
 
The Model name will be the 3-letter ID for the model used in WINGRIDDS. The Location can be either the 
Station ID, Lat/Lon point or the Grid X/Y point. 
 
Therefore, for a Lat/Lon entry, the BUFKIT file name would be; 
NAM_37.97N 75.69W.buf 
 
or,  for a Wallops Island, Va. Station ID entry, the BUFKIT file name would be; 
NAM_KWAL.buf 
 
or,  for a Grid X/Y entry, the BUFKIT file name would be; 
NAM_37X 75Y.buf 
 
 
WINGRIDDS Commands 
 
The BUFKIT Data files can either be created using the menu dialog (above) or from the WINGRIDDS 
command line.  Command-line location can be requested from either a Lat/Lon location, Grid-point X/Y 
location or Station ID.  The commands for BUFKIT Data file generation are as follows: 
 
BUFK LAT25.82N LON80.28W                 > Lat/Lon location 
BUFK X71 Y13                                           > Grid X/Y location 
BUFK STIDKMIA                                         > Station ID selection 
 
NOTICE – as with the sounding commands, there is a space between command parameters *however* 
there are no spaces in the command parameters. “LAT25.82N” is all one continuous string with no spaces. 
This is the same for the longitude, the grid ‘X’ & ‘Y’ values as well as the Station ID.  The Station ID (STID) 
should be the 4-letter WMO ID (KMIA). 
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When the BUFKIT Data File generation command is accepted, WINGRIDDS will go through each forecast 
hour of the currently opened model data file and process the required parameters and diagnostic 
calculations.  The screen will show the progress of the process by showing the following message in the 
upper left corner of the screen; 
 
PROCESSING BUFKIT DATA...PLEASE WAIT - FORECAST HOUR 
 
With the forecast hours increasing till it reaches the end. At that time the screen will show the following: 
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Trajectory Display 
 
WINGRIDDS can generate Trajectory plots which show the movement of air parcels over time in either the 
forward direction (parcel moving away from location) or backward direction (air moving toward the 
location).  Trajectories are plotted on either constant pressure surfaces or constant theta (Isentropic) 
surfaces.   
 
WINGRIDDS Commands 
 
The Trajectory displays can either be created using the menu dialog (above) or from the WINGRIDDS 
command line.  Command-line location can be requested from either a Lat/Lon location, Grid-point X/Y 
location or Station ID.  The commands for trajectory plots are similar to the other grid-point plots but has an 
extra direction command as follows: 
 
TRAJ LAT25.82N LON80.28W FWD                 > Lat/Lon location – forward  
TRAJ X71 Y13 FWD                                           > Grid X/Y location - forward 
TRAJ STIDKMIA BKW                                         > Station ID selection - backward 
 
NOTICE – as with the sounding commands, there is a space between command parameters *however* 
there are no spaces in the command parameters. “LAT25.82N” is all one continuous string with no spaces. 
This is the same for the longitude, the grid ‘X’ & ‘Y’ values as well as the Station ID.  The Station ID (STID) 
should be the 4-letter WMO ID (KMIA). 
 
The extra command at the end (FWD/BKW) shows the direction the trajectory should be calculated.  If the 
trajectory should be plotted on an isentropic surface, the level must be selected prior to issuing the TRAJ 
command.  
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Trajectory Display - Forward 
 

 
 
This is showing a forward trajectory plot on a constant pressure surface.  At each forecast hour location 
there will be an arrow head drawn as well a two boxes.  The boxes will show the pressure level at that 
location and the forecast hour at that location.  On constant pressure plots, the pressure value will not 
change. 
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Trajectory Display - Backward 
 

 
 
This is showing a backward trajectory plot on a constant pressure surface.  The boxes are the same as on 
the forward trajectory on pressure surface. 
 
 
Trajectory Display – Forward - Isentropic 
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This is showing a forward trajectory plot on an Isentropic (constant theta) surface.  The boxes are the same 
as on the forward trajectory on pressure surface but notice the pressure values are changing with the 
movement of the air parcel on the isentropic surface height. 
 
 
 
Surface Frontal Positions 
 
WINGRIDDS now has the ability to read the NCEP issued ASUS Coded Surface Bulletin files (both regular 
and High resolution versions). See the screen shot below: 
 

 
 
 
There is a new Frontal Display button on the WINGRIDDS toolbar right next to the Observation Data 
button.  
 

 
 
WINGRIDDS can only plot frontal positions when an observation data file is opened and when there is an 
ASUS Coded Surface Bulletin file exists with the time that matches the observation time.   
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When the user opens an observation data file, WINGRIDDS searches the ASUS Coded Surface Bulletin 
data files which are stored in the WINGRIDDS\Obs\Surface\Front directory to see if there are any files with 
date-time groups which match the observation time in the observation data file.  If a match is found, 
WINGRIDDS remembers the ASUS Coded Surface Bulletin file name and enables the Frontal Display 
button on the WINGRIDDS toolbar. If the opened data file is from a model or there is no ASUS Coded 
Surface Bulletin data file to match the opened observation data file, this button is grayed out and disabled. 
When the user wishes to display frontal positions and the Frontal Display button is enabled, just click on 
the Frontal Display button or, from the WINGRIDDS command line, type ‘FRNT’. 
 
Since ASUS Coded Surface Bulletin data files are issued every 3 hours, if there is an obs data file which 
does not match the frontal data file time exactly, when WINGRIDDS performs its’ search, it will check to 
see if there are any frontal data files which may be up to 2 hours older that the obs data file. If a file is 
found, it will use the frontal file closest to the obs file time automatically.  
 
 
 
 
-- Product Menus 

This menu option controls the display of WINGRIDDS products.  A product is a display generated by 
executing a series of WINGRIDDS commands contained in a macro file (refer to 'Defining Products').  
When you select this option, the 'Product Category' menu is displayed (Fig.21).  When you select a 
choice from the 'Product Category' menu, the corresponding 'Command Window’ window is displayed 
(Fig.22). 

 
Product Category 

This menu displays a list of product categories that are available in your version of WINGRIDDS 
and is similar to the ‘Table of Contents’ of a book.  Each category contains a group of related 
products that belong to it.  Both the product categories and the actual products in each category 
can be modified by your system administrator to meet the needs of your environment (refer to 
'Defining Products'). 
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Fig.21 

 
 

Position the mouse to the desired choice and click.  After a category is selected, a list of 
products available in that category is displayed. 
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Command Window 

The ‘Command Window’ menu contains a description of the products that are available for the 
product category you selected.  The name of the product category you chose from the ‘Product 
Category’ menu is shown at the top of the menu.  When you select a product, the results are 
displayed on the screen. 

Fig.22 

 
 

Selections from the ‘Command Window’ window are made using the same procedures as for 
the ‘Product Category’ menu. 

 
Position the mouse to the desired choice and click. 
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Product overlays 
Two or more product displays can be overlaid using the Overlay button .  After the 
display of the first product is completed, click  , then the next product selection or 
command entered will be overlaid on the current display. 

 
 

Stepping through product displays for successive times 
Special Tool Bar buttons are provided which allow you to step through displays of products 
at sequentially increasing or decreasing forecast hours. 

 
 Displays the current product at the next time. 
 Displays the current product at the previous time. 
 Redisplays the current product at the current forecast hour. 

 
The forecast hours selected by the time looping characters depend on the forecast hours 
within the data file.   

 
 
  Erasing the Screen 
   The command EMAP will erase the display area and show a blank map or 
        clicking the ‘Erase Map’ button on the Toolbar. 
 

Print Options 
 The command to print the screen is PRNT or 

    clicking the ‘Print Screen’ button on the Toolbar. 
 
-- Command Line Operations 

The Command Line commands to be entered to start and control all processes (refer to Appendix C).  
Using this mode allows the greatest flexibility, but also requires the greatest understanding of 
WINGRIDDS.  Once commands are entered in the command line, either click the Go Button 

  or press the [Enter] key on the keyboard. 
 
 
 NOTE:  All command requests are processed from right to left (a la Reverse  
 Polish Notation).  As such, the command HGHT&WIND will produce a Wind  
 field first,  a Height field in a second color.   
 
 
-- 1 Panel/4 Panel Operations 
The WINGRIDDS viewing area can be viewed as a traditional single viewing area or it can be subdivided 
into 4 windows.  The following commands have been added; 
 

1PNL – switch from 4 panel view mode to 1 panel view mode 
4PNL – switch from 1 panel view mode to 4 panel view mode 
WIN1 – select Window 1 to display data (default in 1PNL mode) 
WIN2 – select Window 2 to display data (not available in 1PNL mode) 
WIN3 – select Window 3 to display data (not available in 1PNL mode) 
WIN4 – select Window 4 to display data (not available in 1PNL mode) 
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The commands 1PNL & 4PNL must be entered as standalone commands and cannot be combined with 
other commands in a command string.   
 
Each window is treated as a separate viewport so any data combinations can be displayed in each window.  
However, remember, WINGRIDDS can be in only one data ‘state’ at a time (PLAN mode, CROSS mode or 
TIME mode) and it does not care which window it draws to and it is not up to WINGRIDDS to keep track.  
For example, you display some PLAN mode data in Window 1.  You then switch to Window 2 and 
configure for a CROSS mode display. This will work fine and cross section data will be processed and 
displayed in Window 2.  However, if you switch back to Window 1 but stay in CROSS mode, the next 
command(s) will be displayed in CROSS mode in Window 1 unless you switch to back to PLAN mode after 
switching to Window 1.  You, the operator, must be explicit about what data you want to be displayed and 
in which window.  This also applies to viewing different data files in different windows.  When switching 
windows, you must also explicitly switch to the data file which matches that window. 
 
When switching between different panel modes, it is *highly* advised you re-calculate any PLAN, CROSS 
or TIME displays.   
 
The 4 panel windows can be displayed in one of two variations with a window banner or without. There is 
an entry in the WINGMODE.DAT file which controls this feature which will be covered later.  
 
The most important thing to remember when using WINGRIDDS is 4 panel mode is that the more space, 
the better.  The higher you can make your computer screen resolution, the better the data display will 
appear. 
 
The tool bar at the top of the main WINGRIDDS window has 4 buttons which control the panel mode and 
window selection.  
 
Screen Printing – When the PRNT command is issued by itself in 4 Panel mode, only the current active 
window will be printed.  If the PRNT is preceded by the ALWN command, all 4 windows will be printed 
(along with the command line). 
 
Screen Saving – When the SAVS command is issued by itself in 4 Panel mode, only the current active 
window will be printed.  If the SAVS is preceded by the ALWN command, all 4 windows will be saved 
(along with the command line). 
 
Animation – 4 Panel animation can ONLY be accomplished through the use of the ANMA (Animate Macro) 
command in a command macro.  Below is an example of the use of the ALWN command in an animation 
macro.  This macro will be using both a Plan view and a Cross Section view.  Whenever Plan & Cross view 
are combined in a 4 Panel animation, it is presumed the Plan view & Cross section view have been 
configured prior to the execution of the macro to animate them together.   
 
 
 
 
 
 
 
 
 
 
 



 
 143 

Defining Products 
 
A product is a display produced by executing a sequence of WINGRIDDS commands that are stored in an 
ASCII formatted file.  These files which are called macros or command files are placed in the MACROS 
directory.  Macro filenames are composed of a 4 character macro name the extension CMD (for example, 
DWPD.CMD).  You can execute a macro from both Command Line and Products Menu. 
 
-- Command Line execution 
 

To execute macros 
To execute a macro from the Command Line enter the name of the macro  [.]. 

 
DWPD. 

 
The above entry erases the screen and produces a display of DeW Point Depression. 

 
To overlay macros 

A macro can be overlaid on the display produced by a previous command or macro.  To overlay 
a macro enter the name of the macro  [:] (colon key). 

 
TEMP 
DWPD: 

 
The above sequence of commands erases the screen, displays TEMPerature, and overlays 
temperature with DeW Point Depression. 

 
Frequently used macro 

The name !!!!.CMD is reserved for a frequently used macro.  This file is created by copying an 
existing macro or using a text editor to enter a set of frequently used WINGRIDDS commands.  
To execute this macro from Command Line press [.] (period key). 

 
 
-- Products Menu execution 
 

To display products 
A product is generated by executing a series of WINGRIDDS commands contained in a macro 
file.  The results are displayed on the screen. 

 
1. Select 'Products' from the main menu. 

The 'Product Category' menu appears which shows you a list of product categories that are available. 
 

2. To select a category, position the mouse to the desired choice and left-click. 
After a category is selected, the 'Command Window' menu appears which shows you the first page of a 
list of products available under the selected category. 

 
3. Select a specific product in the same manner as a category. 

The 4 letters that appear to the left of the product description are the name of the macro which is 
executed to create the desired product. 
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To overlay two or more products 
 

1. Select the first product. 
 

2. When the display of the first product is complete, press  button then select the product 
you wish to overlay. 

 
Default products 

WINGRIDDS is delivered with a default set of menus and products.  You are encouraged to 
develop additional products to meet the needs of your environment.  The command lines 
required to display a product must be stored in a macro file.  You must then add to and/or 
modify the menu system before you can display new products in Products Menu.  Remember to 
include the associated HELP files.  These procedures are discussed in the following sections. 

 
 
-- Overlay data from different files 

Overlaying is the term used to refer to the simultaneous display of multiple data fields.  Data from 
different files can be overlaid on the same plot providing the following conditions are met: 

 
1. The data must be on the same grid projection, though not necessarily from the same model. 
2. The initial and final grid points used in any data subsetting must be the same.  This means that 

the areas selected during the ingest process must be identical. 
 

If the above conditions are not met, a message is displayed indicating that the files are of a different 
size or type.  If this condition occurs when a file is opened, the current plot is cleared from the screen 
and the available fields for the current forecast hour are displayed. 

 
 
-- Product directories 

The product menus and the macro files used by WINGRIDDS are stored in the product directory  
WINGRIDDS\MACROS.  The MACROS directory is the active directory from which WINGRIDDS 
references files.   

 
-- Product menus 

The product menus are stored in ASCII formatted files which are located in the 
\WINGRIDDS\MACROS directory and may be modified by your system administrator.  The 'Product 
Category' menu is similar to the ‘Table of Contents’ in a book.  It provides a list of product categories.  
When you select an entry from the 'Product Category' menu, a list of the available products in that 
category is displayed ('Product List' menu). 
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Product Category file 
Name The entries for the 'Product Category' menu are stored in the file, CMDMENU.LST. 

 
Format This file can be modified using a standard text editor.  Each line in the file defines a 

specific product category.  A maximum of 72 characters can be entered on a line.  
The lines are displayed sequentially in groups of 18 lines per screen.  The file can 
contain a maximum of 10 screens of data (180 categories). 

 
WINGRIDDS automatically ‘numbers’ the order of appearance for each entry on the 
menu page.  All other characters displayed for the entry lines must be contained in 
the menu file.  All lines in the menu must contain text.  If you wish to leave an empty 
line for clarity, add dashes as shown in the example below.  Supply a dummy 
‘Product List’ file that contains a line of blanks.  For the example below, the file 
CMDMENU.012 is a dummy file (refer to Appendix A). 

 
The file contents for the first screen of the default 'Product Category' menu are listed below.  A 
complete listing is contained in Appendix A. 

 
............... Begin file CMDMENU.LST ............................ 

BASIC  PCGRIDDS  SETUP 
SURFACE MAPS 
UPPER AIR MAPS 
STABILITY INDICIES AND MISC. 
PLOT PREDEFINED MAPS FOR SELECTED TIME AND LEVEL 
EXPERIMENTAL QPF MAPS 
CHOOSE NEW MAP FOR DISPLAYS 
OVERVIEW OF ENTIRE FORECAST CYCLE 
DETAILED OVERVIEW OF A SINGLE TIME 
 
BUILD YOUR OWN MAPS 
CUSTOM INTERACTIVE BRIEFING 
BOUNDARY LAYER PRODUCTS                               (RH, wind, etc...) 
"ANY LEVEL" PRODUCTS    (ie. choose level you want)   (RH, wind, etc...) 
LAYER PRODUCTS         (Q vectors, Potential Vorticity, Mean RH, etc...) 
RAIN/SNOW PRODUCTS      (Critical Thickness, Estimated Snowfall, etc...) 
ISENTROPIC PRODUCTS       (Isentropic Lift, Potential Vorticity, etc...) 
CONVECTIVE/SEVERE WEATHER     (CAPE, Estimated Storm Motion, LI, etc...) 
HEAVY PRECIPITATION PRODUCTS                (Precipitable Water, etc...) 
WINTER TYPE PRECIPITATION - MENU 1          [MUST SPECIFY VALID FX HOUR] 
WINTER TYPE PRECIPITATION - MENU 2          [MUST SPECIFY VALID FX HOUR] 
WINTER TYPE PRECIPITATION - MENU 3          [MUST SPECIFY VALID FX HOUR] 
SEVERE CONVECTION - MENU 1                  [MUST SPECIFY VALID FX HOUR] 
SEVERE CONVECTION - MENU 2                  [MUST SPECIFY VALID FX HOUR] 
SEVERE CONVECTION - MENU 3                  [MUST SPECIFY VALID FX HOUR] 
SEVERE CONVECTION - MENU 4                  [MUST SPECIFY VALID FX HOUR] 
QPF - MENU 1                                [MUST SPECIFY VALID FX HOUR] 
QPF - MENU 2                                [MUST SPECIFY VALID FX HOUR] 
MAPS SURFACE ANALYSIS                       [MUST SPECIFY VALID FX HOUR] 
---- 
WAFS - Display ICAO Upper-Air MAPS 
Set WAFS Map Display Areas 
WAFS - WIND/TEMPERATURE  Charts for Americas 

............... End page CMDMENU.LST ................................. 
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Product List file 
 

Name All the files for the ‘Product List’ menus have the name CMDMENU.  The line 
number of the entry in the 'Product Category' file (CMDMENU.LST) determines the 
extension of the file (CMDMENU.###) that provides the information for the 
corresponding 'Product List' menu.  For example, if you select the entry  
‘SURFACE MAPS' which is on line 1 of the 'Product Category' file, the product list 
contained in the file, CMDMENU.001, is displayed. 

 
Format This file can be modified using a standard text editor.  Each line in the file describes 

a specific product. The lines are displayed sequentially in groups of 17 lines per 
screen.  The file can contain a maximum of 10 screens of data (170 products). 

 
A maximum of 72 characters can be entered on a line.  The first 4 characters of each 
line in a 'Product List' file must be the name of the macro file that corresponds to the 
selected entry.  For example, if you select the entry, ‘Mean Sea-level Pressure and 
1000-500mb Thickness' from CMDMENU.001 (listed below), the macro file, 
SFTH.CMD, is executed. 

 
WINGRIDDS automatically ‘numbers’ the order of appearance for each entry on the 
menu page.  All other characters displayed for the entry lines must be contained in 
the menu file.  In the example below, some entries are left blank for clarity.  If the 
user selects a blank entry, WINGRIDDS return to the menu. 

 
The contents for the first screen of the default ‘Product List’ file, CMDMENU.001, are listed 
below.  Complete listings of all the default ‘Product List’ files are contained in Appendix A. 

 
............. Begin file CMDMENU.002 ................................ 

                    *****  SURFACE MAPS *****    
SFTH Mean Sea-level Pressure and 1000-500mb Thickness   (Set TIME first) 
10TH 1000 mb Height and Winds, 1000-500mb Thickness     (Set TIME first) 
10TD 1000 mb Height, Dew Point and Wind                 (Set TIME first) 
10TE 1000 mb Height, Equiv. Pot. Temp., and  Winds      (Set TIME first) 
NSTM NGM MSL Pressure, S982 Temperatures and Winds      (Set TIME first) 
NSTD NGM MSL Pressure, S982 Dew Points and Winds        (Set TIME first) 
NSTE NGM MSL Pressure, S982 Equiv. Pot. Temp. and Winds (Set TIME first) 
ESTM ETA MSL Pressure, B015 Temperature and Winds       (Set TIME first) 
ESTD ETA MSL Pressure  B015 Dew Points and Winds        (Set TIME first) 
ESTE ETA MSL Pressure, B015 Equiv. Pot. Temp. and Winds (Set TIME first) 
THPW MSL Pressure, 1000-500mb Thickness, Precip. Water  (Set TIME first) 
PCPP 12 hour Total and Convective Model Precipitation   (Set TIME first) 
P24L Loop 24 Hour Precipitation Totals for Model cycle(Reset TIME after) 
          
SFIL Change Active File           (Must have multiple files open) 
SFHR ** Set TIME  ** (Forecast Hour: F00,F12,F24,F36,F48,...) 

.............. End page CMDMENU.002 .................................. 
 
 
 
 
 
 
 
 
 



 
 147 

-- MACRO files 
 

MACRO files contain a sequence of WINGRIDDS command lines that are executed in series and can 
be used as shorthand notations for frequently used command sequences or to produce specific 
graphical products.  The command lines may contain a maximum of 16 WINGRIDDS commands and 
aliases in upper or lower case letters (refer to 'User Defined Alias Commands'), but they cannot 
reference another macro. 

 
Note: The commands within a command line are processed from right to left.  Refer to 

Appendices B, C, and D for a more detailed description of the full set of WINGRIDDS 
commands. 

 
The following parameters can be set from within a macro:  forecast hour, time range, vertical level, 
and layer.  If the macro is run from Command Line, these settings will remain in effect after the 
completion of the macro.  If the macro is run from Products Menu, the settings normally remain in 
effect only for the duration of the macro.  At the end of the macro, the settings return to the values 
they had before the macro was started.  If you want the settings defined in a macro to remain in effect 
after the completion of the macro, you must add the PMSV command to the beginning of the macro. 
 
To execute a command macro from the command line, type the name of the macro file a period ‘.’ . 
For example, if the command macro is named WTMP.CMD, you would enter: 
 
 WTMP. 
 
and click  or press [Enter] . 
 
To execute a command macro from the Products Menu, simply click on the ‘Products’ entry on the 
menu line, then select the category of your choice from the Products menu which opens a Command 
Menu.  Here, you select the actual Command Macro from the selection listed by either double-clicking 
with the mouse on the selection or single-clicking the selection then click the OK button.   

 
When a macro is executed, the results from processing the requested command lines are displayed 
in sequence with a prompt to click  or press [Enter] between displays when needed.  Below 
is listed a sample macro file which requires you to press [Enter] after each command line.  This 
sample file sets the display to PLAN view, requests the user to press [Enter], then reads the WIND 
data, converts the Vector wind to KNoTs (VKNT), and plots the resulting vectors as wind BARBs. 

 
PLAN 
BARB VKNT WIND 

 
If you want to eliminate the prompt to press [Enter] after each command line, use the LOOP and 
ENDL (END Loop) commands.  All command lines between these commands are then executed 
without a request to press [Enter].  The command file listed below only pauses for you to press 
[Enter] after the ENDL command. 

 
LOOP 
PLAN 
BARB VKNT WIND 
ENDL 
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Listed below is an example of a macro file (WTMP.CMD) that displays wind as barbs and 
temperature contours as dashed lines.  An explanation is included after every line to describe the 
action of each command in the line. 

 
Note: Within a macro, either an & or a / can be used to indicate that two sets of data will be 

overlaid on the same display. 
 

LOOP 
-- LOOP The prompt to press [Enter] is suppressed until the ENDL command is 

executed or the end of file is encountered. 
 

PLAN 
-- PLAN Set screen to PLAN view  

 
LNDF 

-- LNDF Do Not print DeFault Labels  
 

LTX1 WIND / TEMPERATURE Contours 
-- LTX1 Display the Label TeXt following this command on line 1 of the plot. 

 
LTM1 LLN1 

-- LLN1 Display the Label, forecast LeNgth, on line 1 of the plot. 
-- LTM1 Display the Label, TiMe, on line 1 of the plot. 
-- The label on line 1 has the order:  text, forecast length, time. 

 
LFD2 LFL2 

-- LFL2 Display the Label, Flight Level, on line 2 of the plot. 
-- LFD2 Display the Label, Forecast model Date, on line 2 of the plot 
-- The label on line 2 has the order:  level, date. 

 
LMN3 LFO3 

-- LFO3 Display the Label, Forecast model Origination, on line 3 of the plot. 
-- LMN3 Display the Label, forecast Model Name, on line 3 of the plot. 
-- The label on line 3 has the order:  origination, name. 

 
CLR2 DASH CIN2 TEMP&CLR7 BARB VKNT WIND 

-- WIND Get the WIND field from the gridded data file. 
-- VKNT Convert units for Vector wind data to KNoTs. 
-- BARB Plot wind as BARBs. 
-- CLR7 Use data-display CoLoR 7 for the barbs. 
-- &  End plot 1 and prepare to overlay next plot. 
-- TEMP Get the TEMPerature field from the gridded data file. 
-- CIN2 Set Contour INterval to 2 units (degrees) 
-- DASH Use DASHed lines for contours. 
-- CLR2 Use data-display CoLRr 2 for the contour lines. 

 
ENDL 

-- ENDL Reinstate the need to press [Enter] after each command line.  This 
command is optional if it is the last command in the macro. 
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Listed below is an example of a macro file (IC24.CMD) that sets the flight level to 240, displays wind 
as barbs and displays temperature values at the grid points.  An explanation is included after every 
line to describe the action of each command in the line. 

 
LOOP 

-- LOOP The prompt to press [Enter] is suppressed until the ENDL command is 
executed or the end of file is encountered. 

 
PLAN 

-- PLAN Set screen to PLAN view  
 

LNDF 
-- LNDF Do Not print DeFault Labels  

 
LTX1 WIND / TEMPERATURE 

-- LTX1 Display the Label TeXt following this command on line 1 of the plot. 
 

LTM1 LLN1 
-- LLN1 Display the Label, forecast LeNgth, on line 1 of the plot. 
-- LTM1 Display the Label, TiMe, on line 1 of the plot. 
-- The label on line 1 has the order:  text, forecast length, time. 

 
LFD2 LFL2 

-- LFL2 Display the Label, Flight Level, on line 2 of the plot. 
-- LFD2 Display the Label, Forecast model Date, on line 2 of the plot 
-- The label on line 2 has the order:  level, date. 

 
LMN3 LFO3 

-- LFO3 Display the Label, Forecast model Origination, on line 3 of the plot. 
-- LMN3 Display the Label, forecast Model Name, on line 3 of the plot. 
-- The label on line 3 has the order:  origination, name. 

 
CLR7 BARB VKNT WIND SLVL 400 

-- SLVL 400 Set the pressure LeVeL to 400 hPa 
-- WIND Get WIND data from the gridded data file. 
-- VKNT Convert units for Vector wind data to KNoTs. 
-- BARB Plot wind as BARBs. 
-- CLR7 Use data-display CoLoR 7 for the barbs. 

 
PPLS DAT+ SCL0 SSUM TEMP RGTN 0 MLTN 0 VCMP LAST CLR2& 

-- This command line overlays temperature data plots on the previous wind display.  
Temperature values are expressed as unscaled whole integers and unsigned values 
are negative.  The digits are plotted above the grid point, but only at grid points 
where the V component of the wind is positive (‘southerly’) to prevent the wind barbs 
from overwriting the temperature data. 

-- &  Overlay the following plot on current display. 
-- CLR2 Use data-display CoLoR 2. 
-- LAST Retrieve the previous fields (WIND) already stored in memory. This 

operation is faster than retrieving data from the gridded data file. 
-- VCMP Get the V CoMPonent of the wind field that is stored in memory. 
-- MLTN 0 Set all values Less ThaN 0 as missing data (10**31). 
-- RGTN 0 Replace all values Greater ThaN 0 with 0.  This produces a field of zeros 

and missing values. 
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-- TEMP Get the TEMPerature field from the gridded data file. 
-- SSUM SUM the previous two Scalar fields.  This produces a field of temperature 

values and missing values.  The missing values are located at grid points 
where the V component of the wind is less than 0. 

-- SCL0 Rounds displays to whole integer numbers. 
-- DAT+ Plot DATa values above (+) the grid point. 
-- PPLS Plot PLuS signs.  Unsigned numbers are negative.  Plus signs are plotted 

before positive numbers. 
 

PPLS DAT- SCL0 SSUM TEMP RLTN 0 MGTN 0 VGRD CLR2& 
-- This command line overlays the remaining temperature data on the previous display.  

Temperature values are expressed as unscaled whole integers and unsigned values 
are negative.  The digits are plotted below the grid point, but only at grid points 
where the V component of the wind is negative (‘northerly’) to prevent the wind barbs 
from overwriting the temperature data. 

-- &  Overlay the following plot on current display. 
-- CLR2 Use data-display CoLoR 2. 
-- VGRD Retrieve the the V component of the wind from the Gridded data file.  The 

wind field is no longer available in memory as it was in the previous 
command line. 

-- MGTN 0 Set all values Greater ThaN 0 as missing data points (10**31). 
-- RLTN 0 Replace all values Less ThaN 0 with 0.  This produces a field of zeros 

and missing values. 
-- TEMP Get the TEMPerature field from the gridded data file. 
-- SSUM SUM the previous two Scalar fields.  This produces a field of temperature 

values and missing values.  The missing values are located at grid points 
where the V component of the wind is greater than 0. 

-- SCL0 Rounds displays to whole integer numbers. 
-- DAT- Plot DATa values below (-) the grid point. 
-- PPLS Plot PLuS signs.  Unsigned numbers are negative.  Plus signs are plotted 

before positive numbers. 
 

ENDL 
-- ENDL Reinstate the need to press [Enter] after each command line.  This 

command is optional if it is the last command in the macro. 
 
 
These macro files allow comment lines preceded by the pound-sign ‘#’. 
 
# 
# This is a comment 
# 
 
 
 
-- MACRO Help files 
   Users who create new macro files are strongly encouraged to also create a macro help file to describe 
what the macro is doing.  Macro help files a simple text files with the same name as the macro but with .hlp 
as a file extension.  They are to be stored within the HELP/ directory for use within WINGRIDDS.  For a 
reference & template as to how help file should be constructed, refer to the preexisting help files within the 
HELP/ directory.  Your assistance in this area will be greatly appreciated by all other users of your macros. 
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-- Plot Labels 
 

Default labels 
Plots are automatically labeled with a default label format.  Sample default labels for a 
temperature plot are shown below. 

 
Plan view 

WAFG= 250:LYR=1000/ 500 :FHR= 12:FHRS=  0/ 24::FIL1=WAF28APR.00Z 
95/ 4/28/ 0--TEMP 
V:10/2003--N/X/MN/SD=   -56.49   -42.85   -48.43     3.17 

 
The plan view label displays the following information: 

 
Line 1  

WAFG    Forecast model name 
LVL= 250    Pressure level 
LYR=1000/ 500   Pressure layer 
FHR= 12    Forecast hour 
FHRS=  0/ 24   Time range 
FIL1=WAF28APR.00Z Last active forecast data file 

 
Line 2 

95/ 4/28/ 0   Last active forecast model date (yy/mm/dd/hh) 
TEMP    Command line that produced the display 

Line 3 
V:10/2006    WINGRIDDS version 
N/X/MN/SD   Statistics line key: minimum/maximum/mean/standard 

deviation 
-56.49    Maximum data value 
-42.85    Minimum data value 
-48.43    Mean 
   3.17    Standard deviation 
 

Time-section  (TSCT) 
WAFG:Lat/Lon 35S/ 59W=> 36/  0 :FHR= 12:FHRS=  0/ 24::FIL1=WAF28APR.00Z 
95/ 4/28/ 0--TEMP 

 
The time-section label displays the following information when TSCT is used to define the 
time-section point: 

 
Line 1  

WAFG    Forecast model name 
Lat/Lon 35S/ 59W  Latitude and longitude coordinates of the time-section 

point 
=> 36/  0    Hour range over which the time-section is displayed 
FHR= 12    Forecast hour (used for plan and cross-section) 
FHRS=  0/ 24   Time range (used for plan and cross-section) 
FIL1=WAF28APR.00Z Last active active forecast data file 

 
Line 2 

95/ 4/28/ 0            Last active forecast model date (yy/mm/dd/hh) 
TEMP    Command line that produced the display 
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Time-section  (TSTN) 
WAFG: BOS@42N/ 71W=> 48/  0 :FHR= 12:FHRS=  0/ 24::FIL1=WAF28APR.00Z 
95/ 4/28/ 0--TEMP 

 
The time-section label displays the following information when TSTN is used to define the 
time-section point: 

 
Line 1  

WAFG    Forecast model name 
BOS     Station located at the time section point 
@42N/ 71W   Latitude and longitude coordinates of the time-section 

point 
=> 48/  0    Hour range over which the time-section is displayed 
FHR= 12    Forecast hour (used for plan and cross-section) 
FHRS=  0/ 24   Time range (used for plan and cross-section) 
FIL1=WAF28APR.00Z Last active active forecast data file 

 
Line 2 

95/ 4/28/ 0            Last active forecast model date (yy/mm/dd/hh) 
TEMP    Command line that produced the display 

 
 

Cross-section (XSCT) 
WAFG:Lat/Lon 53N/ 14E=> 28N/ 77E :FHR= 12:FHRS=  0/ 24::FIL1=WAF28APR.00Z 
95/ 4/28/ 0--TEMP 

 
The cross-section label displays the following information when XSCT is used to define the 
cross-section line: 

 
Line 1  

WAFG    Forecast model name 
Lat/Lon 53N/ 14E  Left latitude and longitude coordinates of the cross-

section line 
=> 28N/ 77E   Right latitude and longitude coordinates of the cross-

section line 
FHR= 12    Forecast hour 
FHRS=  0/ 24   Time range 
FIL1=WAF28APR.00Z Last active active forecast data file 

 
Line 2 

95/ 4/28/ 0            Last active forecast model date (yy/mm/dd/hh) 
TEMP    Command line that produced the display 
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Cross-section (XSTN) 
WAFG: ORD> BOS@42N/ 88W=>42N/ 71W :FHR= 12:FHRS=  0/ 24::FIL1=WAF28APR.00Z 
95/ 4/28/ 0--TEMP 

 
The cross-section label displays the following information when XSTN is used to define the 
cross-section line: 

 
Line 1  

WAFG    Forecast model name 
ORD     Station located at left end of cross-section line 
> BOS    Station located at right end of cross-section line 
@42N/ 88W   Left latitude and longitude coordinates of the cross-

section line 
=>42N/ 71W   Right latitude and longitude coordinates of the cross-

section line 
FHR= 12    Forecast hour 
FHRS=  0/ 24   Time range 
FIL1=WAF28APR.00Z Last active active forecast data file 

 
Line 2 

95/ 4/28/ 0            Last active forecast model date (yy/mm/dd/hh) 
TEMP    Command line that produced the display 

 
 

-- Custom labels 
You can produce custom labels using the WINGRIDDS label commands. 

 
Output commands 

Eleven of the label commands are 4 character output commands.  The first three 
characters identify the command.  The fourth character, indicated schematically by the 
symbol #, specifies the line number within the total label message.  For example, if the 
entire label contains 3 lines, then LPL2 specifies that the label for pressure level is on line 
2.  Listed below are the eleven possible output commands, the type of information 
displayed, and a sample of the output format. 

 
LTM# TiMe and TiMe range 

VT 12 UTC FRI 28 APR 1995 
VT 12 UTC TUE 7 JUN 1994-00 UTC MON 6 JUN 1994  

 
LPL#  Pressure Level and Pressure Layer 

LEVEL=250 
LAYER=1000/500 

 
LFL#  Flight Level and Flight Layer 

FL 340 (250 hPa) 
FL LAYER 050-180 

 
LDN# Data file Name 

FILE=WAF28APR.00Z 
 

LFD# Forecast model Date 
From 12 UTC 22 MAR 1991 

 
LMN# forecast Model Name 

WAFG 



 
 154 

 
LFO# Forecast model Origination (text in file WINGLBL.USR) 

DOC/NOAA/NWS    WAFC-WASHINGTON 
 

LLN# forecast LeNgth 
12H FORECAST 

 
LLL#          Latitude and Longitude (time-section and cross-section only) 

LAT/LON: 35S/ 59W 
LAT/LON: 53N/ 14E=>28N/ 77E 

 
LSN# StatioN identifier (time-section and cross-section only) 

STNID:  BOS 
STNID:  ORD=> BOS 

 
LTX#          user TeXt 

WIND/TEMPERATURE 
 

Label message lines 
The symbol # in all the above commands indicates the line number within the total label 
message.  The total number of lines in a label message depends on the value of the 
maximum line number specified in the label commands for a plot.  If the commands LFL1 
LFO3 LTM1 are issued, then the total message will contain three lines with line 2 blank.  

 
Line 1 VT 12 UTC FRI 28 APR 1995   FL 340 (250 hPa) 
Line 2 
Line 3 DOC/NOAA/NWS    WAFC-WASHINGTON 

 
Command entry 

LTX# must be entered on a single line its associated text.  It cannot be combined with any 
other commands.  The remaining nine commands can be entered on separate lines or 
combined on one or more lines.  All label commands for a plot must be entered before the 
command line that actually produces the display. 

 
Note: The first label command on a line must start in the leftmost column. 

 
Examples I, II, and III produce the same results:  a pressure level label on line 1 and a 
time label on line 2.  Example IV is incorrect because the label command, LPL2, is issued 
after the plot command line (TEMP). 

 
I   II   III   IV 
--------------- --------------- --------  -------- 
LPL1 LTM2 LTM2 LPL1 LPL1           LPL1 
TEMP  TEMP  LTM2  TEMP 

TEMP  LPL2 
 
Label construction 

Label commands are combined to produce message lines.  The labels for a line are 
displayed in the order that the commands are processed.  If multiple commands are on 
one line, they are processed starting with the rightmost command.  LTX# is the exception 
in that the specified text will always be left justified within the message line.  A maximum of 
132 characters can be output on one line of a printed copy, but only the first 78 characters 
are displayed on the screen. 
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A sample command sequence and its corresponding message lines are shown below. 
 

Commands: LTM1 LPL2 LLN2 
LTX2 TEMPERATURE 
TEMP 

 
Label:  VT 12 UTC FRI 28 APR 1995 

TEMPERATURE   12H FORECAST   LEVEL=250 
 

Note: The forecast length precedes the pressure level in the label because the 
commands are processed from right to left. 

 
Default labels 

The initial setting for each plot is to display default labels.  This condition is always 
restored at the start of a new display after all overlays are completed. 

 
Default labels can be combined only with the LTX# and LWT# label commands.  If any 
other label commands are used, default labels are automatically turned off for the current 
plot.  Default labels are restored for the next plot regardless of whether it is a new display 
or an overlay, unless the LNDF command is used. 

 
LNDF (No DeFault labels) This command turns off the default labels.  No labels are 

produced unless you enter label commands.  This condition 
will remain in effect for all overlays except menu overlays 
using the [F2] key.  The default label state is restored when all 
overlays are completed.  The LNDF command is useful when 
overlaying multiple data fields.  If label commands are entered 
when the first data field is displayed, the LNDF command 
prevents the display of default labels for the remaining 
overlays. 

 
LDEF (DEFault labels) This command turns on the default labels.  If LNDF was used 

to turn off the default labels, you can use the LDEF command 
to turn on the default labels before all overlays are completed.  
It will remain in effect until another LNDF command is issued. 

 
Label processing 

The control label commands (LNDF, LDEF, LWT#) and the LTX# command are 
processed for all command sequences that produce a display.  The remaining output label 
commands are only processed for command sequences that generate a display from 
gridded data fields.  If gridded data fields are not displayed, output label commands are 
ignored and no label of any kind except text is displayed for the current plot.  For example, 
if you are in time-section mode, the command LFO1 HOUR does not produce labels 
because hour lines are generated internally and not from a gridded data field.  Similarly, if 
you are in plan view, the command LFO1 LATT does not produce labels because latitude 
lines are not produced from a gridded data field.  However, the command LFO1 TEMP 
does produce labels because TEMP is a gridded data field.  The following examples 
illustrate these rules. 
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Example 1 
Commands: LNDF  Turn off default labels. 

LTM1  Command is not processed because LATT does 
not use gridded data. 

LATT           Display latitude lines. 
TEMP&  Overlay temperature contours on latitude lines. 

 
Label:  No labels 

 
Example 2 

Commands: LATT           Display latitude lines.  Default labels are produced. 
LNDF  Turn off default labels. 
LTM1  Display time label on line 1 of the label message. 
TEMP&  Overlay temperature contours on latitude lines. 

 
Label:  VT 12 UTC FRI 28 APR 1995 

95/ 4/28/ 0--LATT 
V:10/2003--N/X/MN/SD= -28.75   -56.25   -42.50   8.29 

 
Example 3 

Commands: LNDF  Turn off default labels. 
LATT           Display latitude lines. 
LTM1  Display time label on line 1 of the label message. 
TEMP&  Overlay temperature contours on latitude lines. 

 
Label:  VT 12 UTC FRI 28 APR 1995 

 
Label display 

Labels are automatically displayed on the screen after a data field is processed.  All 
previous labels are rewritten on the screen with the display of each overlay.  This prevents 
contour lines from writing over the label text.  By default a set of label message lines starts 
on line 1, the line following the command line on the screen. 

 
For printed output the label message lines are written consecutively at the bottom of the 
page immediately below the plot.  The number of label lines you can print depends on the 
maximum number of lines reserved for labels.  The default value is 6.  You can revise this 
value by modifying the file WINGMODE.DAT (Refer to 'Customizing WINGRIDDS'). 

 
LWT# (begin WriTe) This command specifies the line number of the screen to start 

WriTing the current label set.  If this command is not used then the 
label set starts at line 1.  This command has no effect on the label 
position for printed plots. 
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Overlays 
Overlaying is the term used to refer to the simultaneous display of multiple data fields.  If 
an overlay is composed of two plots with identical time and level specifications and user 
labels are requested for both plots, only one set of labels will be displayed.  This applies to 
all label commands except LTX#.  The text associated with an LTX# command will always 
be displayed.  The example below illustrates the overlay restrictions. 

 
Note: The pressure level label is not displayed because it is requested for plot 2 and 

labels are suppressed for overlays with the same time and level specifications. 
 

Commands: LTM1    Display time on line 1 
LTX2 WIND   Display text on line 2 
WIND    Display wind data 
LPL3             Display pressure level on line 3 
LTX4 TEMPERATURE Display text on line 4 
TEMP&    Overlay temperature contours 

 
Label:  VT 12 UTC FRI 28 APR 1995 

WIND 
 

TEMPERATURE 
 

Overlays produced by using the REST command (refer to ‘Print Commands’ in ‘Printing’) 
to display saved graphics are treated as separate displays for label purposes.  This means 
that user labels for both the restored graphics and the first overlay are displayed.  Menu 
overlays produced using  also fall into this category.  The previous example was 
modified slightly to illustrate this concept. 

 
Note: The pressure level label is now displayed because the overlay was used in 

conjunction with the REST command. 
 

Commands: SAVE PLT1   Save graphics in file PLT1.SVG 
LTM1    Display time on line 1 
LTX2 WIND   Display text on line 2 
WIND    Display wind data 
ENDS    Stop saving graphics 
ERAS    Erase screen 

 
REST PLT1   Restore graphics in file PLT1.SVG 
LPL3             Display pressure level on line 3 
LTX4 TEMPERATURE Display text on line 4 
TEMP&    Overlay temperature contours 

 
Label:  VT 12 UTC FRI 28 APR 1995 

WIND 
LEVEL= 250 
TEMPERATURE 
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Annotation of screen displays 
Default labels and those produced by label commands are displayed both on the screen 
and on printer output.  The TXT# command can write text annotation only to the screen. 

 
TXT# (screen TeXT) This command must be entered on a single line its associated text.  

It cannot be combined with any other commands.  The # symbol 
indicates the line on the screen to which the text is written.  Text 
written with the TXT command will never be output to the printer nor 
can it be displayed with the REST command.  This command is 
processed and output immediately.  It should be issued AFTER the 
data field is displayed. 
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WINGRIDDS Command Line Operations 
 

The following discussions describe the operation of WINGRIDDS Command Line. 
 

NOTE: The operating mode of WINGRIDDS is no longer *only* Menu mode or Command mode.  The 
two have been blended together so both the Menu selections and the Command Line are available 
for use. 

 
 
Command Mode requests are input as series of up to 10 ALPHA-NUMERIC INSTRUCTIONS separated  

by Spaces or Delimiters,  the [Enter] key or clicking the  Button.   
 
A maximum of 50 commands can be entered on 1 line as indicated by the 
following guiding template line which is displayed at the top of the screen. 
 

 
 
NOTE:  With few exceptions, a line of commands is processed in order from  
             RIGHT to LEFT or Reverse Polish Notation (RPN),  
             so the last command entered on a line is the first to appear. 
 
 
**- Initial Default values - 
The default Flag Variable values are: 
 
A Forecast Hour (FHOR) -- Default = 12 
 
A four letter Grid Level (LEVL) -- Default =  850  
 
A pair of Forecast Hours (FHRS) consisting of  -- Default = 00/24 
  [See FHR1 and FHR2 later -- Used for time differences, etc.] 
 
A grid layer (LAYR) consisting of two levels -- Default = 1000  500 
  [See LVL1 and LVL2 later -- Used for level differences, etc.] 
 
 
The default values can be customized by the user by modifying the file USER\INITGRID.SPC, in which the 
initial values of the six variable parameters LEVL LVL1 LVL2 FHOR FHR1 FHR2 are specified. 
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**- Changing Flag Variable Values - Level/Layer Specification 
The LeVeL/LaYeR defaults can be Set by typing SLVL or SLYR the four character specifications in the 
next input positions.  For example, 
 
SLVL 1000   - Changes default level to 1000 mb, 
SLVL  MSL   - Changes default level to mean sea level 
SLVL  SFC   - Changes default level to Surface level 
SLVL S896   - Changes default level to the Sigma level centered at 896 mb 
SLVL I300     - Changes default level to the 300K Isentropic level 
SLVL Y240    - Changes default level to the Hybrid-B level 240 (if in data file) 
SLVL H150   - Changes default level to the 15,000 ft Height level 
SLVL PV12   - Changes default level to the 1.2 PVU level 
SLVL P+05   - Changes default level to the PV 500ft above Tropopause 
SLYR  850  300   - Changes layer bottom and top default levels (in order)  
                               to 850 and 300 mb. 
 
For convenience, the LeVeL can also be specified by simply typing the desired level as part of the 
command line to the right of the desired field, e.g., reading from RIGHT to LEFT, the command sequence   
TEMP 850   will first set the level to 850 mb and then read, decode and contour the temperature field. 
 
 
**- Changing Flag Variable Values - Time Specification 
The time defaults can be changed by typing  FHOR [or SFHR]  or  FHRS [or SFHS] 
and answering a free-format prompt.   
 
Alternatively, the time defaults can be changed by typing  SFHR  or  SFHS the desired hour in the next 4 
character command line locations. For example, 
 
SFHR   12         -  Changes the time default to a 12 hour Forecast, 
SFHR   -1          -  Changes the time default to the ANALysis, 
SFHR   00         -  Changes the time default to the 00 h initialized fields, 
SHFS   12   24  -  Changes the time pair defaults to the 12 and 24 h Forecasts. 
 
For convenience, SFHR can also be omitted from the command string if desired, typing instead only  
ANAL, F00, F12, F24, F36 or F48 for those specific times, e.g., reading from RIGHT to LEFT, the 
command sequence   TEMP 850 F24  will first set the forecast hour to 24 hours, then set the level to 850 
mb and lastly read and contour the temperature field. 
 
**- Specifying the Display Area 
The display area can be changed by typing  AREA  at the LEFT end of the command line, followed a new 
central latitude and longitude (given by degrees followed immediately by the letters N/S or E/W to indicate 
hemisphere) and North-to-South display distance in degrees.  For example, the command sequence  
AREA 40N 20E 20   will provide a display over southern Europe, extending roughly from 30 to 50 N. 
 
If no hemisphere indicator is included, positive values are used to represent Northern and Western 
hemispheric locations.  --  If no lat/lon information is included, a prompt will appear showing location at the 
center of the grid. 
 
The Entire grid area can be displayed by entering  AREA  3 zeros, e.g.,  AREA 0 0 0.  The initial display 
AREA used in each WINGRIDDS session can be specified in a file INITMAP.CRD. 
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**- Choosing Custom Map Backgrounds 
The map background can be customized by the addition of the argument MAP* as the last AREA 
argument.  The ‘*’  is 1-9/A-Z, for example, MAP1 – MAP9 and MAPA - MAPZ.   
 
The MAP* command argument refers to the user-created MAP*.DAT files located in the 
WINGRIDDS\USER directory.  These file(s) contain the same information as the MAPFILE.DAT file; a list 
of map data files which the user wants displayed on the screen.   
 
The MAP* argument can be used this way; say, for example, with a wide-view of the grid area, the user 
wants little detail.  So, in MAP1.DAT, the user lists a low resolution map file.  The command: 
 
 AREA 0 0 0 MAP1 
 
Is executed.  However, when the user zooms in to an area of interest, they may want more map detail like 
county outlines or rivers.  So, in MAP2.dat, the user enters a high resolution map file and a county or river 
map file. Then, the user executes: 
 
AREA 40N 20E 20 MAP2 
 
And the new map is drawn with the contents of the MAP2.DAT file.  This allows the user to have map 
background flexibility on the fly instead of modifying the MAPFILE.DAT for every change of the display.  
 
If the MAP* argument is not included in the AREA command, the map is drawn from default data from the 
WINGMODE.DAT and/or MAPFILE.DAT configuration files. 
 
The Area can also be defined centered at a STatioN location using the ASTN command a 3 or 4 character 
station identifier and a North-to-South display distance.  If no N-to-S distance is included, a value of 30 is 
used. This default can be changed using NS##, where ## is the N-to-S distance.  
 
 
**- Choosing 1 Panel or 4 Panel Display Mode 
WINGRIDDS support a display area with either I panel or 4 panels.  The initial configuration is set in the 
WINGMODE.DAT file. The panel mode can be changed from 1 Panel to 4 Panel by typing  4PNL  at the 
LEFT end of the command line.  The panel mode can be changed from 4 Panel to 1 Panel by typing  1PNL  
at the LEFT end of the command line.  
 
Once either operation is complete, to ensure the map or CROSS/TIME Section grid background is properly 
displayed, you must recalculate the map/grid by going to the respective configuration dialogs (PLAN, 
CROSS, TIME) under the Display Menu and just click the [OK] button and allow the backgrounds to be 
recalculated to fit properly in the new windows.  If no CROSS or TIME sections have been configured when 
the panel mode is switched, they do not need to be recalculated. 
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**- Choosing Custom Map Navigation Mode 
There are, at this time, 3 different grid projections you can use to interpolate data to; Equidistant 
Latitude/Longitude (Lat/Lon) - best for near the Equator region (0-30 deg) Lambert Conic Conformal 
(NLCC) – best for the mid-latitudes (30-60 deg) Polar Stereographic (NPST) – best for above 60 deg to the 
Poles. 
 
There are two different ways to set up a custom grid display and this can be done either before or after any 
data files have been opened – there is a command-line option or it can be done through a graphical dialog. 
 
CSTMGRID [Center Lat, Center Lon, Blowup Size, (Tangent Cone), Grid Type] 
CSTMGRID [Grid Spec File Name] 
 
Notice, this is argument string is similar to the AREA command. There are two different command string 
argument types with this command – depending on which grid projections you wish to use.  For Lat/Lon & 
Polar Stereographic grids, you would use the Center latitude, Center Longitude, Blowup Size & Grid Type 
arguments however, the Lambert Conformal also requires a Tangent Cone (in degrees) entry as well. As 
with the AREA command, the coordinate information is describing the *center* of the grid and the *size* (in 
N/S Latitude) of the grid. 
 
*****NOTICE***** 
1) All 4 numeric entries are to be entered in *WHOLE* degrees  a period.  
2) All negative Latitude entries are for Southern Hemisphere and positive Latitude are Northern 
Hemisphere. 
3) ALL negative Longitude entries are for Western hemisphere and all positive Longitude are for Eastern 
Hemisphere. 
4) All Lambert Conformal identities for Grid Type are “NLCC” – even for Southern Hemisphere Views. 
5) All Polar Stereographic identities for Grid Type are “NPST” – even for Southern Hemisphere Views. 
 
 
**- Command Structures -- Displaying Primary Data Fields - 
Once a file has been opened, data can be displayed by typing a series of requests on the command line.  
In general, a command line is read by the program from RIGHT TO LEFT to request grids and perform 
various functions. Results of the last (left most) operations are then displayed automatically.   
 
To display any of the grids stored in the gridded data set, simply type the 4 letter NAME of the grid  
[Enter]. (Again, a list of the available grids will be shown by typing  LIST  .)  For example,  
 
HGHT      - will clear the screen & display contours of the 850 mb HeiGHT field 
TEMP      - will clear the screen & display contours of the 850 mb TEMPerature 
 
A listing of the parameters possibly included in the gridded data sets follows: 
 
**- Primary Gridded Data Fields: 
HGHT > Geopotential HeiGHT (meters) 
PRES > Pressure (mb) 
 
TEMP > TEMPerature (degree C) 
THTA > Potential Temperature - THeTA(degree K) 
 
MIXR > MIXing Ratio (g/kg) 
RELH > Relative Humidity (%) 
DWPT > DeW Point Temperature (degree C) 
TMPK > TeMPerature (degrees K) 
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TMPF > TeMPerature (degrees F) 
THTE > Equivalent Potential Temperature - THeTa/E (degree K) 
 
WIND > Total WIND vector (m/sec) 
WSPD > Total Wind Speed (m/sec) 
WDDF! > Packed value of Wind Direction/speed (tens of degrees and m/sec) 
WDRC > Wind DiReCtion (degrees) 
BWND > WiND Barbs (m/sec) 
BKNT > Wind Barbs (KNoTs) 
 
PMSL > Mean Sea Level Pressure fields, provided without resetting LEVeL 
          Note:  If mean sea level pressure (GRIB ID=002) is not  
                 available, then an attempt is made to retrieve the  
                 RUC Reduction, the Eta Model Reduction, and the  
                 Standard Atmosphere Reduction, in that order. 
 
TPCP > Total Precipitation fields, provided without resetting LEVeL (mm) 
CPCP > Convective Precipitation fields, provided without resetting LEVeL (mm) 
TPCI > Total Precipitation fields, provided without resetting LEVeL (in) 
CPCI > Convective Precipitation fields, provided without resetting LEVeL (in) 
 
       NOTE:  NCEP models accumulate precipitation in 6 hour increments then reset.  
              TPCx/CPCx retrieve the precipitation accumulation at the current 
      forecast hour since the last 6 hour reset. 
 
LIFT > Pre-calculated LIFTed Index, provided without resetting LEVeL 
PWAT > Precipitable Water fields, provided without resetting LEVeL 
 
THCK > Generates Thickness fields determined by LVL1/LVL2 settings 
TWND > Generates Thermal Wind determined by LVL1/LVL2 settings 
 
 
**- Automatically derived parameters - 
In addition to displays of LISTed forecast fields already in the data file, a number of derived parameters 
and functions can also be requested and calculated automatically as the data are being read from the 
computer.  For example, a request of THTA  will automatically calculate and display the potential 
temperature (THeTA) field.  Some of the automatically calculated derived parameters include: 
 
THTA (Potential Temperature)             
SDEF (Saturation Deficit) 
MIXR (Mixing Ratio)                      
SMIX (Saturation Mixing Ratio) 
 
GEOS (Geostrophic Wind - vector)         
AGEO (Ageostrophic Wind - vector) 
 
LNDX > Provides Lifted Index calculated between LVL1 and LVL2 
PLCL > Calculates the Pressure of the LCL from LEVeL data 
PDEF > Calculates the Pressure lift needed for saturation form the LCL 
 
See  the Appendix or  the Online Command Help for more commands and detailed explanations. 
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**- Overlaying displays on a single command line - 
Command requests can also be presented in strings, with & (or /) as a command delimiter to indicate field 
overlays. For example,  
 
RELH&      - will overlay the RELative Humidity analysis on the previously 
             requested fields in a second color, according to the sequence of 
             colors on the color bar at the bottom of the screen. 
 
TEMP&HGHT  - will display contours of HeiGHTs at 850 mb and the 850 mb  
             TEMPerature field in different colors on the same map. 
 
 
NOTE:  All command requests are processed from right to left (a la Reverse Polish Notation [RPN]).  As 
such, the command TEMP&HGHT will produce a Height field first, a temperature field in a second color.   
 
Data from different files can be overlaid under the following conditions: 
 
   1. The data must be on the same grid projection (models can differ) 
   2. The initial and final grid points used in any data subsetting must be the 
      same (i.e., identical areas must be selected during the ingest process). 
 
If these conditions are not met, a message is displayed indicating the files are a different size or type.  The 
current plot is cleared; processing stops. 
 
 
 
**- Changing Contour Intervals - 
The Contour INTerval will be calculated automatically based on the variability of the field by default.  
Specific Contour INTerval requests can be specified in several ways.  By typing  CINT  to the left of a field 
requested for display, the maximum and minimum of the field will be written on the screen and a prompt for 
a desired contour interval will appear.  For example, 
 
CINT HGHT  -  will read the height field and ask the user for a desired contour 
              interval (to be input in free format, with a  0  input requesting 
              an automatically calculated 'reasonable' interval. 
 
NOTE:  A contour interval specification normally is only in effect for one plot.  To keep a contour 
specifications from one plot to another, type  CISV The contour interval specification mode can be returned 
to the single plot convention by typing  CINX.  For example, 
 
HGHT CINX&DWPT&TEMP CISV CIN5  -  will read the TEMPerature and DeWPoinT field 
               and display them with a 5 degree contour and then reset to automatic contour  
               determination and overlay the HeiGHT contours. 
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**- Simplified Contour Interval selection -  
Any contour interval can also be requested without the additional user prompt 
by including any of the following commands to the left or right of the desired 
field:   
                                CIN5 - contour intervals of    5 units 
                                CIN# - contour intervals of    # units 
                                CI10 - contour intervals of   10 units 
                                CI#0 - contour intervals of   #0 units 
                                C100 - contour intervals of  100 units 
                                C#00 - contour intervals of  #00 units 
                                CI.2 - contour intervals of   .2 units 
                                CI.# - contour intervals of   .# units 
                                C2+3 - contour intervals of 2000 (10**2) units 
                                C#+$ - contour intervals of #*10**$ units 
                                C2-3 - contour intervals of .002 (10**-2) units 
                                C#-$ - contour intervals of #*10**-$ units 
 
For example, the command line – 
 
HGHT CI60 SLVL 500&PRES CIN4 SLVL  MSL  -  will display the Mean Sea Level  
                                            PRESsure field contoured at 4 mb  
                                            intervals and the 500mb HeiGHTs  
                                            contoured at 60m intervals.   
 
 
**- Changing Contour Colors / Dashed Contours 
The Contour / Wind display colors will be assigned automatically in sequence according to the template 
shown at the bottom of the screen.  The default color can be overridden by using the  CLR#  command,  
     
   where CLR1 refers to the first color on the template, 
              CLR2 refers to the second color on the template, . . . 
              CLR0 refers to the tenth color on the template, . . . 
              CLRA refers to the first dashed color on the template, . . . 
              CLRX refers to the first dotted color on the template. 
 
Dashed contours can also be produced by including DASH in the command line. DASH is only in effect for 
one plot and must be reset for additional displays. 
 
The commands DNEG and DPOS can be used to dash either the Negative or Positive contours in a data 
field. 
 
 
** - Single Line Contour Plot –  
WINGRIDDS can plot single-line scalar plots.  For example, if you wish to plot the 5700 dm height contour 
on the 500 mb level, enter the following commands: 
 

HGHT 500 SLIN 5700 
 
The new command, SLIN ####, is Single LINe  a four digit value of the contour you wish to plot.  This 
is valuable for creating “spaghetti plots” of the same contour from different model runs or comparing 
different times or making a single contour stand out from the others like the freeze line. The SLIN 
command is valid for only that one plot and must be called every time it is needed. 
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**- Plotting Digital Grid Values at Data Points / Scaling Output 
Digital values of the gridded data can also be requested as follows: 
     DATA > Sets display mode to plot data values at grid points. 
     DATT > Sets display mode to plot data values above grid points. 
     DATB > Sets display mode to plot data values below grid points. 
     DATO > Sets display mode to plot data values high Over grid points. 
     DATU > Sets display mode to plot data values low Under grid points. 
 
 
Data Displays and Contour Labels can be requested to display specific digits 
using the following Scaling and Modulo commands: 
 
     SCL0 / DML0- Display only signed digits greater than or equal to 10**0 (1) 
     SCL1 / DML1 - Display only signed digits greater than or equal to 10**1 (10) 
     SCL# / DML# - Display only signed digits greater than or equal to 10**# 
     SC-1 / DM-1 - Display only signed digits greater than or equal to 10**-1 (.1) 
     SC-# / DM-# - Display only signed digits greater than or equal to 10**-#      
     MOD# > Display labels using Modulo of SCALED display value and 10**# 
 
 
**- Wind Displays - 
Vector displays will be generated automatically for vector quantities, or when two grids area queued for 
plotting.  Again, 4 letter commands can be used to change the mode of display to either arrows  {AROW} , 
barbs  {BARB, m/s} or streamlines {STRM}. Winds can be displayed on pressure, height, Sigma, Potential 
Vorticity or Isentropic levels. 
 
Several wind options are available.  These include: 
 
WIND  to display the gridded total wind data,   
GEOS  to display the geostrophic wind, and   
AGEO  to display the ageostrophic wind.         
 
For example,   
 
WIND&HGHT  - displays contour of the height field with wind arrows overlaid 
 
A number of shorthand alias requests are also available, including 
 
WKNT > Retrieves the total wind Vector in knots. 
WMPH > Retrieves the total wind Vector in mph. 
WKPH > Retrieves the total wind Vector in kph. 
BKNT > Retrieves the total wind Vector in knots and sets display as wind barb. 
BMPH > Retrieves the total wind Vector in mph and sets display as wind barb. 
BKPH > Retrieves the total wind Vector in kph and sets display as wind barb 
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**- Changing Wind Arrow Length – 
The contour interval specification also acts as means for changing the length of arrows used in wind 
displays.  Normally, the lengths of wind arrows are scaled so that the arrow representing the largest wind 
speed in a display is set to be equal to the distance between two adjacent grid points.  Adjustments 
in the length can be made using the "CI" commands, where the requested "contour interval" specifies the 
speed to be plotted as a one grid interval length arrow.  For example, 
 
WIND CI10  -  will produce wind arrows in which the length of a 10 m/s wind is one grid spacing unit. 
 
 
 
Displaying Wind Barbs or Streamlines- 
 
Winds can also be displayed as Barbs by typing  BARB. 
 
Winds can also be displayed as Streamlines by typing  STRM. 
 
To return the wind display to Arrows type  AROW. 
 
 
 
 
 
**- Use of Layers or Multiple time periods - 
Layer and/or time manipulation of PRIMARY DATA VARIABLES can be triggered by inserting keywords to 
the right of the desired variable.  Options include: 
 
   LDIF (Layer Difference)    
   LAVE (Layer Average) 
   LTOT (Layer Sum or Total) 
   TDIF(+) (Time Difference)          
   TAVE(+) (Time Average) 
   TTND(+) (Time Tendency - TDIF/time)     
   TTOT(+) (Time Sum or Total)    
 
NOTE: These commands MUST be positioned to the RIGHT of the variable name and can ONLY be used 
with PRIMARY VARIABLES. 
 
For example, the sequence of commands  
 
SLYR 1000  500  -  will calculate the DIFference in HGHT between the top and  
HGHT LDIF             bottom levels defined by the SLYR command, in this case 
                                producing a 1000 to 500 mb thickness field, and 
 
SFHS  F00  F24  - will calculate and display the difference 
HGHT TDIF           in the HeiGHT fields between the initial conditions and the 
                               24 h forecast. 
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Entries in the SLYR or LVL#  may be in either pressure, Height, Sigma or isentropic levels. 
 
For example, the command line 
 
SLYR 750  400 - will set the layer limits to 750 and 400 mb 
SLYR I300 I320 – will set the layer limits to the isentropic layers of 300K and 320K. 
 
Calculations using either the top or bottom levels of the layer defined by SLYR and/or the beginning or end 
times of a forecast period defined by FHRS can be requested without explicitly resetting the level or time 
defaults by inserting the following keywords to the right of the desired variable: 
 
LVL1 (First level of LAYR)              
LVL2 (Second level of LAYR) 
FHR1 (First time of FHRS)                
FHR2 (Second time of FHRS)   
 
For example, the command line 
 
HGHT LDIF&HGHT LVL2&HGHT LVL1 CI60 SLYR 1000  500  -  will set the layer limits 
                                                      at 1000 and 500 mb and then produce contours of  

                                             the 1000 and 500 mb HeiGHTs,  the 1000-500 mb   
                                             thickness, all contoured with 60 m intervals. 

 
NOTE:  Once a layer or time period is set, it continues in effect for the remainder of that plot request unless 
overturned by another entry.         
 
 
** - Native RUC (Rapid Update Cycle) Hybrid-B Levels –  
 
WINGRIDDS can work with the native RUC level format of Hybrid-B levels. Hybrid-B coordinates are 
defines as roughly equivalent to levels of constant Theta (Isentropic).  The RUC Hybrid-B levels are 
identified in WINGRIDDS with the ‘Y###’ symbols with ‘###’ standing for the numbers ranging from 010 to 
500 in increments of 10.  These levels roughly correspond to Isentropic levels in the following way: 
 
HYBRID = THETA                             HYBRID = THETA 
 
     Y010 = I224                                        Y260 = I312 
     Y020 = I232                                        Y270 = I314 
     Y030 = I240                                        Y280 = I316 
     Y040 = I245                                        Y290 = I318 
     Y050 = I250                                        Y300 = I320 
     Y060 = I255                                        Y310 = I322 
     Y070 = I260                                        Y320 = I325 
     Y080 = I265                                        Y330 = I328 
     Y090 = I270                                        Y340 = I331 
     Y100 = I273                                        Y350 = I334 
     Y110 = I276                                        Y360 = I337 
     Y120 = I279                                        Y370 = I340 
     Y130 = I282                                        Y380 = I343 
     Y140 = I285                                        Y390 = I346 
     Y150 = I288                                        Y400 = I349 
     Y160 = I291                                        Y410 = I352 
     Y170 = I294                                        Y420 = I355 
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     Y180 = I296                                        Y430 = I359 
     Y190 = I298                                        Y440 = I365 
     Y200 = I300                                        Y450 = I372 
     Y210 = I302                                        Y460 = I385 
     Y220 = I304                                        Y470 = I400 
     Y230 = I306                                        Y480 = I422 
     Y240 = I308                                        Y490 = I450 
     Y250 = I310                                        Y500 = I500 
 
If WINGRIDDS is in Pressure level mode, and a Hybrid-B data file is loaded, any parameter or diagnostic 
command will be automatically interpolated from Hybrid-B to the requested pressure level. 
    
 
 
                              
** - Animation –  
 
WINGRIDDS has the ability to animate both PLAN and CROS screen plots. This is accomplished in one of 
three ways.  From the WINGRIDDS Command-line, you wish to animate the 500 mb heights through the 
full forecast length of the model run, you enter: 
 

HGHT 500 & ANIM 
 
The command for animation is ANIM and must be the most right command on the line. This command 
will cycle through every forecast hour in the active model file. The following are other animate 
commands: 

 
ANMA – ANimate Macro 
ANFA – ANimate Forecast hours 
ALWN – Use ALL WINdows in Animation 
 
Command Macros can now be animated as well.  The command ANMA (Animate Macro) must be 
before any LOOP command and there must be only one LOOP/ ENDL set in the macro.   
 
If you wish to compare two or more model runs which may have different time steps or you wish to only 
animate specific time steps, it is easiest to create a Macro but the function can be done from the 
Command line if the total commands are less than 16.  Use the following example to use only the 00h, 
12h, and 24h time steps out of the 00h, 06h, 12h, 18h and 24h time steps available: 
 
From the Command line: 
 
ENDA&ENDL&HGHT 500&SFHR 24&LOOP&ENDL&HGHT 500&SFHR 12&LOOP&  
ENDL&HGHT 500&SFHR 00&LOOP&ANFA 
 
Or in a Macro: 
ANFA 
LOOP 
SFHR 00 
HGHT 500 
ENDL 
LOOP 
SFHR 12 
HGHT 500 
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ENDL 
LOOP 
SFHR 24 
HGHT 500 
ENDL 
ENDA 
 
If you notice, the first Macro command executed is ANFA and the plots are made up of repeating the  
LOOP/ENDL command with the last Macro command being ENDA which is ENDAnimation creation.  
When the ANFA command is executed, WINGRIDDS proceeds through the forecast hours and “builds” 
the animation frames.  Once it has cycled through all the forecast hours, it will begin to loop through the 
animation cycle with a preset delay between frames and with a longer delay between cycles to show 
the end of the cycle.   
 
NOTICE – While WINGRIDDS is building the animation sequence, the user can not go and do other 
WINGRIDDS or Windows operations which will affect the screen.  In building the animation sequence, 
WINGRIDDS is actually taking a “snap-shot” of every screen and it will capture whatever is on the 
screen whether it pertains to the animation process or not. 
 
 
-- Animation in 4 Panel Mode 
WINGRIDDS can perform animations while in 4 Panel mode with either the animation in a single panel 
or in all 4 panels, each with different information.  Animations in a single panel work exactly the same 
as if WINGRIDDS was in 1 Panel mode.  The animation commands will be effective to the panel which 
has control focus.  However, the technique to perform animation which involve all 4 panels is different 
and can only be done through a Command Macro file using the ANMA command along with the ALWN 
command instructing the animation function to use “All Windows”.   
 
****NOTICE –  
    1) WINGRIDDS must already be in 4 Panel mode before attempting a 4 panel animation. 
    2) The ALWN must be inside the LOOP 
    3)  The WIN* commands to change focus to the respective window is a separate command line 
 
 
 
 
Below is an example MACRO 
 
ANMA 
LOOP 
ALWN 
PLAN 
WIN1 
HGHT  
WIN2 
WIND/WSPD CTFG 
WIN3  
CROS 
TEMP/MIXR  
WIN4 
THTA  
ENDL 
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-- Animation Control                                                 
 
There are seven controls on a floating Tool Bar.  This Floating Tool Bar can be positioned anywhere 
within the main WINGRIDDS Window.  The operator can use the buttons within the Tool Bar to control 
the animation operation while the animation is cycling;  the  button speeds up the loop speed, the  
button slows down the loop speed. 
 
The animation cycle can also be switched from a free-run mode to a step-mode at any time by pressing 
the  button to step forward one frame or press the  button to step back one frame or pressing the 

 button to pause the motion. 
 
The animation cycle will stay in the step mode till the  button places it back in loop mode.  The 
animation cycle is terminated by pressing the  button. At the end of the animation sequence, all of 
the bitmap files in the ANIMATION directory are deleted. 
       

         
 
 
 
**- Specify a Cross Section Path  
Cross-section displays can display data on isentropic surfaces and constant height surfaces as well as 
pressure surfaces.  The isentropic levels are predefined from 270K-400K every 10k. The height surfaces 
can be displayed in either feet or meters.  This selection is made within the ‘WINGRIDDS Settings’ tab of 
the ‘Properties’ dialog. The vertical range for CROS sections in height mode is 500 ft to 65,000 ft in 5,000 ft  
increments or 2000 meters to 24,000 meters in 2,000 meter increments.  These are fixed in software. The 
user can use pressure and forecast hour data in the file USER\INITGRID.SPC, which is the default settings 
or the user can utilize all the model pressure levels or use the commands XLVL (file name) to use 
predefined pressure levels.  Cross-section displays for pressure surfaces can be established by  
typing XSCT, displays for Isentropic surfaces can be established by typing XSCI and displays for height 
surfaces can be established by typing XSCH.   They are the left display latitude and longitude and the right 
latitude and longitude. (If no lat/lon information is included, a prompt will appear.)  Two formats can be 
used, either latitudes and longitudes followed IMMEDIATELY (no spaces between) by 1 character 
hemisphere indicators (e.g., 40S  for 40 degrees South latitude) or signed numeric values, where positive  
values indicate Northern and Western Hemispheres. 
 
Cross-sections can also be defined between two Station locations using the Command XSTN for pressure 
levels, XSTI for Isentropic levels or XSTH for Height levels two 3 or 4 letter station identifiers. Once a 
cross-section has been defined, the base map can be redrawn with the cross section path shown as a 
dotted line using either the MAP  command (to overlay a map on the existing product) or the EMAP  
command to erase the screen before drawing the map.   
 
To set up a cross section using all model levels, these commands are executed: 
ALVL 
XSCT  55.00   80.00  25.00   80.00 
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To set up a cross section using XLVL with the file name ‘505m’ , these commands are executed: 
XLVL 505m 
XSCT  55.00   80.00  25.00   80.00  
 
The look of the Cross section display is created by a series of commands executed from the files 
USER\CROSSSECTION.DAT for cross sections.  This file can be customized by the user to change the 
look of the display.  If these files are not found while attempting to build a CROS section, to program will 
default to the current operational CROS display. 
 
The following commands are what are in the included in the USER\CROSSSECTION.DAT file: 
 
NLBL XLTN& 
NCLB NLBL PRES& 
XLBL SCL0 NLBL LAST& 
XLBB SCL0 NLBL ALAT& 
XLBB SCL0 NLBL DATT ALON& 
 
To remove the cross section path, type either XSTN 9999 or XSCT 9999. 
 
Defining a cross section path also initiates the cross section display mode. Display modes can be switched 
from cross section to plan view by typing PLAN, and from plan view to the previously established cross 
section by typing  CROS. 
 
 
**- Cross Section Wind displays 
Cross-sectional wind displays can be modified to provide rotated, cross-section relative wind 
representations by typing XREL to the left of the desired wind type. Individual cross-sectional relative 
components can be displayed using TANG and NORM for contour of the tangential and normal wind 
components and VTNG and VNRM  for vector component displays. 
 
Vertical circulations displays of the tangential component of the wind and the vertical velocity are produced 
by typing  VCRC a wind type. 
 
A number of shorthand notation aliases are available for cross-sectional wind displays, including: 
 
WNDX  to display the total wind rotated relative to the cross section   
GEOX  to display the geostrophic wind rotated relative to the cross section 
AGEO  to display the ageostrophic wind rotated relative to the cross section 
WCRC  to display vertical/tangential circulations of total wind 
GCRC  to display vertical/tangential circulations of geostrophic wind 
ACRC  to display vertical/tangential circulations of ageostrophic wind 
 
 
 
**- Specify a Time Section Point 
Time-section displays can display data on isentropic surfaces and constant height surfaces as well as 
pressure surfaces.  The isentropic levels are predefined from 270K-400K every 10k. The height surfaces 
can be displayed in either feet or meters.  This selection is made within the ‘WINGRIDDS Settings’ tab of 
the ‘Properties’ dialog. The vertical range for TIME sections in height mode is 500 ft to 65,000 ft in 5,000 ft  
increments or 2000 meters to 24,000 meters in 2,000 meter increments.  These are fixed in software. The 
user can use pressure and forecast hour data in the file USER\INITGRID.SPC, which is the default settings 
or the user can utilize all the model pressure/forecast hours or use the commands XLVL and THRS (file 
names) to use predefined pressure levels and forecast hours respectively.   



 
 173 

 
 
 
 
The direction, length and increment of default forecast hours along the bottom of the screen is determined 
by line three of the file USER\INITGRID.SPC as shown below: 
 
13  72  66  60  54  48  42  36  30  24  18  12  06  00  00  00  00 00  00  00 1 
 
This shows the forecast hours will span from hours 00 to 72 every six hours and increase from right to left.  
If it is desired for the forecast hours to increase from left to right, the entry should look like this: 
 
13  00  06 12  18  24  30  36  42  48  54  60  66  72  00  00  00 00  00  00 1 
 
For full information concerning USER\INITGRID.SPC configurations, see:  
Customizing the WINGRIDDS System -- Initial Pressure Levels and Forecast Hours 
 
When creating a Time-section with all model forecast hours (ATIM), the direction of the forecast hours will 
be determined by the order of the hours in the USER\INITGRID.SPC file. 
 
Time-section displays can be established for pressure surfaces by typing TSCT, for Isentropic surfaces by 
typing TSCI and for Height surfaces by typing TSCH.  They are the display latitude and longitude. (If no 
lat/lon information is included, a prompt will appear.)  Two formats can be used, either latitudes and 
longitudes followed IMMEDIATELY (no spaces between) by 1 character hemisphere indicators  
(e.g., 40S  for 40 degrees South latitude) or signed numeric values, where positive values indicate 
Northern and Western Hemispheres. 
 
Time-sections can also be defined for a Station location using the TSTN  command with a 3 or 4 letter 
station identifier. Once a time-section has been defined, the base map can be redrawn with the time 
section point shown as a dotted line using either the  MAP  command (to overlay a map on the existing 
product) or the  EMAP  command to erase the screen before drawing the map. 
 
To set up a time section using all model levels, these commands are executed: 
ALVL 
TSCT  55.00   80.00  25.00   80.00 
 
To set up a time section using XLVL with the file name ‘505m’, these commands are executed: 
XLVL 505m 
TSCT  55.00   80.00  25.00   80.00  
 
To set up a time section using all model levels and all forecast hours, these commands are executed: 
ATIM 
ALVL 
TSCT  42.37   71.03 
 
To remove the time section point, type either TSTN 9999 or TSCT 9999. 
 
Defining a time section also initiates the time section display mode. Display modes can be switched from 
time section to plan view by typing PLAN, and from plan view to the established time section by typing  
TIME. 
 
The look of the Time section display is created by a series of commands executed from the file 
USER\TIMESECTION.DAT for time sections.  This file can be customized by the user to change the look 
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of the display.  If this file is not found while attempting to build a TIME section, to program will default to the 
current operational TIME display. The following commands are what are in the included in the 
USER\TIMESECTION.DAT file: 
 
NCLB NLBL PRES& 
XLBL SCL0 NLBL LAST& 
XLBB SCL0 NLBL HOUR& 
NLBL HOUR& 
 
 
** -Sounding Commands 
 
The Sounding displays can either be created using the menu dialog (above) or from the WINGRIDDS 
command line.  Command-line location can be requested from either a Lat/Lon location, Grid-point X/Y 
location or Station ID.  The commands for Skew-T plots are as follows: 
 
SKEW LAT25.82N LON80.28W                 > Lat/Lon location 
SKEW X71 Y13                                           > Grid X/Y location 
SKEW STIDKMIA                                         > Station ID selection 
 
NOTICE – there is a space between command parameters *however* there are no spaces in the command 
parameters. “LAT25.82N” is all one continuous string with no spaces. This is the same for the longitude, 
the grid ‘X’ & ‘Y’ values as well as the Station ID.  The Station ID (STID) should be the 4-letter WMO ID 
(KMIA). 
 
The commands for Telphigram and Stuve plots are similar: 
 
TEPH LAT25.82N LON80.28W                 > Lat/Lon location 
TEPH X71 Y13                                           > Grid X/Y location 
TEPH STIDKMIA                                         > Station ID selection 
 
STUV LAT25.82N LON80.28W                 > Lat/Lon location 
STUV X71 Y13                                           > Grid X/Y location 
STUV STIDKMIA                                         > Station ID selection 
 
 
 
 
** -Hodograph Commands- 
 
The Hodograph displays can either be created using the menu dialog (above) or from the WINGRIDDS 
command line.  Command-line location can be requested from either a Lat/Lon location, Grid-point X/Y 
location or Station ID.  The commands for hodograph plots are as follows: 
 
HODO LAT25.82N LON80.28W                 > Lat/Lon location 
HODO X71 Y13                                           > Grid X/Y location 
HODO STIDKMIA                                         > Station ID selection 
 
NOTICE – as with the sounding commands, there is a space between command parameters *however* 
there are no spaces in the command parameters. “LAT25.82N” is all one continuous string with no spaces. 
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This is the same for the longitude, the grid ‘X’ & ‘Y’ values as well as the Station ID.  The Station ID (STID) 
should be the 4-letter WMO ID (KMIA). 
 
 
** -Trajectory Commands- 
 
The Trajectory displays can either be created using the menu dialog (above) or from the WINGRIDDS 
command line.  Command-line location can be requested from either a Lat/Lon location, Grid-point X/Y 
location or Station ID.  The commands for trajectory plots are similar to the other grid-point plots but has an 
extra direction command as follows: 
 
TRAJ LAT25.82N LON80.28W FWD                 > Lat/Lon location – forward  
TRAJ X71 Y13 FWD                                           > Grid X/Y location - forward 
TRAJ STIDKMIA BKW                                         > Station ID selection - backward 
 
NOTICE – as with the sounding commands, there is a space between command parameters *however* 
there are no spaces in the command parameters. “LAT25.82N” is all one continuous string with no spaces. 
This is the same for the longitude, the grid ‘X’ & ‘Y’ values as well as the Station ID.  The Station ID (STID) 
should be the 4-letter WMO ID (KMIA). 
 
The extra command at the end (FWD/BKW) shows the direction the trajectory should be calculated.  If the 
trajectory should be plotted on an isentropic surface, the level must be selected prior to issuing the TRAJ 
command.  
 
** -BUFKIT Data Generation Commands_ 
 
The BUFKIT Data files can either be created using the menu dialog (above) or from the WINGRIDDS 
command line.  Command-line location can be requested from either a Lat/Lon location, Grid-point X/Y 
location or Station ID.  The commands for BUFKIT Data file generation are as follows: 
 
BUFK LAT25.82N LON80.28W                 > Lat/Lon location 
BUFK X71 Y13                                           > Grid X/Y location 
BUFK STIDKMIA                                         > Station ID selection 
 
NOTICE – as with the sounding commands, there is a space between command parameters *however* 
there are no spaces in the command parameters. “LAT25.82N” is all one continuous string with no spaces. 
This is the same for the longitude, the grid ‘X’ & ‘Y’ values as well as the Station ID.  The Station ID (STID) 
should be the 4-letter WMO ID (KMIA). 
 
When the BUFKIT Data File generation command is accepted, WINGRIDDS will go through each forecast 
hour of the currently opened model data file and process the required parameters and diagnostic 
calculations.  The screen will show the progress of the process by showing the following message in the 
upper left corner of the screen; 
 
PROCESSING BUFKIT DATA...PLEASE WAIT - FORECAST HOUR 
 
**- PRINTING – 
 
WINGRIDDS prints to the default system printer. This printer can be either local or networked and can print 
in either Portrait or Landscape mode.  The command PRNT or clicking the  button on the Tool Bar will 
print the current screen contents automatically to the Windows default printer and no Print Dialog is 
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displayed.  If you wish to make any modifications to the Windows printer setup, it must be done outside of 
WINGRIDDS. There are no other print modes in WINGRIDDS as there were in the DOS PCGRIDDS. Print 
copies seem to look the best at 800x600 video mode.  Special thanks goes out to Dave Ballinger for his 
programming contribution for this function. 
 
Screen Printing – When the PRNT command is issued by itself in 4 Panel mode, only the current active 
window will be printed.  If the PRNT is preceded by the ALWN command, all 4 windows will be printed 
(along with the command line). 
 
**-Saving and Restoring Pre-Generated Graphics 
Plots can be saved for rapid redisplay by typing the command SAVE  followed by a space and a 
4-character file name (the qualifier .SVG will also be added automatically).  All plot commands are saved 
until the command ENDS is used. To restore the saved plot file, either type REST with the file name 
(again without the .SVG qualifier) or type the file name a semicolon.  The results will be displayed over 
whatever is on the screen already, so be sure to erase the existing graphics using  ERAS  if you do not 
want the graphics overlaid on the existing screen display.  
 
For example, the sequence of commands - 
SAVE 500Z 
VORT WIND&HGHT SLVL  500 
ENDS 
ERAS 
REST 500Z   [This command line could alternatively be input as  500Z; ] 
  -  will create a .SVG file labeled 500Z.SVG, generate contours of the 500 mb 
     HeiGHT and VORTicity fields and save the plotting commands, close the .SVG 
     file, erase the screen and then restore graphics. 
 
The screen contents can be saved to a BMP-format or PNG-format file. The command SAVS a space and 
a file name up to 20 characters (the qualifier .BMP/.PNG will be added automatically) will save the contents 
of the screen. 
 
File format is determined by the BMP or PNG entry on line 9 in the WINGMODE.DAT file. 
 
If WINGRIDDS is in 4PNL mode and all 4 windows are to be saved as 1 image, enter ALWN the SAVS 
command. 
 
 
**-Data Masking Operations 
[Scalar/Vector]POSMASK([Scalar Operation]){AND,OR,NOT}...   > Calculate a 
      Positive Mask to filter requested Scalar/Vector operation 
 
[Scalar/Vector]NEGMASK([Scalar Operation]){AND,OR,NOT}...   > Calculate a
      Negative Mask to filter requested Scalar/Vector operation. 
 
Masking operations are an exciting new addition to WINGRIDDS operations. They provide a way to create 
a plot of Scalar or Vector information which only shows data (POSMASK) where other complex parameters 
are satisfied or it can create a plot of Scalar or Vector information which blocks plotting data (NEGMASK) 
where other complex parameters are satisfied. The parameters are evaluated using logical operators AND, 
OR & NOT. Examples of both Positive and Negative masking will be showed below. 
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Example command for POSMASK; 
 
WIND POSMASK(TEMP GTLT 8 12) AND (RELH GRTN 50) OR (VVEL GRTN 01) 
 
 
Example command for NEGMASK; 
 
MIXR CTFC NEGMASK(TEMP GTLT 8 12) AND (RELH GRTN 50) NOT (DVRG LSTN 0) 
 
How it works: 
POSMASK creates a 'Positive' mask created from multiple SCALAR commands within parenthesis which 
are separated by MASK BOOLEAN OPERATORS of 'AND', 'OR' & 'NOT'. The resulting mask will control 
where the first SCALAR or VECTOR is plotted. 
 
NEGMASK creates a 'Negative' mask created from multiple SCALAR commands within parenthesis which 
are separated by MASK BOOLEAN OPERATORS of 'AND', 'OR' & 'NOT'. The resulting mask will control 
where the first SCALAR or VECTOR is 'NOT' plotted. 
 
Multiple SCALAR commands can be strung along with multiple BOOLEAN OPERATORS as needed to the 
555 Character length limit. All GRIB or Diagnostic calculated scalar parameters can be used. 
 
 
**- Velocity Potential/Stream Function Diagnostics 
WINGRIDDS can now calculate Velocity Potential and Stream Function parameters. These parameters 
include Non-Divergent wind, Irrotational wind, Harmonic wind and a variety of these combinations. These 
parameters are traditionally calculated on a global scale converting from a uniform cylindrical or gaussian 
grid to a spectral wave-space grid, perform the calculations then convert the result back to the original grid 
space. There are new formulas & techniques to approximate these calculations on more limited area grid 
areas such as Lambert Conformal and Equatorial sections of global Lat/Lon cylindrical grids.  
 
Understand, these parameters and calculations are of most value in the Sub Tropic/Tropic areas of the 
world and run into ‘problems’ as you approach the polar regions so if you are using a global grid set, it is 
advised to ensure the area coverage has the polar regions (+/-60 deg Lat) off screen. Below is a list of 
references to publications describing Velocity Potential and Stream Function parameters as well as the 
formulas and research of the techniques used in WINGRIDDS: 
 
 
1974: Computation of Non-Divergent Streamfunction and Irrotational Velocity Potential  

from the Observed Winds, Wea. Rev., 102, 419-425. 
 

1988: Deducing the Wind from Vorticity and Divergence, Wea. Rev., 116, 86-93. 
 
1989: Partitioning the Wind in a Limited Domain, Wea. Rev., 117, 1492-1500. 
 
1992: Quasigeostrophic vertical motions diagnosed from along-and  

cross-isentrope components of Q Vector, Mon. Wea. Rev., 120, 731-741. 
 

1995: A technique for diagnosing three-dimensional ageostrophic circulations  
in baroclinic disturbances on limited-area domains, Mon. Wea. Rev, 123, 1476-1504. 
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WINGRIDDS Contour Color Fill Operations 
 
The programming library Winteracter, which is used to build and apply the GUI features within 
WINGRIDDS also has graphics features which can be incorporated into programs.  Incorporating these 
features into WINGRIDDS has yielded five new commands to accomplish a variety of color and pattern 
contouring within WINGRIDDS. The new features are as follows: 
 
1) Line Based Contouring – this is the same as the regular contouring within WINGRIDDS. 
 
2)  Line Based, Graduated Color – This contouring still uses individual lines but each contour value is 
assigned a color. Color is assigned to Max & Min contour value. 
 
3)  Fill Based, Selected Pattern – This contouring uses a fill pattern of either lines at various angles for the 
contour value or a mesh pattern for the contour value. 
 
4)  Fill Based Selected Color – This contouring uses selected colors to be assigned to specific contour 
values. 
 
5)  Fill Based Graduated Color – This contouring uses continuous color gradually changing shades along 
the contour slope.  Like the Line Based, Graduated Color, the color is assigned to the Max & Min contour 
value. 
 
The individual features will be explained below in detail.  NOTE: There is NO contour smoothing function 
available (yet) from Winteracter for these contour features. This means, at times, some contour lines or 
features may appear blocky or squared off instead of a smooth curve.  
 
The CTLG, CTFP, CTFC & CTFG commands may use default color setting or they can each reference  
configuration files to assign specific colors and/or assign specific max/min contour values.  The 
configuration files are user configured to generate a unique display to make a certain scalar value stand 
out and are best utilized within command macros. The file names can be up to 10 characters long but the 
first three characters *must* match the command it is associated with.  The default color/pattern selections 
for CTLG, CTFP, CTFC & CTFG are contained within WINGMODE.DAT file. 
 
All colors are assigned in RGB (Red, Green, Blue) format with each color assigned a number from 0 – 255 
with 0 = darkest & 255 = brightest.  This allows for up to 16 million colors if the display is capable. For less 
color capable displays, the color assignment will be truncated. 
 
 
 
WINGRIDDS Feature                             COMMAND              CONFIG FILE (Optional) 
Line Based  Contouring          CTLN            ----- 
Line Based, Graduated Color     CTLG          CLN******* (1-9,A-Z) 
Fill Based, Selected Pattern    CTFP          CFP******* (1-9,A-Z) 
Fill Based  Selected Color      CTFC          CFC******* (1-9,A-Z) 
Fill Based  Graduated Color     CTFG          CFG******* (1-9,A-Z) 
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Examples:   
 
To display a Line Based Contour of HGHTs,  
HGHT CTLN 
 
To display a Line Based, Graduated Color contour of HGHTs with default max/min colors is, 
HGHT CTLG 
 
Or to display a Line Based, Graduated Color contour of HGHTs with assigned max/min colors for that type 
display is, 
 
HGHT CTLG CLNFILTEST 
 
NOTE: when you want to use one of the Color Fill features and overlay another scalar or vector value 
using regular contouring, the color-fill command MUST be executed first (most-right command) or else any 
data which is plotted will be overwritten by the color-fill feature.  See the following examples: 
 
TEMP & HGHT CTFC                          GOOD!!! 
HGHT CTFC & TEMP                          BAD!!! 
 

DETAILS 
 

***************** WINGMODE.DAT ************************* 
'c:\WINGRIDDS\GRIB\WAFS\'  
'c:\WINGRIDDS\GRIB\NWS\'  
'c:\WINGRIDDS\GRIB\MOS\' 
'c:\WINGRIDDS\OBS\'           ## new 
'c:\WINGRIDDS\GRIDDATA\' 
'METER' 
'WORLD' 
'C:\WINGRIDDS\PRTFIL\' 
'.BMP' 
'WMO'                         ## new 
'C'                           ## new 
'KTS'                         ## new 
'BARB'                        ## new 
'1PNL'                        ## new 
'BANNER'                      ## new 
'003' 
'0 0 150' 
'255 0 0' 
'0 0 150' 
'255 0 0' 
'6' 
'148 0 211' 
'0 0 255' 
'0 255 0' 
'255 255 0' 
'255 0 0' 
'139 0 139' 
'1' 
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   LINE 17  Contour Line-Based Graduated Min Default Color  
 
   LINE 18  Contour Line-Based Graduated Max Default Color 
 
   LINE 19  Contour Fill-Based Graduated Min Default Color  
 
   LINE 20 Contour Fill-Based Graduated Max Default Color 
 

LINE 21 Number of Colors to follow for use with Contour Fill-Based Selected Colors. 
 
   Last LINE   Contour Fill-Based Pattern Number 
 
 
 
Line Based, Graduated Color 
 
The Line Based, Graduated Color command CTLG (CLN*) will generate a contour line display with each 
contour line assigned a slightly different color from a graduated scale generated by the routine.  The 
routine is passed a color value for the max of the contour scale and a color value for the min of the contour 
scale. The routine will generate a smooth contour graduation between the two colors and assign each 
contour line a specific color depending on the contour interval.  The color values can either be the default 
values listed in the WINGMODE.DAT file or they, along with the min/max contour values, can be assigned  
through the Line Based, Graduated Color configuration files (CLN*).  Below is an example of a Line Based, 
Graduated Color configuration file. 
 
! 
!Configuration file for Contour Line-Graduated Color 
!Displays 
! 
!Min Values 
! 
0.0 
! 
!Max Values 
! 
9.8E29 
! 
!R-G-B Values (Top-min, Bottom-max) 
! 
127 255 0 
255 0 0 
***************************************************** 
***************************************************** 
*************   END-OF-DATA   *********************** 
***************************************************** 
***************************************************** 
 
 
These configuration files must follow this template & order of information.  They allow comment lines 
preceded by an exclamation point ‘!’ and ends with the ‘*****END-OF-DATA ***’ section. 
 
The Min/Max values MUST be in floating-point format and exponential notation is allowed. 
 
RGB values range from 0-255 and are separated by single spaces. 
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Fill Based, Selected Pattern 
 
The Fill Based, Selected Pattern command CTFP (CFP*) will generate a contour display filled with a 
line/pattern assigned a different pattern by the routine.  The routine is passed a pattern mode. The routine 
will generate a pattern by looping through line angles (slope up, slope down, horizontal & vertical) and line 
density (sparse, medium, dense, very dense & extremely dense).  The pattern mode value can either be 
the default value listed in the WINGMODE.DAT file or it, along with the min/max contour values, can be 
assigned  through the Fill Based, Selected Pattern configuration files (CFP*).  Below is an example of a Fill 
Based, Selected Pattern configuration file. 
 
! 
!Configuration file for Contour Line-Fill/Pattern  
!Displays 
! 
!Min Values 
! 
-9.8E29 
! 
!Max Values 
! 
0.0 
! 
!Pattern Mode - 1=Hatched, 2=Crosshatched 
! 
2 
 
***************************************************** 
***************************************************** 
*************   END-OF-DATA   *********************** 
***************************************************** 
***************************************************** 
 
These configuration files must follow this template & order of information.  They allow comment lines 
preceded by an exclamation point ‘!’ and ends with the ‘*****END-OF-DATA ***’ section. 
 
The Min/Max values MUST be in floating-point format and exponential notation is allowed. 
 
Pattern Mode can be only 1 or 2 
 
 
Fill Based Selected Color 
 
The Fill Based Selected Color command CTFC (CFC*) will generate a contour line display with each 
contour line assigned a specific color from 
 
 
1) 2 colors with interpolation between the 2 colors or  
2) a small set of colors with interpolation between the colors to fill the contour range or  
3) specific colors assigned to specific contour values.   
 
The color values can either be the default values listed in the WINGMODE.DAT file or they, along with the 
min/max contour values, can be assigned  through the Fill Based Selected Color configuration files (CFC*).  
The CFC files can have 3 different modes of operation. Below are examples of the 3 types of Fill Based 
Selected Color configuration files. 
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! 
!Configuration file for Contour Line-Fill/Color  
!Displays 
! 
!Color Mode - 1=MAX/MIN COLOR, 2=MULTI INTERPOLATION, 3=INDIVIDUAL COLORS 
! 
1 
! 
!Number of Data Entries (ONLY 2 ALLOWED IN COLOR MODE 1) 
! 
2 
! 
!Number of Color Entries (ONLY 2 ALLOWED IN COLOR MODE 1) 
! 
2 
! 
!Min to Max Values 
! 
-9.8E29 
9.8E29 
! 
!R-G-B Values (Top-min, Bottom-max) 
! 
50 0 50 
255 255 0 
***************************************************** 
***************************************************** 
*************   END-OF-DATA   *********************** 
***************************************************** 
***************************************************** 
 
 
 
! 
!Configuration file for Contour Line-Fill/Color  
!Displays 
! 
!Color Mode - 1=MAX/MIN COLOR, 2=MULTI INTERPOLATION, 3=INDIVIDUAL COLORS 
! 
2 
! 
!Number of Data Entries (ONLY 2 ALLOWED IN COLOR MODE 1) 
! 
2 
! 
!Number of Color Entries (ONLY 2 ALLOWED IN COLOR MODE 1) 
! 
6 
! 
!Min to Max Values 
! 
-9.8E29 
9.8E29 
! 
!R-G-B Values (Top-min, Bottom-max) 
! 
50 0 50 
255 0 255 
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0 0 255 
0 255 0 
255 255 0 
255 0 0 
***************************************************** 
***************************************************** 
*************   END-OF-DATA   *********************** 
***************************************************** 
***************************************************** 
 
 
! 
!Configuration file for Contour Line-Fill/Color  
!Displays 
! 
!Color Mode - 1=MAX/MIN COLOR, 2=MULTI INTERPOLATION, 3=INDIVIDUAL COLORS 
! 
3 
! 
!Number of Data Entries (ONLY 2 ALLOWED IN COLOR MODE 1) 
! 
22 
! 
!Number of Color Entries (ONLY 2 ALLOWED IN COLOR MODE 1) 
! 
22 
! 
!Min to Max Values 
! 
4680.0 
4740.0 
4800.0 
4860.0 
4920.0 
4980.0 
5040.0 
5100.0 
5160.0 
5220.0 
5280.0 
5340.0 
5400.0 
5460.0 
5520.0 
5580.0 
5640.0 
5700.0 
5760.0 
5820.0 
5880.0 
5940.0 
! 
!R-G-B Values (Top-min, Bottom-max) 
! 
50 0 50 
101 0 101 
153 0 153 
204 0 204 
255 0 255 



 
 184 

191 0 255 
128 0 255 
64 0 255 
0 0 255 
0 26 218 
0 51 181 
0 77 144 
0 102 107 
0 128 70    
0 191 35 
0 255 0 
85 255 0 
170 255 0 
255 255 0 
238 214 0 
222 174 0 
205 133 0 
***************************************************** 
***************************************************** 
******************   END-OF-DATA   ****************** 
***************************************************** 
***************************************************** 
 
These configuration files must follow this template & order of information.  They allow comment lines 
preceded by an exclamation point ‘!’ and ends with the ‘*****END-OF-DATA ***’ section. 
 
The Color Mode entry may be 1, 2, or 3.  NOTE: The selection of Mode 3 will override any contour interval 
from the command line. 
 
Number of Data Entries and Number of Color Entries must match the number of entries in the respective 
section.  There is a maximum of 200 Data/Color pairs allowed. 
 
The Min/Max values MUST be in floating-point format and exponential notation is allowed. 
 
RGB values range from 0-255 and are separated by single spaces. 
 
The example Configuration file for Mode 3 is set up to show a rainbow display for 500mb HGHTs.  The 
same type of setup can be built for MIXR, TEMP, VTCY PCPT or any scalar display.  
 
 
 
 
 
 
Fill Based, Graduated Color 
 
The Fill Based, Graduated Color command CTFG (CFG*) will generate a contour fill display with each 
contour value assigned a slightly different color from a graduated scale generated by the routine.  The 
routine is passed a color value for the max of the contour scale and a color value for the min of the contour 
scale. The routine will generate a smooth contour graduation between the two colors and assign each 
contour value a specific color.  The color values can either be the default values listed in the 
WINGMODE.DAT file or they, along with the min/max contour values, can be assigned  through the Fill 
Based, Graduated Color configuration files (CFG*).  Below is an example of a Fill Based, Graduated Color 
configuration file. 
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! 
!Configuration file for Contour Fill-Graduated Color 
!Displays 
! 
!Min Values 
! 
0.0 
! 
!Max Values 
! 
9.8E29 
! 
!R-G-B Values (Top-min, Bottom-max) 
! 
127 255 0 
255 0 0 
***************************************************** 
***************************************************** 
*************   END-OF-DATA   *********************** 
***************************************************** 
***************************************************** 
 
 
These configuration files must follow this template & order of information.  They allow comment lines 
preceded by an exclamation point ‘!’ and ends with the ‘*****END-OF-DATA ***’ section. 
 
The Min/Max values MUST be in floating-point format and exponential notation is allowed. 
 
RGB values range from 0-255 and are separated by single spaces. 
 
 
As you can see, there is a lot of flexibility but with flexibility, these things can get very involved and here is 
where I need your input to the following questions. 
 
1) Is this the best way to implement these features or is there a better way to harness the power & 
capability of these features while keeping it easy to use & understand and do it within the confines of how 
WINGRIDDS works? 
 
2) The configuration files are currently stored in the USER/ directory.  Since they would probably be 
associated mostly with command macros, would it be better to store them in the MACROS/ directory? 
 
 
Known bugs associated with third-party software (I can’t fix myself) 
 
1)  There are times when you may find that color or line contours don’t match exactly with the WINGRIDDS 
contours – or -  contour edges may not go completely to the edge or may go beyond the edge of the 
display.  These are issues associated with the third-party software being used to perform the color-fill 
graphics.  The company has been made aware if the issue and I am awaiting bug fixes. 
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WINGRIDDS Climate Calculations 
 
WINGRIDDS has a gridded climate database files have been improved and expanded. Where before there 
was a single 30-year database file for each month covering the years 1979-2009, now there are two sets of 
database files – a 30 year set from 1985-2015 and a 60-year set from 1955-2015. Also, each monthly file 
covers 4 hourly blocks during the diurnal cycle; hours 00, 06, 12 and 18. The file set for the month of April 
are listed as follows: 
 
APR018500-30.CLM002 
APR018506-30.CLM002 
APR018512-30.CLM002 
APR018518-30.CLM002 
APR015500-60.CLM002 
APR015506-60.CLM002 
APR015512-60.CLM002 
APR015518-60.CLM002 
 
The following parameters/levels are included in each climate data file: 
 
 HGHT       10 TEMP       10 UGRD       10 VGRD       10 VTCY       10 
 HGHT       20 TEMP       20 UGRD       20 VGRD       20 VTCY       20 
 HGHT       30 TEMP       30 UGRD       30 VGRD       30 VTCY       30 
 HGHT       50 TEMP       50 UGRD       50 VGRD       50 VTCY       50 
 HGHT       70 TEMP       70 UGRD       70 VGRD       70 VTCY       70 
 HGHT      100 TEMP      100 UGRD      100 VGRD      100 VTCY      100 
 VVEL      100 HGHT      150 TEMP      150 UGRD      150 VGRD      150 
 VTCY      150 VVEL      150 HGHT      200 TEMP      200 UGRD      200 
 VGRD      200 VTCY      200 VVEL      200 HGHT      250 TEMP      250 
 UGRD      250 VGRD      250 VTCY      250 VVEL      250 HGHT      300 
 RELH      300 TEMP      300 UGRD      300 VGRD      300 VTCY      300 
 VVEL      300 HGHT      400 RELH      400 TEMP      400 UGRD      400 
 VGRD      400 VTCY      400 VVEL      400 HGHT      500 RELH      500 
 TEMP      500 UGRD      500 VGRD      500 VTCY      500 VVEL      500 
 HGHT      600 RELH      600 TEMP      600 UGRD      600 VGRD      600 
 VTCY      600 VVEL      600 HGHT      700 RELH      700 TEMP      700 
 UGRD      700 VGRD      700 VTCY      700 VVEL      700 HGHT      850 
 RELH      850 TEMP      850 UGRD      850 VGRD      850 VTCY      850 
 VVEL      850 HGHT      925 RELH      925 TEMP      925 UGRD      925 
 VGRD      925 VTCY      925 VVEL      925 PRES      MSL ALAT      SFC 
 ALON      SFC DMAP      SFC EDIR      SFC FFFF      SFC GRDX      SFC 
 GRDY      SFC HGHT      SFC LFTX      SFC LIFT      SFC MSG0      SFC 
 MSG1      SFC PRES      SFC PWAT      SFC RELH      SFC HGHT     1000 
 RELH     1000 TEMP     1000 UGRD     1000 VGRD     1000 VTCY     1000 
 VVEL     1000 RELH     B015 TEMP     B015 UGRD     B015 VGRD     B015 
 UGRD     H018 VGRD     H018 UGRD     H027 VGRD     H027 UGRD     H036 
 VGRD     H036 PRES     MAXW TEMP     MAXW UGRD     MAXW VGRD     MAXW 
 RELH     S580 RELH     S720 RELH     S830 RELH     S995 TEMP     S995 
 THTA     S995 UGRD     S995 VGRD     S995 VVEL     S995 PRES     TROP 
 TEMP     TROP UGRD     TROP VGRD     TROP VSSH     TROP  
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The Climate calculation commands are: 
 
CLIMO30  [Scalar/Vector] > Display Climate value (1985-2015) of 
Parameter 
CLIMO60  [Scalar/Vector] > Display Climate value (1955-2015) of 
Parameter 
 
ANOMLY30 [Scalar/Vector] > Display the difference between parameter & 
30yr Climate value 
ANOMLY60 [Scalar/Vector] > Display the difference between parameter & 
60yr Climate value 
 
 
Examples:   
 
To display a 30yr climatological value of TEMP,  
 
CLIMO30 TEMP 
 
To display a 60yr climatological anomaly value of HGHT & WIND,  
 
ANOMLY60 HGHT / ANOMLY60 WIND 
 
WINGRIDDS will evaluate the current data file parameters for the initialization time as well as the 
requested forecast hour and match those to the proper climate database file set to compare to.  
 
These database files have been created from the “NCEP/NCAR Global Reanalysis Products, 1948-
continuing” file set. 
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WINGRIDDS Observation Data Operations 
 
This is to document the new observation data processing and display features within WINGRIDDS.   
 
WINGRIDDS can handle ASCII (TEXT) based surface observations (METAR, Synoptic, Buoy, & Ship) 
reports and Upper-Air RAOB reports as well as some observation-based BUFR format files.  The 
observation ingest utility OBS2PCG.EXE parses the observation reports, performs Barnes Analysis on the 
data and map the data to a specific map projection to create a PCG Data file which is compatible with the 
GRIB-based PCG data files so the observation and model data can be viewed in the same context.  Also, 
the OBS2PCG utility creates a concatenated text file of all surface and upper-air observations to be used to 
create Station Model Plots within WINGRIDDS.  
 
 
***** NOTE:  If you are not aware of how Barnes Analysis works, it is basically trying to arrange random 
scattered data (observation stations) into orderly, fixed-spaced data (grid data) and the more observations 
spread across the selected grid area there are, the better and more accurate the resulting Barnes analysis 
will be.  It is not recommended, for example, that, in order to save time, you only download some coastal 
marine or buoy data and expect a Barnes analysis on a grid covering the entire U.S. to work because there 
is a big data hole covering the entire interior of the U.S. and the Barnes routines do not like big holes of 
nothing.  
 
As stated above, OBS2PCG can now process some observation-based BUFR format files. It must be 
noted these are ‘observation’ BUFR files and *NOT* GRIB forecast-based BUFR files which cannot be 
processed. In case you are not familiar, a single GRIB-based message contains data which covers a broad 
area of the earth however, the BUFR format contains data for a single point on the earth and this can be an 
observation data point or a forecast data point. A single BUFR file can contain thousands of single-point 
data records.  
 
OBS2PCG can only process observation-based BUFR data files and there are also some observation 
BUFR files it cannot decode due to processing limitations.  Below is a list of the base file names used on 
the NCEP servers which OBS2PCG can decode (“?” denotes incomplete description info): 
 
Surface Observations- 
metars.buf  METAR-based obs 
adpsfc.buf  Synoptic-based obs (?) 
sfcshp.buf  Surface Ship obs 
marine.buf  Surface ship/buoy obs (?) 
 
Upper-Air/non-surface Observations- 
vadwnd.buf  NEXRAD VAD winds 
proflr.buf  Profiler Winds 
adpupa.buf  RAOBs  
satwnd.buf  Satellite-based wind obs (over ocean) 
qkswnd.buf  Quicksat surface radar winds (over ocean) 
qkscat.buf  QuickScat surface radar winds (over ocean) 
goesfv.buf  Processed GOES-based Satellite Sounder obs 
atovs.buf  Processed Polar-based Satellite Sounder obs 
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Below is a list of the base file names used on the NCEP servers which OBS2PCG can *NOT* decode: 
 
trmm.buf  Rain Rate obs (over ocean) 
wndsat.buf  WindSat obs – dead platform 
gspro.buf  CHAMP radio occultation data 
geoimr.buf  Processed GOES Imager Tb data 
prepbufr.buf  unknown format issues 
rassda.bufr  raw HIRS-1 1b format 
1bamua.bufr  raw amsu-a 1b format 
1bamub.bufr  raw amsu-b 1b format 
1bhrs3.buf  raw hirs-3 1b format 
1bhrs4.buf  raw hirs-4 1b format 
1bmhs.buf  raw MHS Tb data (NOAA-18, METOP-2) 
airsev.buf  raw AIRS/AMSU-A/HSB 1b DATA (AQUA) 
amsre.buf  raw AMSRE-E Channel data 
mtiasi.buf  unknown data 
osbuv8.buf  unknown data 
sptgrmm.buf  unknown data – possible TRMM as above. 
aircft.buf  AIRCAR (Commercial aircraft) obs (?) 
 
The BUFR data processing can be combined with the regular text-based obs files to improve the Barnes 
Analysis and final data output.  *HOWEVER*, it was found during testing the text-based surface data was 
more complete as compared to the BUFR data and it is not advised to mix the two observation types 
together.  It was found that the best final product used text-based surface obs combined with BUFR-based 
non-surface obs. It must also be noted that the GOES & Polar Processed Sounding files are very large and 
may take a long time to download & process – depending on your internet and computer CPU speed. 
 
When downloading BUFR data files onto your PC, the surface-based files can be transferred to their 
appropriate “OBS\Surface” subdirectories within WINGRIDDS i.e.:  
metars.buf – type files can go into the METAR directory, sfcshp.buf – type files can go into the Ship 
directory, etc. However, due to the different way the text-based RAOB obs are processed, it was required 
that a BUFR directory be created under the  “OBS\UpperAir”  directory and *ALL* non-surface BUFR files 
need to be stored for processing within this directory…even the adpupa.buf – type RAOB BUFR files. 
 
New additions have been added to the WINGMODE.DAT file, new directories have been created to 
accommodate the observation reports, a new dialog has been added to WINGRIDDS for the user to 
interface to the OBS2PCG utility, download scripts have been added to download observation data from 
known free Internet servers and a few new commands have been added to WINGRIDDS. 
 
 
 
Observation Data Ingesting with OBS2PCG 
The new utility OBS2PCG has been created to 1) convert individual observation reports to a PCG Data file 
format so observation data can be viewed in conjunction with model data and 2) concatenate the 
observation data into one text-based data file do build and plot station-model data now as well as skew-t 
and hodographs in later releases. 
 
Since surface observation data is usually reported every hour and RAOB data is only twice a day (00Z & 
12Z), OBS2PCG has the ability to combine surface and upper-air data from different times. Either surface 
only, upper-air only or both data sets can be processed. 
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The data must be conformed to a specific map projection to work within WINGRIDDS.  The user can select 
most any map projection listed in the GRIB documentation (except Arakawa [staggered] grids or grids with 
irregular grid spacing [N/S spacing different from E/W spacing]) or the user can select one or more of the 
WAFS octants in the same way as is used with the WAFS GRIB Ingest utility GRIB2PCG32. 
 
When an observation hour is selected, OBS2PCG filters the data and only allows observations centered at 
that hour +/- 15 min and once a station is processed, it will not process that station again if it is reported 
more than once. 
 
 
 
 
Observation Data Ingesting with OBS2PCG (Command Line) 
 
The command-line entry for OBS2PCG is as follows: 
 
OBS2PCG Ddd Shh Uhh Nggg Woooooooo R 
 
OBS2PCG  - name of the utility 
Ddd             - the letter ‘D’  a 2-digit day of the month 
Shh             - the letter ‘S’  a 2-digit hour of surface report (UTC) 
Uhh             - the letter ‘U’  a 2-digit hour of upper-air report (UTC) 
 
Either: 
Nggg           - the letter ‘N’  a 3-digit grid ID from GRIB documentation 
or 
Woooooooo - the letter ‘W’  up to 8-letters (I-P) identifying the WAFS octant(s) the user wishes to 
use. 
 
Optional: 
R                  - the letter ‘R’ used to reanalyze the processed data to account for modified or 
corrected data or to perform a Barnes analysis to a different grid type on data which has already 
been processed 
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Below is the dialog from within WINGRIDDS to accomplish the same thing: 
 

 
 
 
Observation Data Ingesting with OBS2PCG from within WINGRIDDS 
When the user selects the WINGRIDDS menu selection: Convert Observation Files under the Files menu, 
the dialog Convert Observation Data, as seen above, is shown on the screen.   
 
 
**Observation Date-Time Group Information 
 
The Date-Time Group section will be filled with the numeric day of the month and hours of Surface and 
Upper-Air Observations.  The information will default to local time adjusted to GMT (Zulu) through the hour 
offset setting on line 2 in the file FTPCMD.DAT. 
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NOTICE*****  If your computer is set to observe Daylight Savings Time, this GMT offset entry in the 
FTPCMD.DAT file will have to be modified by one hour when switching between Standard Time and 
Daylight Savings Time for any download and processing to be time accurate. 
 
 
 
**Observation Grid Information 
 
The user can select one of two types of grids to map the observation data; NWS-standard grids or WAFS-
standard grids.  These grid areal coverage and resolution are described in the GRIB1 documentation 
included in the WINGRIDDS Help section. The user can select most any map projection listed in the GRIB 
documentation except Arakawa (staggered) grids or grids with irregular grid spacing (N/S spacing different 
from E/W spacing). 
 
 
The NWS GRID ID default value is selected by entry line 16 of the USER\WINGMODE.DAT file.  The user 
can change the value of the NWS Grid ID by either directly typing in the right-justified number or scrolling 
the values higher or lower with the up-down arrow buttons. 
 
The WAFS Grid ID is a combination of anywhere from 1 to 8 of the WAFS octant letter IDs from I to P.  
The octant letter ID’s MUST be entered in the following, specific order for processing to perform properly.  
If more than one octant is to be listed, the following rules must be followed: 
 
1 – if more than one octant in the same N/S hemisphere is to be used, the octants must be listed from west 
to east.  
 
2 – if more than one octant in different N/S hemispheres is to be used, the octants must be listed from most 
southwest octant, progressing east, then doing the same in the northern hemisphere ending with the most 
northeast octant. 
 
The CUSTOM GRID ID is a file name of a Custom Grid defined and saved during the Custom Grid 
definition operation. (see p.109) 
 
 
 
 
 
**Observation Reanalyze Information 
 
The user can select the Reanalyze option to map a set of observation data which had previously been 
processed and the user has corrected for some bad data or the user wishes to have a barnes analysis 
performed on an observation data set and mapped to a different grid projection.  The Reanalysis option 
makes the OBS2PCG utility skip over the initial raw data conversion and works, instead, from the text-
based combined observation data files located in the GRIBDATA\OBS directory.  The files here are text-
based and can be edited with simple text editors.  The combined observation data file formats are covered 
below. 
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Observation PCG Data File Names 
 
The PCG data files created from OBS2PCG have a unique name convention to convey the data that was 
processed.  The following are examples: 
 
OCT2007S12U12.OBS211 
 
This file name breaks down as follows: 
OCT      - Month of file creation 
20          - Day of the month of data 
07          - 2-digit year (2007) 
S12        - Surface data for 12Z report 
U12       - Upper-Air data for 12Z report 
OBS      - Identifying as Observation Data 
211        - Grid ID which data is mapped to 
 
OCT2007S12.OBSPL 
 
Which breaks down as follows: 
 
OCT      - Month of file creation 
20          - Day of the month of data 
07          - 2-digit year (2007) 
S12        - Surface data for 12Z report 
OBS      - Identifying as Observation Data 
PL         - WAFS Octants which data is mapped to 
 
**Combined Observation Data File Names 
 
A directory called OBS is located off the GRIDDATA directory and holds the combined observation data in 
text format to be read for plotting surface and upper-air station models.  Using the previous PCG Data file 
name examples, if the OCT2007S12U12.OBS211 file is created in the GRIDDATA directory, there will also 
be a corresponding OCT2007S12U12.DAT file in the GRIDDATA\OBS directory. Also, if the 
OCT2007S12.OBSPL file is created, then OCT2007S12.DAT will be created in the GRIDDATA\OBS 
directory as well.  These files can be edited with a simple text editor to correct for unreasonable or incorrect 
data which causes the Barnes Analysis to plot incorrect data.  It is best, if incorrect data is found for a 
specific reporting station, to replace the bad value with value of -9999.00 which indicates MISSING data 
and will be ignored upon reanalysis.   
 
Surface Data -  
The following is an example surface data entry in the Combined Observation data file.  Notice that the data 
are in specific positions and must remain that way when edited if it is to be read properly. 
 
1111-22222-33333333-44444444-55555555-66666666-77777777-88888888-99999999 
KCLT 72314    35.22   -80.93   234.00    14.40    13.30    29.91  1012.88       
 
11111111-22222222-33333333-44444444-55555555-66666666-77777777-88888888 
 1012.88   320.00     2.57   985.09  1025.00     4.00     1.00     9.00 
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Line 1: 
1) KCLT    – ICAO Station ID (4 digits) 
2) 72314    -  WMO Station ID (5digits) 
3)  35.22   - Latitude (8 digits) 
4)  -80.93  - Longitude (8 digits) 
5)  234.00  – Elevation in meters (8 digits) 
6)  14.40   – Temperature Celsius (8 digits) 
7)  13.30   – Dew Point Celsius (8 digits) 
8)  29.91   – Altimeter in Inches (8 digits) 
9)  1012.88 – Altimeter in Millibars (8 digits) 
 
Line 2: 
1) 1012.88  – Sea Level Pressure in Millibars (8 digits) 
2) 320.00  - Wind Direction (8 digits) 
3)  2.57    - Wind Speed (Meters/Second) (8 digits) 
4)  985.09  - Station Pressure in Millibars (8 digits) 
5)  1025.00 – Station Pressure Trend/Change (encoded) (8 digits) 
6)  4.00    – Sky Cover (encoded) (8 digits) 
7)  1.00    – Past Weather (encoded) (8 digits) 
8)  9.00    – Present Weather (encoded) (8 digits) 
 
Upper-Air Data -  
The following is an example upper-air data entry in the Combined Observation data file. The data in this 
section are of a different format due to the volume of data need to be listed. The data are broken down into 
3 sections: Station ID/Location, TTAA (all data from mandatory levels), TTBB (Pressure levels of significant 
Temp/Dewpoint) and PPBB (Height levels of significant Wind Direction/Speed).   TTBB and PPBB entries 
do not have a fix number so there can be quite a few. Notice that the data are in specific positions and 
must remain that way when edited if it is to be read properly. 
 
KWAL 72402                                                                      
       37.93    -75.48     41.00                                                 
 TTAA                                                                            
          13                                                                     
 64.     1006.00    41.00    17.40    15.90   330.00     1.03                    
 32.     1000.00    64.00    19.00    14.10   345.00     2.06                    
 32.      925.00   734.00    16.20     7.20   320.00     4.63                    
 32.      850.00  1446.00    11.00     5.00   245.00     5.66                    
 32.      700.00  3051.00     5.40   -22.60   235.00    28.31                    
 32.      500.00  5720.00    -9.50   -25.50   220.00    41.70                    
 32.      400.00  7420.00   -17.10   -22.10   220.00    49.94                    
 32.      300.00  9520.00   -31.30   -55.30   230.00    53.02                    
 32.      250.00 10790.00   -40.30   -72.30   230.00    47.88                    
 32.      200.00 12270.00   -52.70   -80.70   225.00    48.39                    
 32.      150.00 14080.00   -63.50   -87.50   245.00    40.15                    
 32.      100.00 16540.00   -68.70   -90.70   240.00    16.47                    
  8.      306.00 -9999.00 -9999.00 -9999.00   225.00    53.54                    
 
 
 TTBB                                                                            
          3                                                                     
 64.     1006.00    41.00    17.40    15.90 -9999.00 -9999.00                    
  4.      996.00 -9999.00    19.80    12.80 -9999.00 -9999.00                    
  4.      967.00 -9999.00    19.40     9.40 -9999.00 -9999.00           
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 PPBB                                                     
          3                                                                     
 64.    -9999.00    41.00 -9999.00 -9999.00   330.00     1.03                    
  2.    -9999.00   304.80 -9999.00 -9999.00   345.00     5.15                    
  2.    -9999.00   609.60 -9999.00 -9999.00   325.00     5.66                    

 
Line 1:  Station ID (ICAO  & WMO)  
Line 2:  Lat, Lon, Elevation 
Line 3:  Section ID 
Line 4:  Number of entries in section   
Section Entries: 
 
111----22222222-33333333-44444444-55555555-66666666-77777777 
64.     1006.00    41.00    17.40    15.90   330.00     1.03     
                

1) 64.     -  Entry ID (3 digits) 
                       64 = Surface 
                       32 = Mandatory Pressure Level 
                         8 = Tropopause 
                         4 = Significant Temp/Dewpoint 
                         2 = Significant Wind Direction/Speed (M/S) 
 
2)  1006.00 - Pressure Level in Millibars (8 digits) 
3)  41.00   –  Pressure Height Trend/Change (encoded) (8 digits) 
4)  17.40   – Temperature Celsius (8 digits) 
5)  15.90   – Dew Point Celsius (8 digits) 
6) 330.00  - Wind Direction (8 digits) 
7)  1.03    - Wind Speed (Meters/Second) (8 digits) 
 
With the many additional observation data sources added in the BUFR capability, the resulting Obs Text 
data file, which is stored in the WINGRIDDS\GRIDDATA\OBS directory, has become much larger and new 
data separators are needed to separate the different observation types.  As before, the string “**** 99999 -
9999.99…” is written to show then end of surface obs & the start of RAOB observations.  At the end of any 
RAOB obs though, the new BUFR data is added – each observation type within its own section.  The next 
data separators are written as:  
 
“**** 11111 -9999.99 …”  QKSAT Surface Wind observations. 
“**** 22222 -9999.99 …”  NEXRAD VAD/Profiler observations. 
“**** 44444 -9999.99 …”  Satellite Wind observations. 
“**** 55555 -9999.99 …”  Satellite Sounding observations. 
 
The data collected & concatenated within the Obs Text data file are different, depending on the platform 
type which reported, thus the different data sections. Below are short examples of the different data types 
with short explanations of the contents for each. 
 
Surface QKSAT obs are listed on a single line with the standard “WNDSAT” label  observation ID, 
Lat/Lon, Wind Direction/Wind Speed entries as follows:  
 
**** 11111 -9999.99 -9999.99 -9999.99 -9999.99 -9999.99 -9999.99 -9999.99 
WNDSAT    0000001W    56.68  154.10   259.00     2.80 
WNDSAT    0000002W    56.69  154.32   270.00     3.00 
WNDSAT    0000003W    56.71  154.53   258.00     3.30 
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NEXRAD VAD/Profiler entries are in a similar format to the RAOB entries with Mandatory Level and 
Significant Level sections. However, Temperature & Dewpoint entries are always missing and only Wind 
Speed/Wind Direction are listed.  Each observation has a standard “VADPRF” label. 
 
 
**** 22222  -9999.99 -9999.99 -9999.99 -9999.99 -9999.99 -9999.99 -9999.99 
VADPRF 701      
      65.50   -144.68    259.00 
          12 
 64.      982.00   259.00 -9999.00 -9999.00 -9999.00 -9999.00 
 32.     1000.00 -9999.00 -9999.00 -9999.00 -9999.00 -9999.00 
 32.      925.00 -9999.00 -9999.00 -9999.00 -9999.00 -9999.00 
 32.      850.00 -9999.00 -9999.00 -9999.00    96.00     4.00 
 32.      700.00 -9999.00 -9999.00 -9999.00   108.00     1.00 
 32.      500.00 -9999.00 -9999.00 -9999.00   157.00     4.00 
 32.      400.00 -9999.00 -9999.00 -9999.00   190.00     9.00 
 32.      300.00 -9999.00 -9999.00 -9999.00   196.00    14.00 
 32.      250.00 -9999.00 -9999.00 -9999.00   195.00    15.00 
 32.      200.00 -9999.00 -9999.00 -9999.00   189.00     8.00 
 32.      150.00 -9999.00 -9999.00 -9999.00 -9999.00 -9999.00 
 32.      100.00 -9999.00 -9999.00 -9999.00 -9999.00 -9999.00 
   
          27 
 64.      982.00   259.00 -9999.00 -9999.00 -9999.00 -9999.00 
  4.      898.00  1009.00 -9999.00 -9999.00    35.00     1.50 
  4.      871.00  1259.00 -9999.00 -9999.00    85.00     2.60 
  4.      844.00  1509.00 -9999.00 -9999.00   100.00     5.50 
  4.      819.00  1759.00 -9999.00 -9999.00   106.00     5.80 
  4.      794.00  2009.00 -9999.00 -9999.00    97.00     4.80 
  4.      770.00  2259.00 -9999.00 -9999.00   119.00     2.80 
  4.      746.00  2509.00 -9999.00 -9999.00   128.00     2.90 
  4.      723.00  2759.00 -9999.00 -9999.00   130.00     1.30 
  4.      700.00  3009.00 -9999.00 -9999.00   108.00     1.00 
  4.      678.00  3259.00 -9999.00 -9999.00   104.00     1.40 
  4.      576.00  4509.00 -9999.00 -9999.00   112.00     2.10 
  4.      558.00  4759.00 -9999.00 -9999.00   138.00     2.20 
  4.      355.00  8009.00 -9999.00 -9999.00   206.00    11.70 
  4.      343.00  8259.00 -9999.00 -9999.00   200.00    11.90 
  4.      330.00  8509.00 -9999.00 -9999.00   198.00    12.50 
  4.      318.00  8759.00 -9999.00 -9999.00   199.00    14.10 
  4.      307.00  9009.00 -9999.00 -9999.00   198.00    14.70 
  4.      296.00  9259.00 -9999.00 -9999.00   195.00    15.10 
  4.      244.00 10509.00 -9999.00 -9999.00   196.00    15.20 
  4.      235.00 10759.00 -9999.00 -9999.00   198.00    13.00 
  4.      226.00 11009.00 -9999.00 -9999.00   197.00    13.50 
  4.      217.00 11259.00 -9999.00 -9999.00   197.00    12.60 
  4.      209.00 11509.00 -9999.00 -9999.00   199.00    10.60 
  4.      201.00 11759.00 -9999.00 -9999.00   191.00     9.00 
  4.      165.00 13009.00 -9999.00 -9999.00   153.00     5.20 
  4.      158.00 13259.00 -9999.00 -9999.00   159.00     4.40 
 
 
 



 
 197 

Next, Satellite Cloud-Track Winds have single-line entries the standard “SATWD” label  observation ID, 
Lat/Lon, Pressure Level, Height, Temperature, Dewpoint (always ‘Missing’), Wind Direction/Wind Speed 
entries as follows:  
 
 
**** 44444 -9999.99 -9999.99 -9999.99 -9999.99 -9999.99 -9999.99 -9999.99 
SATWD     C100002I    47.45   34.84   400.00  7184.37   -35.67 -9999.00   190.00    19.20 
SATWD     C100003I    47.40   34.65   400.00  7184.37   -35.27 -9999.00   190.00    20.40 
SATWD     C100004I    47.53   32.53   400.00  7184.37   -34.01 -9999.00   210.00    24.40 
SATWD     C100005I    47.23   31.63   300.00  9163.38   -45.81 -9999.00   214.00    24.30 
SATWD     C100006I    46.67   33.50   500.00  5567.28   -18.54 -9999.00   205.00    25.60 
 
Finally, Satellite Sounding section is formatted similar to the RAOB entries with Mandatory Level and 
Significant Level sections. However, Wind Speed/Wind Direction entries are always missing and only 
Temperature & Dewpoint are listed.  Each observation has a standard “SATSND” label and there is no 
differentiation between a polar satellite sounding obs and a geostationary satellite sounding obs. 
 
**** 55555 -9999.99 -9999.99 -9999.99 -9999.99 -9999.99 -9999.99 -9999.99 
SATSN  = 806561 
     -38.49     61.95      0.00 
          12 
 64.     1019.90     0.00    15.44 -9999.00 
 32.     1000.00    88.66    18.84    13.38 
 32.      925.00   298.70    14.94     9.78 
 32.      850.00   662.09    10.67     6.50 
 32.      700.00   880.94     3.09    -4.68 
 32.      500.00  1012.20   -12.34   -21.11 
 32.      400.00   532.43   -23.37   -32.04 
 32.      300.00  1074.77   -39.23   -45.48 
 32.      250.00   998.60  -132.86  -146.61 
 32.      200.00   894.78  -139.48  -152.00 
 32.      150.00  1117.29  -141.48  -153.63 
 32.      100.00   531.31  -143.60  -155.38 
          21 
 64.     1019.90     0.00    15.44 -9999.00 
  4.      950.00   436.55    16.35    10.96 
  4.      920.00   271.13    14.65     9.54 
  4.      780.00   709.17     6.81     0.60 
  4.      670.00   352.97     1.18    -7.83 
  4.      620.00   618.56    -2.56   -12.50 
  4.      570.00   661.58    -6.16   -16.52 
  4.      475.00   389.71   -14.86   -22.03 
  4.      430.00   745.15   -19.93   -26.90 
  4.      350.00   962.00   -30.71   -38.90 
  4.      135.00   405.54  -141.85  -153.94 
  4.      115.00   613.65  -142.98  -154.86 
  4.       85.00   616.63  -143.48  -155.27 
  4.       70.00   739.33  -142.66  -154.61 
  4.       60.00   592.35  -141.10  -153.32 
  4.       50.00   707.43  -140.10  -152.51 
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Editing Combined Observation Files  
If, after the observation data has been processed and you view the Observation PCG data file and you see 
suspicious data effects (contour ‘bulls-eyes’ to unrealistic values), you can use the STID command to find 
the station ID at or near the bulls-eye center or plot the station model(s) for that area to find the suspect 
station.  Then, open the combined observation data file with a text editor and search for that station ID with 
the suspect data value you saw.  WINGRIDDS now has its’ own text editor which will automatically open 
the current observation data file when executed. This editor is located within the ‘Convert Observation 
Data’ dialog.  See below: 
 
Once the station is found, and the suspect data value is seen, you can either enter a known good value or 
change the value to -9999.00 to denote “missing” data.  Then, from within the ‘Convert Observation Data’ 
dialog, select the same Time & Grid parameters which match the observation data file that was edited and 
also, select the ‘Reanalyze Edited Observation Data’ section or, from the Windows Command Line, run 
OBS2PCG utility with the same parameters and add the ‘R’ flag at the end.  The Combined Observation 
data file will be rescanned to perform a new Barnes Analysis on all of the data and a new PCG data file will 
replace the one with the bad data.  
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When an observation data file is opened within WINGRIDDS and it is determined the contents need to be 
edited follow these simple steps: 
 

1)  On the WINGRIDDS Plan display, locate the geographic area where the spurious data bulls-eye is 
located and note the parameter which is displayed (TEMP, HGHT, etc.) 
2)  Type the command ‘STID’ to show the reporting stations and find the station IDs in the area of the 
bad data. 
3)  Open the ‘Convert Observation Data’ dialog and click the ‘Edit’ button to open the Observation Data 
Editor (see below). 
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4)   Perform a search for the station ID. Refer to the WINGRIDDS documentation for the data layout of 
the observation data file. 
5)   Once the station is found and the data value is seen, either correct the data value or replace the 
value with the ‘missing’ value of -9999. 
6)   Save the file and, from within the ‘Convert Observation Data’ dialog, check the ‘Reanalyze’ button 
and reprocess the observation data with the corrected data value and the data bulls-eye should be 
gone. 

 
 
 
---Station Model Plot Color Control 
 
Below is an example of a surface station model plot: 
 

 
 
 
Surface Station Parameters: 
             1 SKY COVERAGE SYMBOL 
             2 TEMPERATURE 
             3 CURRENT WEATHER SYMBOL 
             4 PRESSURE 
             5 PRESSURE TREND 
             6 DEW POINT 
             7 PAST WEATHER SYMBOL 
             8 WIND 
 
 
 
 
Below is an example of an upper-air (500mb) station model plot: 
 

 
 
Upper-Air Station Parameters: 
             1 SKY COVERAGE SYMBOL (ALWAYS CLEAR) 
             2 TEMPERATURE 
             4 PRESSURE LEVEL HEIGHT 
             6 DEW POINT 
             8 WIND 
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Station parameter location: 
 
    8 
   2  4 
   3 1 5 
   6  7 
 
 
Each parameter can be assigned a unique color based on selection from within the ‘Properties’ dialog 
which is covered in 'Customizing WINGRIDDS’ section. 
 
 
Plotting Station Model Data 
The STWX command has been added for plotting station model data and it is only available to plot data 
when an observation data file is open.  Station plots are governed by the FULG and NRMG flags which 
control data thinning on the display. If normal data thinning is in effect through the use of the NRMG flag 
(default), the station model plotting routine filters the station model plot display so that there are no stations 
over-writing each other.  This is accomplished by selecting stations to plot by reading a new station list file 
called STNID-PRIME.DAT in the DATA directory.  This file is a list of the preferred stations to plot.  It is in 
the same format as STNID.DAT.  The plot routine reads down the list and plots any station which is in the 
field of view of the display and observation data is available to plot.  When the plot routine reads a station 
from the list and it finds data from that station to plot, it checks to see if the station to plot does not interfere 
with any previously plotted stations.  Priority is given on a first-come, first-served basis. After the stations in 
the STNID-PRIME.DAT have been processed, the plot routine reads through the rest of the observation 
data file to plot any remaining station in the field of view of the display checking they do not overlap any 
previous station plots. Therefore, the wider the areal coverage of the display, the fewer stations which will 
be plotted.  As the display is zoomed in, more stations will fill in the areas.  To allow all stations to be 
plotted, first select the FULG command. If the level selected is not SFC, the plot routine will search for any 
upper-air reports and plot the station model if data is found for that level.  A full list of station symbols are 
listed Appendix C. 
 
 
WINGRIDDS Observation Commands 
The following commands have been added to WINGRIDDS for the Observation data: 
 
STWX – Plots the station model on the screen for the level selected  
STID   -  Plots station ID information (WMO or ICAO) at the geographic location.  
 

    This Tool Bar button will be enabled whenever an observation data file is selected.  When pressed, it 
executes the ‘STWX’ command. 
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Diagnostic Functions – 
 
**- Diagnostic Functions - Background and Philosophy - 
The ability to calculate and combine a variety of quantities derived from the grid point data greatly 
enhances the diagnostic capabilities of the system.  The diagnostics are expressed in functional form, in 
that a function name is an ordered set of arguments, optionally enclosed in parentheses or 
brackets and separated by commas. 
 
As an illustration, advection is expressed as the function ADVT followed by a Scalar quantity and a Wind 
Type.  As such, the Temperature Advection field should be thought of as "ADVecTion of the TEMPerature 
by the Total WIND" and correspondingly requested using the sequence  ADVT(TEMP,WIND).  Similarly, 
the ageostrophic component of the Moisture Advection is expressed as "ADVecTion of the MIXing Ratio by 
the AGEOstropic wind" and requested by  ADVT(MIXR,AGEO). Here, both the Mixing Ratio and 
Ageostrophic Wind are derived automatically. 
 
Functional calls can also be chained together.  For example, Vorticity Advection is thought of as "Advection 
of the Vorticity of the Total Wind by the Total Wind."  As such, the functional request becomes 
ADVT[VORT(WIND),WIND].   
 
For clarity, either parentheses - ( and ) - or brackets - [ and ] - can, as an option, be used to group the 
function arguments. 
 
 
**- Available Diagnostic Functions -  
See the Appendix or the Command Help option for full listing of available commands. 
 
Some frequently used functions, include: 
 
SSUM [2 Scalars] > Calculates Scalar grid sum 
SAVR [2 Scalars] > Calculates Scalar grid average 
SDIF [2 Scalars] > Calculates Scalar grid difference 
STND [2 Scalars] > Calculates Scalar grid time tendency  
SMLT [2 Scalars] > Multiplies two Scalar fields 
SDVD [2 Scalars] > Divides two Scalar fields 
SADC [4 digit value] > Sum of Scalar & specified constant 
SSBC [4 digit value] > Difference of Scalar & specified constant 
SMLC [4 digit value] > Multiplies Scalar by specified constant 
SDVC [4 digit value] > Divides Scalar by specified constant 
INVS [Scalar] > Finds INVerSe of a Scalar 
INV1 [Scalar] > Finds INVerse of a Scalar with max. of 1 
ABSV [Scalar] > Calculates ABSolute Value of Scalar grid 
SINE [Scalar] > Calculates the SINE of Scalar grid (e.g., WDRC) 
COSN [Scalar] > Calculates the COSiNe of Scalar grid (e.g., WDRC) 
TNGT [Scalar] > Calculates the TaNGenT of Scalar grid (e.g., WDRC) 
SNEG![Scalar] > Finds the NEGative of a Scalar grid 
DSDX [Scalar] > Calculates X gradient of Scalar 
DSDY [Scalar] > Calculates Y gradient of Scalar 
MGRD [Scalar] > Magnitude of the GRaDient of a Scalar field 
GRAD [Scalar] > Finds the GRADient of a Scalar field 
NGRD [Scalar] > Finds the Negative GRaDient of a Scalar field 
MGRD [Scalar] > Magnitude of the GRaDient of a Scalar field 
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VADC [4 digit value] > Sum of Vector & specified constant 
VSBC [4 digit value] > Difference of Vector & specified constant 
VMLC [4 digit value] > Multiplies Vector by specified constant 
VDVC [4 digit value] > Divides Vector by specified constant 
VNEG![Vector] > Finds the NEGative of a Vector field 
VSUM [Vectors] > Calculates the Vector sum 
VAVR [Vectors] > Calculates the Vector average 
VDIF [Vectors] > Calculates the Vector difference 
VTND [Vectors] > Calculates the Vector time tendency 
VMLT [Vectors] > Multiplies two Vectors by components 
DOTP [Vectors] > Calculates the DOT Product of 2 Vectors 
CRSP [Vectors] > Calculates the CRoSs Product of two Vectors 
VDVD [Vectors] > Divides two Vectors by components 
 
VKNT [Vector] > Converts a Vector from m/s to KNoTs 
VMPH [Vector] > Converts a Vector from m/s to MPH 
VKPH [Vector] > Converts a Vector from m/s to KPH 
MAGN [Vector] > Calculates MAGNitude of a Vector 
SKNT [Scalar] > Converts a Scalar (e.g., WSPD) from m/s to KNOTs 
SMPH [Scalar] > Converts a Scalar (e.g., WSPD) from m/s to MPH 
SKPH [Scalar] > Converts a Scalar (e.g., WSPD) from m/s to KPH 
 
ISAL > Computes the Isallobaric Wind 
INAD > Computes the Inertial Advective Wind 
JCBN [2 Scalars] > Computes the Jacobian determinate of two scalars 
FRTG [wind Vector] > Computes Frontogenesis of the wind 
DFCP [vector] > Calculate the Deformation components  
                (X COMP, Y COMP) of any vector 
FVCT > Calculates F (Normal wind) Vectors 
QVCT > Calculates Q (Geostrophic wind) Vectors 
THTS > Calculates Saturated Theta-e 
 
ADVT [Scalar and Vector] > Calculates advection 
DVRG [Vector] > Calculates divergence 
FLUX [Scalar & Vector] > Produces a flux Vector 
SDVR [Scalar and Vector] > Calculates flux divergence 
RVRT [Vector] > Calculates relative vorticity 
VORT [Vector] > Calculates absolute vorticity 
IPVO > Isentropic Potential Vorticity calculated between LVL1 and LVL2
    when LVL1 and LVL2 are set to Theta levels. 
IPVA > Isentropic Potential Vorticity Advection calculated between LVL1
  and LVL2 when LVL1 and LVL2 are set to Theta levels. 
PVTA > Isobaric Potential Vorticity (Theta) calculated between LVL1 and
  LVL2 when LVL1 and LVL2 are set to pressure levels. 
 
PVTE > Isobaric Potential Vorticity (Theta-E) calculated between LVL1 
  and LVL2 when LVL1 and LVL2 are set to pressure levels. 
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PVTS > Isobaric Potential Vorticity (Theta-S) calculated between LVL1 
 and LVL2 when LVL1 and LVL2 are set to pressure levels. 
PVAA > Isobaric Potential Vorticity (Theta) Advection calculated between 
 LVL1 and LVL2 when LVL1 and LVL2 are set to pressure levels. 
PVEA > Isobaric Potential Vorticity (Theta-E) Advection calculated 
 between LVL1 and LVL2 when LVL1 and LVL2 are set to pressure 
 levels. 
PVSA > Isobaric Potential Vorticity (Theta-S) Advection calculated 
 between LVL1 and LVL2 when LVL1 and LVL2 are set to pressure 
 levels. 
PVN  > potential vorticity (m**2/kg/s) 
PVU  > potential vorticity (10**-6*K*m**2/kg/s) 
 
SPENT > specific entropy (J/K/kg) 
 
SMTH > Applies a binomial smoother to the active Scalar gridded data 
VSMT > Applies a binomial smoother to the active Vector gridded data 
 
ZPOS > Sets all positive values to zero 
ZNEG > Sets all negative values to zero 
RLTN [4 digit value] > Replaces values Less ThaN with that value 
RGTN [4 digit value] > Replaces values Greater ThaN with value 
 
**- Diagnostic Functions - Cross Section Specific: 
XREL [Vector] > Rotates Vector from earth to cross sector relative 
TANG [Vector] > Finds cross-section relative tangential component 
VTNG [Vector] > Plots cross-section relative tangential component 
VCRC [Vector] > Plots VTNG & VVEL 
VCR2 [Vector] > Plots VTNG & VVEL scaled by 2 
VCR5 [Vector] > Plots VTNG & VVEL scaled by 5 
NORM [Vector] > Finds cross-section relative normal component 
VNRM [Vector] > Plots cross-section relative normal component 
 
 
**- Examples of Diagnostic Functions -  
Some sample diagnostic command sequences include: 
 
MAGN(WIND)- will calculate and display isotachs of the MAGNitude of the  
                   total WIND. 
SDIF(MIXR,SMIX) -  will produce the difference between the true and 
 Saturation MIXing Ratios --- the saturation deficit. 
ADVT[TEMP,WIND] -  will produce the TEMPerature ADVecTion field using 
 the total WIND, - Note brackets/parends are interchangeable. 
ADVT TEMP GEOS  -  will produce the TEMPerature ADVecTion field using 
 the GEOStrophic wind, - Note brackets can be omitted 
 
ADVT(PRES,WIND) S982 - will set the default level to the bottom sigma 
 level of the NGM and calculate the ADVecTion of PRESsure on a   
 Sigma surface by the WIND, a measure of the orographic vertical 
 motion 



 
 205 

DVRG[WIND]      -  will calculate and display the DiVeRGence of the 
 total WIND, 
SDVR(MIXR,WIND) -  will contour the Scalar flux DiVeRgence of the MIXing 
  Ratio using the total WIND, etc. 
 
 
**- Shorthand specifications and Commonly Used Diagnostic Functions -  
For simplicity, frequently used sequences of commands can be grouped together 
and given a 4 character ALIAS name.  These alias names can be used in exactly 
the same fashion as all other WINGRIDDS commands, with the difference that they 
are completely user defined in the file  USER\ALIAS.DAT.  
 
Some predefined systems aliased diagnostic commands include, 
 
WSPD > Generates isotachs for the Total wind 
WVRT > Generates vorticity of the Total wind 
GVRT > Generates vorticity of the Geostrophic wind 
 
THCK |TKNS!| > Generates Thickness fields on levels defines by 
LVL1/LVL2 
TWND |THWN!| > Generates Thermal Wind on levels defines by 
LVL1/LVL2 
 

TADV > Generates Temperature Advection using the Total wind 
QADV > Generates Mixing Ratio Advection using the Total wind 
 
 
 
**- Repeating previous commands 
A list of the previous 21 commands input from the keyboard is given by entering the command CMDS.  
This command ERASES the screen.  Individual commands can be examined without erasing the screen by 
using the command CMD#,  where # is the order number of the previous command, e.g., CMD2 will list the 
2nd previous command.  For commands 10 through 21, the letters A through L are used. 
 
A previous command can be repeated by using the command  RPT#,  where again # refers to the order 
number of the previous command.  The command results can be overlaid on the existing graphics by 
including an  &  after the command.  As such,  RPTB&  will overlay the 11th previous command on the 
existing graphics. 
 
A historical record of all commands used in a particular session is stored in the file COMMAND.OUT.  
Reference to particularly complicated commands from this file can simplify writing the command files to be 
described next. 
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**-Calculating Convection and Shear Parameters 
WINGRIDDS can now directly calculate numerous convection and wind shear parameters.  WINGRIDDS 
also has new flag commands to control the way the convection and shear parameters are calculated.  
Below are the new control flags for convection: 
 
 
  VTMP – Virtual Temperature Correction 

All convection parameters are calculated without virtual 
temperature correction by default.  This flag enables 
that correction. 

  SBSI – Surface-Based Lifted Parcel Selected 
  MLSI – Mean-Layer Lifted Parcel Selected 
  MUSI – Most Unstable Lifted Parcel Selected 
  USSI – User-Selected Lifted Parcel Selected 
 
If no Lifted Parcel method is selected, Surface-Based Lifted Parcel is default. 
 
Examples –  
 
To calculate CAPE with virtual temperature correction and using the Mean-Layer Lifted Parcel, enter: 
   CPOS VTMP MLSI 
 
WINGRIDDS can also calculate various wind shear and supercell wind-motion parameters.  There is a new 
control flag for shear calculations: 
 
   **KM – Defines the Lower/Upper bounding levels in Kilometers 
 The first * (0-9) defines the lower level to use and the second * (0-9) defines the     
            upper level to use.  Therefore, a command 14KM defines the 1km to 4km layer. 
 
The wind shear Vector/Scalar diagnostics can be calculated on Pressure, Sigma, Potenial Vorticity, 
Isentropic or Height layers defined with the SLYR command or with the **KM flag: 
 
Examples –  
 
To calculate the total shear between the isentropic layers I320 and I350, enter: 
TSHR & SLYR I320 I350 
 
To calculate the right-moving storm-relative helicity through the 0-3km layer, enter: 
SRHR 03KM 
 
***************************************************************************************** 
******* NOTICE – NOTICE – NOTICE – NOTICE – NOTICE – NOTICE ******** 
***************************************************************************************** 
 
The calculations of shear and convection parameters may not exactly match what other programs calculate 
due to the variations in near surface/boundary-layer data used to calculate the parameters.  Some 
calculations are very sensitive to the lower layer data.  However, the results you get with WINGRIDDS 
should be very close to other programs’ calculations.  Remember – the accuracy of the product is only as 
good as the data used in the calculation.  The less vertical data which is available then the less accurate 
the solution will be. 
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**- COMMAND (MACRO) FILES - 
A command file is simply a sequence of command lines to be executed in series, and can be used as 
shorthand notations for frequently used or particularly complicated command sequences or to produce 
pre-defined products. 
 
Pre-specified sequences of command lines can be written into an ASCII file using any word processor.  
The Command File can be given any 10 alphanumeric NAME and must be ended with the qualifier ".CMD".  
To execute the Command File, type the file NAME at the BEGINNING of a command line, followed 
IMMEDIATELY by a period.  The requested command lines will be displayed in sequence, with a 
prompt to press  [Enter]  displayed between command lines. 
 
Loops can also be set up by including the word LOOP alone at the beginning of any line of the Command 
File.  Loops are ended by including the command line ENDL.  User prompts at the end of each command 
line are NOT given while in LOOP mode. Pauses between looped command lines can be included by 
adding the commands 1SEC, 3SEC, 5SEC, 7SEC, or 9SEC, depending on the number of seconds 
desired. 
       
Annotation can also be added to any line on the screen using the TXT# command.  For example,  'TXT3  
This is line 3' will write the text on the third line of the screen. 
 
**- Sample  COMMAND FILE - 
A sample Command File containing - 
 
WIND&TEMP CIN5&HGHT CI60 SLVL 850 F00  
LOOP 
WIND&TEMP CIN5&HGHT CI60 F12  
WIND&TEMP CIN5&HGHT CI60 F24 5SEC 
WIND&TEMP CIN5&HGHT CI60 F36 5SEC 
WIND&TEMP CIN5&HGHT CI60 F48 5SEC 
ENDL 
 
  -  will display the initial 850 mb heights, temperatures and winds, request the user to press  [Enter], and 
then display a loop of the 12, 24, 36, and 48 h forecasts, pausing 5 seconds between each completed 
graphic. 
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Diagnostic Functions - Advanced Explanations 
 
**- VERTICAL LEVEL COMMANDS 
Setting the vertical levels is quite easy within WINGRIDDS. For example, to set the vertical level to 500 
millibars, simply type in 500 < return >.  For isentropic surfaces (see MTHT), precede the isentropic surface 
by the letter "I", as in I303.  For sigma level surfaces (as found in the NGM gridded data), precede the 
midpoint pressure with the letter "S", as in S982. 
 
####           (NO OUTPUT) The numeric signs #### or ### are a 3 or 4 
###             digit integer that represent the vertical level. See SLVL. 
 
SLVL [vertical level] (NO-OUTPUT) 
This optional command sets the vertical level of data to be examined. The actual numerical value (see 
"####"; e.g., "700") can be entered directly or (optionally) the numeric vertical level may be preceded by 
"SLVL" (e.g. "SLVL 500"). A vertical level can be one of the following: 
 
1)        an isobaric (constant pressure) level (e.g., 850); 
2)        an isentropic level (e.g., I298); or 
3)        a model sigma level (e.g., S982); or 
4)        a boundary layer/10 meter anemometer ht. (e.g., M10); or 
5)        a constant height level in Meters or Feet (in hundreds) (e.g., H100); or 
6)        a Potential Vorticity (PV) level (e.g., PV12) 
 
To change the vertical level, enter a vertical level from one of the valid ones shown in the gridded display 
listing (see LIST). For example, entering "700" sets the vertical level to 700 mb. The current vertical level is 
displayed whenever LIST is invoked and can be found immediately below the command line. The default 
flag variable LEVL contains the current vertical level and is reset whenever the vertical level is changed. 
The default value for LEVL is initially set from the initialization file INITGRID.SPC. 
 
The use of the command word SLVL is optional. Earlier versions of WINGRIDDS required the SLVL 
command. A valid vertical level must be entered or data will not display. 
 
If you type in the wrong value of SLVL (e.g., you type in 860 instead of 850 mb), WINGRIDDS still accepts 
the bogus level, and the LIST command will show it - but nothing will ever be displayed since there are no 
data for that level. This is not an oversight in software design, but a way to allow for new vertical levels to 
be added at a future date without having to update the software. For example, at some later date, gridded 
data may become available for the 925 mb level. Hence, all you would need to type in is "925" and you 
would be ready to display the data for that level. The same rationale also applies for setting the forecast 
hour (F27 is as valid a forecast hour as F24). 
 
The NCEP GFS model had an update to V16. One of the changes was to extend the pressure levels up to 
0.01mb. Since WINGRIDDS treats pressure levels as whole integers (no decimal), the fractional pressure 
levels have to be represented in a different way. NGRB2PCG32 & WINGRIDDS will represent the 
fractional pressure levels with a leading ‘0’ (zero). For example: 
 
SLVL 001 = 0.01 mb  
SLVL 002 = 0.02 mb  
SLVL 01 = 0.1 mb  
SLVL 07 = 0.7 mb  
SLVL 3 = 3 mb  
 
etc. 
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VERTICAL LEVEL COMMANDS (cont.) 
 
B### (NO OUTPUT)  
Sets the vertical level either to the 10-meter anemometer height (M10) or to some other boundary layer 
level. The default flag variable LEVL is set accordingly. 
 
LVL1 (NO OUTPUT)  
LYR1     
Temporarily sets the vertical level to obtain data from bottom of layer for variables specified to the left. 
LVL1 is a system flag variable for the lower layer. For example, if the layer variables as shown on the 
WINGRIDDS variable line are "1000/500', then the  command "WIND LVL2" will plot the total winds at 500 
mb. See also SLYR,   
 
LVL2  (NO OUTPUT)  
Temporarily sets the vertical level to obtain LYR2 data from bottom of layer for variables specified to the 
left. LVL2 is a system flag variable for the lower layer. For example, if the layer variables as shown on the 
WINGRIDDS variable line are "S982/S896", then the command "WIND LVL1" will plot the total winds for 
the sigma three layer.  See also SLYR, LVL1. 
 
LEVL   (NO OUTPUT)  
Overrides the LVL1 and LVL2 variables and gets data from original level. See also LVL1, LVL2, SLYR. 
 
MMSL   (NO OUTPUT)  
Sets the vertical level to mean sea level (MSL) pressure for the NMC Rapid Update Cycle (RUC) hourly 
surface analysis using the same reduction-to-sea level technique as used in the Forecast Systems 
Laboratory (FSL) version of the Mesoscale Analysis and Prediction System (MAPS). See NMSL 
 
NMSL   (NO OUTPUT)  
Sets the vertical level to mean sea level (MSL) pressure for the NMC Rapid Update Cycle (RUC) hourly 
surface analysis using the same reduction-to-sea level technique as used by NMC Automation Division. 
 See also MMSL 
 
S982   (NO OUTPUT)  
Sets the vertical level to the sigma one level. This is the lowest sigma surface. 
 
S943   (NO OUTPUT)  
Sets the vertical level to the sigma two level. 
 
S896   (NO OUTPUT)  
Sets the vertical level to the sigma three level. 
 
S784   (NO OUTPUT)  
Sets the vertical level to the sigma five level. 
 
S###   (NO OUTPUT)  
Sets the level to the sigma level centered at ### mb. Current valid sigma level for the NGM include: S982, 
S943, S896, S784, which represent the bottom, second, third, and fifth sigma levels, respectively. The 
default flag variable LEVL is set accordingly. 
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I###   (NO OUTPUT)  
Sets the vertical level to ### degrees Kelvin isentropic surface. This assumes the isentropic data for that 
level were already created using either the MTHT command or data from upper level MAPS output. For 
example, entering the command I303 causes all subsequent data requests to use data interpolated to the 
303K isentropic surface. The default flag variable LEVL is set accordingly. 
 
PV##   (NO OUTPUT)  
Sets the vertical level to ## Potential Vorticity Units surface. The middle decimal is not shown. For 
example, entering the command PV12 causes all subsequent data requests to use data interpolated to the 
1.2 PVU surface. The default flag variable LEVL is set accordingly. 
 
P+## / P-##   (NO OUTPUT)  
Sets the vertical level to ## Potential Vorticity level above/below the Tropopause (in feet). This is a 2 digit 
number divided by 100. For example, entering the command P+05 causes all subsequent data requests to 
use data interpolated to the 500ft above the Tropopause surface and entering the command P-15 causes 
all subsequent data requests to use data interpolated to the 1500ft below the Tropopause surface. The 
default flag variable LEVL is set accordingly. 
 
SLYR [LVL1 LVL2] (NO OUTPUT)  
Sets the lower and upper layers for use in data selection. LVL1 is a system flag variable for the lower layer 
while LVL2 is the variable for the upper level. For example, the sequence SLYR 1000 500 will cause any of 
the WINGRIDDS commands that perform layer calculations (e.g., see LDIF, LSUM, LAVE, etc.) to set 
LVL1 equal to 1000 mb as the lower surface and 500 mb (= LVL2) as the upper surface. 
 
 
The vertical levels can not only be pressure levels, but also isentropic or sigma level data, or a combination 
of each. For instance, the command SLYR S982 500 sets the bottom level (LVL1) to the bottom sigma 
level surface (S982) while setting the upper level (LVL2) to 500 mb. 
 
 
**- COMMANDS TO ALTER CONTOUR INTERVALS  
 
By default, WINGRIDDS will select a contour interval automatically for each field displayed. For example, 
when you want a depiction of temperatures, you type TEMP. WINGRIDDS then determines what appears 
to be an "eye-pleasing" number of contours for the range of data over the given display area. An "eye-
pleasing" number of contours would be between about six and twelve contours. A user can optionally 
override the WINGRIDDS choice of contour interval by following the command with a specific contour 
interval, e.g., TEMP CIN2 contours isotherms every two degrees C. 
 
In addition, the WINGRIDDS command line interpreter (the software that processes commands), is quite 
flexible. The command processor looks for commands beginning with the letters "CIN" or "CI" and  a 
number as a contour interval. Examples are "CIN6", "CI10", "CI50", etc., which correspond to contour 
intervals of 6, 10, and 50 units, respectively. In addition, the processor uses a template of the form C#+# or 
G#-# when interpreting what contour interval command is given. With this in mind, contours intervals in the 
range of 9 x 10 * to 9 x 10 *9 are possible. For example, if a contour interval of every 0.01 is desired, one 
simply types in "C1-1"; if an interval of 0.05 is needed, then type in "C5-2". With a little practice, specifying 
contours becomes easy. 
 
There commands to allow the user to interactively set the contour interval (see CINT). The maximum 
number of contours can be changed (see CNUM). A specific contour interval can be retained for all 
subsequent plots (see CISV) or until the command to resume automatic program selection of contours is 
given (CINX). 
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COMMANDS TO ALTER CONTOUR INTERVALS (cont.) 
 
NOTE: specifying contour intervals having two significant digits (e.g., CI25, CI33, or CI75) will NOT 
produce the desired results of contouring every 25, 33 or 75 units. However, when two digits are specified, 
but with only one significant digit (e.g., CI20, CI30, etc.), the desired results are obtained. 
 
The following are the contour interval commands: 
 
CNUM [Integer] 
Changes the maximum number of contours to display. The default maximum number of contours is 50. 
 
 
CINT 
Displays the maximum and minimum of preceded by a particular data field and then requests user input in 
setting the contour interval. For example, "DVRG WIND CINT prompts the user: 
 
 "CONTOUR INTERVAL =  OE+00 - INPUT NEW VALUE - " 
 
One can enter the new value in one of two ways: 
1)       type in a positive interval number directly, e.g., 2, 10, .05, 100, etc. 
2)       type the interval number in an "E-format", i.e., scientific exponent notation; 1E5, 1E+5, 5E-4, etc. 
 
CISV 
Sets mode where specified contour interval is retained for future plots. The contour interval is canceled by 
issuance of the command CINX. 
 
CINX 
Returns to mode in which program selects contour interval for each plot. See also CISV, CINT. 
 
CIN#  
Sets contour internal to # units. "#" can be in the range 1 to 9, inclusive. 
 
C1N1   
Sets contour interval to 1 unit. 
 
CIN# 
CIN2 Sets contour interval to 2 units. See CIN#. 
 
Cl#0   
Sets contour interval to # of tens of units. "#' can be in the range 1 to 9, inclusive. 
 
CI10   
Sets contour interval to every 10 units. See Cl#0.  
 
CI20   
Sets contour interval to 20 units. See Cl#0. 
 
C#00  
Sets contour interval to # hundreds of units. "#" can be in the range 1 to 9, inclusive. 
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C100  
Sets contour interval to 100 units. See C#00.  
 
C200  
Sets contour interval to 200 units. See C#00. 
 
C#+#   
Sets contour interval to # x 10** units. For example, C2+3 translates into a contour interval of 2 x 10+3 = 
2000 units. 
 
C1+3   
Sets contour interval to 1000 units or 10+3. See C#+#. 
 
C2+3    
Sets contour interval to 2000 units or 2 x 10*3. See C#+#. 
 
Cl.#    
Sets contour interval to tenths units (0.#) or # x 10 v See C#-1 
 
CI.1   
C1-1 
Sets contour interval to 0.1 units. See C#.1 and Cl.#.  
 
CI.2    
C2-1 
Sets contour interval to 0.2 units. See Cl.# and C#-1.  
 
 
C#-#   
Sets contour interval to # x 10^ units. For example, C2-3 translates into a contour interval of 2 x 10^ = .002 
units. 
 
C2-2   
Sets contour interval to every .02 units. See C#-#. C5-3 Sets contour interval to .005 units. See C#-#. 
 
 
 
**- COMMANDS TO ALTER FORECAST TIME 
 
WINGRIDDS lets you easily change forecast hours (see, e.g., FOO, F12, etc.). Also, you can specify a 
default pair of forecast hours that allows you to compute time differences of some parameter (see SFHS). 
Lastly, you can obtain a grid from one (or both) of the forecast hour pairs without changing the default 
forecast time pair values (see FHR1 and FHR2). 
 
F-1 or ANAL 
Sets the default forecast hour to use the 00-hour grids (i.e., the "analyzed" model grids from the objective 
analysis routine before the grids have been subject to the model's initialization process). 
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COMMANDS TO ALTER FORECAST TIME (cont.) 
 
FOO or INIT 
Sets the default forecast hour to use the 00-hour (or initialized) grids. In most cases the "analyzed" (see F-
1) and initialized data grids are nearly identical. 
 
F12      
Sets the default forecast hour to use the 12-hour grids. 
 
F24      
Sets the default forecast hour to use the 24-hour grids. 
 
F36      
Sets the default forecast hour to use the 36-hour grids. 
 
F48      
Sets the default forecast hour to use the 48-hour grids. 
 
F##      
F###     
Interprets the '###" or "##" to be a number whose value is set to the default forecast hour. For example, 
F18, sets the default forecast hour to use the 18-hour grids, while the command F120 sets the forecast 
hour to use the 120-hour grids. The numeric value of ## or ### can be negative, e.g., F-3 sets the default 
forecast hour to use data grids 3 hours prior to the model initialization (see F-6, F-6). 
 
 
NOTE: WINGRIDDS allows the use to set the default forecast hour to practically anything. However, the 
data grids are only available at set forecast hours (usually the main synoptic times). So setting the default 
forecast hour to say, F26, is permissible, but there is likely no data available at this forecast hour. The data 
grids available at a specified forecast hour can be seen with LIST. 
 
GUES or equivalently F-3 
F-3    Sets the default forecast hour to use "first-guess" grids used in developing the model's initial analysis 
grids.  Usually, this is a grid  valid 3-hours prior to the model analysis valid time. 
 
GES6 or equivalents F-6 
F-6     Sets the default forecast hour to use "first-guess" grids valid 6-hours prior to the model analysis valid 
time. 
 
SFHS [forecast_hr1 forecast_hr2] or  
FHRS 
 Sets the default forecast hour pair. The forecast hour pair is entered using either integer numbers 
(e.g., 12, 48, 06,120) or mnemonics (e.g.,  INIT). SFHS requires the user to type in the two forecast hours 
immediately to the right (e.g., SFHS INIT 24 sets the first forecast hour (FHR1) to use the 00-hour grids 
and the second forecast hour (FHR2) to use the 24-hour grids. In this case, you could compute the 24-hour 
change in some quantity, say, temperature at a given vertical level by typing the commands: TEMP TDIF 
which results in a difference field of temperatures between the initial and 24-hour forecasts. You can 
specify the forecast hours in any order (hence, SFHS 24 12 is valid). 
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COMMANDS TO ALTER FORECAST TIME (cont.) 
 
The values of the FHR1 and FHR2 can be found on the default parameters lines immediately below the 
command line. Remember to use valid forecast hours (i.e., hours that the LIST command shows you 
actually have valid data). The FHRS command does the same thing as SFHS. See also TDIF. 
 
SFHR #### FHOR 
Sets the forecast hour system variable. The user can either enter an up to 4-character integer forecast hour 
immediately to the right of SFHR or the user is prompted for a number to input to set the default forecast 
hour. Number must be an integer (in other words, you cannot use mnemonics like "INIT or a program error 
occurs). SFHR and FHOR perform the same function. 
 
 
FHR1 
Gets data for the command(s) immediately to its left from first time of the "FHRS" time pair. The command 
string "SDIF TEMP TEMP FHR1" will subtract the temperature for the current forecast hour from the 
temperature at the "FHR1" forecast hour. See also FHR2, SFHS, FHRS. 
 
FHR2 Gets data for command(s) immediately to its left from first time of the "FHRS" time pair.   See also 
FHR2, SFHS, FHRS. 
 
FH+      
Steps ahead the forecast hour to the next available forecast hour in the data set. 
 
FH-      
Steps back the forecast hour to the previous available forecast hour in the data set. 
 
 
 
**- COMMANDS TO DISPLAY GRIDDED DATA 
 
In general, most commands issued in WINGRIDDS will all display data from the given vertical level and 
forecast hour as noted by the LEVEL and FHOUR flags in the data listing (see LIST). The data displayed 
can be represented in one of three ways: 
 
1)        contours of a scalar field (e.g. temperature, mixing ration, vorticity); 
2)        a vector representation (e.g., wind, gradient of temperature) either as  an arrow or a wind barb; and 
3)        a numeric data representation of the data at a grid point (see DATA, DDFF, etc.). 
 
The commands below can be combined with other diagnostic functions. For example, "SDIF TEMP DWPT" 
computes the difference of the dry bulb temperature minus the dew point temperature at a given level and 
forecast hour and displays this difference as a contoured field (i.e., contours of dew point depression). 
 
**- PRESSURE and GEOPOTENTIAL HEIGHT Commands 
 
PRES (SCALAR)  
Calculates pressure from available data fields. For example, if the vertical level is set to "S982" (i.e., the 
lowest sigma level in the NGM model), then typing "PRES" will, in essence, display a map of contoured 
terrain elevation, but in units of pressure (mb). This is because the NGM uses the terrain-following sigma 
coordinate system. The "982" for the first (lowest) sigma level refers to the pressure at the midpoint of the 
lowest sigma level assuming a surface pressure of exactly 1000 mb. 
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PMSL (SCALAR)  
Contours Mean Sea Level (MSL) Pressure (in units of millibars). 
 
HGHT (SCALAR)  
Displays contours of geopotential height On meters) for the specified vertical level and forecast hour. For 
example, if the vertical level is 850 mb and the forecast hour is set to 12 hours, then entering the command 
HGHT will draw the 850 mb, 12-hour forecast contoured geopotential height field. It is invalid to type HGHT 
when the vertical level is set to either isentropic or sigma level coordinates. 
 
 
 
 
**- TEMPERATURE Commands 
 
TEMP (SCALAR) 
TMPC            
Displays contours of model forecast dry bulb temperatures in degrees Celsius (deg C) at a specified 
forecast hour and vertical level. The command TMPC does the same thing as TEMP. 
 
TMPF (SCALAR)  
Displays contours of model forecast temperatures in degrees Fahrenheit (deg F) at a specified forecast 
hour and vertical level. 
 
TMPK (SCALAR)  
TMPA            
Displays contours of model temperatures in Kelvin (K) at a given forecast hour and vertical level. The 
command TMPA does the same thing as TMPK. 
 
THTA (SCALAR)  
Displays contours of potential temperature (customarily denoted by the Greek letter "theta") in Kelvin (K) at 
the specified forecast hour and vertical level. Potential temperature, as computed from Poisson's equation, 
is defined as the temperature which a parcel of dry air at some specified pressure and temperature would 
have if it were expanded (or compressed) dry adiabatically to a pressure of 1000 mb. 
 
THTE (SCALAR)  
Displays contours of equivalent potential temperature (denoted by the Greek letter "theta" with an E 
subscript or simply called Theta-E) at the specified forecast hour and vertical level in Kelvin (K). Equivalent 
potential temperature is defined as the temperature an air parcel would have if all its latent heat were 
converted to sensible heat by means of a pseudo-adiabatic expansion to low pressure and temperature  a 
dry adiabatic compression down to 1000 mb. Hence, a field of Theta-E gives information on both the 
thermodynamic and moisture content at a given level. 
 
 
**- WIND COMMANDS 
 
Every WINGRIDDS gridded data file contains model forecast wind data broken down into U (north-south) 
and V (east-west) wind components.  WINGRIDDS follows the conventional meteorological nomenclature 
for plotting the U- and V- components: 
 
U is positive if the wind has a westerly component;  
U is negative if the wind has an easterly component; 
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V is positive if the wind has a southerly component;  
V is negative if the wind has a northerly component. 
 
The U-component of the total wind is normally displayed The U- and V-wind components can be displayed 
automatically as vectors centered at each model grid point (see WIND). A vector quantity has both 
magnitude and direction. A scalar quantity (like temperature) has only magnitude. Any vector quantity 
(including not only winds but, e.g., the gradient of a scalar) can be displayed at each grid point using either 
1) an arrow format (see AROW),  2) conventional wind barb format (see BARB) or 3) streamline format 
(see STRM). 
 
A total of three different wind components can be displayed. They are: 1) the total model forecast wind 
(WIND), 2) the geostrophic (GEOS) wind, and 3) the ageostrophic (AGEO) wind components. The "total 
wind" is the vector sum of the geostrophic and ageostrophic winds. The geostrophic wind obeys the 
geostrophic-wind relationship which can be found in any dynamics textbook. To wit, the geostrophic wind 
blows parallel to isobars on a constant height surface; to geopotenial height contours on a constant-
pressure surface, and to isopleths of the Montgomery streamfunction on an isentropic surface. 
 
Units of wind speed for both the arrow and wind barb formats can be plotted using one of: meters/second, 
knots, miles/hour, or kilometers/hour (see WIND, WKNT, WMPH, and WKPH, respectively). If winds are 
plotted using the wind barb format, then the barbs points in the direction FROM which the wind is blowing. 
Each full stem represents ten units while each half stem denotes the fives unit. For example, any 25 unit 
wind speed (whether it be in knots, meters/sec, etc.) would always have two full stems and one half stem. If 
winds are plotted as arrows, then the arrow points in the direction TO which the wind is blowing. The length 
of the wind arrow is, by default, scaled so that the highest wind speed for the display domain spans one 
grid increment. 
 
The individual U-and V-wind components can be displayed as contoured fields (see UGRD, VGRD and 
XCMP, YCMP). The wind direction over the display domain can be contoured (see DRCT - an isogonal 
analysis) as well as wind speeds - isotachs (see SPED, SPKT, SPML, SPKM, WSPD). A packed digital 
presentation of wind direction and speed is available (see DATA, DATT, DATE, DDFF). 
 
Wind vectors in WINGRIDDS are displayed using the standard meteorological wind direction. This direction 
is the compass heading from which the wind is blowing. In a meteorological coordinate system, a south 
wind vector points north with a compass heading of 180 degrees. If a standard cartesian X-Y coordinate 
system is used (with the positive X abscissa axis increasing to the right, and the positive Y ordinate axis 
increasing up), the meteorological wind direction is the angle measured clockwise from the -Y axis. The 
mathematical wind direction is the angle measured counterclockwise from the positive X axis. To obtain the 
mathematical wind direction, simply subtract the meteorological wind direction from 270 degrees. (from p. 
19, Bluestein, 1992 book)  
 
 
The following commands are flags to show how the wind is displayed. 
 
AROW  
Sets the default format for plotting vectors to arrows. All subsequent displays of any vector quantity 
(including winds) will be depicted using the arrow format. 
 
BARB 
Sets the default format for plotting vectors to wind barbs. All subsequent 
displays of a vector quantity (not just winds) will be depicted using the wind barb format. 
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WIND COMMANDS (cont.) 
 
STRM 
Sets the default format for plotting vectors to streamlines. All subsequent 
displays of a vector quantity (not just winds) will be depicted using the wind streamline format. 
 
The following commands for displaying and manipulating winds area given in alphabetical order. 
 
AGEO [VECTOR] 
Displays a computed field of ageostrophic winds derived from the total U- and V-wind components. The 
ageostrophic wind depicted in WINGRIDDS is the vector difference between the total (WIND) and 
geostrophic (GEOS) wind components. That is, you could produce a field of ageostrophic wind vectors by 
entering  
 
"VDIF WIND GEOS". 
 
BKNT [VECTOR] 
Displays the total wind in wind barb format using units of knots (kts) and sets subsequent display of vectors 
in wind barb format. 
 
BKPH [VECTOR] 
Displays the total wind in wind barb format using units of kilometers per hour (km/hr) and sets subsequent 
display of vectors in wind barb format. 
 
BMPH [VECTOR] 
Displays the total wind in wind barb format using units of miles per hour (mph) and sets subsequent display 
of vectors in wind barb format. 
 
BWND [VECTOR] 
Displays the total wind in wind barb format using units of meters/second (m/s) and sets subsequent display 
of vectors in wind barb format. WNDB does the same thing. 
 
DDDD [VECTOR] 
(NUMERIC) Displays digital values at every gridpoint of the direction On degrees) of any vector. Same as 
issuing the commands "DATA DRCT [vector]". See also DRCT. 
 
DDFF [VECTOR] 
(NUMERIC) Displays digital values of any vector (typically a wind vector) in a packed format of 4 
characters. If "XXYY" represents the packed format, then XX represents the direction of the vector in tens 
of degrees, while YY represents the magnitude of the vector in whatever units are displayed. The 
command line DDFF WIND displays a grid of 4 character groups (e.g., 1209) at every model grid point 
within the display domain. The example group "1209" is decoded as a wind direction of 120 degrees at 9 
m/s. 
 
DRCT [VECTOR] 
(SCALAR) Contours values of the direction of a vector (typically a wind vector-but .any vector quantity can 
be used) from 0 to 360 degrees in a meteorological sense (see introduction to winds). If "vector" is a wind 
vector, then the contours are equivalent to isogons. i.e. lines of constant wind direction. See also DDDD. 
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WIND COMMANDS (cont.) 
 
The DRCT command also acts as the Fortran equivalent to an "ATAN2" command, which computes the 
tangent angle of two linear components (rise over run). Hence, the command: "DRCT VGRD UGRD" takes 
the tangent of the u- and v-wind components and displays contours of meteorological degrees. 
 
The "vector" used for DRCT need not be the wind but could be any x- and y-type quantity. When used as 
an "ATAN2" command, the y-component is given immediately to the right of DRCT, followed next by the x-
component. 
 
GEOS [VECTOR] 
Displays a computed field of geostrophic winds from the total U and V wind components. The geostrophic 
wind expresses the balance between the horizontal Coriolis and pressure gradient (or geopotential height 
gradient) forces. On a constant isobaric level, the geostrophic wind blows parallel to the geopotential height 
lines with wind speeds inversely proportional to the spacing of the height lines. See also WIND, AGEO. 
 
KMPH [vector] 
(SCALAR) Converts a scalar field having units of meters/sec (e.g., WSPD) to kilometers per hour (kph). 
 
 
KNOT [vector] 
(SCALAR) Converts a scalar field having units of meters/sec (e.g., WSPD) to knots (kts). 
 
MLPH [vector] 
(SCALAR) Converts a scalar field having units of meters/sec (e.g., WSPD) to mile per hour (mph). 
 
SPED or SPED [vector] 
(SCALAR) The command SPED by itself will display a contoured field of the magnitude of the total wind in 
meters/second, i.e., a contoured isotach field. SPED, by itself, is equivalent to the command sequence  
 
MAGN WIND. Also, WSPD is equivalent to SPED. See also MAGN. 
 
Optionally, SPED  any vector quantity (e.g., SPED GEOS) to its right will display contours of the 
magnitude of that vector quantity. The two command sequences SPED GEOS and MAGN GEOS produce 
identical results: a contoured field of the magnitude of the geostrophic wind. SPED can be thought of as 
equivalent in usage to the MAGN command when a vector is specified. 
 
SPKT [vector] 
(SCALAR) Displays contours of the magnitude of a wind vector in knots converted from meters/second. 
Unlike SPED, a vector wind must be given with SPKT. Typically, the required vector is one of WIND, 
GEOS, or AGEO. 
 
SPKM [vector] 
(SCALAR) Displays contours of the magnitude of a wind vector in kilometers/hour (km/h) converted from 
meters/second. Typically, the required vector is one of WIND, GEOS, or AGEO. 
 
SPML [vector] 
(SCALAR) Displays contours of the magnitude of a wind vector in miles per hour (mph) converted from 
meters/second. 
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WIND COMMANDS (cont.) 
 
VKNT [vector] 
(VECTOR) Converts the Vector" quantity from m/s to knots (kts). The commands VKNT WIND will display 
the total wind in knots without resetting the arrow or barb flags. See also VKPH and VMPH. 
 
VKPH [vector] 
(VECTOR) Converts the "vector" quantity from m/s to kilometers per hour (kph). See also VKNT and 
VMPH. 
 
VMPH [vector] 
(VECTOR) Converts the "vector" quantity from m/s to miles per hour (mph). See also VKNT and VKPH. 
 
WDDF 
(NUMERIC) Same as DDFF except no vector is specified and the total wind direction and speed (in m/s) 
are displayed. WDDF is equivalent to the command sequence DDFF WIND. 
 
WDDD  
(NUMERIC) Displays digital values of the total wind direction (degrees). WDDD is equivalent to the 
command sequence "DATB DRCT WIND". 
 
WDRC (SCALAR)  
Contours values of the total wind direction in degrees. Same as issuing the commands "DRCT WIND". 
 
WIND  
(VECTOR) Displays a representation of the model total wind vector in units of meters/second (m/s) for the 
specified level and forecast hour centered at a grid point. If the wind display flag is set to AROW, then the 
length of the wind vector arrows is automatically scaled so that the maximum wind vector will be displayed 
as an arrow whose length is equal to one gridbox interval. If the BARB flag is set, then one full barb equals  
10 m/s while a half barb equals 5 m/s. 
 
WKNT            
(VECTOR) Displays the model total wind in either arrow or barb format with wind speeds given in knots 
(kts). See WIND, WKPH, and WMPH. 
 
WKPH           
(VECTOR) Displays the model total wind in either arrow or barb from with wind speeds given in kilometers 
per hour (km/hr). See also WIND, WMPH and WKNT. 
 
WMPH          
(VECTOR) Displays the model total wind in either arrow or barb format with wind speeds given in miles per 
hour (MPH). See also WIND, WKNT, and WKPH. 
 
WNDA            
(VECTOR) Displays the total wind in arrow format using units of meters/second (m/s) and sets subsequent 
display of vectors in arrow format. 
 
WNDB            
(VECTOR) Same as BWND. See BWND. 
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WSPD            
(SCALAR) Displays contours of the magnitude of the total wind in meters/sec, i.e., isotachs in m/s. See 
SPED. 
 
WSPK            
(SCALAR) Displays contours of the magnitude of the total wind in knots, i.e., isotachs in knots. See also 
SPKT. 
 
 
**- CROSS/TIME SECTION DISPLAYS 
 
WINGRIDDS offers great flexibility in constructing vertical cross sections both in a spatial or temporal 
reference frame. It is often useful when assessing the state of the atmosphere to display meteorological 
parameters in a vertical cross section. WINGRIDDS allows one to switch back and forth between a vertical 
cross section view and a horizontal map, or "plan" view (see PLAN, CROS, TIME).  In fact, using the 
overlay capability, one can overlay plan view maps onto a cross section or vice versa. 
 
A spatial cross section represents a vertical slice through the atmosphere between any two geographical 
points at a given forecast hour. 
 
The endpoints of the cross section are user-specified in terms of two latitude/longitude coordinate pairs 
which represent the left and right endpoints of the cross section, respectively. The command XSCT defines 
the endpoints of the spatial cross section. Spatial cross section endpoints are saved to a file (XSCT.INF) 
for future reference for use with the CROS command. A spatial cross section is labeled by running the 
command file "XLBL". 
 
A temporal cross section represents the change in meteorological parameters occurring with time above a 
single geographical point 
 
The TSCT command is used to define the lat/lon pair at a specific geographical point. The left and right 
endpoints of a temporal cross section are user-selectable forecast hours. The default temporal cross 
section will contour values every 12 hours from 00 through 48 hours (see TINC to change the time interval; 
see THRS to specify the forecast time endpoints). The geographical points specified with the TSCT 
command are also stored in a file (TSCT.INF) for use with the TIME command. A temporal cross section 
can be labeled by running the command file TLBL". 
 
***CROSS/TIME SECTION COMMANDS  
 
Any field which can be displayed in plan (i.e., horizontal) view can be displayed in either a spatial or 
temporal cross section. For example, you can contour the divergence of the wind in a spatial or temporal 
cross section by entering the cross section mode (typing one of: XSCT, CROS, TSCT or TIME) and typing 
"DVRG WIND". In this manner, one can investigate the old adage that wind convergence (indicated by 
negative values of divergence) in the lower levels of the atmosphere is usually beneath an area of upper 
level divergence. Also, you can simply type "WIND" while in a cross section mode to observe the "true" 
earth-relative wind directions (vs a "cross section-relative" wind) (see XREL). 
 
You can overlay as many fields on a cross section as you wish. WINGRIDDS contains several commands 
that are used to look at winds either normal to (see NORM, VNRM) or tangential to (see TANG, VTNG) the 
plane of the cross section. Also, WINGRIDDS has a useful command that combines the scalar vertical 
motion field (VVEL) with the tangential component of the ageostrophic wind (TANG AGEO) to produce a 
"vertical circulation" that is observed in the vicinity of jet streaks (see VCRC, VCR1). 
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WINGRIDDS also has commands to "rotate" wind vector into a cross section-relative sense (see XREL, 
GEOX, AGEX). To understand what is plotted you must first understand how the cross section is specified. 
Say you wanted a spatial cross section from 50N/100W to 35N/85W. If you specify the cross section with 
the command: XSCT 50 100 35 85, then the left side of the cross section is at 50N/100W and the right side 
ends at 35N/85W. Conversely, if the same two endpoints were specified in reverse order (i.e., XSCT 35 85 
50 100), then the left side of the cross section would be at 35N/85W and the right side ends at 50N/100W. 
 
When you "rotate" the winds, the winds are plotted in a sense of looking from the first specified cross 
section lat/long pair to the second specified lat/long pair. Hence, the following statements regarding rotated 
winds in a cross section are true: 
 
A north wind represents a wind blowing into the cross section from left to right as viewed from the first 
defined endpoint looking toward the second defined endpoint. 
 
A south wind represents a wind blowing into the cross section from right to left as viewed from the first 
defined endpoint looking toward the second defined endpoint. 
 
An east wind represents a wind blowing towards the first defined endpoint. 
 
A west wind represents a wind blowing away from the first defined endpoint. 
 
Finally, the number of vertical levels displayed in a cross section can be specified by the user depending 
what vertical resolution is available in the gridded data. The command XLVL is used along with a 4-letter 
file name ending in ".LVL" (e.g., MAND.LVL) to change the vertical spacing. The format of the ".LVL" files 
is: 
 
##xxx1xxx2xxx3xxx4 ... xxxN 
 
where the left-most 2 digits (##) is the number of vertical levels followed immediately by this same number 
of vertical levels. The default is to use the lowest 10 mandatory levels (viz., 1000, 850, 700, 500, 400, 300, 
250, 200, 150, and 100). 
 
The following are the commands related to cross sections: 
 
XSCT [ left and right Lat/Lon pairs] 
(SWITCHES TO SPATIAL VERTICAL CROSS SECTION MODE) Defines the two endpoints for a spatial 
cross section in the vertical.  For instance, the command 
 
XSCT 45 95 33 70 
 
specifies the left portion of the cross section begins at 45N/90W and extends to the right to the point 
33N/70W. Typing XSCT by itself (without lat/lon pairs) will cause the system to prompt the user for the  
two geographical endpoints. The lat/lon pair immediately to the right of XSCT is defined as left-most 
endpoint. After the cross section is defined, a straight line is drawn connecting the two endpoints on all 
subsequent maps (this line can be erased on future maps by entering: "XSCT 0 0 0 0". 
 
NOTE: WINGRIDDS has the flexibility to define a spatial cross section so that the western-most point is 
either on the left or right side of the cross section. That is, the following command sequences define the 
same line: 
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XSCT 45 95 33 70  
XSCT 33 70 45 95 
 
but for the first case, the western-most point is on left side, while in the second case, the western-most 
point is on the right side. Be careful when interpreting wind directions in a cross sections where the 
western-most point is on the right side! See also PLAN, CROS, TIME. 
 
 
TSCT [ one lat/long pair] 
(SWITCH TO TIME/HEIGHT CROSS SECTION MODE) Defines the location for a time/height cross 
section, where time is given on the abscissa while height is the ordinate. The location of the time/height 
cross section is denoted on the map with a plus"+" sign. Once in time cross section mode, all subsequent 
commands are displayed in vertical cross section. See TINC to change the time interval; see THRS to 
specify the forecast time endpoints). See also PLAN, CROSS. 
 
XREL [vector] 
(VECTOR) Rotates the vector wind from an earth-relative to a cross section-relative frame of reference. To 
better understand what these winds mean, imagine that you are standing at the left side of the cross 
section looking toward the right side and you are interpreting the output of the command XREL BKNT. A 
north wind represents winds blowing into the cross section from left to right. A south wind represents winds 
blowing into the cross section from right to left. An east wind represents winds blowing in plane of the cross 
section towards you. A west wind represents winds blowing in the plane of the cross section away from 
you. See also WNDX. 
 
AGEX             
(VECTOR) Displays the ageostrophic wind rotated relative to the cross section (same as XREL AGEO). 
See also discussion for XREL 
 
GEOX             
(VECTOR) Displays the geostrophic wind rotated relative to the cross section. See also discussion for 
XREL Issuing the commands: XREL GEOS does the same thing. 
 
WNDX            
(VECTOR) Displays the total wind rotated relative to the cross section (same as XREL WIND). See 
discussion for XREL 
 
TANG [vector] 
(SCALAR) Finds cross section-relative tangential component of the vector. The tangential wind component 
is the wind blowing wholly in the plane of the cross section. If the wind is blowing perpendicular to the cross 
section, the tangential wind component is zero. Positive values of tangential winds represent winds blowing 
from left to right or away from the first defined (left-most) cross section endpoint. Negative values represent 
winds blowing from right to left or towards the first defined (left-most) cross section endpoint. See also 
VTNG and NORM. 
 
VTNG [vector] 
(VECTOR) Plots cross section-relative tangential wind component On vector form) for the vector specified. 
The vector of the tangential wind either point to the left or right. Tangential wind arrows pointing from left to 
right represent winds blowing away from the first defined (left-most) cross section endpoint while wind 
arrows pointing from right to left denote winds blowing towards the first defined (left-most) cross section 
endpoint. See TANG, VNRM. 
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NORM [vector] 
(SCALAR) Finds cross-section relative normal wind component for the vector specified. The normal wind 
component is the component of the wind relative to the cross section that is blowing wholly perpendicular 
to the cross section. Positive values of the normal wind component represent winds blowing through the 
cross section from left to right as viewed if standing at the left-most portion of the cross section. Negative 
values of normal winds represent winds blowing through the cross section from right to left as viewed from 
the left-most portion of the cross section endpoint. See also VTNG and TANG. 
 
VNRM [vector] 
(VECTOR) Plots the cross-section relative normal wind component (in vector format) for the vector 
specified. The normal wind component is the wind component relative to the cross section that is blowing 
wholly perpendicular to the cross section. The normal wind vectors will either point straight up or down. A 
wind arrow pointing up (a "south" wind), denoting positive values of the normal wind component, represent 
winds blowing through the cross section from left to right as viewed if standing at the left-most portion of 
the cross section. A wind arrow pointing down (a "north" wind), denoting negative values, represent winds 
blowing through the cross section from right to left as viewed from the left-most portion of the cross section 
endpoint See also VTNG and TANG. 
 
VCRC [vector] 
(VECTOR) Plots a vector representing the vector tangential wind component (VTNG [vector]) scaled by the 
vertical motion field (WEL). This vector represents the "vertical circulation" in the plane of the cross section. 
It has useful applications in diagnosing thermally direct and indirect circulations as found in the entrance  
and exit regions of jets. See also ACRC, VCR2, GCRC, and WCRC. 
 
VCR2 [vector] 
(VECTOR) Plots a vector representing the vector tangential wind component scaled by the vertical motion. 
Same as VCRC except resultant vectors are "magnified" by 2. See VCRC. 
 
VCR5 [vector] 
(VECTOR) Plots a vector representing the vector tangential wind component scaled by the vertical motion. 
Same as VCRC except resultant vectors are "magnified" by 5. See VCRC. 
 
ACRC             
(VECTOR) Displays vertical/tangential circulations of the ageostrophic wind (in vector form). Same as 
entering "VCRC AGEO". See also VCRC. 
 
GCRC             
(VECTOR) Displays vertical/tangential circulations of the geostrophic wind On vector form). Same as 
entering "VCRC GEOS". See also VCRC. 
 
WCRC            
(VECTOR) Displays vertical/tangential circulations of the total wind vector form). Same as entering "VCRC 
WIND". See also VCRC. 
 
CROS             
(NO OUTPUT) Re-activates the spatial cross sectional display. The line denoting the activated cross 
section on the map background will be highlighted with a brighter white color. Subsequent commands  
will be processed in the spatial cross section mode until terminated with a return to plan view (PLAN) or  
time/height cross section mode (TIME). If the XSCT command has not been run during the active 
WINGRIDDS session and CROS is entered, then the file "XSCT.INP supplies the endpoints for the cross 
section. 
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PLAN  
(NO OUTPUT) Re-activates viewing maps in "plan" 0-e., horizontal) mode, usually issued to exit viewing 
parameters in a cross section mode. The line denoting the activated cross section or time/height location 
on the map background is de-emphasized in a dull shade of white. Subsequent commands will be 
processed in the plan view mode until terminated with a return to either a spatial cross section model 
(CROS) or time-height cross section model (TIME). 
 
TIME  
(NO OUTPUT) Re-activates the time/height cross sectional display. A plus sign denotes the location of the 
activated time cross section, and is highlighted with a bright white color. Subsequent commands are 
processed in the time-height cross section mode until terminated with a return to plan view (PLAN) or 
spatial cross section mode (CROS). If the TSCT command has not been issued during the active 
WINGRIDDS session and TIME is entered, then the file TSCT.INF supplies the geographical location for 
the cross section. 
 
TINC [##] 
(NO OUTPUT) Changes the time increment for contouring display in time-height cross sections. The 
system default is to contour data every 12 hours (TINC 4). The time increment is set according to the 
following table: 
 COMMAND              INCREMENT 
 TINC 8         -  every 24 hours 
 TINC 4         -  every 12 hours 
 TINC 2         -  every 6 hours 
 TINC 1         -  every 3 hours 
 
NOTE: at present, the time interval between gridded model data fields are either every 12 hours or every 6 
hours.  Hence, if you have 6-hourly interval grids, set TINC 2. 
 
XLVL [ 4 Character name] 
Reads the file "xxxx.LVL", where "xxxx" is any 4 characters, to define both the spatial XSCT and/or 
temporal TSCT cross section vertical levels. The default is to use the lowest 10 mandatory levels (viz., 
1000, 850, 700, 500, 400, 300, 250, 200,150, and 100). The xxxx.LVL file is in ASCII format (no word 
processing format codes please!). An example file, "MAND.LVL", is provided with each copy of 
WINGRIDDS. The format of all ".LVL" files is: 
 
##xxx1xxx2xxx3xxx4 ... xxxN 
 
where the left-most 2 digits (##) is the number of vertical levels followed immediately by this same number 
of vertical levels. 
 
For example the following file • MAND.LVL - specifies 10 vertical levels at 1000, 850, 700, 500, 400, 300, 
250, 200, 150, and 100 millibars: 
 
101000 850 700 500 400 300 250 200 150 100 
 
In Fortran parlance, the format above is represented by "12,1014". The vertical levels need not all be 
pressure; they could be sigma level data (e.g., S896). 
 
THRS [ 4 Character name] 
(NO OUTPUT) Reads the file —.LVL to define time-height cross section hours. Uses the same format as is 
used in reading the "xxxx.LVL" files. 
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**- MOISTURE COMMANDS 
 
A host of moisture fields are available in WINGRIDDS. For example, to contour the 24-hour forecast of 850 
mb mixing ratio, simply set the forecast hour to 24 (F24), the vertical level to 850 mb (850) and type 
"MIXR". WINGRIDDS will then contour mixing ratios at 850 mb forecast at 24 hours. The mixing ratio 
(MIXR) is available for most vertical levels and forecast hours (NOTE: for some levels specific humidity 
(SPFH) is available which is virtually identical to the mixing ratio). Other computed moisture parameters 
include relative humidity (RELH), saturated mixing ratio (SMIX), and the saturation deficit of mixing ratio - 
SDEF (which is simply the difference between the saturated and unsaturated mixing ratios). 
 
Since moisture is a scalar, all of the scalar diagnostic commands can be used, e.g., moisture advection by 
the wind (ADVT MIXR WIND) or geostrophic moisture flux divergence (SDVR MIXR GEOS). Forecasts of 
model precipitable water are available (PWAT, PWAI). 
 
DWPT             
(SCALAR) Displays contours of dew point temperature for those vertical levels where mixing ratio and 
temperature are available. Contoured in units of degrees Celsius (C). A useful parameter is to compute the 
difference between the temperature and the dew point fields: SDIF TEMP DWPT - a field of dew point 
depressions. This field can be compared with observed upper air moisture data typically plotted as dew 
point depressions. 
 
DWPK            
(SCALAR) Displays contours of calculated dew point temperature 
wherever mixing ratio and temperature are available in units of degrees Kelvin (K). See also DWPT. 
 
MIXR  
(SCALAR) Displays contours of mixing ratio in units of grams of water vapor per gram of dry air (i.e., g/g). 
The mixing ratio is the ratio of the mass of water vapor present to the mass of dry air containing the vapor. 
The mixing ratio can be displayed for any vertical level. See also SMIX, SPFH, and RELH. 
 
(HINT: although the units for the mixing ratio are in grams/gram, a display of gridded mixing ratios might 
have contour labeled "8" or "14", which can be thought of in the more traditional mixing ratio units of grams 
H2O per kilogram (g/kg) of dry air. But for any diagnostic calculations, units of g/g will be used internally.) 
 
PWAI  
(SCALAR) Displays contours of model-based precipitable water fields. Units are in inches of liquid water 
equivalent. See also PWAT. 
 
PWAT             
(SCALAR) Displays contours of model-based precipitable water fields. Units are in millimeters of liquid 
water equivalent. See also PWAI. 
 
 
RELH              
(SCALAR) Displays contours of relative humidity (RH) in percent at any specified forecast hour and vertical 
level. The relative humidity is computed by dividing the mixing ratio MDCR by the saturated mixing ratio 
SMDC RH can be displayed for any vertical level that has either RELH or SPFH listed for that level in the 
data listing. Entering the command sequence: SDVD MDCR SMIX computes the RH just as if you typed in 
RELH for some vertical level. 
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RELH can also be displayed on an isentropic surface from the interpolated mixing ratio data for that 
surface. NOTE: the RH field computed on isentropic surfaces where the air is extremely dry will produce 
unrealistic values of RH greater than 100 percent. In these cases use the MIXR to see the value of 
moisture on that surface. 
 
SDEF  
(SCALAR) Displays contours of the mixing ratio saturation deficit in units of 
grams of water vapor per gram of dry air (g/g) for forecast hours/vertical levels where mixing ratio or 
specific humidity are available. The field of SDEF is simply the scalar difference between the saturated and 
unsaturated mixing ratios (i.e., one could compute the same thing by entering the command: SDIF SMIX 
MIXR). 
 
SMIX  
(SCALAR) Displays contours of saturated mixing ratio in units of grams of water vapor per gram of dry air 
(i.e., g/g). The saturated mixing ratio can be displayed for any vertical level. See also MDCR. 
 
SPFH  
(SCALAR) Displays contours of specific humidity in units of grams of water vapor per gram of dry air (i.e., 
g/g) and is virtually identical to MIXR. Specific humidity is only available for those levels where "SPFH" is 
explicitly listed in the gridded data listing. 
 
 
**- PRECIPITATION FIELDS COMMANDS 
 
Quantitative precipitation forecasts (QPFs) output from various models are displayable in WINGRIDDS 
using one of four commands: TPCI, TPCP, CPCI, and CPCP. The commands beginning with TP.." denote 
the Total precipitation field, while those beginning with "CP.." denote only that portion of the precipitation 
resulting from a model's particular Convective parameterization. The units of precipitation are available in 
either millimeters or inches. 
 
The other important consideration when viewing precipitation fields is the time interval they represent, i.e., 
are you looking at 6-hourly or 12-hourly accumulated precipitation fields.  Unfortunately, this information is 
not included in the grids themselves. However, in all instances, whenever precipitation output is displayed 
at any forecast hour that is an even multiple of 12 (e.g., FOO, F12, F24, F36, F48, F60, etc.), then the field 
displayed contains a 12-hour accumulated precipitation amount (ending at that forecast hour). For the 
mesoscale model outputs, there are 6-hourly accumulated precipitation totals available at forecast hours: 
F06, F18, F30, and F42. 
 
The precipitation commands are described below. 
 
CPCI  
(SCALAR) Displays contours of the portion of the total precipitation field based on the model's convective 
parameterization scheme in units of inches. The valid time interval for accumulation is either 6 or 12 hours. 
See also CPCP, TPCI, and TPCP. 
 
CPCC  
(SCALAR) Displays contours of the portion of the total precipitation field based on the model's convective 
parameterization scheme in units of centimeters. The valid time interval for accumulation is either 6 or 12 
hours. See also CPCP, TPCC, and TPCP. 
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CPCP             
(SCALAR) Displays contours of the portion of the total precipitation field 
based on the model's convective parameterization scheme in units of millimeters. The valid time interval for 
accumulation is either 6 or 12 hours. See also CPCI, TPCI, and TPCP. 
 
TPCI  
(SCALAR) Displays contours of the total precipitation fields in units of inches. The valid time interval for 
accumulation is either 6 or 12 hours. See also TPCP, CPCI, and CPCP. 
 
TPCC              
(SCALAR) Displays contours of the total precipitation fields in units of 
centimeters. The valid time interval for accumulation is either 6 or 12 hours. See also TPCI, CPCI, and 
CPCP. 
 
TPCP              
(SCALAR) Displays contours of the total precipitation fields in units of 
millimeters. The valid time interval for accumulation is either 6 or 12 hours. See also TPCI, CPCI, and 
CPCP. 
 
 
**- SCALAR and VECTOR DIAGNOSTIC COMMANDS 
 
WINGRIDDS offers a variety of diagnostic commands to manipulate gridded data fields. Both scalar data 
(e.g., temperature, moisture fields) and vector quantities (e.g., wind) can be manipulated.  Remember that 
in WINGRIDDS a 'scalar' data field is any contoured field (like temperature); a vector field is a plotted as 
arrows (or barbs). What is meant by "manipulate" is to perform some operation on one or more scalar 
and/or vector fields. Examples of gridded data manipulation include: 
 
*         adding two scalar fields together; 
*         determine the vector difference between the total wind and the geostropic component (i.e.,     
compute ageostrophic winds); 
*         multiplying a scalar field by a constant; 
*         taking the negative of a scalar field; 
*         taking the square root of a field; 
*         multiply the x- and y-components of a vector by a constant; 
*         compute the Sine of the wind direction. 
 
Although it may not be readily obvious, there are many benefits to manipulating the gridded fields. For 
example, if you want to compute a difference in mean sea level (MSL) pressures between two forecast 
times, this can be readily done (see TDIF or SDIF). 
 
Another example is any WINGRIDDS user can (with some practice!) transform mathematical equations of 
meteorological quantities into displayable contoured (or vector) fields. For example, the equation to 
compute the quasi-geostrophic "Q-vectors" discussed in the meteorological literature can be coded into a 
command file. Invoking this command file will produce a grid of Q-vectors at a given vertical level (or layer). 
The command file "QVEC.CMD" included with WINGRIDDS does such a task. Other quantities, like scalar 
frontogenesis, various stability parameters such as the K-index, total-totals, and more esoteric quantities, 
like depicting kinematic deformation of the wind field in the form of the "axii of dilatation", can be all be 
"programmed" and put in command files for ready access (see the section on COMMAND FILES). 
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In this reference manual, the commands to manipulate scalar and vector fields will be discussed in two 
separate sections, although functionally, many of the commands do the same thing. Contrast computing 
the difference of two scalar fields (see SDIF) with taking the difference between two vectors (see VDIF). 
The first section after this introduction describes commands to manipulate and/or produce scalar fields. 
This first section includes those "scalar diagnostic" functions (e.g. computing advection or divergence) that 
result in scalar (i.e., contoured) fields. A following section describes those commands for manipulating and 
producing vector quantities. The second section includes those "vector diagnostic" commands that produce 
a field of vectors as a result. 
 
 
**- SCALAR DIAGNOSTIC COMMANDS 
 
A) Scalar Addition, Subtraction, Multiplication, Division 
 
SADC [1-4 digit value, scalar] 
(SCALAR) Add a constant value to the specified scalar field and display a contoured field of the resultant 
summation. For example, the commands "SADC 10 TEMP" will add a constant value of 10 to the scalar 
temperature field at a given level. The constant is optional; if it's not given the user is asked to enter one. 
 
There are number of ways the constant for this command can be entered. The discussion given in this 
paragraph is applicable for all WINGRIDDS scalar diagnostic commands requiring constants and will not 
be repeated (see SMLC, SSBC, SDVC). The constant can be entered using one, two, three, or four digits, 
and a decimal can be used, but the constant cannot be longer than 4 digits!. Valid constants are: "2", 
"1000", "98.4". Negative values are entered with a leading minus sign (e.g., "-23"). Scientific notation can 
be entered with an exponent in "E-format. Examples of valid E-format constants are: "3E3", "1E+5", "5E-7" 
"52E5". 
See also SSBC. 
 
SAVR [ 2 scalars] 
(SCALAR) Calculates the arithmetic scalar grid average for the two scalar fields and display the resultant 
average as a contoured field. The arithmetic average method simply sums the two scalar fields together 
and divides by 2. For example, the command string to compute the average value of the 12- and 24-hour 
forecast temperature fields given by: 
 
 “SAVR TEMP F24 TEMP F12” 
 
is identical to the command string: 
 
 “SDVC 2 SSUM TEMP F24 TEMP F12" 
 
SDIF [scalar1 scalar2] 
(SCALAR) Subtracts the "scalar2" field from the 'scalar1' field and displays the resulting difference as a 
contoured field. For example, the command string to compute the dew-point depression at some level is: 
"SDIF TEMP DWPT". The order that the two scalar fields is entered is important; the two scalar fields are 
NOT commutative. See also SSUM. 
 
SDVC [1-4 digit value, scalar] 
(SCALAR) Divide the scalar field by a user-specified constant and display a contoured field of the resultant 
division. For example, the command line: "SDVC -2 TEMP" will divide the scalar temperature field at a 
given level by -2. Entering the constant is optional; if it's not given the user is asked to enter one. Refer to 
the discussion in SADC for possible ways to enter the constant to multiply by. 
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SDVD [scalar1 scalar2] 
(SCALAR) Divides the "scalar1” grid field by the "scalar2" grid field and displays the resultant division as a 
contoured field. For example, the command line: "SDVD MDCR SMXR" will divide the mixing ratio (MIXR) 
by the saturated mixing ration (SMIX). If this result is then multiplied by 100 (e.g., "SMLC 100 LAST), the 
field of relative humidity is obtained. 
 
SMLC [1-4 digit value, scalar] 
(SCALAR) Multiply a constant value times the specified scalar field and display a contoured field of the 
resultant multiplication. For example, the command "SMLC .8 RELH" will multiply the constant value of 0.8 
times the scalar relative humidity (RH) field at a given level; in essence, a way of taking 80 percent of the 
given RH field. The constant is optional; if it's not given, the user is asked to enter one. Refer to the 
discussion in SADC for possible ways to enter the multiplication constant 
 
SMLT [ 2 Scalars] 
(SCALAR) Multiplies the two specified scalar grid fields together displaying the resultant multiplication as a 
contoured field. 
 
SSBC [1-4 digit value, scalar] 
(SCALAR) Subtract a specified constant from a scalar field and display a contoured field of the resulting 
difference field. For example, the command: "SSBC 1E-5 DVRG WIND" subtracts a constant value of 1 x 
10"5 from the divergence of the total wind field. Refer to the discussion in SADC for possible ways to enter 
the constant to be subtracted. 
 
SSUM [ 2 Scalars] 
(SCALAR) Sums the two specified scalar grid fields and displays the resultant summation as a contoured 
field. 
 
STND [ 2 scalars] 
(SCALAR) Calculates the time tendency for the two sealer grid fields. A time tendency is simply the 
arithmetic average of the two scalar fields divided by the time interval specified between FHR1 and FHR2, 
in inverse seconds. For example, the scalar time tendency of the 12- and 24-hour temperature fields at 
some vertical level is given by: 
 
STND TEMP F24 TEMP F12 
 
which is exactly equivalent to the command: TEMP TTND SFHS 12 24 
 
 
 
Miscellaneous Scalar Diagnostic Commands 
 
The units for both of the above expressions would be in degrees Celsius per sec. The "per sec" units can 
be converted to "per hour" using HRLY or to "per 24-hour day" using DALY. See also TTND, VTND, HRLY, 
DALY, SFHS, FHR1, FHR2. 
 
ABSV [Scalar] 
(SCALAR) Calculates the absolute value of scalar grid. 
 
INV1 [Scalar] 
(SCALAR) Finds the inverse of a scalar quantity up to a maximum of 1. See INVS. 
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INVS [Scalar] 
(SCALAR) Finds the inverse of a scalar quantity. The inverse is simply one divided by that quantity. See 
also INV1. 
 
SNEG [Scalar] 
(SCALAR) Finds the negative of a scalar grid. It is equivalent to multiplying a scalar grid by-1. 
 
 
B.       Trigonometric Scalar Functions 
 
There are six trigonometric functions defined in mathematics. They are referred to as the sine, cosine, 
tangent, cotangent, secant, and cosecant functions. Three of these functions are available in WINGRIDDS 
to compute the sine (SINE), cosine (COSN), and tangent (TNGT) from a scalar grid assumed to be 
degrees. These three basic "trig" functions can be combined using the fundamental trigonometric identities 
to give the other trigonometric functions (secant, cosecant, and cotangent), as given by: 
 
 cosecant  = 1 / sine 
 secant    = 1 / cosine  
 cotangent = 1 / tangent 
 
COSN [Scalar] 
Calculates the trigonometric cosine of a scalar grid. The scalar grid must be in degrees. See also, SINE, 
TNGT, WDRC. 
 
SINE [Scalar] 
(SCALAR) Calculates the trigonometric cosine of a scalar grid. The scalar grid must be in degrees. See 
also, COSN, TNGT, WDRC. 
 
TNGT [Scalar] 
(SCALAR) Calculates the trigonometric tangent of a scalar grid. The scalar grid must be in degrees. See 
also, SINE, COSN, WDRC. 
 
C.       Other Scalar Mathematical Functions 
Several miscellaneous (but useful) functions that act on scalar grid fields are available in WINGRIDDS. 
These are the gradient or "del" operator (GRAD, MGRD, NGRD), and the horizontal gradient operators 
DSDX and DSDY. These functions are quite useful in computing several meteorological diagnostic 
quantities such as advection (see ADVT) 
 
DSDX [Scalar] 
(SCALAR) Calculates the gradient of the scalar field in the X (i.e., east-west) direction using second order 
finite differencing. An example is DSDX TEMP which, in essence, is the partial derivative of the 
temperature field with respect to the X direction, or mathematically: 
 
dT dX 
 
DSDY [Scalar] 
(SCALAR) Calculates the gradient of the scalar field in the Y (i.e., north-south) direction using second order 
finite differencing. An example is DSDY MIXR which, in essence, is the partial derivative of the moisture 
field with respect to the Y direction, or mathematically: 
 
dY 
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GRAD [Scalar] 
(VECTOR) Computes the two-dimensional (X,Y) horizontal gradient of the specified scalar field and 
outputs the result as a vector field. The definition of the gradient or "del" operator is fin the horizontal 
plane): 
 
dX  dY 
 
where / and / refer to the positive X and Y directions, respectively. Geometrically, GRAD yields the 
horizontal "ascendent" vector; a vector at right angles to the horizontal isopleths of the scalar quantity and 
directed (pointing) toward higher values of the scalar. The WINGRIDDS function NGRD (see NGRD) 
operating on a scalar field yields a vector at right angles to the contours but directed toward lower values of 
the scalar, which is mathematically equivalent to the "descendent" vector. NGRD is also called the 
"negative ascendent" in some texts. 
 
The length of each vector produced by GRAD is proportional to the magnitude of the gradient of the scalar. 
In other words, the longest vector occurs in places where there is a close packing of contour lines gradient. 
See also MGRD, NGRD, DSDX, DSDY. 
 
MGRD [scalar] 
(SCALAR) Computes the magnitude of the gradient of any scalar field and displays the resultant magnitude 
as contours. The closer the contours are packed together, the larger the value of the magnitude of the 
gradient. For example, MGRD TEMP contours the magnitude of the gradient of the scalar temperature 
field. An equivalent field would be given by the commands "MAGN GRAD TEMP". Units of the magnitude 
of the gradient of a scalar are in the units of the scalar divided by distance (meters). See also GRAD, 
NGRD, MAGN. 
 
NGRD [scalar] 
(VECTOR) Displays in vector form the negative gradient of a scalar field. For example, the command 
"NGRD TEMP" displays a field of vectors at right angles to the contours of the scalar but directed toward 
lower values, mathematically equivalent to the "descendent" vector. NGRD is also called the "negative 
ascendent". Another way to produce this vector is to precede the GRAD command with the command 
VNEG, as in "VNEG GRAD TEMP". See also GRAD, MGRD, VNEG. 
 
  
 
 
 
**- VECTOR DIAGNOSTIC COMMANDS 
 
A vector is a quantity that has attributes of magnitude and direction. The most common vector in 
meteorology is the wind which is composed of a direction attribute and a speed or velocity attribute. A 
knowledge of vectors and how they are manipulated in meteorology is fundamental to understanding the 
kinematics of the atmosphere. 
 
WINGRIDDS offers a host of commands to manipulate vectors and to combine vectors and scalars into 
useful diagnostics (e.g., moisture convergence, temperature advection, etc.). This section documents the 
following WINGRIDDS commands that manipulate vectors. These commands include vector addition 
(VSUM), subtraction (VDIF), multiplication (VMLT), division (VDVD), advection (ADVT), divergence 
(DVRG) and scalar flux divergence (SDVR), the dot product (DOTP) and cross product (CROS), both 
absolute vorticity (VORT) and relative vorticity (RVRT), etc. 
 



 
 232 

A. Vector Addition, Subtraction, Multiplication, Division 
 
VADC [1-4 digit value, vector] 
(VECTOR) Add a constant value to the specified vector field and displays a vector field of the resultant 
summation. For example, the command "VADC 5 GEOS" adds a value of 5 m/s to both the X- and Y- 
components of the geostrophic wind at a given level. Hence, if the geostrophic wind at a gridpoint was 270 
degrees at 10 m/s, the new geostrophic wind would be west-southwesterly (251 degrees) at about 15.8 m/s 
(Remember: the constant is added to BOTH the X- and Y- wind components). Entering the constant 
immediately after the command is optional; if it's not given the user is asked to enter one. 
 
NOTE: adding a constant value to a vector WILL change the direction of that vector! 
 
There are number of ways the constant for this command can be entered. The discussion given in this 
paragraph is applicable for all WINGRIDDS vector diagnostic commands requiring constants and will  
not be repeated (see also VMLC, VSBC, VDVC). The constant can be entered using one, two, three, or  
four digits, and a decimal can be used, but the constant cannot be longer than 4 digits I. Valid constants 
are: "2", "1000", "98.4". Negative values are entered with a leading minus sign (e.g., "-23"). Scientific 
notation can be entered with an exponent in "E-format". Examples of valid E-format constants are: "3E3", 
"1E+5", "5E-7 52E5". 
 
VAVR [2 vectors] 
(VECTOR) Calculates the arithmetic vector grid average for the two vector fields and display the resultant 
average as a contoured field. The arithmetic average method first sums the X- and Y- components of the 
vector fields together and divides these by 2. For example, the command string to compute the average 
value of the 1000 mb and 500 mb forecast wind fields given by: 
 
"VAVR WIND 1000 WIND 500" 
 
is identical to the command sequence: 
 
"CONT SDVC 2 SSUM YCMP WIND 1000 YCMP WIND 500  
VDVC 2 SSUM XMCP WIND 1000 XCMP WIND 500" 
 
VDIF [vector1 vector2] 
(VECTOR) Vectorially subtracts "vector2" from "vector1" and displays the resulting difference as a new 
vector. For example, the command string to compute the vector difference between the 1000 mb 
geostrophic wind and the 500 mb geostrophic wind (i.e., the thermal wind) is: 
 
"VDIF GEOS 500 GEOS 1000". 
 
Note in the above command string that the second vector (GEOS 1000) is subtracted from the first vector 
(GEOS 500). An equivalent form of the above command is GEOS LDIF. Also, the order that the two 
vectors are entered IS important Taking the difference of two vector fields is NOT commutative. See also 
VSUM. 
 
VDVC  [1-4 digit value, vector] 
(VECTOR) Divide the vector field by a user-specified constant and displays the resultant vector field. For 
example, the command line: "VDVC 3 WIND" divides each X- and Y- component of the wind field at a 
given level by 3. Entering the constant immediately next to the command is optional; If it's not given the 
user is asked to enter one. Refer to the discussion in VADC for possible ways to enter the multiplication 
constant. 
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VDVD [vector1 vector2] 
(VECTOR) Divides the “vector1” X- and Y- components by the "vector2" X- and Y- components and 
displays the resultant division as a new vector. See also VMLT, VDVC. 
 
VMLC [1-4 digit value, vector] 
(VECTOR) Multiply a constant value times the specified vector field and displays the resultant vector field.  
Multiplying the vector by a positive scalar value simply multiplies the length of the vector without affecting 
the direction. The command "VMLC .5 WIND" multiplies both the X- and Y-components of the total wind by 
0.5 (1/2) at a given level. This results in a wind field having the same direction as before but only half the 
magnitude (See MAGN). If the scalar constant is negative, then not only is the vector's magnitude affected, 
but the vectors are reversed in direction. The constant is optional; if it's not given, the user is asked to enter 
one. Refer to discussion in VADC for possible ways to enter the constant.  
See also VDVC, VMLT. 
 
VMLT [vector1 vector2] 
(VECTOR) Multiplies the two specified vector fields together and displays the resultant multiplication as a 
new vector. The X- and Y-components are multiplied to together to create this new vector. See also VDIF, 
VMLC. 
 
VSBC [1-4 digit value, vector] 
(VECTOR) Subtract the specified constant from both the X- and Y- components of the vector field and 
displays a vector of the resulting difference field. For example, the command: "VSBC 5 WIND" subtracts a 
constant value of 5 from both the X- and Y- components of the vector total wind. The resultant vector will 
have a new direction. Refer to the discussion in VADC for possible ways to enter the constant to be 
subtracted. See also VDIF. 
 
VSUM [vector1 vector2] 
(VECTOR) Vectorially sums the two specified vectors grid fields and displays the resultant vector 
summation. The scalar X- components of vector1 and vector2 are summed  a similar summation of the Y- 
components, with the resultant X- and Y- scalar components placed on the data stack to create the new 
summed vector. For example, if vector1 represents a wind of 20 knots from the west (270°) and vector2 
represents a wind of 30 knot also from the west, then the result of "VSUM" of these two winds results in a 
new wind of 50 knots from the west. See also VADC. 
 
VTND [vector1 vector2] 
(VECTOR) Calculates the time tendency for the two vector fields. A vector time tendency is vector average 
of the two vector fields divided by the time interval specified between FHR1 and FHR2, in inverse seconds. 
For example, the vector time tendency of the 12- and 24-hour wind fields at some vertical level is given by: 
 
 VTND WIND F24 WIND F12 
 
 
which is exactly equivalent to the command:  
 
 WIND TTND SFHS 12 24 
 
The units for both of the above expressions would be in meters/sec per sec. The "per sec" units can be 
converted to "per hour" using HRLY or to "per 24-hour day" using DALY. See TTND, STND, HRLY, DALY, 
SFHS, FHR1, FHR2. 
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B.    Other vector functions 
 
CRSP [2 Vectors] 
(SCALAR) Calculates and displays the magnitude of the vector cross product of the two specified vectors. 
The cross product is defined as the magnitude of the first vector times the magnitude of the second vector 
and multiplied by the cosine of the angle between the two vectors: 
 
A x B - \A\ \B\ Sine* 
 
DOTP [2 Vectors] 
(SCALAR) Calculates and displays the scalar "dot” product of the two specified vectors. Since the dot 
product operation is commutative, the vectors can be given in either order. The scalar dot product has  
no direction. The scalar dot product is defined as the magnitude of the first vector times the magnitude of 
the second vector and multiplied by the sine of the angle between the two vectors: 
 
A-B- \A\ \B\ cosa  
 
See also ADVT, CRSP, DVRG. 
 
DVRG [vector] 
(SCALAR) Calculates the mathematical divergence of the vector quantity defined as the dot product of the 
gradient operator dotted with the vector quantity: 
 
Divergence «  V • [vector] 
 
Positive values indicate divergence of the vector; negative values indicate convergence. The command 
"DVRG WIND" displays contours of the divergence of the wind at a given forecast level and hour. Consult a 
dynamic meteorological textbook (e.g., Bluestein, 1992) for a more complete explanation of divergence. 
 
See also DOTP, GRAD, SDVR, WDVR. 
 
GVRT             
(SCALAR) Generates the absolute vorticity using the geostrophic wind displaying the resultant field in 
contoured form. The GVRT command is equivalent to the commands: VORT GEOS. For a more complete 
treatment of vorticity, refer to the discussion for the VORT command. 
 
See also GEOS, VORT, WVRT. 
 
WDVR            
(SCALR) Calculates the divergence of the total wind field and displays the result as contours of the 
divergence of the wind at a given forecast level and hour. Positive values indicate divergence of the wind; 
negative values indicate convergence. The command "DVRG WIND" does the same thing as WDVR. See 
also the discussion on divergence in DVRG. 
 
 
C. Combined vector/scalar functions 
 
ADVT [Scalar and Vector] 
(SCALAR) Calculates the advection of the scalar quantity by the vector quantity. There are two ways the 
command can be entered: either normal or functional. Using temperature advection by the total wind as an 
example, the commands can be entered in the normal manner like: 
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ADVT TEMP WIND 
 
or in a functional format: 
 
ADVT [TEMP,WIND] 
 
Both forms produce identical results for temperature advection. The mathematical equation that is 
computed for advection (using temperature as the quantity advected) is: 
 
Advection = -V*7T 
 
As an example, an equivalent sequence of WINGRIDDS commands for computing temperature advection 
by the total wind is: 
 
SNEG DOTP WIND GRAD TEMP 
 
which mathematically is the negative of the scalar dot product of the total wind "dotted" with the gradient of 
temperature.  For the adventuresome, another way to codify in WINGRIDDS the temperature advection by 
the total wind is: 
 
SNEG SSUM SMLT XCMP WIND DSDX TEMP SMLT YCMP WIND DSDY TEMP 
 
There are several "pre-programmed" advection functions to advect various quantities by the total wind: 
temperature (TADV), mixing ratio (QADV), and pressure (PADV). 
 
PADV              
(SCALAR) Displays contours of the field of pressure advection using the 
total wind. See discussion for ADVT. 
 
 
QADV             
(SCALAR) Displays contours of the field of mixing ratio advection using 
the total wind. See discussion for ADVT. 
 
SDVR [Scalar and Vector] 
(SCALAR) Calculates the flux divergence of the scalar and vector quantities. The mathematical scalar flux 
divergence of the vector quantity is defined as the dot product of the gradient operator dotted with the 
scalar-vector quantity: 
 
Scalar Divergence =  V • [scalar x vector] 
 
Positive values of scalar flux divergence occur where the wind field acting on the gradient of the scalar is 
tending to decrease the scalar quantity; negative values occur where winds are tending to increase the 
scalar quantity. The scalar flux divergence command combines the advective portion of wind and the 
divergent/convergent portion of the wind acting on the scalar quantity. Mathematically, scalar divergence 
can be written as the sum of the two aforementioned factors (i.e., advective part and divergent/convergent 
part) as: 
 
Scalar Divergence  -   (V -V q) + q (V • V) 
 
See also DOTP, DVRG, FLUX. 
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TADV  
(SCALAR) Displays contours of the field of temperature advection using the total wind. See discussion for 
ADVT. 
 
FLUX [a Scalar and a Vector] 
(VECTOR) Displays a vector representation of the product of a scalar and the input vector. These  
vectors, referred to as "flux" vectors, have the same direction as the input vector. However, the original 
vector's magnitude has been multiplied by the scalar value at that point. A "flux" can be viewed as the 
amount of some quantity (e.g., moisture) transported by the vector (say, wind) across a given area. The 
FLUX command also resets the wind display to AROW format. 
 
As an example, the moisture flux at 1000 mb is computed using the command "FLUX MDCR WIND 1000". 
This produces a field of vectors whose direction are everywhere the same as the wind at 1000 mb but 
whose length is proportional to the amount of 1000 mb moisture at a grid point. Assuming that the 1000 mb 
moisture can vary by an order of magnitude (i.e., dry -1 gr/kg vs wet -10 gram/kg air), while the 1000 mb 
wind varies by less than an order of magnitude (i.e., <1 m/s to 25 m/s), then the scaling effect from 
moisture will surpass that due to the magnitude of the wind. Hence, the 1000 mb moisture flux vectors in 
areas of high moisture content air but relatively weak winds will generally be longer relative to those flux 
vectors in low moisture content air but either weak (pi strong) winds. (NOTE: taking the divergence of the 
moisture flux (at any level) yields the often-desired field of moisture flux divergence (i.e., DVRG FLUX 
MDCR WIND), which, equivalently can be computed by "SDVR MIXR WIND".) See also AROW DVRG, 
SDVR. 
 
MAGN [Vector] 
(SCALAR) Calculates the magnitude of the vector displaying the result as a contoured scalar field. If the 
vector is a wind vector, than the wind magnitude is equivalent to the field of isotachs. The vector does not 
have to be a wind. See also MGRD, SPED, SPKT, WSPD, WSPK. 
 
 
RVRT [vector] 
(SCALAR) Calculates the horizontal relative vorticity of the specified vector. The vector given is usually a 
wind vector (e.g., WIND, GEOS, etc.). The relative vorticity of the total wind is given by the command 
"RVRT WIND". The units of relative vorticity are in inverse seconds, with typical values on the order of 10-5 
sec-1. 
 
The actual mathematical quantity calculated via a first order finite difference technique is: 
 
Relative Vorticity 
f dv    eiM 
( dX~ BY ) 
 
 
The term in parentheses is defined as the relative vorticity of the vector wind, where U and V wind 
components are in the east-west and north-south directions, respectively. An equivalent way in 
WINGRIDDS to compute the relative vorticity of the total wind by computing the actual finite difference of 
the U- and V- wind components is: 
 
SDIF DSDX VGRD DSDY UGRD  
 
See also VORT. 
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VNEG [vector] 
(VECTOR) Displays the "negative" of a vector field. The negative of a vector is a vector having a direction 
180 degrees opposite of the specified vector, but having the same magnitude. For example, if a wind 
vector at some gridpoint points from south to north (i.e., a south wind) then command VNEG WIND results 
in a vector that points from north to south (i.e., a north wind). See also MAGN. 
 
VORT [vector] 
(SCALAR) Calculates the horizontal absolute vorticity of the specified vector. The vector given is usually a 
wind vector (e.g., WIND, GEOS, etc.). The absolute vorticity of the total wind (i.e. what's plotted on the 
AFOS and DIFAX 500 mb graphics) is given by the command "VORT WIND". The units of absolute vorticity 
are in inverse seconds, with typical values on the order of 10-5 sec-1. 
 
The actual mathematical quantity calculated via a first order finite difference technique is: 
 
Abs.Vorticity = | -^- 
 
The first term on the right (in parentheses) is the relative vorticity (see RVRT) of the vector wind, where U 
and V wind components are in the east-west and north-south directions, respectively. The second term on 
the right (f) is the Coriolis parameter (see FFFF). An equivalent way in WINGRIDDS to display the absolute 
vorticity of the total wind is to sum the relative vorticity with the Coriolis force: 
 
SSUM RVRT WIND FFFF  
 
See also GVRT, RVRT, FFFF, WVRT. 
 
WVRT             
(SCALAR) Calculates the horizontal absolute vorticity of the specified vector. The vector given is usually a 
wind vector (e.g., WIND, GEOS, etc.). WVRT is equivalent to the absolute vorticity of the total wind as 
given by the command "VORT WIND'. The units of absolute vorticity are in inverse seconds, with typical 
values on the order of 10-5 sec-1. See discussion in VORT for more details on vorticity. See also GVRT, 
RVRT. 
 
**- COMMANDS for LAYER AND TIME VALUES 
 
This section documents commands within WINGRIDDS to display or compute quantities involving either 
the specified layer pair (see LVL1, LVL2) or time pair (see FHR1, FHR2).  For example, computing a 
contoured 1000-500 mb thickness field of geopotential height involves setting the layer values LVL1 and 
LVL2 to 1000 and 500 mb, respectively (i.e., the command: SLYR 1000 500 does this) and then typing 
HGHT LDIF at the command line. 
 
Similarly, computations involving the time pair are accomplished by specifying values for FHR1 and FHR2 
using the SFHS command and using an appropriate time command (TDIF, TTOT). For example, to 
compute a contoured time difference field of 500 mb temperature between the 12 and 24 hour forecasts, 
first set the time pair variables (SFHS 12 24) and then enter the commands TEMP TDIF 500. 
 
A time tendency, as defined in WINGRIDDS, is the arithmetic average (see TAVE) of a scalar or vector 
quantity taken between the time pairs FHR1, FHR2, and divided by the time interval (in seconds) between 
FHR1 and FHR2 (see TTND). The default time interval used for time tendencies is (sec'1). This interval can 
be modified to other units (e.g., hourly - HRLY; daily - DALY; etc.), or any other user-specified value. A time 
tendency for both scalar and vector fields is available (see STND, VTND, respectively). 
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Section A describes commands that use the time pair. Section B describes commands involving layer 
computations. 
 
A. Time pair 
 
TAVE [proceeded by variable] 
(SCALAR or VECTOR) Calculates the time average of a variable to the left of the command using the time 
pairs FHR1 and FHR2. The variable can either be a scalar or vector quantity. If a scalar variable is used, 
the arithematic average is computed by dividing the sum of the scalar at times FHR2 and FHR1 by two. If a 
vector variable is specified, a new vector field is created with each new vector being the arithmetic sum of 
the u- and v- components at the two specified time pair hours (FHR1, FHR2) divided by two. 
 
The time pairs are set with the command SFHS and default to the initial values specified in the 
INITGRID.SPC file. The values of FHR1 and FHR2 are found on the default parameters line (the line 
immediately below the command line). 
 
TAVE+ [proceeded by variable] 
(SCALAR or VECTOR) Calculates the time average of a variable to the left of the command using the next 
available Forecast Hour. 
 
TTOT [proceeded by variable]  
(SCALAR or VECTOR) Calculates the time total or sum of a variable to the left of the command using the 
time pairs FHR1 and FHR2. The variable can either be a scalar or vector quantity. If a scalar variable is 
used, the arithmatic sum is computed by simply summing the scalar at times FHR2 and FHR1. For 
example, the command MIXR TTOT contours the sum of the mixing ratios at the forecast hours FHR1 and 
FHR2.. If the variable specified is a vector, then a new vector field is created where each new vector 
represents the arithmetic sum of the u-and v- vector components at the two specified time pair hours FHR1 
and FHR2 divided by two. See also TDIF. 
 
TTOT+ [proceeded by variable] 
(SCALAR or VECTOR) Calculates the time total or sum of a variable to the left of the command using the 
next available Forecast Hour. 
 
TDIF [proceeded by variable] 
(SCALAR or VECTOR) Calculates the time difference of a variable to the left of the command using the 
time pairs FHR1 and FHR2. The variable can either be a scalar or vector quantity. If a scalar variable is 
used, the arithmatic sum is computed by simply summing the scalar at times FHR2 and FHR1. For 
example, the command TEMP TDIF contours the resulting difference field between the temperature at the 
specified level between FHR1 and FHR2. The sense of the difference computed is: [FHR2 • FHR1]. If the 
variable specified is a vector, then a new vector field is created where each new vector represents the 
arithmetic sum of the u- and v- vector components at the two specified time pair hours FHR1 and FHR2 
divided by two. See also TTOT. 
 
 
TDIF+ [proceeded by variable] 
SCALAR or VECTOR) Calculates the time difference of a variable to the left of the command using the 
next available Forecast Hour. 
 

 
TTND [proceeded by variable] 
(SCALAR/VECTOR) Calculates the time tendency for variable specified. A time tendency is the arithmetic 
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average of the variable field at times FHR1 and FHR2 divided by the time interval specified between these 
two times. For example, the time tendency of the 24- and 36-hour dew point fields at some vertical level is 
given by: 
 
DWPT TTND SFHS 24 36 
 
which is exactly equivalent to the command:  
 
STND DWPT F24 TEMP F36 
 
The units for both of the above expressions would be in °C per sec. The "per sec" units can be converted 
to "per hour using HRLY or to "per 24-hour day" using DALY. See also STND, VTND, TAVE, HRLY, DALY, 
SFHS, FHR1, FHR2. 
 
TTND+ [proceeded by variable] 
(SCALAR/VECTOR) Calculates the time tendency for variable specified using the next available Forecast 
Hour. 
 
 
B.       Layer Pairs 
 
LAVE [proceeded by variable(s)] 
LYAV  
(SCALAR or VECTOR) Calculates the layer average of a variable to the left of the command using the 
layer pairs LVL1 and LVL2. The variable can either be a scalar or vector quantity. If a scalar variable is 
used, the layer average is computed by dividing the sum of the scalar at the levels LVL1 and LVL2 by two. 
If a vector variable is specified, a new vector field is created with each new vector being the arithmetic sum 
of the u- and v- components at the two specified layer levels (LVL1, LVL2) divided by two. 
 
For example, the command RELH LAVE computes the arithematic average of the relative humidity at layer 
levels LVL1 and LVL2. This is not the same as a true mean relative humidity between these two levels 
typically depicted on standard AFOS and facsimile graphics. A true "mean" RH is calculated by summing 
up the individual RH's at every vertical level between the LVL1 and LVL2 layers and then taking a 
pressure-weighted average of this sum. 
 
The layer pairs are set with the command SLYR and default to the initial values specified in the 
INITGRID.SPC file. The values of LVL1 and LVL2 are found on the default parameters line (the line 
immediately below the command line). 
 
See also SLYR, LVL1, LVL2. 
 
LSUM [proceeded by variable(s)] 
LADD             
LYSM             
(SCALAR or VECTOR) Calculates the layer sum of a variable (or variables) to the left of the command 
using the layer levels LVL1 and LVL2. The variable can either be a scalar or vector quantity. If a scalar 
variable is used, the sum is computed by summing the scalar at layer levels LVL1 and LVL2. For example, 
the command SMIX LSUM contours the sum of the saturated mixing ratios at the layer levels LVL1 and 
LVL2. If the variable specified is a vector, then a new vector field is created where each new vector 
represents the arithmetic sum of the u-and v- vector components at the two specified levels LVL1 and 
LVL2. 
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See also SLYR, LVL1, LVL2, LAVE, LDIF. 
 
LDIF  [preceded by variable(s)] 
LYDF  
(SCALAR or VECTOR) Calculates the layer difference of the variable (or variables) to the left of the 
command using the layer levels LVL1 and LVL2. The variable can either be a scalar or vector quantity. If a 
scalar variable is used, the difference is computed by subtracting the scalar at layer level LVL1 from that at 
LVL2. For example, the command TEMP LDIF contours the difference between the temperature at layer 
LVL2 minus the temperature at LVL1. If the variable specified is a vector, then a new vector field is created 
where each new vector represents the arithmetic difference of the u- and v- vector components at the two 
specified levels LVL1 and LVL2. 
 
See also SLYR, LVL1, LVL2, LSUM, LAVE. 
 
 
 
**- COMMANDS RELATED TO LIFTING OF LAYERS 
 
WINGRIDDS offers several commands that deal with "lifting". A common example of "lifting" used in 
forecasting is computing the lifted index. In WINGRIDDS, one can specify the two layers that are used in 
computing the lifted index and issue a command (LNDX) that computes this temperature difference.  In 
addition, the lifted index is commonly included with the basic gridded data from the model. Typing LIFT 
displays contours of the model "best" lifted index, which tends to depict the most unstable (i.e., most 
negative) of the lifted indicies. Consult NWS Technical Procedures Bulletin No. 207 for details on the "best" 
lifted index. 
 
Other commands allow for computing the temperature and pressure of the lifted condensation level (LCL) 
of parcels originating from some user-specified level (TLCL and PLCL, respectively). In addition, a layer's 
"pressure deficit" can be computed -that is, the difference between the pressure of the layer and the 
pressure at which that layer's LCL is reached (see PDEF). Consult a meteorological textbook for definitions 
of LCL and explanation of parcel theory. 
 
The vertical levels used for lifting can be specified at constant pressure (e.g., 850 mb), sigma or boundary 
layer level (e.g., S982, B015), or even an isentropic surface (see SLVL, I###, S###, and B###). 
 
LIFT |UFX| > Provides Lifted Index fields without resetting LEVeL 
 
LNDX             
(SCALAR) Calculates the "lifted index" (U) between LVL1 and LVL2 and displays the results as a 
contoured field in units of degrees Celsius. WINGRIDDS uses the standard definition of U, viz., the 
temperature difference between the temperature a parcel obtains when lifted from some lower level (i.e., 
LVL1) dry adiabatically until it reaches saturation, then moist adiabatically to some specified upper level 
(e.g., LVL2 set equal to 500 mb), with the observed (or forecast) ambient mb temperature at the upper 
level (assuming no mixing or entrainment of environmental air into the parcel)- For example to compute the 
surface-based U similar to the NGM surface U on AFOS (PIL NMCGPH02L, 04L, etc.), you first set the 
bottom layer to the lowest sigma layer (S982) and the upper level to 500 mb (500) using the command 
"SLYR S982 500", then type in LNDX. 
 
See also LIFT, LFTDX, PLCL, TTHE. 
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PLCL  
(SCALAR) Calculates the pressure of the lifted condensation level (LCL) using temperature, moisture, and 
pressure values taken from the current vertical level (LVL) and displays a contoured field In units of 
millibars (mb). The LCL Is the level at which saturation of an initially unsaturated parcel occurs. See also 
PDEF, TLCL, TTHE. 
 
PDEF > Calculates the Pressure lift needed for saturation from the LCL 
 
 
TLCL  
(SCALAR) Calculates the temperature at the lifted condensation level (LCL) of parcels having 
characteristic temperature, moisture, and pressure values taken from the current vertical level (LVL) and 
displays a contoured field in units of degrees Celsius (°C). The LCL is the level at which saturation of an 
initially unsaturated parcel occurs. See also PDEF, TLCL, TTHE. 
 
TTHE > Calculates temperature of parcel lifted from bottom to top of layer 
 
 
**- COMMANDS TO ALTER APPEARANCE OF DISPLAYIED FIELDS AND DATA  
 
A.        COLOR 
 
The color of contour lines or alphanumeric data (see DATA) are based on the color palette line and the 
number of overlays. When the first field is displayed after the screen erases, it will use color 1, which is the 
left hand-most color on the color bar at the bottom of the screen. Subsequent overlays of fields increment 
the color by one for each overlay. For example, the command "BKNT/TEMP/HGHT will display the height 
field first in color one, then the temperature field is overlaid in color 2, the wind barbs in color 3.  (NOTE: 
sometimes this scheme for contour coloring does not work - there is a known bug in the software that 
cause multiple overlays to be displayed in the same color - normally color 2. Hopefully, a future software 
will have this bug corrected). 
 
Commands are available to override the default contour colors. They all begin with "CLR" and either a 
single digit number (1-9 & 0, inclusive) or a single alphabetic letter (A-Z, inclusive). The numbers and 
letters represent color as depicted in the thin color palette line at the bottom of all WINGRIDDS graphic 
displays. Solid contours are displayed for all single digit numbers (1-9 & 0) and the letters: A, B, C, E, F. 
Dashed contours can be displayed by using the letters "G" through "W”, inclusive, as in CLRH. Dotted 
contours can be displayed by using the letters X, Y, or Z. 
 
Note that the command "CLRD" has special meaning in that it is the same color as the map background 
(i.e., black). When CLRD is used to display a field, it will appear in the background color (i.e., black) and 
you won't see it. However, if CLRD is used to overlay a field that has previously been displayed, that field 
will be erased without disturbing the rest of the display area. 
 
 
Remember that the color palette can be changed by changing the values within the default file 
PALETTE.CLR. 
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Solid lines... 
 
CLR1 Override default and use color 1 in palette (Solid). 
 
CLR2 Override default and use color 2 in palette (Solid). 
• •• 
CLR9 Override default and use color 9 in palette (Solid).  
 
CLR0 Override default and use color 10 in palette (Solid). 
CLRA Override default and use color 11 in palette (Solid). 
• •• 
CLRF Override default and use color 16 in palette (Solid). 
 
Dashed lines... 
 
Note: the commands CLRH, CLRI,... through CLRW, inclusive all plot dashed lines -the only difference 
being in color plotted. 
 
CLRG  Override default and use color 1 in palette (Dashed). 
 
CLRH Override default and use color 2 in palette (Dashed). 
• •• 
CLRW   Override default and use color 16 in palette (Dashed). 
 
DASH     
Sets display mode to plot dashed lines for parameter specified either to 
the right or left. For example, the commands "DASH TEMP" and TEMP DASH" do exactly the same thing; 
i.e., they plot the temperature contours as dashed lines. See also DNEG, DPOS. 
 
 
Dotted lines... 
 
CLRX    Override default and use color 14 in palette (Dotted). 
 
CLRY    Override default and use color 15 in palette (Dotted). CLRZ Override default and use color 16 in 
palette (Dotted). 
 
B.       CONTOUR AND DATA SMOOTHING 
 
CNSM |KSMO| [ integer value] > Changes smoothing (1) on Contours  
 
SMTH > Applies a binomial smoother to the active gridded data  
 
SMOO > Applies a light smoother to the active gridded data 
 
DALY |PRDY| > Converts diagnostic command results from /sec to /day  
 
HRLY |PRHR| > Converts diagnostic command results from /sec to /hour 
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STOF > Stops display of grid statistics.  
 
STON > Starts display of grid statistics. 
 
 
 
WINGRIDDS Automatic Mode 
 

The following discussions describe the operation of WINGRIDDS in Automatic Mode. 
 
WINGRIDDS can be run in an automatic mode.  Within a batch file or if you are at a Windows 
Command prompt, you can enter WINGRIDDS  a listing of up to 35 PCG Data files  a single 
Command Macro file name.  WINGRIDDS will startup, load all the data files in the order they were 
listed and will execute the command macro file and will then quit.  This process is useful for 
generating WINGRIDDS graphics (a screen save operation) without needing to have a user do it by 
hand.  The screen save commands (SAVS) must be included in the command macro and the 
command macros cannot require any user intervention or the system will pause waiting for the user to 
enter the required data.  
 
Remember, if WINGRIDDS is in 4PNL mode and all 4 windows are to be saved as one image, enter 
the command ALWN just before the SAVS command. 

 
-- Automatic Starting WINGRIDDS  

Use the following example to initiate a WINGRIDDS session in Automatic Mode: 
 
  1. From the MS command line within the WINGRIDDS directory or within a batch file, enter: 
    c:\ WINGRIDDS > WINGRIDDS JL030312.ETA211 TEST.CMD 
 

All commands are separated by spaces and the last entry MUST be the name of a single 
command macro file name with the .CMD extension. 
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Online Help 
 
There are four (4) different types of help functions within WINGRIDDS for the user to utilize in the operation 
of WINGRIDDS.   
 
 
-- Help Menus 

This menu option shows the Macro Help and WINGRIDDS and GRIB documentation.   
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-- Macro Help 
 
All Command Macro files *should* have a help created to go along with the macro to explain in detail 
what the macro is doing and what data and input it expects.  See the figure below: 
 

 
 
With the Macro Help dialog, the user enters the 4-character name of the help file (which should be 
the same as the macro name) and click ‘Search’ or hit the [Enter] key.  The program will search 
for that macro help file name and, if found, display the contents.  If no file is found, the user will be 
notified. 
 
These macro help files are stored in the ‘Help’ directory of the WINGRIDDS program and are 
simple text files with the file name extension ‘.hlp’.  If any user creates a new command macro, 
they are encouraged to create a corresponding help file for other users to use. 
 
-- WINGRIDDS Documentation 
  Opens up the WINGRIDDS User Guide within Adobe Acrobat Reader or other PDF file viewer. 
 
-- GRIB1 & GRIB2 Documentation 
  Opens the GRIB 1 or GRIB 2 Documentation with the default HTML viewer.  
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Customizing the WINGRIDDS System 
 
 
You can customize the basic operation of WINGRIDDS by modifying the files in the \WINGRIDDS\USER 
directory.  Unless otherwise specified, all files discussed in this section reside in the \WINGRIDDS\USER 
directory.  Many files contain internal documentation that describes each item and its range of acceptable 
values.  It is IMPERATIVE that you make the data entries at the specified line and column of the file. 
 

Note: The documented files identify a line number and an entry number for each data entry. The line position of 
an entry should not be changed. 

 
 
-- WINGRIDDS Configuration 
Many new improvements have been added to this version of WINGRIDDS and several underlying details 
have been changed in how this version of WINGRIDDS stores configuration data verses how WINGRIDDS 
v2.0 did.  The WINGMODE.DAT file is now no longer used and has been replaced by WINGCFG.DAT.  
However, WINGCFG.DAT is not meant to be directly modified by the WINGRIDDS user as it was with 
WINGCFG.  Now, within WINGRIDDS, a ‘Properties’ menu and dialog has been created for the user to 
manage the look-and-feel of WINGRIDDS. The new menu entry looks like this: 
 

 
 
The ‘Properties’ dialog is a tabbed dialog with eight (8) different sections which will control the way 
WINGRIDDS looks and operates.  These sections will be covered in detail below. 
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This WINGRIDDS Contour Color tab controls the colors of the individual contour colors which are shown 
across the bottom of the screen.  The individual Red-Green-Blue (RGB) values are adjustable between 0-
255 either through the Up/Down arrows or typing directly in each window. The color patch on the right is 
dynamic and will reflect the current RGB values.  The ‘Color’ buttons open a color select dialog which will 
be covered later. 
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The WINGRIDDS Surface/Upper Air Station Colors dialog controls the way the surface and upper-air 
station plots look.  The numbers to the left of the parameters are associated with the parameter locations 
when plotted.  The color selection is as explained before.  
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The WINGRIDDS Data Directories dialog allows the user to manage where raw and processed data is 
stored.  The user can either type directly in the individual windows or click the ‘Select’ button which opens a 
graphical directories dialog which is shown below. 
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This Directories Dialog pops up whenever the user clicks a ‘Select’ button.  This allows the user to 
graphically roam and select the desired directory.   
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This dialog controls the look and feel of all of the sounding displays.  The colors are controlled as with the 
other color selections.  The Check-boxes down the left side either enable or disable the individual 
parameters as to whether they are displayed on the screen.  The colors of the Wind Barbs/Arrows are 
controlled in the Hodograph Colors dialog shown next. 
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This dialog controls the look and feel of the Hodograph display.  The colors are controlled as with the other 
color selections. The Wind colors are also reflected on the Sounding displays.  The ‘Hodograph Wind Ring 
Settings’ section define whether the rings on a Hodograph are automatically adjusted to the maximum wind 
speed on a specific display or if the wind rings are fixed regardless of the maximum wind speeds. When 
the Hodograph is animated, the rings could change with every forecast hour causing the display 
appearance to jump around. Now, if the win speed scaling is set to ‘Manual’ the speed rings will be fixed to 
the setting within the window which is in meters-per-second. If there are wind speeds greater than the fixed 
setting, they will be drawn beyond the hodograph border & will not be seen. 
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This dialog controls the look and feel of all of the Streamline displays.  
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This dialog controls the default behavior of other WINGRIDDS display issues.  The colors are controlled as 
with the other color selections.  The buttons within each border show that only one of the selections can be 
selected.  The colors at the bottom control the default maximum/minimum color values associated with the 
gradient displays. 
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This dialog controls the look and feel of all of the WINGRIDDS Map and Cross/Time Section displays as 
well as Custom Map Navigation Startup settings.  The colors are controlled as with the other color 
selections. 
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Users have the ability for WINGRIDDS to startup with a fixed window size other than the Full-Window.  The 
user can choose the window height & width in pixels to allow easier Web page creation. 
 
Users have the ability to always force NGRB2PCG32 to process in old-file format when the check-box is 
checked. 
 
There are radio-buttons to switch between 2 different contour labels styles: Whole Integer (Classic) or 
Floating Point/Exponential Notation. When a button is selected, that will be the contour labeling mode for 
operations. 
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Custom Color Selection 
 

 
 
Whenever a ‘Color’ button is pressed, the Color dialog is displayed and the user can select a customized 
color for the specific parameter through either selecting a ‘Basic’ color, ‘Custom’ color or dragging the 
mouse in the rainbow window or typing the specific RGB values or Hue-Saturation-Luminance values. 
Press ‘OK’ to accept or ‘Cancel’ to reject any selection. 
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 -- Model Origination and Flight Levels for Labels 
The file, WINGLBL.USR, provides information that WINGRIDDS uses to customize the labels which 
describe output from the products (refer to 'Defining Products').  The file contains the model and plot 
origination for the LFO# label command.  It also contains a corresponding list of pressure levels (hPa) 
and flight levels for the LFL# label command.  Refer to the file for a description of each item and its 
acceptable values.  A sample file is shown below. 

 
................ Begin file WINGLBL.USR .............................. 
'DOC/NOAA/NWS    WAFC-WASHINGTON' 
LINE 1 (Entry 1) MODEL AND PLOT ORIGINATION 

THE TEXT IS DISPLAYED IN THE PLOT LABEL WHEN THE LFO# 
COMMAND IS USED.  THE TEXT MUST BE ENCLOSED IN  
QUOTES. 

********************************************************************* 
850,700,500,400,300,250,200,150,100, 70,  -1,-1,-1,-1,-1 
050,100,180,240,300,340,390,450,530,450,  -1,-1,-1,-1,-1  
LINE 7 (Entry 2) LIST OF PRESSURE LEVELS (UNITS=hPa). 
LINE 8 (Entry 3) LIST OF FLIGHT LEVELS THAT CORRESPOND TO THE PRESSURE LEVELS IN 

LINE 7.  
THE TEXT IS DISPLAYED IN THE PLOT LABEL WHEN THE LFL# 
COMMAND IS USED.  EACH VALUE MUST BE SEPARATED BY A COMMA.  
VALUES FOR ALL 15 LEVELS MUST BE ENTERED.  A VALUE OF -1 
INDICATES THAT NO VALUE IS DEFINED FOR THAT POSITION.  ALL 
THE UNDEFINED POSITIONS MUST BE AT THE END OF THE LIST AND 
MUST CONTAIN -1. 

............... End file WINGLBL.USR ................................. 
 
 
-- Initial Pressure Levels and Forecast Hours 

When WINGRIDDS starts, the level and time specifications are set to the default values defined in the 
file INITGRID.SPC. 

 
Line 1 Pressure level, vertical layer, forecast hour, and time range are defined on line 1 of the file.  

Each of the 6 fields has a length of 4 characters. 
 

Line 2 The pressure levels used for time-section and cross-section plots are defined on line 2 of 
the file.  A maximum of 19 pressure levels can be entered.  The number of pressure levels 
entered (field 1) has a length of 2 characters and can have a value between 1 and 19.  
Each of the pressure level fields has a length of 4 characters.  The number of pressure 
level fields you actually enter must agree with the number of levels you specify in field 1. 

 
Line 3 The forecast hours used for time-section plots are defined on line 3 of the file.  A total of 

19 forecast hours MUST be entered.  If you wish to define fewer hours, the remaining 
values must be set to zero.  The number of hours defined (field 1) has a length of 2 
characters.  Each of the hour values (fields 2-20) has a length of 4 characters.  The 
increment between selected hour fields (field 21) has a length of 2 characters.  This 
increment determines which of the defined hour fields will actually be used by 
WINGRIDDS for time-section plots.  Refer to 'Changing Forecast Hours for Time-section 
Plots' for a discussion of the effect these values have on the plot display. 

 
Each line of the file must begin in column 1.  Values must be right justified within their field.  There are 
no spaces between the fields.  Numerical values are expressed as integers with no decimal point. 
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Below is a sample INITGRID.SPC file.  The lines are formatted as described above. 
 

 2501000 500  12   0  24 
101000 850 700 500 400 300 250 200 150 100 
13  36  33  30  27  24  21  18  15  12  09  06  03  00  00  00  00  00  00  00 2 

 
This second example contains the same data as the previous sample file, but with the field positions 
indicated below each line for clarity.  The lines are grouped into pairs.  The first line is the file entry.  
The second line indicates the field positions for reference, but is not actually entered into the file. 

 
 2501000 500  12   0  24 
111122223333444455556666 
101000 850 700 500 400 300 250 200 150 100 
112222333344445555666677778888999900001111 
13  36  33  30  27  24  21  18  15  12  09  06  03  00  00  00  00  00  00  00 2 
11222233334444555566667777888899990000111122223333444455556666777788889999000011 

 
This example defines the following initial specifications: 

 
 Pressure level:  250 hPa 
 Vertical layer:  1000 hPa-500 hPa 
 Forecast hour:  12 
 Time range:   0-24 
 10 Pressure levels: 1000 850 700 500 400 300 250 200 150 100 
 13 Forecast hours: 36  33  30  27  24  21  18  15  12  09  06  03  00   

The field increment of 2 selects 7 hours:  36 30 24 18 
12 6 0 

 
 
-- Changing Width of a Cross-section Plot 

By default, cross-sections are displayed in proportion to the vertical height.  As a result, very narrow 
cross-sections may cover a small portion of the screen width.  To control the width of the cross-
section display while the program is in execution, you can use one of the following commands: 

 
XNRO Displays the cross-section in proportion to vertical height 

 
XWID Displays the cross-section in proportion to the vertical height 

 
Both of these commands must be entered in PLAN  view. 

 
 
-- Changing Pressure Levels for Cross-section and Time-section Plots 

WINGRIDDS initializes the pressure levels used for cross-section and time-section plots from the 
default set of values defined in the file INITGRID.SPC.  The information specified in this file includes 
the number of levels defined and the level values.  To change this default set of levels while the 
program is in execution, you can use the command 'XLVL xxxx', where xxxx is a 4 character file 
name (xxxx.LVL).  Once a set of pressure levels is defined, it will remain in effect until a new set is 
defined with the 'XLVL' command. 
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MAND.LVL is a sample file that defines the values of the pressure levels used for time-section and 
cross-section plots using only mandatory pressure levels.  The number of pressure levels entered 
and the value of each level are entered on line 1 of the file starting in column 1.  A maximum of 19 
pressure levels can be defined.  The number of pressure levels entered (field 1) has a length of 2 
characters while each of the pressure level fields has a length of 4 characters.  The actual number of 
pressure level fields you enter must agree with the number of levels you specify in field 1.  The values 
must be right justified within the field.  There are no additional spaces between the fields.  Numerical 
values are expressed as integers without decimal points. 

 
In the example shown below, the first line is the actual file entry.  The second line indicates the field 
positions for clarity, but is not actually entered into the file. 
 

101000 850 700 500 400 300 250 200 150 100 
112222333344445555666677778888999900001111 

 
This example defines 10 pressure levels:  1000 850 700 500 400 300 250 200 150 100. 

 
 
 
 
-- Changing Forecast Hours for Time-section Plots 

WINGRIDDS initializes the forecast hours used to generate time-section plots with the default set of 
values defined in the file INITGRID.SPC.  The information specified in this file includes the number of 
hours defined, the hour values and the time increment  The time increment determines which of the 
defined hour fields will actually be used by WINGRIDDS for time-section plots.  You can use the 
command 'THRS xxxx', where xxxx is a 4 character file name (xxxx.HRS), to change the default set 
of hours while the program is executing.  Once a set of hours is defined, it will remain in effect until a 
new set is defined with the 'THRS' command.  The time increment is defined in the .HRS file, but it 
can be changed independently with the 'TINC ####' command, where #### is the time increment. 

 
36HR.HRS is a sample file that defines the forecast hours used for time-section plots.  The number of 
hours defined, the hour values and the time increment are entered on line 1 of the file starting in 
column 1.  A total of 19 forecast hours MUST be entered.  If you wish to define fewer hours, the 
remaining values must be set to zero.  The number of hours defined (field 1) has a length of 2 
characters.  Each of the hour values (fields 2-20) has a length of 4 characters.  The increment 
between selected hour fields (field 21) has a length of 2 characters.  The values must be right justified 
within the field.  There are no spaces between the fields.  Numerical values are expressed as 
integers. 

 
In the example shown below, the first line is the actual file entry.  The second line indicates the field 
positions for clarity, but is not actually entered into the file.  All the data must be entered on the first 
line of the file. 
 

13  36  33  30  27  24  21  18  15  12  09  06  03  00  00  00  00  00  00  00 2 
11222233334444555566667777888899990000111122223333444455556666777788889999000011 

 
This example defines 13 times:  36  33  30  27  24  21  18  15  12  09  06  03  00.  The time increment 
of 2 selects 7 times (36 30 24 18 12 6 0) that are actually used to create displays. 

 
Note that the number of times defined is also used to control the width of the time-section screen 
displays.  The time-section plot is scaled so that up to 19 times can be displayed across the full width 
of the screen.  If you define fewer times, the display is centered but covers less of the screen width, 
as illustrated in the following examples. 
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Example 1: This file entry defines only 4 times (30,24,18,12).  The time increment of 1 specifies 
all four hours for data selection.  The data for hours 30,24,18,12 are displayed from 
the top to the bottom of the screen, but only across the center 4/19 of the horizontal 
screen width. 

 
04  30  24  18  12  00  00  00  00  00  00  00  00  00  00  00  00  00  00  00 1 
11222233334444555566667777888899990000111122223333444455556666777788889999000011 

 
Example 2: This file entry defines 7 times (30,27,24,21,18,15,12).  The time increment of 2 

specifies only four of the times (30, 24,18,12) for data selection.  The data used to 
create the displays come from the same hours as example 1 (30,24,18,12), but are 
now displayed across 7/19 of the screen because more hours were defined. 

 
07  30  27  24  21  18  15  12  00  00  00  00  00  00  00  00  00  00  00  00 2 
11222233334444555566667777888899990000111122223333444455556666777788889999000011 

 
Example 3: This file entry defines 10 times (30,28,26,24,22,20,18,16,14,12).  The time increment 

of 3 still specifies the same hours for data selection as Example 1 (30,24,18,12), but 
now the data are displayed across 10/19 of the screen. 

 
10  30  28  26  24  22  20  18  16  14  12  00  00  00  00  00  00  00  00  00 3 
11222233334444555566667777888899990000111122223333444455556666777788889999000011 

 
Example 4: This file entry defines 10 times (12,14,16,18,20,22,24,26,28,30).  The time increment 

of 3 still specifies the same hours for data selection as Example 1 (30,24,18,12), but 
now the data are displayed across 10/19 of the screen. Also, the time will increment 
from left-to-right.  

 
10  12  14  16  18  20  22  24  26  28  30  00  00  00  00  00  00  00  00  00 3 
11222233334444555566667777888899990000111122223333444455556666777788889999000011 
 

-- Station ID Lists 
The list of station id’s used to define a display mode (refer to ‘Display Menu’) is contained in the file, 
\WINGRIDDS\DATA\STNID.DAT.  There is also a list of primary stations used for Observation 
Station plots called STNID-PRIME.DAT. This is a list of stations the user wants to be guaranteed to 
be plotted (if data is available).  It is also in the \WINGRIDDS\DATA directory and has the same 
format as STNID.DAT.  However, stations at the top of the list have priority to be plotted over other 
stations lower on the list. 
 
If necessary, your system administrator can add additional station id’s to the files.  The following 
items must be entered for each station you add: 

 
Station id  3 or 4 character id; a 3 character id must be contain a leading blank (e.g., 

_ADS).  Use uppercase letters. 
 

Latitude  Real number of the form ###.## (e.g., _35.23); North latitudes are positive; 
South latitudes are negative. 

 
Longitude  Real number of the form ####.## (e.g., -101.70); East longitudes are positive; 

West longitudes are negative. 
 

It is imperative that new entries be aligned with the current values in the file. 
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-- User Defined Alias Commands 
WINGRIDDS performs computations using internally defined basic commands and combinations of 
these basic commands called alias commands.  An alias command can be defined in terms of basic 
WINGRIDDS commands and other alias commands.  It is useful to define alias commands when you 
repeatedly execute a group of WINGRIDDS commands or if you want to create up to a 10-letter 
command that is more appropriate for a user. 

 
Basic systems alias commands are defined in the file, WINGRIDDS\DATA\ALIAS.DAT, and 
SHOULD NOT BE MODIFIED.  You can expand the number of available alias commands by making 
an entry in the file, ALIAS.USR, in the WINGRIDDS\USER directory.  The format of the entry is 

 
xxxxxxxxxx=aaaa bbbb cccc ... oooo 

 
where 'xxxxxxxxxx' is the alias name up to 10 alphanumeric characters long and 'aaaa bbbb cccc ... 
oooo' is the series of WINGRIDDS and other alias commands that define the new alias.  All entries 
must be in uppercase and have the exact format specified above.  The definition may contain a 
maximum of 50 commands/aliases and must be entered on one line of the file starting in column 1.  
An alias definition must not reference a macro (refer to 'Defining Products').  It can, however, be used 
in a macro.  An alias command must not duplicate a WINGRIDDS command name or system alias.  
Once an alias is entered into ALIAS.USR, it can be used like any WINGRIDDS command. 

 
A sample alias command that plots the vector wind as barbs is shown below. 

 
WNDB=BARB WIND 

 
Alias commands can have the potential to get very complicated and it is very important to understand 
that every command that replaces an alias command gets parsed through both the ALIAS.DAT and 
ALIAS.USR files. The following shows a more complex example: 
 
VV54=SAVR VVEL 500 VVEL 400 
VV67=SAVR VVEL 700 VVEL 600 
VVML=SMLC 1000 SAVR VV54 VV67 
 
The main alias command is VVML which yields the first command VV67. VV67 would then be parsed 
and yield:  
 
VV67=SAVR VVEL 700 VVEL 600 
 
Since there are no other alias listed commands in that string, the next command parsed in the VVML 
line would be VV54. VV54 would then be parsed and yield: 
 
 VV54=SAVR VVEL 500 VVEL 400 
 
Since there are no other alias commands in the VVML command string, the final combined string to 
be executed in WINGRIDDS would look like this: 
 
SMLC 1000 SAVR SAVR VVEL 500 VVEL 400 SAVR VVEL 700 VVEL 600 

 
Alias commands can also be used to translate WINGRIDDS commands for international users. 

 
VENT=WIND (French) 
VNTO=WIND (Spanish/Portuguese) 
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-- GRIB Specifications for Data Ingest 
The ingest process requires information relating GRIB identification values to convert model, grid, 
level, and parameter identifiers to the corresponding WINGRIDDS identifiers.  Lists of these 
relationships are provided by the following set of files which reside in the GRIB directory.  For most 
users, the default values contained in these files are sufficient.  However, they may be modified if a 
required relationship was omitted. 

 
GRIBMODL.DAT 

This file is composed of entries containing a GRIB model value and its corresponding 
WINGRIDDS character model identifier.  The GRIB model value is expressed as 3 numeric 
characters beginning in column 1.  This is the WINGRIDDS model ID which consists of 3 
alphanumeric characters beginning in column 5. 

 
The WINGRIDDS model identifier has the following functions. 

 
1. The model ID with a 1 character grid ID forms the 4 character WINGRIDDS model 

name which is used to reference information in the green area at the bottom of the 
screen while in Menu mode. 

 
2. The first 2 characters of the WINGRIDDS model ID with a 1 character grid ID form 

the 3 character extension of the NWS and WAFS data file name. 
 

Note: Some models, analyses, and/or forecasts from the same model run may be assigned 
different GRIB model values.  To collate this data into a single WINGRIDDS data set, 
these different GRIB model values are given the same WINGRIDDS model identifier. 

 
 
GRID.DAT         

This file is composed of entries relating a GRIB grid identification value to a corresponding 
WINGRIDDS grid identifier.  The WINGRIDDS grid identifier is used in conjunction with the 
WINGRIDDS model identifier as described above. 

 
A portion of GRID.DAT is listed below.  The first line indicates the field positions for clarity, but is 
not actually entered into the file.  Note that there can be multiple entries for some GRIB grid 
identifiers.  When this situation occurs, the first entry in the file for a given GRIB grid identifier is 
processed and the remaining entries (included only for historical purposes) are ignored. 

 
111 2 ______________33333333333333333333333333333333 
212 4               AWIPS 40KM FULL GRID 
212 4               AWIPS 40KM SUBSETTED GRID 
211 8               AWIPS 80KM FULL GRID 
211 8               AWIPS 80KM SUBSETTED GRID 
  6 L               LFM GRIDS 
101 G               NGM 'OLD' C-GRID 
104 S               NGM SUPER C-GRID 
105 C               NGM '83' C-GRID 
201 H               AWIPS NORTH HEMISPHERIC GRID    
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A sample entry (line 2 in the above sample file) and a description of each field in the entry is 
shown in the following table.  Optional fields must be blank filled if they are not used. 

 
 
Example 

 
Field 

 
Description 

 
Start 
column 

 
Number of 
characters 

 
Character 
type 

 
212 

 
1 

 
GRIB grid identification number 

 
1 

 
3 

 
Numeric 

 
4 

 
2 

 
WINGRIDDS grid identifier 

 
5 

 
1 

 
Text 

 
AWIPS 40KM 
SUBSETTED 
GRID 

 
3 

 
Grid description-optional 

 
20 

 
N/A 

 
Text 

 
 

GRIBPARM.DAT and MOSGRIBPARM.DAT 
These files are composed of entries relating GRIB1 parameter identifiers to corresponding 
WINGRIDDS parameter names.  The WINGRIDDS parameter name with the WINGRIDDS level 
identifier is then used to form the 8 character WINGRIDDS field name (e.g., TEMPB015).  
GRIBPARM.DAT is used for WAFS and NWS general GRIB1 file processing and 
MOSGRIBPARM.DAT is only used for MOS GRIB1 processing due to the different parameters 
which pertain to MOS data. 

 
A portion of GRIBPARM.DAT is listed below.  The first line indicates the field positions for 
clarity, but is not actually included in the file. The MOSGRIBPARM.DAT layout is similar. 

 
111 2222 3333 444 55555555555555555555555 
001 PRES       -2 PRESSURE 
002 PRES  MSL  -2 MEAN SEA LEVEL PRESSURE 
003 PTND       -2 PRESSURE TENDENCY 
007 HGHT          HEIGHT - GEOPOTENTIAL 
008 GHGT          HEIGHT - GEOMETRIC 
010 OZON          TOTAL OZONE 
011 TEMP          TEMPERATURE 
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A sample entry (line 2 in the above example) and a description of each field in the entry is 
shown in the following table.  Optional fields must be blank filled if they are not used.  The level 
override is used to set a standard level when there are potentially conflicting levels in the GRIB 
message.  If a level override is given, that value is used in place of the WINGRIDDS level 
identifier.  The ‘power of 10' scale factor is used to convert the data from the units used in the 
GRIB message to those desired for WINGRIDDS.  It is the user’s responsibility to assure that 
the final scaled value is within the floating point range of -3.4E+38 to +3.4E+38. 
 

 
 
Example 

 
Field 

 
Description 

 
Start 
column 

 
Number of 
characters 

 
Character type 

 
001 

 
1 

 
GRIB parameter identifier 

 
1 

 
3 

 
Numeric 

 
PRES 

 
2 

 
WINGRIDDS parameter name 

 
5 

 
4 

 
Alphanumeric 

 
MSL 

 
3 

 
Level override (optional) 

 
10 

 
4 

 
Alphanumeric 

 
-2 

 
4 

 
Power of ten scale factor (optional) 

 
15 

 
3 

 
Signed integer 

 
MEAN SEA 
LEVEL 
PRESSURE 

 
5 

 
Parameter description (optional) 

 
19 

 
N/A 

 
Text 

 
 

GRIB2PARM.DAT 
 

All GRIB2 messages use the parameter decode file called GRIB2PARM.DAT.  This file has 
similar functions to the GRIBPARM.DAT file which will still be used for any GRIB1 processing. 
Notice, the parameter name allowance has been extended from 4 characters to 8 to allow more 
verbose parameter naming. 

 
Due to the different parameter encoding scheme used in GRIB2 messages, the format of the 
GRIB2PARM.DAT file is different as well.  See the example below: 
 

 
 
 
111 222 333 44444444 5555 666 7777777777777777777777777777777777777777777777777777 
000 000 000 TEMP              TEMPerature (deg K converted to deg C by WINGRIDDS) 
000 000 001 VTMP              Virtual TeMPerature (degree K) 
000 000 002 THTA              potential temperature [THeTA] (degree K) 
000 000 003 THTE              equivalent potential temperature [THeTa-E] (degree K) 
000 001 000 SPFH              SPeciFic Humidity (g/g) 
000 001 001 RELH              RELative Humidity (%) 
000 001 002 MIXR              MIXing Ratio (g/g) 
000 001 003 PWAT     0000  -1 Precipitable WATer (cm) 
000 001 004 VPRS           -2 Vapor PReSsure (mb=hPa) 
000 002 000 WNDD              WiND Direction (degree) 
000 002 001 WNFF              WiNd speed (m/sec) 
000 002 002 UGRD              GRiD relative U wind component (m/sec) 
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Example 

 
Field 

 
Description 

 
Start 
column 

 
Number of 
characters 

 
Character type 

 
000 

 
1 

 
GRIB2 Discipline from Section 0 

 
1 

 
3 

 
Numeric 

 
001 

 
2 

 
GRIB2 Category number 

 
5 

 
3 

 
Numeric 

 
003 

 
3 

 
GRIB2 Parameter number 

 
9 

 
3 

 
Numeric 

 
PWAT 

 
4 

 
WINGRIDDS parameter name 

 
13 

 
8 

 
Alphanumeric 

 
0000 

 
5 

 
Level override (optional) 

 
22 

 
4 

 
Alphanumeric 

 
-1 

 
6 

 
Power of ten scale factor (optional) 

 
27 

 
3 

 
Signed integer 

 
PRECIPITABLE 
WATER 

 
7 

 
Parameter description (optional) 

 
31 

 
N/A 

 
Text 

 
Within both the GRIB2PCG32 and NGRB2PCG32 debug output files, the GRIB2 Discipline, 
Category and Parameter numbers are listed for each GRIB2 message as follows: 
 
GRIB2 Displn/Cat/Param =    0   1   29 
 
With the appropriate numbers listed for the specific parameter.  If the parameter is not listed 
within the GRIB2PARM.DAT file, the raw GRIB2 parameter name will be listed as well as 
follows: 
 
RAW GRIB2 PARAMETER = ASNOW 
 
So the user can go and add that parameter to the GRIB2PARM.DAT for WINGRIDDS to use. 
 
 

 
NOTICE***NOTICE*** NOTICE***NOTICE*** NOTICE***NOTICE*** 
The user should not presume that since the GRIB2 parameters are embedded within and 
automatically assigned that they should not need the GRIB2PARM.DAT for proper operations. 
The GRIB2PARM.DAT file is still required for and the ‘automatic’ ability within NGRB2PCG32 
should only be used for any new, esoteric parameters which are not within the 
GRIB2PARM.DAT file or which may be added by NCEP or WMO at a future date. 
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GRIB2ENSPROBPARM.DAT 
 

For NGRB2PCG32 to process Ensemble Probability GRIB2 data, it must utilize its own GRIB-to-
Parameter decoding file.  This file is of similar structure to GRIB2PARM.DAT.  See the example 
below: 
 

 
 
 
111 222 333 44444444 5555 666 7777777777777777777777777777777777777777777777777777 
000 000 000 TMP               TEMPerature (deg K converted to deg C by WINGRIDDS) 
000 000 002 THT               potential temperature [THeTA] (degree K) 
000 001 001 RLH               RELative Humidity (%) 
000 001 002 MXR               MIXing Ratio (g/g) 
000 001 003 PWT      0000  -1 Precipitable WATer (cm) 
000 001 004 VPR            -2 Vapor PReSsure (mb=hPa) 
 

 
 
Example 

 
Field 

 
Description 

 
Start 
column 

 
Number of 
characters 

 
Character type 

 
000 

 
1 

 
GRIB2 Discipline from Section 0 

 
1 

 
3 

 
Numeric 

 
001 

 
2 

 
GRIB2 Category number 

 
5 

 
3 

 
Numeric 

 
003 

 
3 

 
GRIB2 Parameter number 

 
9 

 
3 

 
Numeric 

 
MXR 

 
4 

 
WINGRIDDS parameter name 

 
13 

 
8 

 
Alphanumeric 

 
0000 

 
5 

 
Level override (optional) 

 
22 

 
4 

 
Alphanumeric 

 
-1 

 
6 

 
Power of ten scale factor (optional) 

 
27 

 
3 

 
Signed integer 

 
MIXING RATIO 

 
7 

 
Parameter description (optional) 

 
31 

 
N/A 

 
Text 
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GRIBLEVL.DAT 
This file is composed of entries containing a numeric GRIB level value and its corresponding 
WINGRIDDS character level identifier.  Only information for special levels is contained in this 
file.  WINGRIDDS identifiers for other levels are described in the section ‘Variables for Gridded 
Data Set’.  The WINGRIDDS parameter name the WINGRIDDS level identifier form the 8 
character WINGRIDDS field name. 

 
The GRIB level value is expressed as 3 numeric characters beginning in column 1.  This is the 
WINGRIDDS level id which consists of 4 alphanumeric characters beginning in column 5.  No 
WINGRIDDS level id can begin with zero except for the currently used values of 0000, 0DEG, 
0DGX. 

 
 
 
 
 
 
 
 
 

GRIB2SKIP.DAT 
 

GRIB2SKIP.DAT contains a list of parameters which, if they match what is in a GRIB2 
message, the message will be skipped and NGRB2PCG32 will not crash. Below is a sample of 
the GRIB2SKIP.DAT file: 

 
 
111 222 333 444 
003 000 243 255 
003 000 242 255 
002 002 109 255 
 
 
 
 

 
 
Example 

 
Field 

 
Description 

 
Start 
column 

 
Number of 
characters 

 
Character type 

 
003 

 
1 

 
GRIB2 Category number 

 
1 

 
3 

 
Numeric 

 
000 

 
2 

 
GRIB2 Parameter number 

 
5 

 
3 

 
Numeric 

 
243 

 
3 

 
GRIB2 Level number 1 

 
9 

 
3 

 
Numeric 

 
255 

 
4 

 
GRIB2 Level number 2 

 
13 

 
3 

 
Numeric 

 
 
Please refer to the Troubleshooting GRIB Ingest and Processing section for details on how to use this 
file. 
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-- Map Type Specifications 
 
        The MAPTYPE.DAT file is obsolete in WINGRIDDS and is not required for the processing of the    

PCG Version 2 data files.  HOWEVER – If you wish to display PCG Version 1 data files created      
with the DOS versions of PCGRIDDS, you MUST copy the MAPTYPE.DAT file from your PCGRIDDS 
program into WINGRIDDS for WINGRIDDS to accurately display the Version 1 files.  Please refer to 
the DOS PCGRIDDS documentation concerning the explanation of the MAPTYPE.DAT file fields  

 
 
 
 
-- Background Map Selection 
 

WINGRIDDS has many high resolution map files with a variety of different features which can be 
used. The map files are stored in the \WINGRIDDS\MAPFIL directory.   A file in the \WINGRIDDS\USER 
directory named MAPFILE.DAT is available to control the use of these high resolution map files.  The 
names of the map files which the user wishes to display are listed in this file.  The ‘WINGRIDDS Settings’  
tab of the ‘WINGRIDDS Properties’ dialog contain the selection to use the Hi Rez maps and that option 
under ‘Map Base File Name’ must be selected for WINGRIDDS to read the MAPFILE.DAT  file. 
 
In the MAPFILE.DAT, you list the new map file names you wish to display.  You can list multiple files for 
display.  Below is a list of the high resolution map file names and what they display: 
 
AFRICABOUND – Africa boundaries and lakes 
AFRICARIVER – Africa rivers 
ASIABOUND – Asia, Australia and Pacific Islands boundaries 
ASIARIVER – Asia and Australia rivers 
COUNTY – US Counties 
COUNTY2 – US Counties 
EUROPEBOUND – Europe boundaries and lakes 
EUROPERIVER – Europe lakes 
HRWO – Hi-Resolution World Outlines 
HRWOB – Hi-Resolution World Outlines  
HRUSS – Hi-Resolution US Streams 
LRUSR – Lo-Resolution US Rivers 
MRUSR – Med-Resolution US Rivers 
NOAM1-BDY – US-Canada boarder 
NOAM2-CIV – North America Outer Boundaries & Lakes 
NOAM3-STATE – North America State Boundaries 
NOAM4-RIV – North America Rivers 
NOAM – North America and Mexico Borders and boundaries 
NARR – North America Rural Roads 
NAIH – North America Interstate Highways 
NASH – North America State Highways 
NASR – North America State Roads 
SOUTHAMBOUND – South and Central America Boundaries and Lakes 
SOUTHAMRIVER – South and Central America Rivers 
STATES – US Hi Resolution State Boundaries 
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Also, within the \WINGRIDDS\MAPFIL directory is the directory Country_Provinces which has individual 
country files which contain high resolution province maps. These can be used only in conjunction with the 
high resolution files in the MAPFILE directory and are also controlled by the directions listed in the 
MAPFILE.DAT file. 
 
The use of the MAPFILE.DAT is explained in the comments within the file itself. Below is an example of 
the MAPFILE.DAT; 
 
**************************************************************************** 
! 
! This file lists all Hi-Rez map files to be plotted in WINGRIDDS 
! when the option is selected in the WINGRIDDS Properties. If an optional  
! entry is not used, the default parameter from the WINGRIDDS 
! Properties is used. Maps will be drawn in the order they are listed.  
! 
! The format is as follows: 
! 
!  1) (required) first is the file name from the MAPFIL/ directory 
! 
!  2) (optional) color the map info will be plotted in.  
!  There are 8 basic colors which can be used. The colors are: 
! 
!   black    
!   red      
!   yellow   
!   green    
!   cyan     
!   blue     
!   magenta  
!   white    
! 
!  3) (optional) line width - in pixels 
! 
!  4) (optional) line pattern style the map info will be plotted. 
!  There are 8 line styles which can be used but the 
!  represented number is what is used inline. The styles are: 
! 
!     SolidLine   - 0 
!     Dotted   - 1 
!     Dashed   - 2 
!     DotDash   - 3 
!     DotDotDash   - 4 
!     LongShort   - 5 
!     ShortDash   - 6 
!     LongShortShort  - 7  
! 
! 
! Individual Hi-Rez country province files are available as well & reside in  
! the MAPFIL\Country_Provinces directory. These files may be plotted with the  
! same color & pattern options as listed above. To include these files in the  
! map plotting, you must include the directory in the file string as follows: 
! 
! Country_Provinces\Guatemala_Prov.MAP green 1 2 
! 
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 
! 
!COUNTY.MAP cyan 1 1 
!NOAM4-RIV.MAP blue 3 
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!NAIH.MAP red 1 2 
Country_Provinces\Mexico_Prov.MAP red 1 2 
Country_Provinces\Guatemala_Prov.MAP green 1 2 
Country_Provinces\Cuba_Prov.MAP cyan 1 2 
Country_Provinces\Costa_Rica_Prov.MAP blue 1 2 
Country_Provinces\El_Salvador_Prov.MAP magenta 1 2 
Country_Provinces\Panama_Prov.MAP red 1 2 
Country_Provinces\Nicaragua_Prov.MAP cyan 1 2 
NOAM.MAP 
SOUTHAMBOUND.MAP 
*********************************************************************************** 
 
--Plan, Cross Section & Time Section Area Lookup Tables 
 
The Area Setup menus for Plan View, Cross Section and Time Section views all have a button labeled 
‘Lookup’ which opens a window with a list of geographic areas or station IDs from which to choose from to 
configure the specific operation the user is trying to configure.  The files to configure the Plan View, Cross 
Sections and Time Sections are AREA.DSP, CROS.DSP and TIME.DSP respectively and are located in 
the /DATA directory of WINGRIDDS.  These files are simple text files and can be updated and modified by 
the user to add or change the listings.  Each file’s contents are a fixed format and are similar but different 
and will be covered below. 
 
 AREA.DSP – this file contains the area of coverage/station ID, latitude, longitude and latitude N/S 
distance for the viewable area. A portion of AREA.DSP is listed below.  The first line indicates the field 
positions for clarity, but is not actually included in the file. 
 
1111111111111111222222344444445666 
AWIPS Grid 211   40.00N 100.00W 40 
Great Plains     39.12N  94.60W 20 
Gulf Coast       32.32N  90.08W 20 
Mid-Atlantic     38.00N  80.00W 20 
New England      42.75N  77.00W 20  

 
Notice, the area in field one is Left justified and all the data areas are Right justified. Negative numbers 
are not needed to signify different hemispheres.  That is shown in fields 3 & 5 with the N/S/E/W letters. The 
last line in this file is required to be the text ***DELETED*** .  This signifies the end of the data area. 

 
 
 
 

 CROS.DSP – this file contains the area of coverage/station IDs, and latitude/ longitude pairs for the 
start/end points of the Cross Section.. A portion of CROS.DSP is listed below.  The first line indicates the 
field positions for clarity, but is not actually included in the file. 
 
1111111111111111222222344444445666666788888889 
INL-ELP          48.57N  93.38W 31.80N 106.40W      
INL-PHX          48.57N  93.38W 33.43N 112.02W      
INL-TLH          48.57N  93.38W 30.38N  84.37W      
{ 80 West}       55.00N  80.00W 25.00N  80.00W      
{ 90 West}       55.00N  90.00W 25.00N  90.00W    
 
Notice, the area in field one is Left justified and all the data areas are Right justified. Negative numbers 
are not needed to signify different hemispheres.  That is shown in fields 3,5,7 & 9 with the N/S/E/W letters. 
The last line in this file is required to be the text ***DELETED*** .  This signifies the end of the data area. 
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 TIME.DSP – this file contains the area of coverage/station IDs, and latitude/ longitude pair for the 
location point of the Time Section. A portion of TIME.DSP is listed below.  The first line indicates the field 
positions for clarity, but is not actually included in the file. 
 
1111111111111111222222344444445 
BOS              42.37N  71.03W      
DEN              39.50N 104.40W      
ORD              41.98N  87.90W      
 
Notice, the area in field one is Left justified and all the data areas are Right justified. Negative numbers 
are not needed to signify different hemispheres.  That is shown in fields 3 & 5 with the N/S/E/W letters. The 
last line in this file is required to be the text ***DELETED*** .  This signifies the end of the data area. 
 
Setting and Reading Default Contour Color-Fill Colors 
 
WINGCONTFILLDEF.DAT within the USER/ directory contains the default listings of colors to be used 
whenever the command CTFC is used without a following reference to a file name containing specific color 
listings.  The format of the WINGCONTFILLDEF.DAT file included with WINGRIDDS is as follows:  
 
10 
148 0 211 
0 0 255 
0 255 0 
255 255 0 
255 0 0 
191 119   0                                                                               
0 0 150 
0 150 0 
150 150 0 
150 0 0 
 
Line 1 – number of Red-Green-Blue (RGB) colors to follow.  These range from 2 to 50. 
Lines 2-10 – the individual RGB values from 0-255 (0=black, 255 = bright) 
 
Since WINGRIDDS contouring algorithms default to have a consistent number of 9 contour lines on a 
display, it is best to have a minimum of 9 colors listed in the WINGCONTFILLDEF.DAT file to ensure all 
contours are assigned a color. 
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Customizing Data Downloading  
 

 
 
WINGRIDDS now has GRIB-file and Observation-file downloading capability which comprises of two utility 
functions, a batch file and, with the WINGRIDDS distribution, over 1800 data files which can be modified by 
the user to customize or add to any data file downloads the user wishes to add.  This section will describe 
how the system works and how it can be modified or updated. 
 
The GRIB/Observation download data files use the same book/chapter model of files that the ‘Product 
Menu’/’Command Window’ models use. In the figure above, the GRIB downloads are broken down into five 
fixed categories and each category has its own reference file which are located in the 
WINGRIDDS/GRIB/USER directory.  The Observation download has its own section but uses the same 
paradigm as the GRIB download. 
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GRIB/Observation Download Category file 
 
  Name The entries for each Download Category menu are stored in the files,  
 
  Download Category               Reference File 
  WAFS GRIB                            WAFSGDL.LST 
  Regular GRIB                          REGGDL.LST 
  MOS GRIB                               MOSGDL.LST 
  Ensemble-Regular GRIB         EREGGDL.LST 
  Ensemble-WAFS GRIB           EWAFSGDL.LST 
  Observation Data                    OBSDL.LST 
 

 
Format These files can be modified using a standard text editor.  Each line in the file 
defines a specific download category.  A maximum of 72 characters can be entered on a line.  
The lines are displayed sequentially. 

 
WINGRIDDS automatically ‘numbers’ the order of appearance for each entry on the 
menu page.  All other characters displayed for the entry lines must be contained in 
the menu file.  All lines in the menu must contain text.  If you wish to leave an empty 
line for clarity, add dashes as shown in the example below.   

 
NOTICE - All Reference files in the WINGRIDDS GRIB Download system follow the similar 
arrangements and usage.  Only one category is used for this example.  
 
The file contents for the first screen of the default ' Ensemble-WAFS GRIB' menu are listed 
below.   

 
............... Begin file EWAFSGDL.LST ............................ 
---    NCEP Server I - ENSEMBLE WAFS GRIB 
00Z WAFS  (ALL OCTANTS)  
06Z WAFS  (ALL OCTANTS) 
12Z WAFS  (ALL OCTANTS) 
18Z WAFS  (ALL OCTANTS) 
--- 
---    NCEP Server II - ENSEMBLE WAFS GRIB 
00Z WAFS  (ALL OCTANTS) 
06Z WAFS  (ALL OCTANTS) 
12Z WAFS  (ALL OCTANTS) 
18Z WAFS  (ALL OCTANTS) 
............... End page EWAFSGDL.LST ................................. 
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Download List file 
 

Name All the files for the ‘Ensemble-WAFS GRIB’ menus have the name EWAFSGDL.  
The line number of the entry in the ' Ensemble-WAFS GRIB ' file (EWAFSGDL.LST) 
determines the extension of the file (EWAFSGDL.###) that provides the information 
for the corresponding 'Ensemble-WAFS GRIB ' menu.  For example, if you select the 
entry  
‘00Z WAFS  (ALL OCTANTS)' which is on line 2 of the 'Ensemble-WAFS GRIB ' file, 
the product list contained in the file, EWAFSGDL.002, is displayed. 

 
Format This file can be modified using a standard text editor.  Each line in the file describes 

a specific product. The lines are displayed sequentially. 
 

A maximum of 72 characters can be entered on a line.  The first 4 characters of each 
line in a 'Ensemble-WAFS GRIB List' file must be the name of the macro file that 
corresponds to the selected entry.  For example, if you select entry 11, ‘AREA 
between  30W to  60E and  0N to 90N ' from EWAFSGDL.002 (listed below), the 
data file name, EWFI1003.DAT, is used as the argument for the utility 
GETGRIB.EXE. 

 
WINGRIDDS automatically ‘numbers’ the order of appearance for each entry on the 
menu page.  All other characters displayed for the entry lines must be contained in 
the menu file.  In the example below, some entries are left blank for clarity.  If the 
user selects a blank entry, WINGRIDDS return to the menu. 

 
The contents for the first screen of the default ‘Ensemble-WAFS GRIB List'  file, 
EWAFSGDL.002, are listed below.   

 
............. Begin file EWAFSGDL.002 ................................ 
                          --- Global Coverage --- 
EWAFG003   GLOBE Centered on Greenwich                 (Octants=OPMNKLIJ) 
                         --- Hemisphere Coverage --- 
EWNHG003   NORTHERN HEMISPHERE Centered on Greenwich   (Octants=KLIJ) 
EWSHG003   SOUTHERN HEMISPHERE Centered on Greenwich   (Octants=OPMN) 
                            --- Selected Areas --- 
EWPL2003   The Caribbean and the Americas              (Octants=PL) 
EWOK4003   The Pacific and the Americas                (Octants=OPKL) 
EWMI4003   Europe,Africa and Western Asia              (Octants=MNIJ) 
                  --***-- Northern Hemispheric Areas --***-- 
EWFI1003   AREA between  30W to  60E and  0N to 90N    (Octants=I) 
EWFI2003   AREA between  30W to 150E and  0N to 90N    (Octants=IJ) 
EWFI3003   AREA between  30W to 120W and  0N to 90N    (Octants=IJK) 
EWFJ1003   AREA between  60E to 150E and  0N to 90N    (Octants=J) 
EWFJ2003   AREA between  60E to 120W and  0N to 90N    (Octants=JK) 
EWFJ3003   AREA between  60E to  30W and  0N to 90N    (Octants=JKL) 
EWFK1003   AREA between 150E to 120W and  0N to 90N    (Octants=K) 
EWFK2003   AREA between 150E to  30W and  0N to 90N    (Octants=KL) 
EWFK3003   AREA between 150E to  60E and  0N to 90N    (Octants=KLI) 
EWFL1003   AREA between 120W to  30W and  0N to 90N    (Octants=L) 
EWFL2003   AREA between 120W to  60E and  0N to 90N    (Octants=LI) 
EWFL3003   AREA between 120W to 150E and  0N to 90N    (Octants=LIJ) 
                  --***-- Southern Hemispheric Areas --***-- 
EWFM1003   AREA between  30W to  60E and 90S to  0N    (Octants=M) 
EWFM2003   AREA between  30W to 150E and 90S to  0N    (Octants=MN) 
EWFM3003   AREA between  30W to 120W and 90S to  0N    (Octants=MNO) 
EWFN1003   AREA between  60E to 150E and 90S to  0N    (Octants=N) 
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EWFN2003   AREA between  60E to 120W and 90S to  0N    (Octants=NO) 
EWFN3003   AREA between  60E to  30W and 90S to  0N    (Octants=NOP) 
EWFO1003   AREA between 150E to 120W and 90S to  0N    (Octants=O) 
EWFO2003   AREA between 150E to  30W and 90S to  0N    (Octants=OP) 
EWFO3003   AREA between 150E to  60E and 90S to  0N    (Octants=OPM) 
EWFP1003   AREA between 120W to  30W and 90S to  0N    (Octants=P) 
EWFP2003   AREA between 120W to  60E and 90S to  0N    (Octants=PM) 
EWFP3003   AREA between 120W to 150E and 90S to  0N    (Octants=PMN) 
                --***-- Rectangular Pole-to-Pole Areas --***-- 
EWMI2003   AREA between  30W to  60E and 90S to 90N    (Octants=MI) 
EWMI4003   AREA between  30W to 150E and 90S to 90N    (Octants=MNIJ) 
EWMI6003   AREA between  30W to 120W and 90S to 90N    (Octants=MNOIJK) 
EWNJ2003   AREA between  60E to 150E and 90S to 90N    (Octants=NJ) 
EWNJ4003   AREA between  60E to 120W and 90S to 90N    (Octants=NOJK) 
EWNJ6003   AREA between  60E to  30W and 90S to 90N    (Octants=NOPJKL) 
EWOK2003   AREA between 150E to 120W and 90S to 90N    (Octants=OK) 
EWOK4003   AREA between 150E to  30W and 90S to 90N    (Octants=OPKL) 
EWOK6003   AREA between 150E to  60E and 90S to 90N    (Octants=OPMKLI) 
EWPL2003   AREA between 120W to  30W and 90S to 90N    (Octants=PL) 
EWPL4003   AREA between 120W to  60E and 90S to 90N    (Octants=PMLI) 
.............. End page EWAFSGDL.002 .................................. 

 
 
The naming of the ‘Ensemble-WAFS GRIB List'  files (and all other GRIB Download data files) are not fixed 
in any set way and the user creating new data files are free to name them in any way they choose. 
 
NOTICE – The List file names must not be longer than 8 alphanumeric characters long.  
 
Each line entry in the data file (except line 1) are read by GETGRIB.EXE and passed to the FTPCMD.BAT 
file.  The download data file format is explained below. 
 
Download Data file 
 

Name Each data file is a list of commands which are loaded into the FTPCMD.BAT file by 
the utility GETGRIB.EXE.  The names of the files are assigned by the user. 

 
Format This file can be modified using a standard text editor.  Each line in the file describes 
a specific product. The lines are displayed sequentially. 
 
There is no maximum number of characters to be entered on a line.  The first 4 characters of 
each line in a 'Ensemble-WAFS GRIB List' file must be the name of the macro file that 
corresponds to the selected entry.  For example, if you select entry 11, ‘AREA between  30W to  
60E and  0N to 90N ' from EWAFSGDL.002 (listed below), the data file name, EWFI1003.DAT, 
is used as the argument for the utility GETGRIB.EXE. 
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............. Begin file EWFI1003.DAT ................................ 
00                                                                                                                                                                                                       
@echo off                                                                                                                                                                                                
if "%4"=="" goto End                                                                                                                                                                                     
::                                                                                                                                                                                                       
:: Begin Download                                                                                                                                                                                        
::                                                                                                                                                                                                       
echo Please wait... This download may take a while...                                                                                                                                                    
::                                                                                                                                                                                                       
::                                                                                                                                                                                                       
cd \wingridds\grib\wafs\OctantI                                                                                                                                                                          
echo Downloading ENSEMBLE WAFS OctantI GRIB 000                                                                                                                                                          
“ftp://ftpprd.ncep.noaa.gov/pub/data/nccf/com/gens/prod/gefs.%1%2%3/%4/wafs/wafs.37.t%4z.ens0
0” -o wafs.37.t%4z.ens00                                                                                         
 
<<<<< Sequence repeated to the end for each file to be downloaded >>>>>>> 
 
::                                                                                                                                                                                                       
:: All Done!!!                                                                                                                                                                                           
::                                                                                                                                                                                                       
echo                                                                                                                                                                                                     
echo Download Complete                                                                                                                                                                                   
goto :End                                                                                                                                                                                                
::                                                                                                                                                                                                       
:End                                                                                                                                                                                                     
............. End file EWFI1003.DAT ................................ 
 
 
 
Download Data file – Format (Cont.) 
 
Line 1 – (Required) “00”  Signifies the hour of the model run. 
All Other Lines  (Note Required)  Begin Batch File commands.  These commands may be customized by 
the user for their requirements.  Ensure the data transfers area delivered to the proper WINGRIDDS 
directories.  For the explanation of the “%1%2%3/%4” batch file variables in the data files, refer to the 
GETGRIB.EXE Utility details. 
 
The GETGRIB.EXE Utility is explained below. 
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Automated Data Download 
 
When the user within WINGRIDDS clicks on a specific data file to be downloaded, the download process 
starts by WINGRIDDS executing the following command (using the above example):   
 
GETGIRB EWFI1003.DAT 
 
The same command can be executed in an automated batch file set up by the user.  The use has to know 
which data file to use for the specific data to be downloaded and then schedule the download to retrieve 
the data once the model post-processing is complete.  
 
GETGRIB Download Utility 
 
When the user selects a specific download data file for GETGRIB to use, GETGRIB opens that file and 
reads the first line which should be a two digit number between 00-24.  This signifies the hour of the 
specific model run.  GETGRIB then open the file FTPCMD.DAT.   
 
............. Begin file FTPCMD.DAT ................................ 
120  
5 
\WINGRIDDS\CURL 
 
*************** File Structure Documentation ************************* 
Line 1    Time to wait (MIN) after model run time before switching to new  
          day's run 
 
Line 2    Local GMT time offset (positive number: GMT is ahead of local  
          time, negative number: GMT is behind local time) 
 
Line 3    Command string for file download utility.  This is to include 
          any configuration flags required for your local network setup. 
   Refer to the section 'Get GRIB Data' in the WINGRIDDS User's  
   Guide for a detailed explanation. 
 
............. End file FTPCMD.DAT ................................ 
 
 
 
 
Using the data derived from FTPCMD.DAT, GETGRIB then checks the system time to get the year, month 
and day.  If the Delay time and GMT offset sync well with the system time and the requested model run 
time read from the first line of the download data file, GETGIB then builds the FTPDATA.BAT file.  The 
utility used to do the actual data transfer is CURL.EXE and that utility is covered in detail in its own section 
below.  Continuing the example shown above, the resultant FTPDATA.BAT created would look like this: 
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............. Begin file FTPDATA.BAT ................................ 
@echo off                                                                                                                                                                                                
if "%4"=="" goto End                                                                                                                                                                                     
::                                                                                                                                                                                                       
:: Begin Download                                                                                                                                                                                        
::                                                                                                                                                                                                       
echo Please wait... This download may take a while...                                                                                                                                                    
::                                                                                                                                                                                                       
::                                                                                                                                                                                                       
cd \wingridds\grib\wafs\OctantI                                                                                                                                                                          
echo Downloading ENSEMBLE WAFS OctantI GRIB 000    
“\WINGRIDDS\URL2FILE ftp://ftpprd.ncep.noaa.gov/pubdatanccf/com/gens/prod/gef. 
%1%2%3%4.wafs/wafs/wafs.37.t%4z.ens00” -o wafs.37.t%4z.ens00                                                                                                                                                       
 
<<<<< Sequence repeated to the end for each file to be downloaded >>>>>>> 
 
::                                                                                                                                                                                                       
:: All Done!!!                                                                                                                                                                                           
::                                                                                                                                                                                                       
echo                                                                                                                                                                                                     
echo Download Complete                                                                                                                                                                                   
goto :End                                                                                                                                                                                                
::                                                                                                                                                                                                       
:End                                                                                                                                                                                                     
............. End file FTPDATA.BAT ................................ 
 
 
NOTICE - Due to formatting restrictions of this word processor, the \WINGRIDDS\CURL command line 
above is not shown in its proper form.  Please ignore the ‘word-wrap’ effect shown above.  The command 
line entry should be one long line.   
 
NOTICE – To ensure the file is copied properly, notice the file name at the end of the cURL command line 
is repeated twice.  The first file name is the name of the file to be downloaded from the data server.  The 
second file name is the name the file will be stored as within WINGRIDDS.  The second file name does 
NOT have to be the same as what is downloaded. 
 
GETGRIB then executes the FTPDATA.BAT with the following command: 
 
FTPDATA “YYYY MM DD HH” 
 
Where the YYYY MM DD HH is filled with the date-time-group. 
 
The date-time-group is passed as arguments to the FTPDATA.BAT batch file and are used within the batch 
file in the following ways: 
 
YYYY  =  %1 
MM      =  %2 
DD      =  %3 
HH      =  %4 
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Therefore, the following line within the batch file; 
 
gef.%1%2%3%4.wafs/wafs/wafs.37.t%4z.ens00 
 
would actually be executed as, for example; 
 
gef.2006092600.wafs/wafs/wafs.37.t00z.ens00 
 
 
*****NOTICE***** 
The cURL (sic) utility is used to perform the data downloads into WINGRIDDS. Detailed info and man 
pages can be found at:  curl.haxx.se 
 
WINGRIDDS has the ability to use custom scripts to download sectorized GRIB files from the NOMADS 
servers using the GRIB Filter feature on the website.  As an example, do the following: 
 
To download a 1x1 GFS forecast, 
I started from this the Sept 01 18Z forecast 1x1 GFS 
 
> https://nomads.ncep.noaa.gov/cgi-bin/filter_gfs_1p00.pl?dir=%2Fgfs.20190901 
 
a) Select all levels. 
b) Select tmp and hgt parameters. 
c) Select "Show the URL". 
d) Click on "start download" 
 
A web page will be displayed with the following URL info: 
 
URL= 
https://nomads.ncep.noaa.gov/cgi-
bin/filter_gfs_1p00.pl?file=gfs.t18z.pgrb2.1p00.f000&all_lev=on&var_HGT=on&var_TMP=on
&leftlon=0&rightlon=360&toplat=90&bottomlat=-90&dir=%2Fgfs.20210901%2F18%2Fatmos 
 
The URL that you use should not have "&showurl=". 
 
The URL string must be modified in a few ways to work properly. 
 
1) Change the date-time-group from “dir=%2Fgfs.20210901%2F18%2Fatmos” to 
“dir=%2Fgfs.%3%4%5%2F%6%2Fatmos” 
 
Where: %3 = year (YYYY) 
            %4 = month (MM) 
            %5 = day (DD) 
            %6 = model run hour (HH) 
 
2) Change the model run hour in the file name “file=gfs.t18z.pgrb2.1p00.f000” to 
“file=gfs.t%6z.pgrb2.1p00.f000” 
 
 
 

https://nomads.ncep.noaa.gov/cgi-bin/filter_gfs_1p00.pl?dir=%2Fgfs.20190901
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3) Place the whole string in quotations 
“https://nomads.ncep.noaa.gov/cgi-
bin/filter_gfs_1p00.pl?file=gfs.t%6z.pgrb2.1p00.f000&all_lev=on&var_HGT=on&var_TMP=on&leftlon
=0&rightlon=360&toplat=90&bottomlat=-90&dir=%2Fgfs.%3%4%5%2F%6%2Fatmos” 
 
4) On the end, add a space then “-o” (lower-case ‘oh’) then the desired file name to save 
download as. 
 
Following other download scripts, repeat this entry for each forecast hour desired – changing the 
file name to reflect other desired forecast hours such as… 
file=gfs.t%6z.pgrb2.1p00.f006 
file=gfs.t%6z.pgrb2.1p00.f012 
file=gfs.t%6z.pgrb2.1p00.f024 
… 
etc., etc. 
 
*****NOTICE***** 
The NOMADS site has a variety of different model runs with various sectorized options. The URL link that 
is displayed will vary with different file= and dir= names and even these will change over time for the 
same model/sector runs. It is very important you become familiar with the basic formats to know how to 
handle individual differences. 
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WINGRIDDS Workstation/Server Setup 
 
It has been the design history of WINGRIDDS that the GRIB file downloads from a model run and 
the GRIB ingest utilities would be would be run one at a time and there were no abilities for any 
parallel operations. These days, with multiple model runs becoming available at similar times, the 
ability to download and process multiple model runs is needed. Also, with the need of multiple 
users needing access to the same data files at the same time, a client/server configuration would 
be useful. 
 
WINGRIDDS now allows systems to be configured to handle and process multiple simultaneous 
model runs either on a standalone workstation for a single user or on a server system with 
multiple users remotely accessing the WINGRIDDS data files. The following section will go 
through a step-by-step process configuring a standalone workstation and, later, due to their 
similarities, configure a server with similar operations but providing remote access to the data.  
 
These sections will cover the recommended drive/directory setup, batch file creation and Windows 
Task Scheduler management. There may be other ways to implement the following tasks but if 
you deviate from what is laid out here, I may not be able to offer any support. Also, I won’t be 
covering any Windows Network or User permissions/management here. Please consult your local 
Windows System/Network Administrator. 
 
For the following sections, a Workstation is defined as a system which has the automated 
download and WINGRIDDS operations on the same machine. For a Server, only the automated 
GRIB download and processing tasks are on the server and the processed data files are remotely 
accessed by single or multiple WINGRIDDS computer through a network connection.   
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***Workstation Automation Configuration: 
 
When setting up a system (Workstation or Server) to automate GRIB downloading and processing, I find it 
is the easiest to configure and manage if the System Time is set to UTC (Coordinated Universal Time) or 
Zulu time because model runs, post processing and status times are all given in UTC so it just makes it 
easier to set up and manage scripts when everyone is on the same time zone. In Windows, you would go 
to the lower right corner, right-click the system clock numbers and select “Adjust Date/Time” then click the 
“Change time zone” button.  
 

 
 
 
Along with this, you need to edit the FTPCMD.DAT file line 2 and change the “Local GMT 
time offset” to zero (0). 
 
Next, you need to have an idea as to what models and GRIB files you wish to download on 
a scheduled basis. You need to ensure you have sufficient drive space to accommodate 
all of the data you wish to download and store the processed data. Your drive may fill up 
quicker than you anticipate!  
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If you wish to use the existing WINGRIDDS download scripts, you should open 
WINGRIDDS and go through the GRIB Download menu selections to select and document 
the download scripts you are interested in. The screenshot below shows a “GRIB 
Download Selection” dialog for one of the GFS models. Notice, the left column shows the 
names of the Download Scripts which are stored in the WINGRIDDS/GRIB/USER 
directory.  These file names are what you need to record when making your list of GRIB 
download scripts to run.  
 

 
 
However, if you wish to create your own download scripts, that is acceptable as well. 
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In order to run multiple copies of NGRB2PCG32 on different models at the same times, 
you need to create a different directory structure to accommodate each model type. Below 
is a screen shot of what I set up for this demonstration. 
 

 
 
I created the “Ingest” directory and a separate directory within Ingest for each model I 
wanted to download and process. The location within Drive E is not important.  
 
I will be using the GFS directory as a reference but the contents will be the same for any 
other model directory you choose to add. 
 
 
 
 
 



 
 286 

 
 
 
 
 
Within the GFS directory is the “GRIB” directory as well as copies of the 
NGRB2PCG32.EXE and GRIBNAMES.DAT files. The NGRB2PCG32.OUT file is the log 
file for NGRB2PCG32 and is created with every GRIB Process job. These files are copied 
from the WINGRIDDS directory. 
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Next, within the GRIB directory are all the configuration files that NGRB2PCG32 requires 
for operations.  All of these files are copied from the WINGRIDDS/GRIB directory. Also in 
this directory is the “GFS” directory which is the download destination of the GRIB files to 
be processed. The name of this directory can be anything you wish – I just name it the 
same as the model run but it is not important.  
 

 
 
 
 
 
These steps outlined above need to be repeated for each model you wish to download and 
process. 
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*** GRIB Download Scripts and Batch Files 
 
In the steps above, you were instructed to go through and list the various GRIB download 
scripts you would need for operations. It is easier to manage this automated process if 
those scripts are copied from the WINGRIDDS\GRIB\USER directory to a separate, 
common directory. I have placed mine in the root of the E:\ drive. They are the *.DAT files.  
 
If a download script is copied from the WINGRIDDS\GRIB\USER directory, each file needs 
to be modified. The following screen shot shows the example of the GF202.DAT file.  
 

 
 
Notice, the destination directory string (in red circle) that every download script has needs 
to be changed to point to the new destination directory the user has set up. With this 
example, it is; 
 
\Ingest\GFS\GRIB\GFS 
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There is also a batch file (*.BAT) for every .DAT file. The associated batch file to go along 
with the GF2002.DAT file is “GETGFS00Z.BAT” which downloads and processes the 00Z 
GFS model run. The user may name the file anything they wish. These batch files 
functions are to call the GETGRIB utility to download the GRIB data, call NGRB2PCG32 to 
convert the data and, finally, to delete the GRIB data which was processed to make room 
for the next GFS GRIB download cycle. The contents of the GETGFS00Z.BAT file follow 
the same template and are as follows: 
 
************************************************************* 
ECHO OFF 
  
REM >CHANGE DIRECTORY TO \WINGRIDDS & EXECUTE THE 
REM >GETGRIB TO BUILD & EXECUTE BATCH FILE. 
 
CD \WINGRIDDS 
 
GETGRIB GF2002.DAT 
 
REM >CHANGE DIRECTORY TO ACTIVE MODEL DIR AND 
REM >EXECUTE NGRB2PCG32 TO CONVERT GRIB DATA 
 
CD \Ingest\GFS 
 
NGRB2PCG32.EXE S/E:\Ingest\GFS\GRIB\GFS\ D/C:\WINGRIDDS\GRIDDATA\  
 
REM >CHANGE DIRECTORY TO THE GRIB DIR & DELETE 
REM >DOWNLOADED GRIB DATA 
 
CD \Ingest\GFS\GRIB\GFS 
 
DEL *.* /q 
 
REM >DONE!!! 
 
************************************************************* 
 
Notice – NGRB2PCG32 now has options to dictate a Source directory (S/) and dictate a 
Destination directory (D/). 
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*** Automated GRIB Download Schedule Setup  
 
This section will cover the configuration and management of the Windows Task Scheduler 
utility. The screen shots and steps will show the Windows 7 version. Other windows 
versions should be different but similar. 
 
To start the Windows Task Scheduler, click the Start button, right-click on Computer and 
select “Manage” menu option. 
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This will bring up the Windows task Scheduler. 
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To set up a new scheduled task, click the ‘Create Basic Task’ in the top right “Actions” 
window. 
 

 
 
I named my task “GFS00ZDownload” and entered a simple description of its function. 
 
Click “Next” 
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Since this task will be needed once a day, select “Daily” button. 

 
 
 
Click “Next” 
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This section tells the Scheduler when during the day and how often during the day to 
execute. 
 

 
 
It is important at this point to know when the post-processing of the model data you are 
interested in will be available to download into WINGRIDDS. NCEP provides a web site to 
show the status of all its model runs. The Internet address is:  
 
http://www.nco.ncep.noaa.gov/pmb/nwprod/prodstat/ 
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A screen shot of the 00Z GFS model run status looks like the following; 

 
 
Notice – the average time of the final GRIB product availability is around 0400Z. I would 
not start the download process till around 15-20 minutes after this time to ensure all 
products would be available. If you start the download too soon or if the post processing is 
delayed, you may not download the complete model run. 
 
Each NCEP model has different model run times so you should consult this page to 
determine a good download time. 
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With this information, I would start the 00Z GFS GRIB download at around 0430Z every 
day. 
 

 
 
 
Click “Next” 
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The next step is obvious – what action to perform? “Start a program” 
 

 
 
 
Click “Next” 
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Next, you are telling the Task Scheduler what program to start & where it is located. 
 

 
 
You browse to where you have your script located and select it. *Also*, you must put the 
drive and/or directory where it is located in the “Start in (optional)” window or, for whatever 
reason, it will not execute. 
 
Click “Next” 
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In this last window, you confirm the Name of the task, the Trigger event and the 
Name/Location of the batch file. If all is correct, click “Finish”. 
 

 
 
 
These steps need to be repeated for every different model name and/or run you wish to 
download and process. 
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***Server Configuration: 
 
A WINGRIDDS Server setup and configuration is very similar to the Workstation setup as far as Automated 
GRIB download is concerned.  What makes the Server setup different is that you are ‘sharing’ the 
processed data directory on the network for other computers to see and use.  
 
 
Server File Sharing Configuration Setup 
 
For our Server example, we have a separate drive F: where our GRIB Ingest and WINGRIDDS directories 
are located. 
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To setup the sharing of directories, from the Windows Desktop, go to the ‘Start-button’, 
right-click ‘Computer’ then select ‘Manage’ option. 
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Within the ‘Computer Management’ console tree, click ‘System Tools’, click ‘Shared 
Folders’, and then click ‘Shares’. On the ‘Action’ menu, click ‘New Share’. Follow the steps 
in the Create a Shared Folder Wizard, and then click ‘Finish’. You will want to share your 
WINGRIDDS folder. Once it is complete, it should look like this: 
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Once the WINGRIDDS folder is shared, you will need to set the properties and 
permissions so other users can have access to the folder. Right-click on the new shared 
folder in the ‘Shared Folders’,’Shares’ window as seen below; 
 

 
 
Set the ‘User limit’ to ‘Maximum Allowed’. For Windows 7 Professional, the limit is 20 
concurrent users. If you need more user access, you need to use Windows Server. 
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Next, click the ‘Share Permissions’ tab. Ensure ‘Everyone’ has full control ‘Allow’ of the 
folder. 
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Next, click the ‘Security’ tab & ensure the ‘Home Users’ have ‘Read & Execute’, ‘List 
Folder Contents’ and ‘Read’ permissions. 
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Once your folder sharing is complete and your remote WINGRIDDS Workstation is 
connected to the same network, on your WINGRIDDS Workstation PC, open the Windows 
Explorer and click on the ‘Network’. You should see the WINGRIDDS Workstation you are 
on (in this case, WINGRIDDS-PC) and you should see the Server PC as well (in this case, 
WINGRIDDSDEV-PC). 
 

 
 
 
 
 
Double-click on the Server name to show the folders which are shared. 
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Right-click on the shared folder name you need to bring up the menu and select ‘Map 
Network Drive’. 
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Select the drive letter you wish to use, ensure the folder name is 
“ \\(system name)\WINGRIDDS  “, check “Connect at logon” and click “Finish”. 
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Once that is complete, you should see the shared drive on your ‘Computer’ selection in the 
‘Windows Explorer’. Click on the shared drive and you should see it’s contents. 
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To complete the WINGRIDDS Server connection configuration, you need to open 
WINGRIDDS>Properties and select the “WINGRIDDS Data Directories” to change the 
“Processed Data Destination” to the location on the shared folder. 
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Once the shared folder is selected, the result will look like this: 
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Now, whenever data is selected within WINGRIDDS, the ‘Select PCG Data File’ dialog will 
always open to the WINGRIDDS\GRIDDATA directory on the shared folder on the remote 
server. 
 

 
 
 
 
Again, if there are any issues or problems getting any of this to work correctly, please 
consult your local Microsoft Windows/Network Administrator and explain what you need. 
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Troubleshooting GRIB Download and Processing 
 
This section will briefly cover some of the more common issues preventing WINGRIDDS 
from either downloading GRIB data properly or processing the correctly downloaded GRIB 
data. The sections will be listed by error description and will give a probable solution to 
correcting the problem to allow downloading/processing to continue. 
 
 
GRIB Download Problem #1 
Symptom - GRIB files downloads very fast and processing ‘zips’ by but no data files are 
created.  
 
Solution – The cURL download utility will create a requested file which is effectively empty 
even if no data is downloaded. If you look in the \WINGRIDDS\GRIB\NWS directory, you 
will probably find all the requested GRIB file names listed but their file sizes are 1kb: 
 

 
 
The problem is most likely with the download script having either a unintentional 
typographical error or the server/directory you are trying to download GRIB data from has 
changed. Check for correct server name and/or directory name. 
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GRIB Processing Problem #1 
Symptom – GRIB data downloads correctly but when it is processed, every GRIB 
message has an error message:  
 
****ERROR  UNKNOWN MODEL TYPE #           81 
 
and no data files are created. 
 
Solution – The NGRB2PCG32 utility needs to know how to decode and identify the model 
generating the GRIB data because the PCG file name contains the 3-letter ID of the model 
ID. The example below, unknown model ID type #81 refers to the GFS model.  
 

 
 
For whatever model ID is failing, you need to open the 
\WINGRIDDS\GRIB\GRIBMODEL.DAT file and add the specific model ID which is missing 
so NGRB2PCG32 can process the data. (see p. 260). 
 
 
GRIB Processing Problem #2 
Symptom – GRIB data downloads correctly but when it is processed, there are random 
GRIB message that have an error message:  
 
****NOTICE - UNKNOWN GRIB PARAMETER #           81 
 
Solution – The NGRB2PCG32 utility needs to know how to decode and identify the GRIB2 
parameters and it references the \WINGRIDDS\GRIB\GRIB2PARM.DAT file for that 
function. If the specific GRIB2 parameter is not found in the GRIB2PARM.DAT file, it will 
reference all the known parameters in the source code and assign the ‘Standard’ 
parameter name which is acceptable. 
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If you as a user do not like the pre-assigned name, you need to go and collect the specific 
GRIB2 parameter information from the NGRB2PCG32.OUT file for that specific GRIB2 
message and update the GRIB2PARM.DAT file with your own preferred parameter name. 
 
 
GRIB Processing Problem #3 
Symptom – GRIB data downloads correctly and processes every GRIB2 message but at 
the end, when collecting and saving the WINGRIDDS Inventory Records, an error 
message:  
 
Forrtl: severe (66): output statement overflows record, unit 4 ….. 
 
is shown on the screen. 
 
Solution – this situation is saying that there are too many GRIB2 parameters in the 
forecast hour to store in the PCG data file. This situation is created usually when a user 
downloads a small sub-sector geographic area for a model that also has a very large 
number of parameters. The ‘record’ in the error message is a fixed size which is 
determined by the number of grid points in the geographic area. When a sub-sector is 
requested, the record size (in bytes) will shrink in proportion the fewer umber of grid points 
and if the model run has many parameters (this example had 355 parameters in the 
forecast hour) there is a risk of having too many parameters & it will fail. 
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The solution is, when downloading the GRIB data, either request a larger sub-sector area 
or request fewer GRIB parameters. Regretfully, this is a trial-and-error process. You must 
delete the processed data files, delete the downloaded GRIB files, modify the script & try 
again, repeating till it works. 
 
GRIB Processing Problem #4 
Symptom –NGRB2PCG32 is executed but it immediately fails with a file open error 
message:  
 
FILE OPEN ERROR: ERROR, FILE=  601 
 
is shown on the screen. 
 

 
 
Solution – This is saying that the required PCG data file has already been created during a 
previous session for the GRIB data being processed. Delete the processed data files. 
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GRIB Processing Problem #5 
Symptom –NGRB2PCG32 is executed but it immediately fails with a file open error 
message:  
 
FILE OPEN ERROR: ERROR, FILE=  602 
 
is shown on the screen. 
 

 
 
Solution – This is saying that the requested PCG data directory or the link to the directory 
where the PCG data files are stored does not exists. Correct the directory listed in the 
WINGRIDDS Properties to one that exists or create the directory that is listed. 
 
 
 
GRIB Processing Problem #6 
Symptom –NGRB2PCG32 is executed and processing through the data but it fails at some 
point with an error message:  
 
Forrtl: severe (157): Program Exception – access violation 
 
And will list GBYTESC as the offending routine. See screen shot below: 
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Solution - It has been discovered that some GRIB2 messages from NOMADS have unique 
parameters which are not packed correctly and may cause NGRB2PCG32 to crash. This 
seems to only affect GRIB2 messages that are packed with “Simple Packing” which 
NOMADS uses when users request sub-sectored GRIB data. All GRIB2 messages have 
their raw GRIB2 Category, Parameter, Level 1 & Level 2 information decoded just before 
the unpacking starts. The entry in the NGRB2PCG32.OUT file from above looks like this: 
 
 ===== BEGIN READ ===== IGB100(           7 &           8) COPIED TO 1 & 2 
  READING NEW GRIB RECORD =       21927 
 ===== BEGIN NEW GRIB EDITION 2 RECORD ===== 
 REC#,SIZE =          408        5356 
  NBYTES,IRDRC7,IRDREC=        5356          54       21979 
  IRDST/IRDEND/IGRBZZ=       21928       21978           3 
 *****GF_UNPACK4            2           2         109         255 
 ******* Simple Unpacking  
 
If the specific GRIB2 message causes NGRB2PCG32 to fail, the next to last message will 
be the “*****GF_UNPACK4 “ message. This is listing the GRIB2 Category, Parameter, 
Level 1 & Level 2 information. To prevent the crash, the user needs to open the 
\WINGRIDDS\GRIB\GRIB2SKIP.DAT file and add the specific information and reprocess 
the data. When NGRB2PCG32 encounters this GRIB message, it will skip & continue. 
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Appendix A:  Command Function Summary 
 
 
**-                WINGRIDDS --- COMMAND SUMMARY   
 
    General Commands:  -- |NAME| indicates an alternative name -- 
                             -- [....] describes additional information needed 
                             -- Ch. is an abbreviation for Character 
                             -- ! following command name indicates system alias 
        -- (Scalar/Vector) Shows what is result of calculation 
 
ERAS|ERSN!,ERSC!| > ERASes current screen display 
EXIT|X QUIT Q STOP S END or E| > Terminates the program 
 
**- Gridded Data File Manipulation Commands: 
SFIL  > Interactively resets active grid file 
          
FIL1  > Changes active gridded data file to first file opened 
FIL2  > Changes active gridded data file to second file opened 
...  
FIL9  > Changes active gridded data file to ninth file opened 
FILA  > Changes active gridded data file to tenth file opened 
... 
FILK  > Changes active gridded data file to twentieth file opened 
 
FI-#  > Changes active gridded data file to #th file earlier on list 
FI+#  > Changes active gridded data file to #th file later on list 
FI-   > Changes active gridded data file to next file earlier on list 
FI+   > Changes active gridded data file to next file later on list 
 
LFIL|FILS,LFI=!| > List data files already opened 
 
**- Setting Forecast Time Specifications for data requests:   
FHOR|SFHR| > Requests input of Forecast HOuR 
FHRS|SFHS| > Requests input of PAIR OF Forecast HOuRs 
SFHR[1 integer time ] > Changes default forecast time  
SFHS[2 integer times] > Change default fcst time pair  
ANAL|F-1, F-1| > Sets Forecast Hour to use analysis grids 
GUES|F-3, F-3| > Sets Forecast Hour to use analysis guess grids 
GES6|F-6, F-6| > Sets Forecast Hour to use analysis 6 h guess grids 
F###| F##| > Sets Forecast Hour to use ### hour forecast grids 
F00 |INIT| > Sets Forecast Hour to use initialized grids 
F12 | F12| > Sets Forecast Hour to use 12 hour forecast grids 
F24 | F24| > Sets Forecast Hour to use 24 hour forecast grids 
FHR1  > Gets data from first time of FHRS time pair for commands to left 
FHR2  > Gets data from second time of FHRS time pair for commands to left 
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FH+   > Steps forward to the next available forecast hour in the data set  
FH-   > Steps backward to the previous available forecast hour in the data set 
 
**- Setting Level/Layer specifications for data requests: 
SLVL [one 4 chtr level] > Specifies LeVeL for data selection 
####|###|[3 or 4 digit integer] > Sets Level to numerical value #### 
S###  > Sets Level to Sigma level centered at ### mb 
S###|S982,S943,S896,S844,S784| > Sets Level to bottom 5 sigma level 
###M|0M,2M,10M| > Sets Level to ### Meters above ground (height<100m) 
M###  > Sets Level to ### hectometers above ground (height>=100m) 
###Z  > Sets Level to ### Meters above mean sea level (height<100m) 
Z###  > Sets Level to ### hectometers above mean sea level (height>=100m) 
###U  > Sets Level to ### centimeters below land surface (depth<1000cm) 
U###  > Sets Level to ### meters below land surface (depth>=1000cm) 
B###  > Sets Level to "Boundary" layer centered at ### mb above ground 
I###  > Sets Level to ### degree (K) Isentropic surface  
L###  > Sets Level to Flight Level ### 
PV##  > Sets Level to #.# PV (Potential Vorticity) Surface of 1.2 PV Units 
P+##/P-## > Sets Level to PV (Potential Vorticity) level ## hundreds ft above / below the Tropopause 
H###  > Sets Level to ### feet or meters above sea level (x10) 
Y###  > Sets Level to ‘Hybrid-B’ level (010-500) (Native RUC grids only) 
MSL   > Sets Level to Mean Sea Level 
TROP  > Sets Level to TROPopause 
MAXW |WMAX!| > Sets Level to MAXimum Wind level 
SFC  |0000|  > Sets Level to the Earth SurFaCe 
 
 
**- Level/Layer specifications: 
SLYR |LAY=!,LAYR|[two 4 Ch. levels] > Change data LaYeR specs 
LV+#  > Increments LeVel to next # higher level 
 
SVLV  > SaVes current LeVel specification 
SVLY  > SaVes current LaYer specification 
RSLV  > ReStores saved LeVel specification 
RSLY  > ReStores saved LaYer specification 
LV-#  > Increments LeVel to next # lower level 
 
LS+#  > Changes LeVel to # higher than current LVL (useful in XSCT processing) 
LS-#  > Changes LeVel to # lower than current LVL (useful in XSCT processing) 
LVL0  > Return to originally defined LVL after completing LS+# or LS-# commands 
 
LY+#  > Changes LaYer Top (LVL2) to # higher than LVL 
LY-#  > Changes LaYer Bottom (LVL1) to # lower than LVL 
 



 
 322 

 
 
 
**- Output specifications: 
AROW |VCTR!| > Sets display mode to plot winds as arrows (Default) 
BARB  > Sets display mode to plot winds as Barbs (m/s) 
STRM  > Sets display mode to plot winds IN STReaMline like presentation 
 
DASH  > Sets display mode to plot DASHed lines for this plot only 
DOTS  > Sets display mode to plot DOTTed lines for this plot only 
DDSH  > Sets display mode to plot DOTTED/DASHED dashed lines for this plot only 
LDSH  > Sets display mode to plot Long DaSHed lines for this plot only 
MDASH   > Sets display mode to plot Medium Dash 
LSDASH  > Sets display mode to plot Long/Short Dash 
LDASHD  > Sets display mode to plot Long Dash/Dot 
LDASHDD  > Sets display mode to plot Long Dash/2 Dots 
LSSSDASH  > Sets display mode to plot Long/3 Short Dash 
MDASHDDD  > Sets display mode to plot Medium Dash/3 Dots 
 
DPOS  > Dash POSitive contours 
DNEG  > Dash NEGative contours 
 
DATA  > Sets display mode to plot DATa values At grid points - no contours 
DAT+  > Sets display mode to plot DATa values slightly above grid points 
DAT-  > Sets display mode to plot DATa values slightly below grid points 
DATT  > Sets display mode to plot DATa values on Top of grid points 
DATB  > Sets display mode to plot DATa values Below grid points 
DATO  > Sets display mode to plot DATa values Over grid points - Above DATT 
DATU  > Sets display mode to plot DATa values Under grid points - Below DATB 
PNMS  > Plots - in front of all negative numbers; positive numbers unsigned 
PPLS  > Plots + in front of all positive numbers; negative numbers unsigned 
 
 
**- Output specifications: 
HILO  > Plots H or L above data at local maximum/minimum (with contours) 
HIIS  > Plots H above data at local maximum (with contours) 
HIID  > Plots H above data at local maximum (without contours) 
LOWS  > Plots L above data at local minimum (with contours) 
LOWD  > Plots L above data at local minimum (without contours) 
 
MXMN  > Plots X or N above data at local maximum/minimum (with contours) 
MAXS  > Plots X above data at local maximum (with contours) 
MAXD  > Plots X above data at local maximum (without contours) 
MINS  > Plots N above data at local minimum (with contours) 
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MIND  > Plots N above data at local minimum (without contours) 
BOXS! > Plots boxes at grid points below the surface 
BOX#  > Plots a box at each grid point; # indicates box size 
 
**- Output specifications: 
SCL#/DML# > Display labels with signed digits greater than or equal to 10**# 
SCL0/DML0 > Display labels with signed digits greater than or equal to 10**0 (1) 
SCL1/DML1 > Display labels with signed digits greater than or equal to 10**1 (10) 
SC-#/DM-# > Display labels with signed digits greater than or equal to 10**-# 
SC-1/DM-1 > Display labels with signed digits greater than or equal to 10**-1 (.1) 
 
MOD#  > Display labels using Modulo of SCALED display value and 10**# 
          
STOF  > Stops display of grid statistics at top of screen 
STON  > Starts display of grid statistics at top of screen 
          
CNSM|KSMO,KSM=!|[Integer] > Sets CoNtour SMoothing (Default=1) 
CNUM [Integer] > Changes maximum number of contours to display 
#DGT  > Plot maximum # of digits on contour labels / data plots (default 4) 
 
 
 
**- Layer/Time interval manipulations >>> For data in gridded data set <<< 
LAVE|LAVR!| > Calculate Layer AVErage of variables to LEFT in Command line 
LSUM|LADD!| > Calculate Layer SUM of variables to LEFT in Command line 
LDIF  > Calculate Layer DIFference of variables to LEFT in Command line 
LVL1|LYR1,LY1=!| > Gets data from bottom of Layer for variables to LEFT 
LVL2|LYR2,LY2=!| > Gets data from top of Layer for variables to LEFT 
LEVL  > Overrides LVL1 and LVL2 and gets data from original level 
TAVE  > Calculate Time AVEerage of variables at LEFT using times FHR1 and FHR2 
TAVE+ > Calculate Time AVEerage of variables at LEFT using next Forecast Hour 
TTOT  > Calculates Time TOTal of variables at LEFT using times FHR1 and FHR2 
TTOT+ > Calculates Time TOTal of variables at LEFT using next Forecast Hour 
TDIF  > Calculate Time DIFference of variables at LEFT between FHR1 and FHR2 
TDIF+ > Calculate Time DIFference of variables at LEFT using next Forecast Hour 
TTND  > Calculate Time TeNDency of variables at LEFT between FHR1 and FHR2 
TTND+ > Calculate Time TeNDency of variables at LEFT using next Forecast Hour 
 
**- Layer/Time interval manipulations >>> For data in gridded data set <<< 
          
     >>> For data grids or computed functions -- Appears right of last & <<< 
LYSM  > Calculates LaYer SuM of functions to RIGHT - One plot per line 
LYAV  > Calculates LaYer AVerage of functions to RIGHT - One plot per line 
LYDF  > Calculates LaYer DiFference of functions to RIGHT - One plot per line 
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TMSM  > Calculates TiMe SuM of functions to RIGHT - One plot per line 
TMAV  > Calculates TiMe AVerage of functions to RIGHT - One plot per line 
TMDF  > Calculates TiMe DiFference of functions to RIGHT - One plot per line 
TMTN  > Calculates TiMe TeNdency of functions to RIGHT - One plot per line 
HRLY|PRHR| > Converts diagnostic command results from  /sec  to  /hour 
DALY|PRDY| > Converts diagnostic command results from  /sec  to  /day 
 
 
 
**- Special Gridded Data Requests: 
MIXR  > Calculates Mixing Ratio from available data fields 
SPFH  > calculates Specific Humidity from available data fields 
RELH  > Calculates Relative Humidity from available data fields 
SMIX  > Calculates Saturation Mixing Ratio from available data fields 
SDEF  > Calculates Mixing Ratio Saturation Deficit from available data fields 
DWPT|DWPC!| > Calculates DeW Point Temperature from available data fields (C) 
DWPK! > Calculates DeW Point Temperature from available data fields (K) 
DWPF! > Calculates DeW Point Temperature from available data fields (F) 
PRES  > Calculates Pressure from available data fields 
TEMP|TMPC!| > Calculates temperature in degrees C 
TMPK|TMPA!| > Calculates temperature in degrees K 
TMPF! > Calculates temperature in degrees F 
THTA  > Calculates Potential Temperature from available data fields (K) 
THTE  > Calculates Equivalent Potential Temperature from data fields (K) 
THTS  > Calculates Saturated Equivalent Potential Temperature from data fields (K) 
THCK|TKNS!| > Generates Thickness fields 
WIND  > Retrieves the total wind Vector in m/s 
WKNT! > Retrieves the total wind Vector in knots 
WMPH! > Retrieves the total wind Vector in mph 
WKPH! > Retrieves the total wind Vector in kph 
BWND!|WNDB!| > Retrieves the total wind Vector in m/s for display as wind barb 
BKNT! > Retrieves the total wind Vector in knots and sets display as wind barb 
BMPH! > Retrieves the total wind Vector in mph and sets display as wind barb 
BKPH! > Retrieves the total wind Vector in kph and sets display as wind barb 
WNDA! > Retrieves the total wind Vector in m/s and sets display as wind arrow 
GEOS  > Generates the Geostrophic wind Vector 
AGEO! > Generates the Ageostrophic wind Vector 
TWND|THWN!| > Generates Thermal Wind 
ISAL  > Computes the Isallobaric Wind 
INAD  > Computes the Inertial Advective Wind 
ALTI    > Altimeter Setting (Inches) 
ALTM    > Altimeter Setting (Millimeters) 
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JCBN[2 Scalars] > Computes the Jacobian determinate of two scalars 
FRTG[Vector] > Computes Frontogenesis of the wind 
FVCT   > (Vector) Calculates F {Normal wind} Vectors 
FVCTS  >  (Vector) Calculates F {Normal wind} Vectors Tangent 
FVCTN     >  (Vector) Calculates F {Normal wind} Normal 
FVCTU  >  (Scalar) Calculates F {Normal wind} Vectors Tangent (UGRD) 
FVCTV  >  (Scalar) Calculates F {Normal wind} Vectors Tangent (VGRD) 
FVCTSU >  (Scalar) Calculates F {Normal wind} Vectors Tangent (UGRD) 
FVCTSV >  (Scalar) Calculates F {Normal wind} Vectors Tangent (VGRD) 
FVCTNU >  (Scalar) Calculates F {Normal wind} Vectors Normal (UGRD) 
FVCTNV >  (Scalar) Calculates F {Normal wind} Vectors Normal (VGRD) 
QVCT    > (Vector) Calculates Q {Geostrophic wind} Vectors 
QVCTS    >  (Vector) Calculates Q {Geostrophic wind} Vectors Tangent 
QVCTN    >  (Vector) Calculates Q {Geostrophic wind} Vectors Normal 
QVCTU    >  (Scalar) Calculates Q {Geostrophic wind} Vectors Tangent (UGRD) 
QVCTV    >  (Scalar) Calculates Q {Geostrophic wind} Vectors Tangent (VGRD) 
QVCTSU >  (Scalar) Calculates Q {Geostrophic wind} Vectors Tangent (UGRD) 
QVCTSV >  (Scalar) Calculates Q {Geostrophic wind} Vectors Tangent (VGRD) 
QVCTNU >  (Scalar) Calculates Q {Geostrophic wind} Vectors Normal (UGRD) 
QVCTNV >  (Scalar) Calculates Q {Geostrophic wind} Vectors Normal (VGRD) 
 
 
VECR [Scalar,Scalar] > Creates a vector from 2 scalar grids 
SPED![Vector] > Calculates magnitude of wind Vector (m/s) 
SPKT![Vector] > Calculates magnitude of wind Vector (knots) 
SPML![Vector] > Calculates magnitude of wind Vector (mph) 
SPKM![Vector] > Calculates magnitude of wind Vector (kph) 
DRCT [Vector] > Contours values of DiReCTion of a Vector 
DDFF [Vector] > Displays packed value of Vector Direction/speed 
DDDD [Vector] > Displays values of DiReCTion of a Vector 
WSPD! > Generates isotachs for Total wind (m/s) 
WSPK! > Provides total Wind SPeed in Knots 
WDDF! > Displays packed value of Total Wind Direction/speed (m/s) 
WDRC! > Contours value of Total Wind Direction (degrees) 
WDDD! > Displays value of Total Wind Direction (degrees) 
XCMP|UCMP[Vector]| > Returns grid relative X CoMPonent of vector 
YCMP|VCMP[Vector]| > Returns grid relative Y CoMPonent of vector 
 
LIFT|LIFX,LIFB| > Provides Lifted Index fields without resetting LEVeL 
TTHE  > Temperature of a parcel lifted from the bottom to the top of LAYeR 
CNVT  > Temperature needed for parcel from surface to lift freely to LEVeL 
 
TPCP  > Provides Total Precipitation fields without resetting LEVeL (mm) 
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CPCP  > Provides Convective Precipitation fields without resetting LEVeL (mm) 
LPCP  > Provides Large-Scale Precipitation fields without resetting LEVeL (mm) 
TPCC  > Provides Total Precipitation fields without resetting LEVeL (cm) 
CPCC  > Provides Convective Precipitation fields without resetting LEVeL (cm) 
LPCC  > Provides Large-Scale Precipitation fields without resetting LEVeL (cm) 
TPCI! > Provides Total Precipitation fields without resetting LEVeL (in) 
CPCI! > Provides Convective Precipitation fields without resetting LEVeL (in) 
LPCI  > Provides Large-Scale Precipitation fields without resetting LEVeL (in) 
 
PMSL  > Provides Mean Sea Level Pressure fields without resetting LEVeL 
          Note:  If mean sea level pressure (GRIB ID=002) is not  
                 available, then an attempt is made to retrieve the  
                 RUC Reduction, the Eta Model Reduction, and the  
                 Standard Atmosphere Reduction, in that order. 
PMSS! > Provides MSL Pressure fields (Std. atm. reduction) -- No LEVeL reset 
PMSR! > Provides MSL Pressure fields (RUC reduction) -- No LEVeL reset 
PMSE! > Provides MSL Pressure fields (ETA model reduction) -- No LEVeL reset 
MMSL  > MSL pressure for RUC (MPAS) surface analysis using MAPS reduction 
NMSL  > MSL pressure for RUC (MPAS) surface analysis using NMC reduction 
PSFC  > Provides Surface Pressure fields without resetting LEVeL 
PWAT  > Provides Precipitable Water fields without resetting LEVeL (mm) 
PWAI! > Provides Precipitable Water fields without resetting LEVeL (in) 
WVRT! > Generates vorticity of the Total wind 
GVRT! > Generates vorticity of the Geostrophic wind 
AVRT! > Calculates the absolute VoRTicity of Ageostrophic wind  
WDVR! > Calculates DiVeRgence of the total Wind field 
WSHD! > Calculates SHearing Deformation of total Wind 
GSHD! > Calculates SHearing Deformation of Geostrophic Wind 
ASHD! > Calculates SHearing Deformation of Ageostrophic Wind 
WSTD! > Calculates STretching Deformation of total Wind 
GSTD! > Calculates STretching Deformation of Geostrophic Wind 
ASTD! > Calculates STretching Deformation of Ageostrophic Wind 
TADV! > Generates Temperature Advection using the Total wind 
QADV! > Generates Mixing Ratio Advection using the Total wind 
PADV! > Generates Pressure Advection using the Total wind 
STAB|STBL!| > Computes static stability in a layer 
IMAS  > Calculates Isentropic MASs (inverse static stability) in any layer 
LNDX  > Calculates 'Lifted Index' between LVL1 and LVL2 
SHOW  > Calculates 'Showalter Index' 
SWET  > Calculates 'SWEAT Index - NH' 
SWTS  > Calculates 'SWEAT Index - SH' 
KINX  > Calculates 'K Index' 
TOTL  > Calculates 'TOTAL Index' 
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CTOT  > Calculates 'CROSS TOTAL Index' 
VTOT  > Calculates 'VERTICAL TOTAL Index' 
 
TLCL  > Calculates the Temperature at the LCL from LEVeL data 
PLCL  > Calculates the Pressure of the LCL from LEVeL data 
PDEF! > Calculates the Pressure DEFicit (lift) needed for saturation the LCL 
DCAPE > Downdraft CAPE 
CAPE3KM > CAPE Calculated through lowest 3km 
CAPE6KM > CAPE Calculated through lowest 6km 
 
P0C     > Pressure 0C deg level 
PM10C   > Pressure -10C deg level 
PM20C   > Pressure -20C deg level 
PM30C   > Pressure -30C deg level 
HGT0C   > Height 0C deg level 
HGTM10C > Height -10C deg level 
HGTM20C > Height -20C deg level 
HGTM30C > Height -30C deg level 
 
THTAV > Virtual Potential Temperature - THeTA(degree K)  
 
**- Inversion Diagnostics: 
TEMPFCNV > SFC Temperature for Free Convection 
PRHB  > PRES at Relative Humidity Break 
HRHB  > HGHT at Relative Humidity Break 
PBINV > PRES at base of Inversion 
HBINV > HGHT at base of Inversion 
EMLFLG > Elevated Mixing Layer Flag 
THKEML > Thickness of EML (meters) 
AVGTHTEEML > Average THTE of EML 
INVLSI > LID Strength Index 
LSILT  > LID Strength Index - Lid Term 
LSIBT  > LID Strength Index - Buoyancy Term 
PTINV  > PRES at Top of Inversion 
HTINV  > HGHT at Top of Inversion 
TTINV  > TEMP at Top of Inversion 
RHTINV > RELH at Top of Inversion 
TBINV  > TEMP at Base of Inversion 
RHBINV > RELH at Base of Inversion 
THTATINV > THTA at Top of Inversion 
THTABINV > THTA at Base of Inversion 
THKINV   > Thickness of Inversion (meters) 
TDIFINV  > Temperature Difference through Inversion 
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RHDIFINV > RELH Difference through Inversion 
MAUL > Moist Absolute Unstable Layer 
WKMAUL > Weak Moist Absolute Unstable Layer 
LIDS > Max Sat. Wet Bulb Pot. Temp. (SWBPT) above sfc 
LIDSDT > Delta SWBPT across inversion near sfc to 400 mb 
LIDSLOW > Max SWBPT layer below 650 mb only 
LIDSDTLOW > Delta SWBPT across inversion layer below 650 mb only 
LIDSHIGH > Max SWBPT layer between 650 mb and 400 mb 
LIDSDTHIGH > Delta SWBPT across inversion layer between 650 mb and 400 mb 
SWBPTMAX > value of max SWBPT 
SWBPTMAXLO > value of max SWBPT below 650 mb only 
SWBPTMAXHI > value of max SWBPT between 650 mb and 400 mb 
LIDVALUE > Lid strength near SFC to 400 mb 
LIDVALUELO > Lid strength below 650 mb only 
LIDVALUEHI > Lid strength between 650 mb and 400 mb 
 
TURBH > Turbulence (Ellrod) Index - Horizontal Term 
TURBV > Turbulence (Ellrod) Index - Vertical Term 
TURBT > Turbulence (Ellrod) Index - Total Term 
 
INRI! > Calculates the INverse of the RIchardson number 
IGRI! > Calculates the Inverse of the Geostrophic RIchardson number 
 
VELPOT      [Vector] > Velocity Potential (Scalar) 
VELOPTHW  [Vector] > Velocity Potential of Harmonic Wind (Scalar) 
STRMFNC   [Vector] > Stream Function (Scalar) 
STRMFNCHW [Vector] > Stream Function of Harmonic Wind (Scalar) 
WINDNDI   [Vector] > Non-Divergent Wind (Vector) 
UNDI      [Vector] > UGRD Non-Divergent Wind (Scalar) 
VNDI      [Vector] > VGRD Non-Divergent Wind (Scalar) 
WINDIRR   [Vector] > Irrotational Wind (Vector) 
UIRR      [Vector] > UGRD Irrotational Wind (Scalar) 
VIRR               [Vector] > VGRD Irrotational Wind (Scalar) 
WINDHAR   [Vector] > Harmonic Wind (Vector) 
UHAR      [Vector] > UGRD Harmonic Wind (Scalar) 
VHAR      [Vector]  > VGRD Harmonic Wind (Scalar) 
WINDINV   [Vector] > Summed Wind (IR+ND+VELPOT) (Vector) 
USUMVP    [Vector] > UGRD Summed Wind (IR+ND+VELPOT) (Scalar) 
VSUMVP    [Vector] > VGRD Summed Wind (IR+ND+VELPOT) (Scalar) 
WINDINS   [Vector] > Summed Wind (IR+ND+STRMFNC) (Vector) 
USUMSF    [Vector] > UGRD Summed Wind (IR+ND+STRMFNC) (Scalar) 
VSUMSF    [Vector] > VGRD Summed Wind (IR+ND+STRMFNC) (Scalar) 
WINDDIFF  [Vector] > Provided Wind (ND+IR) (Vector) 
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UDIFF     [Vector] > UGRD Provided Wind (ND+IR) (Scalar) 
VDIFF     [Vector] > VGRD Provided Wind (ND+IR) (Scalar) 
WINDDIFFV [Vector] > Summed VELPOT Wind - Provided Wind (Vector) 
UDISSVP   [Vector] > UGRD Summed VELPOT Wind - Provided Wind (Scalar) 
VDIFFVP   [Vector] > VGRD Summed VELPOT Wind - Provided Wind (Scalar) 
WINDDIFFS [Vector] > Summed STRMFNC Wind - Provided Wind (Vector) 
UDIFFSF   [Vector] > UGRD Summed STRMFNC Wind - Provided Wind (Scalar) 
VDIFFSF   [Vector] > VGRD Summed STRMFNC Wind - Provided Wind (Scalar) 
WINDROT   [Vector] > Irrotational Wind - Provided Wind (Vector) 
UROT      [Vector] > UGRD Irrotational Wind - Provided Wind (Scalar) 
VROT      [Vector]  > VGRD Irrotational Wind - Provided Wind (Scalar) 
WINDDD    [Vector] > VELPOT Harmonic Wind + Non-Divergent Wind (Vector) 
UDD       [Vector] > UGRD VELPOT Harmonic Wind + Non-Divergent Wind (Scalar) 
VDD       [Vector] > VGRD VELPOT Harmonic Wind + Non-Divergent Wind (Scalar) 
 
FFFF|F!  | > Provides coriolis parameter at each grid point 
DMAP|MFTR!,MAPF!| > Provides map factor at each grid point 
ALAT|LATT!,LAT!,LATI!| > Latitude 
ALON|LONG!,LON! | > Longitude 
EDIR  > DIRection of rotation from map standard North/South Earth longitude 
CSLT  > Cosine of Latitude 
MSG0  > Produces grid with 1's at points with data and 0's at points without 
MSG1  > Produces grid with 0's at points with data and 1's at points without 
MSNG! > Produces grid with missing value flags at points without data 
ZERO  > Provides scalar grid of all zeros (Used to display wind components) 
GMIN    > Produces scalar Grid with values of MINimum of last grid 
GMAX  > Produces scalar Grid with values of MAXimum of last grid 
GMEN  > Produces scalar Grid with values of MEaN of last grid 
GSDV  > Produces scalar Grid with values of Standard DeViation of last grid  
SCPY > Produces a CoPY of a Scalar field 
VCPY > Produces a CoPY of a Vector field 
SSWP > SWaPs locations of last 2 Scalar fields in memory 
VSWP > SWaPs locations of last 2 Vector fields in memory 
DUMP > Prints grid point values in file 'GRIDS.OUT' 
 
SSUM [2 Scalars] > Calculates Scalar grid sum 
SAVR [2 Scalars] > Calculates Scalar grid average 
SDIF [2 Scalars] > Calculates Scalar grid difference 
STND [2 Scalars] > Calculates Scalar grid time tendency  
SMLT [2 Scalars] > Multiplies two Scalar fields 
SDVD [2 Scalars] > Divides two Scalar fields 
SADC [<10 digit value] > Sum of Scalar & specified constant 
SSBC [<10 digit value] > Difference of Scalar & specified constant 
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SMLC [<10 digit value] > Multiplies Scalar by specified constant 
SDVC [<10 digit value] > Divides Scalar by specified constant 
INVS [Scalar] > Finds INVerSe of a Scalar 
INV1 [Scalar] > Finds INVerse of a Scalar with maximum of 1 
ABSV [Scalar] > Calculates ABSolute Value of Scalar grid 
 
 
 
**- Diagnostic Functions: 
 
SNEG![Scalar] > Finds the NEGative of a Scalar grid 
SINE [Scalar] > Calculates the SINE of Scalar grid (e.g., WDRC) 
COSN [Scalar] > Calculates the COSiNe of Scalar grid (e.g., WDRC) 
TNGT [Scalar] > Calculates the TaNGenT of Scalar grid (e.g., WDRC) 
ASIN [Scalar] > Calculates the ARC SINe of Scalar grid 
ACOS [Scalar] > Calculates the ARC COSine of Scalar grid 
ATAN [Scalar] > Calculates the ARC TANgenT of Scalar grid 
ALOG [Scalar] > Calculates the LOG (Base e) of Scalar grid 
LG10 [Scalar] > Calculates the LOG (Base 10) of Scalar grid 
EXPP [Scalar] > Calculates the EXPonent (Base e) of Scalar grid 
EX10 [Scalar] > Calculates the EXponent (Base 10) of Scalar grid 
SQRT [Scalar] > Return square root of absolute value of scalars 
 
SKNT![Scalar] > Converts Scalar from m/s to KNoTs 
SMPH![Scalar] > Converts Scalar from m/s to Miles Per Hour 
SKPH![Scalar] > Converts Scalar from m/s to Kilometers Per Hour 
M2F=![Scalar] > Converts Scalar from meters to feet 
CM2I![Scalar] > Converts Scalar from centimeters to inches 
 
 
DSDX [Scalar] > Calculates X gradient of Scalar 
DSDY [Scalar] > Calculates Y gradient of Scalar 
GRAD [Scalar] > Finds the GRADient of a Scalar field 
MGRD![Scalar] > Magnitude of the GRaDient of a Scalar field 
NGRD![Scalar] > Finds the Negative GRaDient of a Scalar field 
DVDX [Vector] > Calculates X gradients of a Vector 
DVDY [Vector] > Calculates Y gradients of a Vector 
VADC [<10 digit value] > Sum of Vector & specified constant 
VSBC [<10 digit value] > Difference of Vector & specified constant 
VMLC [<10 digit value] > Multiplies Vector by specified constant 
VDVC [<10 digit value] > Divides Vector by specified constant 
VNEG![Vector] > Finds the NEGative of a Vector field 
VSUM [2 Vectors] > Calculates the Vector sum 
VAVR [2 Vectors] > Calculates the Vector average 
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VDIF [2 Vectors] > Calculates the Vector difference 
VTND [2 Vectors] > Calculates the Vector time tendency 
VMLT [2 Vectors] > Multiplies two Vectors by components 
DOTP [2 Vectors] > Calculates the DOT Product of 2 Vectors 
CRSP [2 Vectors] > Calculates the CRoSs Product of two Vectors 
VDVD [2 Vectors] > Divides two Vectors by components 
 
VKNT![Vector] > Converts a Vector from m/s to KNoTs 
VMPH![Vector] > Converts a Vector from m/s to MPH 
VKPH![Vector] > Converts a Vector from m/s to KPH 
MAGN|MSPC!|[Vector] > Calculates MAGNitude of a Vector 
KNOT![Scalar] > Converts a Scalar (e.g., WSPD) from m/s to KNOTs 
MLPH![Scalar] > Converts a Scalar (e.g., WSPD) from m/s to MPH 
KMPH![Scalar] > Converts a Scalar (e.g., WSPD) from m/s to KPH 
DVRG [Vector] > Calculates divergence (inverse of convergence) 
CNVG [Vector] > Calculates convergence (inverse of divergence) 
ADVT [Scalar and Vector] > Calculates advection 
FLUX [Scalar and Vector] > Produces a flux Vector 
SDVR![Scalar and Vector] > Calculates flux divergence 
RVRT [Vector] > Calculates relative vorticity 
VORT![Vector] > Calculates absolute vorticity 
IPVO  > Isentropic Potential Vorticity calculated between LVL1 and LVL2 when 
         LVL1 and LVL2 are set to Theta levels. 
IPVA  > Isentropic Potential Vorticity Advection calculated between LVL1 and  
         LVL2 when LVL1 and LVL2 are set to Theta levels. 
PVTA  > Isobaric Potential Vorticity (Theta) calculated between LVL1 and LVL2 when 
         LVL1 and LVL2 are set to pressure levels. 
PVTE  > Isobaric Potential Vorticity (Theta-E) calculated between LVL1 and LVL2 when 
         LVL1 and LVL2 are set to pressure levels. 
PVTS  > Isobaric Potential Vorticity (Theta-S) calculated between LVL1 and LVL2 when 
         LVL1 and LVL2 are set to pressure levels. 
PVAA  > Isobaric Potential Vorticity (Theta) Advection calculated between LVL1 and  
         LVL2 when LVL1 and LVL2 are set to pressure levels. 
PVEA  > Isobaric Potential Vorticity (Theta-E) Advection calculated between LVL1 and  
         LVL2 when LVL1 and LVL2 are set to pressure levels. 
PVSA  > Isobaric Potential Vorticity (Theta-S) Advection calculated between LVL1 and  
         LVL2 when LVL1 and LVL2 are set to pressure levels. 
PVN    >  potential vorticity (m**2/kg/s) 
PVU   >  potential vorticity (10**-6*K*m**2/kg/s) 
SPENT >  specific entropy (J/K/kg) 
 
SHRRVRT[Vector] > Calculates Shear Relative Vorticity 
SHRAVRT[Vector] > Calculates Shear Absolute Vorticity 
CRVRVRT[Vector] > Calculates Curvature Relative Vorticity 



 
 332 

CRVAVRT[Vector] > Calculates Curvature Absolute Vorticity 
SHDF   [Vector] > Calculates SHearing DeFormation 
STDF   [Vector] > Calculates STretching DeFormation 
DFCP   [Vector] > Calculates Deformation components {X COMP, Y COMP} of any vector 
WGEO   [Scalar] > Calculates Geostrophic Wind from Scalar field 
VRTV   > Calculates instantaneous Vertical Velocity approximation. 
OMGA   > Calculates Vertical Velocity over the forecast period of time. 
 
 
 
SMTH  > Applies a binomial SMooTHer to the active scale data field 
SMT#  > Applies a binomial SMooTHer # times to the active scalar data field 
SMOO  > Applies a light SMOOther to the active scalar data field 
VSMT  > Applies a binomial sMooTHer to the active Vector field 
VSM#  > Applies a binomial sMooTHer # times to the active Vector field 
RLTN [digit value] > Replaces values Less ThaN with that value 
RGTN [digit value] > Replaces values Greater ThaN with value 
MLTN [digit value] > Replaces values Less ThaN as Missing 
MGTN [digit value] > Replaces values Greater ThaN as Missing 
MSKS![a field] > Replaces values below the surface as missing 
SMAX  > Finds the MAXimum at each grid point of two Scalar fields 
SMIN  > Finds the MINimum at each grid point of two Scalar fields 
ZNEG  > Sets all NEGative values to Zero 
ZPOS  > Sets all POSitive values to Zero 
SPOW [digit value] > Computes the exponential value of scalar raised to the power of constant 
VPOW [digit value] > Computes the exponential value of vector raised to the power of constant 
 
 
FNTW  > Calculates areas of frontal wave formations 
FNSP  > Calculates the speed/direction of frontal areas 
FNZN  > Calculates Frontal Zone 
FNADVTA  > Calculates Frontal Advection with THTA 
FNADVTW  > Calculates Frontal Advection with THTW 
 
RFGD [Vector] > Deformation Term of Rotational Frontogenesis 
RFGT [Vector] > Tilting Term of Rotational Frontogenesis 
RFGV [Vector] > Relative Vorticity Term of Rotational Frontogenesis 
RFGN [Vector] > Rotational Frontogenesis (RFGD+RFGT+RFGV) 
EFGD [Vector] > Deformation Term of Escalar Frontogenesis 
EFGT [Vector] > Tilting Term of Escalar Frontogenesis 
EFGG [Vector] > Divergence Term of Escalar Frontogenesis 
EFGN [Vector] > Escalar Frontogenesis (EFGD+EFGT+EFGG) 
 
 



 
 333 

 
 
 
ERPV  > Ertel Potential Vorticity 
BVFS  > Brunt-Vaisala Frequency Squared 
BVFQ  > Brunt-Vaisala Frequency 
BVFP  > Brunt-Vaisala Frequency Period 
TRVC  > Trof/Ridge Vector  
DFRM [Vector] > Deformation of the wind 
 
CLIMO30  [Scalar/Vector]  > Display 30yr Climate value (1985-2015) of Parameter 
CLIMO60  [Scalar/Vector]  > Display 60yr Climate value (1955-2015) of Parameter 
 
ANOMLY30 [Scalar/Vector]  > Display the difference between parameter & 30yr Climate value 
ANOMLY60 [Scalar/Vector]  > Display the difference between parameter & 60yr Climate value 
 
 
**- Diagnostic Functions - Convection Control Flags 
 
VTMP  > Virtual Temperature Correction 

All convection parameters are calculated without virtual temperature correction by default.   
This flag enables that correction. 
 

SBSI  > Surface-Based Lifted Parcel Selected 
MLSI  > Mean-Layer Lifted Parcel Selected 
MUSI  > Most Unstable Lifted Parcel Selected 
USSI  > User-Selected Lifted Parcel Selected 
If no Lifted Parcel method is selected, Surface-Based Lifted Parcel is default. 
 
**- Diagnostic Functions - Convection Parameters 
 
CPOS [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Convective Positive Energy (CAPE) 
CNEG [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Convective Negative Energy (CINH) 
PLPL [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Pressure Lifted Parcel Level 
TLPL [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Temperature Lifted Parcel Level 
DLPL [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Dew point Lifted Parcel Level 
HLPL [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Height Lifted Parcel Level 
THLP [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Theta Lifted Parcel Level 
TELP [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Theta-e Lifted Parcel Level 
PLCL [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Pressure Lifted Condensation Level 
TLCL [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Temperature p Lifted Condensation Level 
MLCL [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Mixing ratio Lifted Condensation Level 
HLCL [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Height Lifted Condensation Level 
THLC [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Theta Lifted Condensation Level 
TELC [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Theta-e Lifted Condensation Level 
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PLFC [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Pressure Level of Free Convection 
TLFC [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Temperature Level of Free Convection 
DLFC [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Dew point Level of Free Convection 
HLFC [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Height Level of Free Convection 
THLF [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Theta Level of Free Convection 
TELF [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Theta-e Level of Free Convection 
PCCL [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Pressure Convective Condensation Level 
TCCL [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Temperature Convective Condensation Level 
DCCL [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Dew point Convective Condensation Level 
HCCL [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Height Convective Condensation Level 
THCC [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Theta Convective Condensation Level 
TECC [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Theta-e Convective Condensation Level 
PEQL [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Pressure Equilibrium Level 
TEQL [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Temperature Equilibrium Level 
DEQL [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Dew point Equilibrium Level 
HEQL [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Height Equilibrium Level 
MPCL [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Height Max Parcel Level 
VGP  [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Vorticity Generation potential  
SCP  [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Supercell Composite Parameter 
STP  [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Significant Tornado Parameter 
CONVT  [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Convective Temperature 
DCONVT [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Deep Convective Temperature 
VVMAX  [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Parcel Maximum Vertical Velocity 
ENERGY  [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Heating Required for Convection 
HAILSZ  [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Hail Size 
PWATER  [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Precipitable Water 
EHINDX  [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Energy Helicity Index 
DENBUOY  [(VTMP)(SBSI,MLSI,MUSI,USSI)] > CAPE Density 
LFTDX{***}{Top Pressure}[(VTMP)(SBSI,MLSI,MUSI,USSI)] > Lifted Index 
TDIFLCLF [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Temp Difference between LCL & LFC 
TDIFCCLF [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Temp Difference between CCL & LFC 
 
SCP1 > Alt Supercell Composite Parameter // eshear * (esrh/50) * (cape/1000.) 
STP1 > Significant Tornado Parameter // eshear * (esrh/150) * (mlcape/1500) * lclh 
STP2 > Significant Tornado Parameter (with CIN) // eshear * (esrh/150) * (mlcape/1500) * lclh * mlcinh 
STP3 > Significant Tornado Parameter // shr6 * (srh1/150.) * (sbcape/1500.) * lclh 
STP4 > Significant Tornado Parameter (tropical cyclone) // srh1/40.) * (shr3/23.) * ((2000.- mllclh)/1400. 
STP5 > Significant Tornado Parameter (effective layer) // eshear * (esrh/150.) * (cape6km/500.) * lclh 
STP6 > Craven & Brooks Significant Tornado Parameter // (6ksh * 1ksh * mlcape) / (mllcl hgt * dcape) 
MCSPROB   > Probability of MCS (Mesoscale Convective System) 
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LAPSP[****-****]> Lapse Rate between Pressure Surfaces (mb) 
LAPSH[****-****]> Lapse Rate between Height Surfaces (km) 
LAPSP[****-****]> Lapse Rate between Pressure Surfaces (mb) 
MWNDP[****-****]> Mean Wind between Pressure Surfaces (mb) 
MWNDPU[****-****]> U-Parameter Mean Wind between Pressure Surfaces (mb) 
MWNDPV[****-****]> V-Parameter Mean Wind between Pressure Surfaces (mb) 
MWNDH[****-****]> Mean Wind between Height Surfaces (km) 
MWNDHU[****-****]> U-Parameter Mean Wind between Height Surfaces (km) 
MWNDHV[****-****]> V-Parameter Mean Wind between Height Surfaces (km) 
 
 
 
 
EILB    > Effective Inflow Layer – Bottom 
EILBH   > Effective Inflow Layer – Bottom Height (M) 
EILBP   > Effective Inflow Layer – Bottom Pressure (mb) 
EILT    > Effective Inflow Layer – Top 
EILTH   > Effective Inflow Layer – Top Height (M) 
EILTP   > Effective Inflow Layer – Top Pressure (mb) 
EILTHKH > Effective Inflow Layer – Thickness Height (M) 
EILTHKP > Effective Inflow Layer – Thickness Pressure (mb) 
 
SCAPE   > Slantwise CAPE 
SCIN    > Slantwise CIN 
SCAPEP > Slantwise CAPE Partial Pressure 
SCPTP  > Cloud Physics Thunder Parameter with CAPE 
CSI     > Convective Symmetric Instability 
PSI     > Potential Symmetric Instability 
CFA     > Cold Front Aloft (pressure level) 
WFA     > Warm Front Aloft (pressure level) 
VCHI    > Velocity Potential Function 
PSIVCT > Streamfunction Vector 
PSIU    > U - Portion Streamfunction Vector 
PSIV    > V - Portion Streamfunction Vector 
PSIXD   > Partial Derivative of PSI-U 
PSIYD   > Partial Derivative of PSI-V 
PSIXDX > X – Portion of Partial Derivative of PSI-U 
PSIXDY > Y – Portion of Partial Derivative of PSI-U 
PSIYDX > X – Portion of Partial Derivative of PSI-V 
PSIYDY > Y – Portion of Partial Derivative of PSI-V 
 
CALCSYSMO [SCALAR] > Calculate Synoptic Motion of a given scalar grid 
SYSRWIND[SCALAR,WIND] > Calculate the requested synoptic-relative     
   wind direction/speed from the synoptic motion of the given scalar. 
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PWBZ > Pressure Wet-Bulb Zero Level 
TWBZ > Temperature Wet-Bulb Zero Level 
HWBZ > Height Wet-Bulb Zero Level 
WBTF > Wet-Bulb Temperature degrees F 
WBTC > Wet-Bulb Temperature degrees C 
WBTK > Wet-Bulb Temperature degrees K 
WBPT > Wet-Bulb Theta 
SWPT > Saturated Wet-Bulb Theta-e 
CNPR > Condensation Pressure Ratio 
CNPD > Condensation Pressure Deficit 
DPDP > Dew Point Depression 
SVPR > Saturated Vapor Pressure 
VAPR > Vapor Pressure 
LVAP > Latent heat of vaporization 
 
 
**- Diagnostic Functions - Shear Control Flags 
   **KM – Defines the Lower/Upper bounding levels in Kilometers 
 The first * (0-9) defines the lower level to use and the second * (0-9) defines the     
            upper level to use.  Therefore, a command 14KM defines the 1km to 4km layer. 

Shear functions will use the default KM flags or, if missing, SLVL pressure levels  
unless overridden by user requested KM flag. 

 
***NOTICE: ALL shear plotted data is in M/S values. Remember to convert to KTS if required. 
 
**- Diagnostic Functions - Shear Parameters 
UAVG > (Scalar) U-average wind through layer 
VAVG > (Scalar) V-average wind through layer 
WAVG > (Vector) Average Wind through layer 
BLKS > (Scalar) Bulk Shear (06KM) 
DBRSH> (Scalar) Deep Bulk Richardson Shear (09 KM) 
BRCH > (Scalar) Bulk Richardson Number (06KM) 
DBRCH> (Scalar) Deep Bulk Richardson Number (09KM) 
TCSH > (Scalar) Total Cumulative Shear through layer 
USHR > (Scalar) U-Shear between layer 
VSHR > (Scalar) V-Shear between layer 
TSHR > (Vector) Total Wind Shear between layer 
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The following supercell specific diagnostics are controlled with only the **KM flag except where noted.  If 
the flag is omitted, 03KM is assumed.  All calculations use the Bunkers Method algorithm. 
 
RMSU > (Scalar) Supercell U-component, Right-moving (06KM) 
RMSV > (Scalar) Supercell V-Component, Right-moving (06KM)  
RMSS > (Vector)  Supercell Motion, Right-moving (06KM) 
RMSP > (Scalar) Supercell Speed, Right-moving (06KM) 
RMDR > (Scalar) Supercell Direction, Right-moving (06KM) 
LMSU > (Scalar) Supercell V-Component, Left-moving (06KM) 
LMSV > (Scalar) Supercell V-Component, Left-moving (06KM) 
LMSS > (Vector)  Supercell Motion, Left-moving (06KM) 
LMSP > (Scalar) Supercell Speed, Left-moving (06KM) 
LMDR > (Scalar) Supercell Direction, Left-moving (06KM) 
SHER > (Scalar) Storm-relative HElicity, Right moving 
SHEL > (Scalar) Storm-relative HElicity, Left moving 
SHOR > (Scalar) Storm-relative HOlicity, Right moving 
SHOL > (Scalar) Storm-relative HOlicity, Left moving 
CFDV > (Scalar) CorFiDi Vectors 
CFDVU> (Scalar) Corfidi Vector (UGRD) 
CFDVV> (Scalar) Corfidi Vector (VGRD) 
SHRVCT03   > (Vector) 0-3KM Shear Vector 
SHRVCT03U  > (Scalar) 0-3KM Shear Vector (UGRD) 
SHRVCT03V  > (Scalar) 0-3KM Shear Vector (VGRD) 
SHRVCT36   > (Vector) 3-6KM Shear Vector 
SHRVCT36U  > (Scalar) 3-6KM Shear Vector (UGRD) 
SHRVCT36V  > (Scalar) 3-6KM Shear Vector (VGRD) 
SHRVCT612  > (Vector) 6-12KM Shear Vector  
SHRVCT612U > (Scalar) 6-12KM Shear Vector (UGRD) 
SHRVCT612V > (Scalar) 6-12KM Shear Vector (VGRD) 
SMV3075    > (Vector) Storm Motion Vector 30/75  
SMV3075U   > (Scalar) Storm Motion Vector 30/75 (UGRD) 
SMV3075V   > (Scalar) Storm Motion Vector 30/75 (VGRD) 
SMV1585    > (Vector) Storm Motion Vector 15/85  
SMV1585U   > (Scalar) Storm Motion Vector 15/85 (UGRD) 
SMV1585V   > (Scalar) Storm Motion Vector 15/85 (VGRD) 
 
 
**- Diagnostic Functions - Cross/Time Section Specific: 
XREL [Vector] > Rotates Vector from GRID to Cross Sector relative 
EREL [Vector] > Rotates Vector from GRID to Earth relative (TSCT) 
TANG [Vector] > Finds cross-section relative tangential component 
VTNG [Vector] > Plots cross-section relative tangential component 
VCRC [Vector] > Plots VTNG & VVEL 
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VCR2 [Vector] > Plots VTNG & VVEL scaled by 2 
VCR5 [Vector] > Plots VTNG & VVEL scaled by 5 
NORM [Vector] > Finds cross-section relative normal component 
VNRM [Vector] > Plots cross-section relative normal component 
DIST > Calculates DISTance from left end of cross section 
MSFC!> Calculates constant Momentum SurFaCe (M-Surfaces) 
WNDX!> Displays the total wind rotated relative to the cross section 
GEOX!> Displays the geostrophic wind rotated relative to the cross section 
AGEX!> Displays the ageostrophic wind rotated relative to the cross section 
WCRC!> Displays vertical/tangential circulations of total wind 
GCRC!> Displays vertical/tangential circulations of geostrophic wind 
ACRC!> Displays vertical/tangential circulations of ageostrophic wind 
 
 
**- Contour Specification:   
CINT > Displays Max and Min of field and requests user input 
 
CISV > Sets mode where specified contour interval is retained for future plots 
CINX > Returns to mode in which program selects contour interval for each plot 
 
CIN# > Sets Contour Internal to # units 
CIN1 > Sets Contour Interval to 1 unit 
CIN2 > Sets Contour Interval to 2 units 
... 
CI#0 > Sets Contour Interval to # of tens of units 
CI10 > Sets Contour Interval to 10 units 
CI20 > Sets Contour Interval to 11 units 
... 
C#00 > Sets Contour Interval to # hundreds of units 
C100 > Sets Contour Interval to 100 units 
C200 > Sets Contour Interval to 200 units 
 
C#+#  > Sets Contour Interval to #*10**# {units == C2+3 -> 2*10**3 = 2000} 
C1+3  > Sets Contour Interval to 1000 units -> 10**3 
C2+3  > Sets Contour Interval to 2000 units -> 2*10**3 
... 
 
CI.#|C#-1| > Sets Contour Interval to .# units -> #*10**-1 
CI.1|C1-1| > Sets Contour Interval to .1 units 
CI.2|C2-1| > Sets Contour Interval to .2 units 
... 
 
C#-# > Sets Contour Interval to #*10**-# {units == C2-3 -> 2*10**-3 = .002} 
C2-2 > Sets Contour Interval to .02 units 
C5-3 > Sets Contour Interval to .005 units 
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CTLN > Line-based Contouring 
CTLG [optional CLN*(1-9,A-Z)] > Line Based Contouring with Graduated Color 
CTFP [optional CFP*(1-9,A-Z)] > Fill Based Contouring with Selected Pattern 
CTFC [optional CFC*(1-9,A-Z)] > Fill Based Contouring with Selected Color 
CTFG [optional CFG*(1-9,A-Z)] > Fill Based Contouring with Graduated Color 
GRTN[<10 digit value] > Displays contours greater than the value 
LSTN[<10 digit value] > Displays contours less than the value 
GT##|GT00!| > Displays contours greater than the value  ## 
LT##|LT00!| > Displays contours less than the value  ## 
GTNE[<10 digit value] > Displays contours greater than or equal to the value 
LTHE[<10 digit value] > Displays contours less than or equal to the value 
GTLT[2 <10 digit values] > Displays contours Greater Than and Less Than the 2 values 
 
CNTFLT > Have contour labels in Floating Point/Exponential Notation. This overrides Properties  
      Selection for 1 plot 
CNTINT > Have contour labels in Whole Integer Notation. This overrides Properties    
      Selection for 1 plot 
 
 
[Scalar/Vector] POSMASK([Scalar Operation]){AND,OR,NOT}...  > Calculate 
      a Positive Mask to filter requested Scalar/Vector operation 
[Scalar/Vector] NEGMASK([Scalar Operation]){AND,OR,NOT}...  > Calculate
      a Negative Mask to filter requested Scalar/Vector operation. 
 
 
 
 
 
**- Graphical Display Setup Commands: 
AREA[Optionally center Lat/Lon&N-S Lat.Dist MAP*] > Specify Map area 
XSCT[left and right Lat/Lon pairs] > Defines Cross-Section path 
TSCT[Lat/Lon] > Defines Time-Section location 
ASTN[center Station ID and N-S Lat.Dist.] > Specify Map area 
XSTN[left and right Station IDs] > Defines Cross-Section path 
TSTN[Station ID] > Defines Time-Section location 
XSCI[left and right Lat/Lon pairs] > Defines Isentropic Cross-Section path  
XSTI[left and right Station IDs]  > Defines Isentropic Cross-Section path 
XSCH[left and right Lat/Lon pairs] > Defines Height Surfaces Cross-Section path  
XSTH[left and right Station IDs]  > Defines Height Surfaces Cross-Section path 
TSCI[Lat/Lon]    > Defines Isentropic Time-Section location 
TSTI[Station ID] > Defines Isentropic Time-Section location 
TSCH[Lat/Lon]   > Defines Height Surfaces Time-Section location 
TSTH[Station ID] > Defines Height Surfaces Time-Section location 
NS## > Sets default North-to-South distance for ASTN to ## degrees 
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XWID > Display Cross-Section across full width of screen--Set in PLAN view 
XNRO > Display Cross-Section in proportion to vertical height--Set in PLAN  
ALVL > Use all available pressure levels in Cross or Time section 
ATIM > Use all available forecast hours in Time section 
 
XLVL[4 Ch. name] > Reads file ----.LVL to define TSCT/XSCT levels 
THRS[4 Ch. name] > Reads file ----.LVL to define TSCT hours 
TINC[Integer] > Changes time increments for time section 
THN# > THiN computation grid to use every #th grid point {CAN OVERFLOW PROGRAM!!} 
THN0 > Display current display mode and grid thinning factor 
FULG > Displays grid data at full grid resolution 
NRMG > Displays grid data at normal thinning 
 
**- Graphics Commands: 
PLAN > Re-activates PLAN view display 
CROS > Re-activates CROSs-sectional display 
TIME > Re-activates TIME-sectional display 
XLBL > Plots values of left most column of cross/time section along left side 
XLBB > Plots values of bottom row of cross/time section along bottom 
XLTN > Calculates Latitude locations along a cross section 
XLNT > Calculates Longitude locations along a cross section 
HOUR > Places forecast hour into time section array 
NCLB > Draws contours without labels for current request only 
NLBL > Prevents plot label (top of screen) from being overwritten 
BSMP|BASM!|> Read the base map file name (without extension or directory) 
SAVE[4 Chtr NAME] > SAVEs graphics commands to file NAME 
ENDS > Stops SAVEing graphics commands 
REST[4 Chtr NAME] > RESTores graphics in file NAME 
;  [####;,";" preceded by 4 Chtr NAME] > RESTores graphics in file NAME 
SAVS[4 Chtr NAME] > SAVes Screen contents to BMP file NAME  
ALWN > If in 4PNL mode, flag to include all 4 windows in either Animation or SAVS operations. 
 
PRSC!|BKWT| > Converts screen colors for printing using 'PRint SCreen' key 
 
POPT > List current print option and select a new print option 
PRNT [optional 4 Ch. name] > Print screen contents to default Printer 
LSVG > List files containing a set of saved graphics commands 
 
MAP  > Redraws map background with no data 
EMAP > Erases screen and draws map background with no data 
SVMP > Save, list, or delete map plot files 
 
&   |or / | > Overlays output on previous graphics  
OLAY|CNTR!| > Overlays output on previous graphics -- First command in a line 
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WSTOS [2 digit number] > Write Scalar solution to storage file number requested by user 
WSTOV [2 digit number] > Write Vector solution to storage file number requested by user 
RSTOS [2 digit number] > Read Scalar solution from storage file number requested by user 
RSTOV [2 digit number] > Read Vector solution from storage file number requested by user 
 
CLR1 > Override default and use color 1 in palette {Solid} 
CLR2 > Override default and use color 2 in palette {Solid} 
... 
CLR9 > Override default and use color 9 in palette {Solid} 
CLR0 > Override default and use color 10 in palette {Solid} 
CLRA > Override default and use color 11 in palette {Solid} 
... 
CLRF > Override default and use color 16 in palette {BLACK - ERASES LINES} 
    --- 
CLRG > Override default and use color 1 in palette {Dashed} 
CLRH > Override default and use color 2 in palette {Dashed} 
... 
CLRX > Override default and use color 14 in palette {Dotted} 
CLRY > Override default and use color 15 in palette {Dotted} 
CLRZ > Override default and use color 16 in palette {Dotted} 
 
SCLR > Save current CoLoR order from palette 
RCLR > Return to saved CoLoR order on palette 
 
LNW* (*=1-9) > Change width of contour line for this display (width in pixels) 
 
 
ANIM > Animates a display of data using all forecast hours (PLAN or CROSS). 
              Must be first command. 
ANMA > Animates a Command Macro 
ANFA > Animates specific forecast hours 
ENDA > Ends the Animation build process. 
 
1PNL > If WINGRIDDS is in 4 Panel Mode, changes to 1 Panel mode 
4PNL > If WINGRIDDS is in 1 Panel Mode, changes to 4 Panel mode 
WIN1 > If WINGRIDDS is in 4 Panel Mode, selects Window 1 (default in 1PNL mode) 
WIN2 > If WINGRIDDS is in 4 Panel Mode, selects Window 2 (not available in 1PNL mode) 
WIN3 > If WINGRIDDS is in 4 Panel Mode, selects Window 3 (not available in 1PNL mode) 
WIN4 > If WINGRIDDS is in 4 Panel Mode, selects Window 4 (not available in 1PNL mode) 
ALWN > Use ‘All Windows’ when Printing, Screen Saving or Animation  
 
STWX > Plots the station model on the screen for the level selected  
STID > Plots station ID information (WMO or ICAO) at the geographic location.  
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CSTMGRID [Center Lat,Center Lon,Blowup Size,(Tangent Cone),Grid Type] 
 > Command to enable custom grid using specific grid navigation info. 
CSTMGRID [Grid Spec File Name] 
 > Command to enable custom grid using previously saved file name.  
 
 
**- Command Manipulations: 
CMDS |LCMD| > Lists the previous 21 commands lines 
          
CMD1 > Lists last CoMmanD given (without erasing screen) 
CMD2 > Lists 2nd previous CoMmanD given (without erasing screen) 
... 
CMD9 > Lists 9th previous CoMmanD given (without erasing screen) 
CMDA > Lists 10th previous CoMmanD given (without erasing screen) 
... 
CMDL > Lists 21st previous CoMmanD given (without erasing screen) 
          
RPT1 > RePeaTs last command given 
RPT2 > RePeaTs 2nd previous command given 
... 
RPT9 > RePeaTs 9th previous command given 
RPTA > RePeaTs 10th previous command given 
... 
RPTL > RePeaTs 21st previous command given 
 
 
 
 
**- Special COMMAND FILE (.CMD Files) Commands: 
####.(Preceded by 4 Ch. Name) > Executes Named command (script) file 
####:(Preceded by 4 Ch. Name) > Overlays Named command file on existing plot 
 
LOOP > All following commands will be executed without keyboard prompts 
ENDL > Ends LOOP in .CMD file 
 
#SEC > Wait # seconds before executing next request 
1SEC > Wait 1 second before executing next request 
2SEC > Wait 2 seconds before executing next request 
... 
9SEC > Wait 9 seconds before executing next request 
 
^   > Repeat last macro for current time 
<   > Repeat last macro for time equals current time - increment set by DELT 
>   > Repeat last macro for time equals current time + increment set by DELT 
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BEGT [integer] > Set begin limit of time sequence for macro repeat 
ENDT [integer] > Set end limit of time sequence for macro repeat 
DELT [integer] > Set increment of time sequence for macro repeat 
PMSV > Save parameters (eg, LVL) in macro as permanent settings 
 
 
**- Special LABELING Commands: 
TXT# [line of text] > Writes TeXT on line # from top of screen 
TXT1 |TEXT,TUTR| > Writes text on TOP line of screen 
TXT2 > Writes text on 2nd line of screen 
... 
LTM# > Write forecast hour or TiMe range on line sequence # of label set 
LPL# > Write Pressure Level or layer on line sequence # of Label set 
LFL# > Write Flight Level or layer on line sequence # of Label set 
LDN# > Write Data file Name on line sequence # of Label set 
LFD# > Write Forecast model Date on line sequence # of Label set 
LMN# > Write forecast Model Name on line sequence # of Label set 
LFO# > Write Forecast model Origination on line sequence # of Label set 
LLN# > Write forecast LeNgth on line sequence # of Label set 
LLL# > Write Latitude/Longitude on line sequence # of Label set (tsct/xsct) 
LSN# > Write StatioN identifier on line sequence # of Label set (tsct/xsct) 
LTX# [line of text] > Write TeXt on line sequence # of Label set 
LNDF > Stop display of DeFault Labels (applies to current plot and overlays) 
LDEF > Start display of DEFault Labels (applies to current plot and overlays) 
LWT# > Begin WriTing current Label set on line # from top of screen 
 
 
**-    ---  To String Commands from One Line to the Next  --- 
CONT {LEFTMOST position} > Save fields for next command line, without plotting 
 
LAST|LSTS!,LSTV!,LST#|{RIGHTMOST command} > Returns data to work array 
       -- NOTE:  LSTS |LST1,KEPS!| retrieves last 1 Scalar array only -- 
       -- NOTE:  LSTV |LST2,KEPV!| retrieves last 2 scalar arrays (Vector) only 
       -- NOTE:  LST# retrieve last # scalar arrays back to work array -- 
       ----------------------------------------------------------------------- 
       ** NOTE:  LAST, etc. should be used ONLY for redisplay in XSCT or TSCT 
       ** NOTE:  LSTS, LSTV can NOT be used in COMMAND ( .CMD ) files 
       ** NOTE:  LAST is not needed if CONT was in previous line -- 
 
 
 
 
 
 
 
 



 
 344 

**- Commands/Diagnostics contained in the ALIAS.DAT file 
VCTR > Sets display mode to plot winds as arrows (Default) 
BOXS > Plots boxes at grid points below the surface 
STBL > Computes static stability in a layer 
TKNS > Generates Thickness fields 
THWN > Generates Thermal Wind 
TMPF > TeMPerature (degrees F) 
TMPC > Calculates temperature in degrees C 
TMPA > Calculates temperature in degrees K 
TPCI > Provides Total Precipitation fields without resetting LEVeL (in) 
CPCI > Provides Convective Precipitation fields without resetting LEVeL (in) 
PWAI > Provides Precipitable Water fields without resetting LEVeL (in) 
GEOX > Displays the geostrophic wind rotated relative to the cross section 
GCRC > Displays vertical/tangential circulations of geostrophic wind 
WDRC > Wind DiRCtion (degrees) 
WDDD > Displays value of Total Wind Direction (degrees) 
WDDF > Displays packed value of Total Wind Direction/speed (m/s) 
WNDA > Retrieves the total wind Vector in m/s and sets display as wind arrow 
WKNT > Retrieves the total wind Vector in knots 
WMPH > Retrieves the total wind Vector in mph 
WKPH > Retrieves the total wind Vector in kph 
WNDB > Retrieves the total wind Vector in m/s for display as wind barb 
BWND > Retrieves the total wind Vector in m/s for display as wind barb 
BKNT > Retrieves the total wind Vector in knots and sets display as wind barb 
BMPH > Retrieves the total wind Vector in mph and sets display as wind barb 
BKPH > Retrieves the total wind Vector in kph and sets display as wind barb 
MSPC[Vector] > Calculates MAGNitude of a Vector 
KNOT[Scalar] > Converts a Scalar (e.g., WSPD) from m/s to KNOTs 
MLPH[Scalar] > Converts a Scalar (e.g., WSPD) from m/s to MPH 
KMPH[Scalar] > Converts a Scalar (e.g., WSPD) from m/s to KPH 
SPED[Vector] > Calculates magnitude of wind Vector (m/s) 
SPKT[Vector] > Calculates magnitude of wind Vector (knots) 
SPML[Vector] > Calculates magnitude of wind Vector (mph) 
SPKM[Vector] > Calculates magnitude of wind Vector (kph) 
SKNT[Scalar] > Converts Scalar from m/s to KNoTs 
SMPH[Scalar] > Converts Scalar from m/s to Miles Per Hour 
SKPH[Scalar] > Converts Scalar from m/s to Kilometers Per Hour 
VKNT[Vector] > Converts a Vector from m/s to KNoTs 
VMPH[Vector] > Converts a Vector from m/s to MPH 
VKPH[Vector] > Converts a Vector from m/s to KPH 
WNDX > Displays the total wind rotated relative to the cross section 
WCRC > Displays vertical/tangential circulations of total wind 
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AGEO > Generates the Ageostrophic wind Vector 
AGEX > Displays the ageostrophic wind rotated relative to the cross section 
ACRC > Displays vertical/tangential circulations of ageostrophic wind 
TADV > Generates Temperature Advection using the Total wind 
QADV > Generates Mixing Ratio Advection using the Total wind 
PADV > Generates Pressure Advection using the Total wind 
WDVR > Calculates DiVeRgence of the total Wind field 
SDVR[Scalar and Vector] > Calculates flux divergence 
VORT[Vector] > Calculates absolute vorticity 
WVRT > Generates vorticity of the Total wind 
GVRT > Generates vorticity of the Geostrophic wind 
AVRT > Calculates the absolute VoRTicity of Ageostrophic wind  
WSHD > Calculates SHearing Deformation of total Wind 
WSTD > Calculates STretching Deformation of total Wind 
GSHD > Calculates SHearing Deformation of Geostrophic Wind 
GSTD > Calculates STretching Deformation of Geostrophic Wind 
ASHD > Calculates SHearing Deformation of Ageostrophic Wind 
ASTD > Calculates STretching Deformation of Ageostrophic Wind 
MGRD[Scalar] > Magnitude of the GRaDient of a Scalar field 
NGRD[Scalar] > Finds the Negative GRaDient of a Scalar field 
WSPD > Total Wind Speed (m/sec) 
WSPK > Provides total Wind SPeed in Knots 
SNEG[Scalar] > Finds the NEGative of a Scalar grid 
DWPC > Calculates DeW Point Temperature from available data fields (C) 
DWPK > Calculates DeW Point Temperature from available data fields (K) 
DWPF > Calculates DeW Point Temperature from available data fields (F) 
PDEF > Calculates the Pressure DEFicit (lift) needed for saturation the LCL 
LATT > Latitude 
LATI > Latitude 
LAT  > Latitude 
LONG > Longitude 
LON  > Longitude 
F    > Provides Coriolis parameter at each grid point 
MFTR > Provides map factor at each grid point 
MAPF > Provides map factor at each grid point 
VCTR > Sets display mode to plot winds as arrows (Default) 
CNTR > Overlays output on previous graphics -- First command in a line 
GT00 > Displays contours greater than the value 0 
LT00 > Displays contours less than the value 0 
ERSN > ERASes current screen display 
ERSN > ERASes current screen display 
ERSC  > ERASes current screen display 
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PRSC > Converts screen colors for printing using 'PRint SCreen' key 
LAVR > Calculate Layer AVErage of variables to LEFT in Command line 
LY1= > Gets data from bottom of Layer for variables to LEFT 
LY2= > Gets data from top of Layer for variables to LEFT 
KSM=[Integer] > Sets CoNtour SMoothing (Default=1) 
LAY=[two 4 Ch. levels] > Change data LaYeR specs 
LFI= > List data files already opened 
M2F=[Scalar] > Converts Scalar from meters to feet 
INRI > Calculates the INverse of the RIchardson number 
IGRI > Calculates the Inverse of the Geostrophic RIchardson number 
MSFC > Calculates constant Momentum SurFaCe (M-Surfaces) 
BASM > Read the base map file name (without extension or directory) 
LSTS{RIGHTMOST command} > retrieves last 1 Scalar array only 
LSTV{RIGHTMOST command} > retrieves last 2 scalar arrays (Vector) only 
KEPS > retrieves last 1 Scalar array only 
KEPV > retrieves last 2 scalar arrays (Vector) only 
PMSS > Provides MSL Pressure fields (Std. atm. reduction) -- No LEVeL reset 
PMSR > Provides MSL Pressure fields (RUC reduction) -- No LEVeL reset 
PMSE > Provides MSL Pressure fields (ETA model reduction) -- No LEVeL reset 
MSKS[a field] > Replaces values below the surface as missing 
BOXS > Plots boxes at grid points below the surface 
MSNG > Produces grid with missing value flags at points without data 
 
 
 
**- Commands/Diagnostics contained in the ALIAS.USR file (DIAGNOSTICS DEVELOPED AT THE 
WPC INTERNATIONAL DESKS – Dr. José M Gálvez ) 
 
GDIF          > Galvez-Davison Index (GDI). Diagnosis of tropical/subtropical and air mass convection 
GDIS   > Enhanced GDI (EGDI) 
GRF1    > Potential for severity (shades in the macro) 
GMKTT  > Areas with the potential for strong convection 
ILEV    > Level of the lowest stable layer 
WIML         > Winds averaged over the 700-450 hPa layer 
F_ALPP   > Air mass field “alpha” (α). Ranges from cool/dry (low α) to warm/moist (high α) 
F_ALPPG> Air mass field, adjusted for higher latitudes 
F_GRAD > Frontal gradients 
F_GRADG>  Frontal gradients, adjusted for higher latitudes 
KINX    > K-index for tropical and air mass convection 
TOTI   > Total-totals Index 
DENS    > Air density 
COMA    > Convergence of the flux of mixing ratio or moisture convergence 
RHTT   > Relative humidity averaged in the 1000-400 hPa layer 
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RELM   >  Relative humidity averaged in the 700-400 hPa layer 
WWLL   >  Winds averaged over the 1000-925 hPa layer 
WWML   >  Winds averaged over the 1000-850 hPa layer 
WWMM   >  Winds averaged over the 700-450 hPa layer 
WWMU   > Winds averaged over the 600-300 hPa layer 
WWUU   > Winds averaged over the 400-200 hPa layer 
VVML    > Vertical velocity (omegas) in 700-400 hPa layer 
DDLL    > Divergence in the 1000-925 hPa Layer, times 10^6 
DDML    > Divergence in the 1000-850 hPa Layer, times 10^6 
DDMM    > Divergence in the 700-450 hPa Layer, times 10^6 
DDMU    > Divergence in the 600-300 hPa Layer, times 10^6 
DDUU    > Upper divergence, in the 400-200 hPa Layer, empirically scaled 
DDUT    > Upper divergence, in the 400-200 hPa Layer, times 10^6 
PVRT   > Potential vorticity in specific units 
VPOT    > Potential Vorticity (general calculation) 
AVPT    > Advection of potential vorticity 
AVRD    > Advection of vorticity by the wind 
VR56    > Mid-level (500-600 hPa) vorticity 
DEFO   > Deformation 
MSKT   > Blocks data over terrain higher than 750m 
MS70   > Blocks data over terrain higher than 3000m (~700 hPa) 
MS97   > Blocks data over terrain higher than 975 hPa 
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Appendix B:  Listing of Basic Grid Fields 
 
 
**-                WINGRIDDS --- BASIC GRIDDED DATA FIELDS 
      
     
       ******   Basic ICAO-Required Fields   ****** 
      
TEMP > TEMPerature  (degree C) 
WIND > WIND (m/s) 
WKNT > Wind (KNoTs) 
      
UGRD > West-to East Wind Component (m/s)  
VGRD > South-to-North Wind Component (m/s) 
      
HGHT > HeiGHT (Geopotential Meters) 
MAXW |WMAX!| > Data from MAXimum Wind level 
TROP > Data From TROPopause level 
 
 
**-    ******   Additional Meteorological Fields   ****** 
 
HGHT > Geopotential HeiGHT (meters)  
PRES > Pressure (mb) 
MIXR > MIXing Ratio (g/kg) 
VVEL > Vertical VELocity (Microbars/sec) 
 
PMSL > Mean Sea Level Pressure fields, obtained without resetting LEVeL 
 
          Note:  If mean sea level pressure (GRIB ID=002) is not  
                 available, then an attempt is made to retrieve the  
                 RUC Reduction, the Eta Model Reduction, and the  
                 Standard Atmosphere Reduction, in that order. 
 
PRSS > Mean sea level PReSsure (Std. atm. reduction) -- Set level first 
PRSR > Mean sea level PReSsure (Ruc reduction) -- Set level first 
PRSE > Mean sea level PReSsure (Eta model reduction) -- Set level first 
 
TPCP > Total Precipitation fields, obtained without resetting LEVeL (mm) 
CPCP > Convective Precipitation fields, obtained without resetting LEVeL (mm) 
      
TPCI! > Total Precipitation fields, obtained without resetting LEVeL (in) 
CPCI! > Convective Precipitation fields, obtained without resetting LEVeL (in) 
 
       NOTE:  TPCx/CPCx attempt to retrieve a 12 hour accumulation.  If this 
              is not possible, then they try to obtain the longest 
              accumulation (6,3,2,1) available. 
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TPC# > Total Precipitation fields in cm (#=hour accumulation)--no level reset 
CPC# > Convective Precipitation field in cm(#=hour accumulation)-no level reset 
 
 
**-    ******    Automatically Derived Scalar Parameters   ****** 
           
THTA > Potential Temperature - THeTA(degree K)  
RELH > Relative Humidity (%) 
DWPT > DeW Point Temperature (degree C)  
TMPK > TeMPerature (degrees K) 
TMPF!> TeMPerature (degrees F) 
THTE > Equivalent Potential Temperature - THeTa/E (degree K) 
 
 
      
       ******   Automatically Derived Vector Parameters   ****** 
      
GEOS > GEOStrophic wind vector (m/sec)  
WDDF!> Packed value of Wind Direction/speed (tens of degrees and m/sec)  
WDRC!> Wind DiRCtion (degrees) 
BWND > WiND Barbs (m/sec) 
BKNT > Wind Barbs (KNoTs) 
      
      
**-    ******   Isobaric Level Specifications   ****** 
      
 100 >  100 hPA level data --> FL-530  (ICAO-Required)  
 150 >  150 hPa level data --> FL-450  (ICAO-Required)  
 200 >  200 hPa level data --> FL-390  (ICAO-Required)  
 250 >  250 hPa level data --> FL-350  (ICAO-Required)  
 300 >  300 hPa level data --> FL-300  (ICAO-Required)  
 400 >  400 hPa level data --> FL-240  (ICAO-Required)  
 500 >  500 hPa level data --> FL-180  (ICAO-Required)  
 700 >  700 hPa level data --> FL-100  (ICAO-Required)  
 850 >  850 hPa level data --> FL-050  (ICAO-Required) 
1000 >  1000 hPa level data 
 
 
**-    ******   Special Level Specifications   ****** 
TROP > TROPopause level data    (ICAO-Required)  
MAXW |WMAX!| > MAXimum Wind level data (ICAO-Required) 
SFC  > Earth's SurFaCe data 
MSL  > Mean Sea Level data 
CBAS > Cloud BASe level data 
CTOP > Cloud TOP level data 
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0DEG > First freezing level above ground 
CLVL > Adiabatic Condensation LeVeL data (parcel lifted from surface) 
0DGX > Top freezing level 
LCDB > Low ClouD Bottom level data 
LCDT > Low ClouD Top level data 
LCDL > Low ClouD Layer data 
MCDB > Middle ClouD Bottom level data 
MCDT > Middle ClouD Top level data 
MCDL > Middle ClouD Layer data 
HCDB > High ClouD Bottom level data 
HCDT > High ClouD Top level data 
HCDL > High ClouD Layer data 
 
       NOTE:  No special level can begin with 0 except 0DEG, 0DGX, 0000  
 
 
**-    ******   Additional Level/Layer Specifications   ****** 
 
###Z > Height above mean sea level in m (<100m) 
Z### > Height above mean sea level in hm (>=100m) 
 
###M > Height above ground in m (<100m) 
M### > Height above ground in hm (>=100m) 
 
###U > Depth below land surface in cm (<1000cm) 
U### > Depth below land surface in m (>=1000cm) 
 
S### > Sigma level number 
H### > Height above sea level (x10) 
I### > Isentropic level in degrees K 
B### > Boundary layer in hPa (mb) above surface at the center 
 
 
**-    ******   Time Specifications   ****** 
      
 F06 >  6 hour forecast data  
 F12 > 12 hour forecast data  (ICAO-Required)  
 F18 > 18 hour forecast data  (ICAO-Required)  
 F24 > 24 hour forecast data  (ICAO-Required)  
 F30 > 30 hour forecast data  (ICAO-Required)  
 F36 > 36 hour forecast data 
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**-    ******   Special Optional Gridded Data Fields   ****** 
           
LIFT > LIFTed Index, obtained without resetting LEVeL 
LFTX > LIFTed Index, obtained without resetting LEVeL 
LFT4 > LIFTed Index, obtained without resetting LEVeL 
LFTS > LIFTed Index, obtained without resetting LEVeL 
PWAT > Precipitable Water fields, obtained without resetting LEVeL (mm)  
PWAI!> Precipitable Water fields, obtained without resetting LEVeL (in)      
THCK > Generates Thickness fields between LVL1 and LVL2 
THWN > Generates Thermal Wind between LVL1 and LVL2 
 
 
 
**-    ******  Other Parameters commonly in GRIB data sets: ****** 
 
TEMP > TEMPerature  (degree C) 
WIND > WIND (m/s) 
WKNT!> Wind (KnoTs) 
PRES > PRESsure (mb, .1hPa) 
PTND > Pressure TeNDency (mb/hr, .1hPa/hr) 
HGHT > geopotential HeiGHT (m) 
GHGT > Geometric HeiGhT (m) 
OZON > Total  OZONe 
TEMP > TEMPerature (degree C) 
VTMP > Virtual TeMPerature (degree K) 
THTA > potential temperature [TheTA] (degree K) 
THTE > equivalent potential temperature [TheTa-E] (degree K) 
DWPT > DeWPoinT temperature (degree C) 
DPTD > DeWPoint temperature Depression (degree C) 
WNDD > WiND Direction (degree) 
WNFF > WIND SPEED (m/sec) 
UGRD > GRiD relative U wind component (m/sec) 
VGRD > GRiD relative V wind component (m/sec) 
 
 
SFTN > Stream FuNcTion (m**2/sec) 
PSYM > montgomery stream function [PSYM] (m**2/sec**2) 
VVEL > Vertical VELocity (micro-bars/sec) 
VTCY > absolute VorTiCitY (1/sec) 
SPFH > SPeciFic Humidity (g/g) 
RELH > RELative Humidity (%) 
MIXR > MIXing Ratio (g/g) 
PWAT > Precipitable WATer (cm) 
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VCRS > Vapor pressure (mb, .1hPa) 
DEF.   > Saturation DEFicit (mb, .1hPa) 
PCRT > PreCipitation RaTe (cm/sec) 
TPCP > Total PreCiPitation (mm) 
LPCP > Large-scale (stable) PreCiPitation (mm) 
CPCP > Convective PreCiPitation (mm) 
SWAT > WATer equivalent Snow depth (cm) 
SNDP > Snow DePth (cm) 
TCLD > Total Cloud percent (%) 
CCLD > Convective ClouD percent (%) 
LCLD > Low CLouD percent (%) 
MCLD > Middle ClouD percent (%) 
HCLD > High CLouD percent (%) 
CH2O > Cloud water [H2O] (cm) 
PCON > CONdensation Pressure (mb, .1hPa) 
WTMP > Water TeMPerature (degree K) 
TSOL > SOiL Temperature (degree K) 
SWEL > significant SWELl wave height (m) 
SWVR > net Short WaVe Radiation at surface (W/m**2) 
LWVR > net Long WaVe Radiation at surface (W/m**2) 
PRSS > mean sea level Pressure - Standard atmosphere reduction (mb, .1hPa) 
PRSR > mean sea level Pressure - RUC reduction (mb, .1hPa) 
PRSE > mean sea level Pressure - Eta reduction (mb, .1hPa) 
LIFT >  "Surface " LIFTed index (degree K) 
LFTX > "best" LiFTed index (degree K) 
LFTB > "Boundary layer" LiFTed index (degree K) 
KNDX > K iNDeX (degree K) 
SWET > SWEeT index (degree K) 
 
HQDV > Horizontal moisture [Q] DiVergence (g/g/sec) 
VSSH > Vertical wind Speed Shear (1/sec) 
PTN3 > 3 hour interval Pressure TeNdency (mb/sec) 
CRAN > Categorical RaiN (1/0 = Yes/No) 
CZRN > Categorical freeZing RaiN (1/0 =Yes/No) 
CPEL > Categorical ice PELlets (1/0 = Yes/No) 
CSNO > Categorical SNOw (1/0 = Yes/No) 
CWTR > Cloud WaTeR (mm) 
CINH > Convective INHibition (J/kg) 
CAPE > Convective Available Potential Energy (J/kg) 
TKEN > Turbulent  KENetic energy (J/kg) 
THTV > Virtual potential temperature [TheTa-V] (degree K) 
HLCY > storm relative HeLiCitY  
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POPP > Probability Of PreciPitation (%) 
POZP > Probability Of froZen Precipitation (%) 
POFP > Probability Of Freezing Precipitation (%) 
USTM > U-component of STorM relative motion (m/sec) 
VSTM > V-component of STorM relative motion (m/sec) 
PSNC > Percent SNow Cover (%) 
 
A new Fixed Surface Type processing has been added to NGRB2PCG32 to processes Potential Vorticity 
Surfaces and to show the distance the PV level is above or below the Tropopause. The new PV level is 
prefixed with the ‘P’ letter  a ‘+’ or ‘-‘. As an example: 
 
P+05 >  PV (Potential Vorticity) level 500 ft above the Tropopause 
P-15 >  PV (Potential Vorticity) level 1500 ft below the Tropopause 
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Appendix C:  Observation Station Weather Symbols 
 
 
Current Weather Symbols: 
 

  0 -   Cloud Development NOT observed or NOT observable during past hour 

 1-   Clouds generally dissolving or becoming less developed during past hour 

  2 -   State of sky on the whole unchanged during past hour 

  3 -    Clouds generally forming or developing during past hour 

  4 -  Visibility reduced by smoke 

  5 -   Haze 

  6 -     Widespread dust in suspension in the air, NOT raised by wind, at time of observation 

  7 -    Dust or sand raised by wind, at time of observation 

  8 -     Well developed dust devil(s) within past hour 

  9 -  Dust storm or sand storm within sight of or at station during past hour 

10 -   Light fog 

11 -  Patches of shallow fog at station, NOT deeper than 6 feet on land 

12 -  More or less continuous shallow fog at station, NOT deeper than 6 feet on land 

13 -   Lighting visible, no thunder heard 

14 -   Precipitation within sight, but NOT reaching the ground 

15 -  Precipitation within sight, reaching the ground, but distant from station 

16 -   Precipitation within sight, reaching the ground, near to but NOT at station 

17 -  Thunder heard, but no precipitation at the station 

18 -    Squall(s) within sight during past hour 

19 -  Funnel cloud(s) within sight during past hour 

20 -  Drizzle (NOT freezing and NOT falling as showers) during past hour, but NOT 
     at time of observations 

21-  Rain (NOT freezing and NOT falling as showers) during past hour, but NOT at 
 time of observations 
 

22 -  Snow (NOT falling as showers) during past hour, but NOT at time of observation 
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Current Weather Symbols (cont.): 
 

23 -  Rain and snow (NOT falling as showers) during past hour, but NOT at time of observation 

24 -  Freezing drizzle or freezing rain (NOT falling as showers) during past hour, but NOT at time      of 
observation                                     

25 -  Showers of rain during past hour, but NOT at time of observation 

26 -  Showers of snow, or of rain and snow, during past hour, but NOT at time of observation 

27 -  Showers of hail, or of hail and rain, during past hour, but NOT at time of observation 

28 -  Fog during past hour, but NOT at time of observation 

29 -  Thunderstorm (with or without precipitation) during past hour, but NOT at time of observation 

30 -  Slight or moderate dust storm or sand storm, has decreased during past hour 

31 -   Slight or moderate dust storm or sand storm, no appreciable change during past hour 

32 -  Slight or moderate dust storm or sand storm, has increased during past hour 

33 -  Severe dust storm or sand storm, has decreased during past hour 

34 -   Severe dust storm or sand storm, no appreciable change during past hour 

35 -  Severe dust storm or sand storm, has increased during past hour 

36 -    Slight or moderate drifting snow, generally low 

37 -  Heavy drifting snow, generally low 

38 -  Slight or moderate drifting snow, generally high 

39 -  Heavy drifting snow, generally high  

40 -  Fog at distance at time of observation, but NOT at station during past hour 

41 -  Fog in patches 

42 -  Fog, sky discernible, has become thinner during past hour 

43 -  Fog, sky NOT discernible, has become thinner during the past hour 

44 -   Fog, sky discernible, no appreciable change during past hour 

45 -   Fog, sky NOT discernible, no appreciable change during past hour 

46 -  Fog, sky discernible, has begun or become thicker during past hour 
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Current Weather Symbols (cont.): 
 

47 -  Fog, sky NOT discernible, has begun or become thicker during past hour 

48 -  Fog, depositing rime, sky discernible 

49 -   Fog, depositing rime, sky NOT discernible 

50 -     Intermittent drizzle (NOT freezing) slight at time of observation 

51 -  Continuous drizzle (NOT freezing) slight at time of observation 

52 -   Intermittent drizzle (NOT freezing moderate at time of observation 

53 -  Continuous drizzle (NOT freezing), moderate at time of observation 

54 -    Intermittent drizzle (NOT freezing), thick at time of observation 

55 -  Continuous drizzle (NOT freezing), thick at time of observation 

56 -  Slight freezing drizzle 

57 -  Moderate or thick freezing drizzle 

58 -     Drizzle and rain, slight 

59 -   Drizzle and rain, moderate or heavy 

60 -      Intermittent rain (NOT freezing), slight at time of observation 

61 -  Continuous rain (NOT freezing), slight at time of observation 

62 -     Intermittent rain (NOT freezing) moderate at time of observation 

63 -  Continuous drizzle (NOT freezing), moderate at time of observation 

64 -    Intermittent rain (NOT freezing), heavy at time of observation 

65 -    Continuous rain (NOT freezing), heavy at time of observation 

66 -  Slight freezing rain 

67 -  Moderate or heavy freezing rain 

68 -   Rain or drizzle and snow, slight 

69 -   Rain or drizzle and snow, moderate or heavy 

70 -     Intermittent fall of snowflakes, moderate at time of observation 

71 -  Continuous fall of snowflakes, slight at time of observation 

72 -    Intermittent fall of snowflakes, moderate at time of observation 
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Current Weather Symbols (cont.): 
 

73 -  Continuous fall of snowflakes, moderate at time of observation 

74 -     Intermittent fall of snowflakes, heavy at time of observation 

75 -  Continuous fall of snowflakes, heavy at time of observation 

76 -   Ice needles (with or without fog) 

77 -    Granular snow (with or without fog) 

78 -  Isolated star like snow crystals (with or without fog) 

79 -    Ice pellets (sleet, U. S. definition) 

80 -  Slight rain shower(s) 

81 -  Moderate or heavy rain showers(s) 

82 -  Violent rain shower(s) 

83 -   Slight shower(s) of rain and snow mixed 

84 -   Moderate or heavy shower(s) of rain and snow mixed 

85 -   Slight snow shower(s) 

86 -  Moderate or heavy snow shower(s) 

87 -  Slight shower(s) of soft or small hail with or without rain, or rain and snow mixed 

88 -  Moderate or heavy shower(s) of soft or small hail with or without rain, or rain and snow mixed 

89 -  Slight shower(s) of hail, with or without rain or rain and snow mixed, not associated with thunder 

90 -   Moderate or heavy shower(s) of hail, with or without rain or rain and snow 
 mixed, not associated with thunder 

91 -  Slight rain at time of observation; thunderstorm during past hour, but NOT at time of observation 

92 -  Moderate or heavy rain at time of observation; thunderstorm during past hour, 
 but NOT at time of observation 
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Current Weather Symbols (cont.): 
 

93 -  Slight snow or rain and snow mixed or hail at time of observation; thunder 
 storm during past hour, but not at time observation 
 

94 -  Moderate or heavy snow, or rain and snow mixed or hail at time of observation; thunderstorm 
during past hour, but NOT at time of observation 

 

95 -  Slight or moderate thunderstorm without hail, but with rain and/or snow at 
time of observation 

 

96 -  Slight or moderate thunderstorm, with hail at time of observation 
 

97 -  Heavy thunderstorm, without hail, but with rain and/or snow at time of observation 

98 -  Thunderstorm combined with dust storm or sand storm at time of observation 

99 -  Heavy thunderstorm with hail at time of observation 

201 -  Volcanic ash 

202 -  Blowing spray 

203 -     Unknown precipitation from an automatic station 
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Sky Cover Symbols: 
 

  0 -   No clouds 

  1 -  Less than one-tenth or one-tenth 

  2 -  Two-tenths or three-tenths 

  3 -   Four-tenths 

  4 -    Five-tenths 

  5 -   Six-tenths 

  6 -  Seven-tenths or eight-tenths 

  7 -  Nine-tenths or overcast with openings 

  8 -  Completely overcast 

  9 -  Sky obscured 

10 -  Missing 
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Pressure Tendency Symbols: 
 

0 -    Rising, the falling 

1 -   Rising, then steady; or rising, the rising more slowly 

2 -    Rising steadily, or unsteadily 

3 -   Falling or steady, then rising; or rising, then rising more quickly 

4 -   Steady, same as 3 hours ago 

5 -  Falling, then rising, same or lower than 3 hours ago 

6 -  Falling, then steady; or falling, then falling more slowly 

7 -   Falling steadily, or unsteadily 

8 -   Steady or rising, then falling; or falling, then falling more quickly 
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Past Weather Symbols: 
 

0 -    Clear or Few Clouds 

1 -    Partly cloudy (scattered) or variable sky 

2 -    Cloudy (broken) or overcast 

3 -  Sandstorm or dust storm, or drifting or blowing snow 

4 -     Fog, or smoke, or thick dust haze 

5 -     Drizzle 

6 -      Rain 

7 -   Snow, or rain and snow mixed, or ice pellets (sleet) 

8 -    Shower(s) 

9 -   Thunderstorm, with or without precipitation 
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Appendix D:  Common Color Tables 
 
 
 Basic Colors                 RED     GREEN     BLUE 
RED                255       0      0  red 
GREEN                0     255      0  green 
BLUE                 0       0    255  blue 
YELLOW             255     255      0  yellow 
CYAN                 0     255    255  cyan 
MAGENTA            255       0    255  magenta 
WHITE              255     255    255  white 
BLACK                0       0      0  black 
 
GRAY               127     127    127  gray 
VANILLA            255     228    220  bisque 
 
 Oranges 
ORANGE             255     127      0  DarkOrange 
DKORANGE           205     133      0  orange 
CORAL              255     130     71  sienna 
 
 Browns 
BROWN              139      71     38  sienna 
BEIGE              255     127     36  chocolate 
SAND               205     133     63  tan 
MUD                139      69     19  chocolate 
 
 Blues 
SKY                  0     178    238  DeepSkyBlue 
LTBLUE              30     144    255  DodgerBlue 
GRPBLUE             16      78    139  DodgerBlue 
MDCYAN               0     238    238  cyan 
AQUA                 0     205    205  cyan 
NAVY                 0       0    139  blue 
DKBLUE               0       0    205  blue 
INDIGO             148       0    211  DarkViolet 
 
 Greens 
LWNGRN             127     255      0  chartreuse 
MDGREEN              0     205      0  green 
DKGREEN              0     139      0  green 
LTGREEN            124     252      0  lawn green 
AVOCADO            107     142     35  olive drab 
FOGREEN              0     100      0  dark green 
 
 Yellows 
GOLD               255     215       0  gold 
DKYELLOW           238     238       0  yellow 
BLOND              238     180      34  goldenrod 
 Reds 
PINK               255     174     185  LightPink 
DKPINK             255     106     106  IndianRed 
MAROON             139       0       0  red 
APRICOT            255     165      79  tan 
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VIOLET             137     104     205  MediumPurple 
MDVIOLET           238      44      44  firebrick 
PURPLE             145      44     238  purple 
PLUM               139       0     139  magenta 
FIREBRIC           205       0       0  red 
ORRED              238      64       0  OrangeRed 
  
 Grays 
G99                252     252     252  gray99 
G98                250     250     250  gray98 
G97                247     247     247  gray97 
G96                245     245     245  gray96 
G95                242     242     242  gray95 
G94                240     240     240  gray94 
G93                237     237     237  gray93 
G92                235     235     235  gray92 
G91                232     232     232  gray91 
G90                230     230     230  gray90 
G89                227     227     227  gray89 
G88                224     224     224  gray88 
G87                222     222     222  gray87 
G86                219     219     219  gray86 
G85                217     217     217  gray85 
G84                214     214     214  gray84 
G83                212     212     212  gray83 
G82                209     209     209  gray82 
G81                207     207     207  gray81 
G80                204     204     204  gray80 
G79                201     201     201  gray79 
G78                199     199     199  gray78 
G77                196     196     196  gray77 
G76                194     194     194  gray76 
G75                191     191     191  gray75 
G74                189     189     189  gray74 
G73                186     186     186  gray73 
G72                184     184     184  gray72 
G71                181     181     181  gray71 
G70                179     179     179  gray70 
G69                176     176     176  gray69 
G68                173     173     173  gray68 
G67                171     171     171  gray67 
G66                168     168     168  gray66 
G65                166     166     166  gray65 
G64                163     163     163  gray64 
G63                161     161     161  gray63 
G62                158     158     158  gray62 
G61                156     156     156  gray61 
G60                153     153     153  gray60 
G59                150     150     150  gray59 
G58                148     148     148  gray58 
G57                145     145     145  gray57 
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Grays (cont.) 
 
G56                143     143     143  gray56 
G55                140     140     140  gray55 
G54                138     138     138  gray54 
G53                135     135     135  gray53 
G52                133     133     133  gray52 
G51                130     130     130  gray51 
G50                128     128     128  gray50 
G49                125     125     125  gray49 
G48                122     122     122  gray48 
G47                120     120     120  gray47 
G46                117     117     117  gray46 
G45                115     115     115  gray45 
G44                112     112     112  gray44 
G43                110     110     110  gray43 
G42                107     107     107  gray42 
G41                105     105     105  gray41 
G40                102     102     102  gray40 
G39                 99      99      99  gray39 
G38                 97      97      97  gray38 
G37                 94      94      94  gray37 
G36                 92      92      92  gray36 
G35                 89      89      89  gray35 
G34                 87      87      87  gray34 
G33                 84      84      84  gray33 
G32                 82      82      82  gray32 
G31                 79      79      79  gray31 
G30                 77      77      77  gray30 
G29                 74      74      74  gray29 
G28                 71      71      71  gray28 
G27                 69      69      69  gray27 
G26                 66      66      66  gray26 
G25                 64      64      64  gray25 
G24                 61      61      61  gray24 
G23                 59      59      59  gray23 
G22                 56      56      56  gray22 
G21                 54      54      54  gray21 
G20                 51      51      51  gray20 
G19                 48      48      48  gray19 
G18                 46      46      46  gray18 
G17                 43      43      43  gray17 
G16                 41      41      41  gray16 
G15                 38      38      38  gray15 
G14                 36      36      36  gray14 
G13                 33      33      33  gray13 
G12                 31      31      31  gray12 
G11                 28      28      28  gray11 
G10                 26      26      26  gray10 
G09                 23      23      23  gray9 
G08                 20      20      20  gray8 
G07                 18      18      18  gray7 
G06                 15      15      15  gray6 
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Grays (cont.) 
 
G05                 13      13      13  gray5 
G04                 10      10      10  gray4 
G03                  8       8       8  gray3 
G02                  5       5       5  gray2 
G01                  3       3       3  gray1 
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Appendix E:  Assorted Diagnostic Formulas 
 
 
Helicity/Holicity Information –  
 
Many meteorologists are familiar with the term ‘Helicity’ but they may not have heard of ‘Holicity’. Below is 
an explanation of the two functions. 
 
Helicity: integrated "streamwise component" of horizontal vorticity flux. 
Holicity: integrated "crosswise component" of horizontal vorticity flux. 
 
Holicity calculation is based on code developed by Erik Rasmussen (1990-1991) 
 
The Holicity function computes the integrated "crosswise component" of horizontal vorticity flux.  This 
parameter is similar to helicity and is discussed in Davies-Jones, JAS 41, p. 2991- (1984). 
 
HELICITY = INTEGRAL [ (u-c_u) * dv/dz - (v-c_v) * du/dz] Dz 
HOLICITY = INTEGRAL [ (u-c_u) * du/dz - (v-c_v) * dv/dz] Dz 
 
Note that holicity is the same as helicity but with the vertical derivative terms reversed. 
 
It is possible that comparisons of crosswise (holicity) vs. streamwise (helicity) integrated vorticity may lead 
to intriguing new techniques to forecast storm type or motion. 
 
 
 
New Frontogenesis Formulas –  
 
Rotational Frontogenesis and its sub functions use the following formula: 
 
       RFGV = 0.5*MAG(GRAD(THTA))*(DDX(VGRD)-DDY(UGRD)) 
       RFGD = (0.5/MAG(GRAD(THTA))*(2.*DDX(THTA)*DDY(THTA)*Est+ 
                (DDX(THTA)*DDX(THTA)-DDY(THTA)*DDY(THTA))*Esh) 
       RFGT = (1./MAG(GRAD(THTA))*thetap*(DDX(OMEGA)*DDY(THTA) 
                 +DDY(OMEGA)*DDX(THTA)) 
       RFGN = (RFGV+RFGD+RFGT)*1.E9 
 
       WHERE: Esh = DDX(VGRD)+DDY(UGRD) 
                       Est = DDX(UGRD)-DDY(VGRD) 
                 Thetap = ((PRES(LVL)-PRES(LVL+1))*(THETA(LVL-1)- 
                 THETA(LVL))/(PRES(LVL-1)-PRES(LVL))+(PRES(LVL-1)-PRES(LVL))* 
                (THETA(LVL)-THETA(LVL+1))/(PRES(LVL)-PRES(LVL+1)))/ 
                (PRES(LVL-1)-PRES(LVL+1)) 
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Escalar Frontogenesis and its sub functions use the following formula: 
 
       EFGG = -0.5*MAG(GRAD(THTA))*(DDX(UGRD)+DDY(VGRD)) 
       EFGD = -(0.5/MAG(GRAD(THTA))*(2.*DDX(THTA)*DDY(THTA)*Esh+ 
                (DDX(THTA)*DDX(THTA)-DDY(THTA)*DDY(THTA))*Est) 
       EFGT = -(1./MAG(GRAD(THTA))*thetap*(DDX(OMEGA)*DDX(THTA) 
                 +DDY(OMEGA)*DDY(THTA)) 
       EFGN = (EFGG+EFGD+EFGT)*1.E9 
 
 
       WHERE: Esh = DDX(VGRD)+DDY(UGRD) 
                       Est = DDX(UGRD)-DDY(VGRD) 
                 Thetap = ((PRES(LVL)-PRES(LVL+1))*(THETA(LVL-1)- 
                 THETA(LVL))/(PRES(LVL-1)-PRES(LVL))+(PRES(LVL-1)-PRES(LVL))* 
                (THETA(LVL)-THETA(LVL+1))/(PRES(LVL)-PRES(LVL+1)))/ 
                (PRES(LVL-1)-PRES(LVL+1)) 
 


